
Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tässä oppaassa käsitellään tuotteen ILME-FR7 / ILME-FR7K Interchangeable Lens Digital Camera määrityksiä ja
toimintaa.

Tutustu tähän käyttöoppaaseen ja asiaankuuluvien laitteiden käyttöohjeisiin tarvittaessa.

Yleistä

Tyypilliset käyttösovellukset

Järjestelmän määritys

Yksittäisen laitteen hallinta mukana toimitetulla infrapunakaukosäätimellä

Yksittäisen laitteen hallinta tabletilla tai tietokoneella

Yksittäisen laitteen hallinta ulkoisella kaukosäätimellä

Useiden laitteiden hallinta ulkoisella kaukosäätimellä

Osien sijainti ja toiminta

Näkymä laitteen edestä

Näkymä laitteen takaa

Liitäntälohko

Näkymä laitteen sivusta

Näkymä laitteen päältä

Näkymä laitteen alapuolelta

Objektiivin tuki

Infrapunakaukosäätimen (mukana) osien sijainti ja toiminta

Verkkosovellusnäyttö

Yleistä verkkosovellusnäytöstä

Näyttöjen yleisen alueen rakenne

Suoran käyttönäkymän rakenne

Toistotoimintojen näytön rakenne

Asetusnäytön rakenne

1



Valmisteleminen

Kameran valikko

Kameran näyttö

Laitteen asentaminen

Kiinnittäminen pystyasentoon kiinteään paikkaan

Kiinnittäminen korkealle kiinteään paikkaan

Kattoon kiinnittäminen

Objektiivin kiinnittäminen/irrottaminen

Muistettavaa objektiivin liittämistä/irrottamista koskien

Objektiivin kytkinten tarkistaminen

Muistettavaa zoom-objektiivin käyttöä koskien

Objektiivin kiinnittäminen

Objektiivin irrottaminen

Liitäntäjohdot

Laitteen yhdistäminen verkkolaitteeseen kaapelilla

Virtalähteen yhdistäminen

Verkkovirran käyttäminen

PoE++-virran käyttäminen

Panoroinnin/kallistuksen nollaaminen

Määrittäminen ennen kuvaamista

Laitteen alustaminen verkkosovelluksen avulla

Verkkosovelluksen käyttäminen verkkoselaimella

Laitteen alustaminen

Perustoimintojen määrittäminen

Muistikorttien valmisteleminen

Tuetut muistikortit

Muistikorttien asettaminen

Muistikortin poistaminen
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Kuvaaminen

Muistikorttien formatoiminen (alustaminen)

Jäljellä olevan tallennusajan tarkistaminen

Muistikorttien palauttaminen

Perustoiminnot

Tallentamisen aloittaminen/lopettaminen

Vaihtaminen muistikorttien välillä

Äänen tarkistaminen

Aikatietojen määrittäminen

Tallennuksen tarkasteleminen (Rec Review)

Rajauksen säätäminen

Rajauksen säätönäyttö

Kuvaussuunnan säätäminen

Kuvaussuunnan säätäminen verkkosovelluksen avulla

Panoroinnin/kallistuksen käyttönopeuden määrittäminen

Panorointi-/kallistustoiminnon kiihdytyksen määrittäminen

Kuvaussuunnan säätäminen mukana toimitettavan infrapunakaukosäätimen avulla

Zoomin säätäminen

Zoomityypin määrittäminen

Zoomin säätäminen verkkosovelluksen avulla

Zoomauksen käyttönopeuden määrittäminen

Zoomin säätäminen mukana toimitettavan infrapunakaukosäätimen avulla

Kameran panorointi-/kallistus-/zoomausasennon tallentaminen/palauttaminen (esiasetusvalinta)

E-pidikkeellisen objektiivin kalibrointi

Panoroinnin/kallistuksen, zoomausasennon ja tarkennuksen asetusten tallentaminen/palauttaminen verkkosovelluksen avulla

Esiasetusvalintojen nimeäminen uudelleen verkkosovelluksella

Tallennetun esiasetusvalinnan korvaaminen uudella asennolla verkkosovelluksen avulla

Tallennetun esiasetusvalinnan poistaminen verkkosovelluksen avulla

Panorointi-/kallistustoiminnon ja zoomaus-/tarkennustoiminnon synkronointi esiasetusvalintaa palautettaessa
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Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen esiasetusvalintaa palautettaessa

Panorointi-/kallistus- ja zoomausasennon tallentaminen/palauttaminen mukana toimitettavan infrapunakaukosäätimen avulla

Kameran rajaustoimintojen tallennus/toisto (PTZ Trace)

Kameran rajaustoimintojen tallennus verkkosovelluksella

Kameran rajaustoimintojen toistaminen verkkosovelluksella

Tallennettujen kameran rajaustoimintojen poistaminen verkkosovelluksella

Kameran rajaustoimintojen tallentaminen mukana toimitettavan infrapunakaukosäätimen avulla

Kameran rajaustoimintojen toistaminen mukana toimitettavan infrapunakaukosäätimen avulla

Tarkennuksen säätäminen

Tarkennuksen säätönäyttö

Tarkennuksen säätäminen käsin (Manual Focus)

Säätäminen käsin verkkosovelluksen avulla

Säätäminen käsin mukana toimitettavan infrapunakaukosäätimen avulla

Tarkennuksen säätäminen määrittämällä tarkennuskohta (Spot Focus)

Automaattitarkennuksen käyttäminen tilapäisesti (Push Auto Focus (AF))

Yksittäisen automaattitarkennuksen käyttäminen (Push Auto Focus (AF-S))

Tarkennuksen säätäminen automaattisesti (Auto Focus)

Säätäminen automaattisesti verkkosovelluksen avulla

Automaattinen säätäminen mukana toimitettavan infrapunakaukosäätimen avulla

Automaattitarkennusalueen/-kohdan määrittäminen (Focus Area)

Tarkennusalueen vaihtaminen nopeasti (Focus Setting)

Tarkennusalueen kehyksen siirtäminen kosketustoiminnoilla (kosketustarkennusalue)

Automaattitarkennustoimintojen säätäminen (AF-siirtymisnopeus, AF-kohteenvaihtumisherkkyys)

Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen avulla

Tarkentaminen käsin automaattitarkennuksen aikana mukana toimitettavan infrapunakaukosäätimen avulla

Manuaalitarkennuksen käyttäminen tilapäisesti automaattitarkennuksen aikana (Push Manual Focus)

Tarkentaminen käyttämällä kasvojen-/silmientunnistusta (Face/Eye Detection AF)

Määritetyn kohteen seuraaminen (Realtime Tracking AF)

Kirkkauden säätäminen
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Hyödyllisiä toimintoja

Kirkkauden säätönäyttö

Perusherkkyyden määrittäminen

Automaattisen kirkkaussäädön tavoitetason määrittäminen

Himmentimen säätäminen

Himmentimen säätäminen automaattisesti

Himmentimen säätäminen käsin

Herkkyysvahvistuksen säätäminen

Herkkyysvahvistuksen säätäminen automaattisesti

Herkkyysvahvistuksen säätäminen käsin

Sulkimen säätäminen

Sulkimen säätäminen automaattisesti

Sulkimen säätäminen käsin

Valon määrän säätäminen (ND-suodatin)

Tietoja ND-suodattimesta

Säätäminen esiasetetussa tilassa

Automaattinen säätäminen muuttuvassa tilassa

Säätäminen käsin muuttuvassa tilassa

Värin säätäminen luonnolliseen sävyyn (valkotasapaino)

Valkotasapainon säätöpaneeli

Valkotasapainon säätäminen automaattisesti

Valkotasapainon säätäminen käsin

Automaattisen valkotasapainon suorittaminen

Tallennettavan äänen määrittäminen

Äänen määritysnäyttö

Äänen tulolähteen valitseminen

Äänitystason säätäminen automaattisesti

Äänitystason säätäminen käsin

Suoravalikon toiminnot
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Ohjelmoitavat painikkeet

Hidastus ja nopeutus

Videon tallentaminen jaksottaisesti (Interval Rec)

Kuvien tallentaminen välimuistiin (Picture Cache Rec)

Muistikorteille A ja B tallentaminen samanaikaisesti (2 paikan Simul Rec)

Videosignaalin näyttö

Leikeliput

Hengityksen kompensaatio

Välityspalvelimelle tallentaminen

Yleistä välityspalvelimelle tallentamisesta

Välityspalvelimen tallentaminen

Kuvaaminen halutulla ulkoasulla

Yleistä ulkoasusta

Ulkoasun valitseminen

Halutun perusulkoasun tuominen

Ulkoasun mukauttaminen

Ulkoasun tallentaminen

Perusulkoasun poistaminen

Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä

Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä

LUT-tiedoston käyttäminen HDMI-lähdössä ja suoratoistossa

LUT-tiedoston vaihtaminen

Tummien ja kirkkaiden alueiden jakauman muuttaminen tallennetussa kuvassa

RAW-tallennus

RAW-videon tallentaminen

RAW-videon tallentaminen Hidastus ja nopeutus -tilassa

Boken hallinta (Bokeh Control -toiminto)

Boken hallintatoiminnon kytkeminen päälle / pois päältä
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Verkkotoiminnot

Pikkukuvanäyttö

Kameran valikko ja tarkemmat asetukset

Boken määrän säätäminen

Määritystietojen tallentaminen ja lataaminen

Yleistä määritystietojen tallentamisesta ja lataamisesta

ALL-tiedoston tallentaminen

ALL-tiedoston lataaminen

Tiedostojen siirtäminen

Tietoja tiedoston siirrosta

Tiedostonsiirtokohteen rekisteröiminen

Tiedoston valitseminen ja lataaminen

Välityspalvelintiedoston lataaminen muistikortille pikkukuvanäytöstä

Alkuperäistiedoston lataaminen muistikortille pikkukuvanäytöstä

Tiedostonsiirron tilan tarkistaminen

Lataaminen käyttämällä suojattua FTP:tä

Suoratoiston määrittäminen

Tietoja suoratoistosta

Suoratoistomuodon määrittäminen

Videokoodekin määrittäminen suoratoistoa varten

Äänikoodekin määrittäminen suoratoistoa varten

Suoratoiston aloittaminen/lopettaminen

Pikkukuvanäyttö

Leikkeiden toistaminen ja muut leiketoiminnot

Tallennettujen leikkeiden toistaminen

Tallennettujen leikkeiden toiminnot

Kameran valikon määritykset

Kameran valikon käyttäminen

Kameran valikon käyttäminen
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Merkkijonon syöttäminen

User-valikko

User

Edit User-valikko

Edit User

Shooting-valikko

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project-valikko

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Paint/Look-valikko

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt-valikko

P/T Acceleration

TC/Media-valikko

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring-valikko

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio-valikko
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Audio Input

Audio Output

Thumbnail-valikko

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical-valikko

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network-valikko

Wired LAN

File Transfer

Maintenance-valikko

Language

Clock Set

Hours Meter

Shooting-valikon asetukset ja oletusarvot

ISO/Gain -asetukset ja oletusarvot
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Verkkovalikko ja tarkemmat asetukset

AGC Limit -asetukset ja oletusarvot

Kullekin kuvaustilalle tallennetut kuvanlaatuasetukset

Verkkovalikon määritykset

Verkkovalikon toiminnot

Shooting-valikko

Focus

Project-valikko

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look-valikko

Base Look

Pan-Tilt-valikko

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring-valikko

Output Format

Output Display

Audio-valikko

Audio Input
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Audio Output

Technical-valikko

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network-valikko

Camera Name

User

Wired LAN

File Transfer

FTP Server 1–3

SSL

Referer Check

Brute Force Attack Protection

Stream-valikko

Stream

Video Stream

Audio Stream

Maintenance-valikko

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Ulkoisen laitteen liittäminen

Liite

Service

EULA

Software

Ulkoisten näyttöjen ja tallennuslaitteiden liittäminen

RCP:n/MSU:n (lisävaruste) liittäminen

Yhdistäminen RCP:llä/MSU:lla

Laitteen ja RCP:n kahdenvälinen yhteys

Laitteen käyttäminen monikameraympäristössä MSU:lla tai kameran etäohjausohjelmistolla

Tuettujen toimintojen lista

Toimintojen käyttäminen RM-IP500-kaukosäätimen (lisävaruste) avulla

Toimintojen käyttäminen RM-IP500-kaukosäätimen (lisävaruste) avulla

RM-IP500-kaukosäätimen liittäminen

Synkronoiminen ulkoisen laitteen kanssa

Synkronoiminen ulkoisen laitteen kanssa

Videosignaalin vaiheiden synkronointi (tahtilukitus)

Aikakoodin lukitseminen muihin laitteisiin

Ulkoisen mikrofonin tai ulkoisen äänilaitteen liittäminen

Leikkeiden hallitseminen/muokkaaminen tietokoneella

Optisen kuitusignaalin lähettäminen

Tally-merkkivalosignaalin yhdistäminen

Seurantatietojen lähetys (free-d)

Objektiivin ohjaimen liittäminen

Zoomin säätäminen objektiivin ohjaimella

Käyttöä koskevat varoitukset

Lähtömuodot ja rajoitteet

Vianetsintä

Virhe-/varoitusviestit
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5-041-958-73(1) Copyright 2022 Sony Corporation

Valikkokohteiden luettelo

Esiasetusvalintojen tallennetut kohteet

Lohkokaaviot

E-pidikkeellisen objektiivin ohjelmiston päivittäminen

Objektiivin vapautuspainikkeen kannen kiinnittäminen

Lisenssit

Tekniset tiedot

Tavaramerkit
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Järjestelmän määritys

Tämä laite voidaan yhdistää oheislaitteisiin ja muodostaa erilaisia järjestelmäyhdistelmiä.

E-pidikkeellinen objektiivi1.

LA-EA3 / LA-EA4 A-pidikkeellinen sovite2.

Infrapunakaukosäädin (mukana)3.

CFexpress Type A -muistikortit / SDXC-muistikortit4.

CFexpress Type A -kortin lukulaite / SD-kortin lukulaite5.

ECM-680S, ECM-678*, ECM-674* -mikrofoni6.
EC-0.5X3F5M 3-napainen → 5-napainen XLR-sovitinjohto tarvitaan.*

Verkkovirtalaite (mukana)7.

Videonäyttö8.

RM-IP500-kaukosäädin9.
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5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Yksittäisen laitteen hallinta mukana toimitetulla infrapunakaukosäätimellä

Yksittäistä laitetta voi hallita etänä mukana toimitetulla infrapunakaukosäätimellä.

 Videosignaali
 Signaalin kulku

5-041-958-73(1) Copyright 2022 Sony Corporation

Infrapunakaukosäädin (mukana)1.

Videonäyttö2.

17



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Yksittäisen laitteen hallinta tabletilla tai tietokoneella

Laitteeseen voi yhdistää tabletin tai tietokone ja hallita laitetta verkkoselaimella.

 Videosignaali
 Kaukosäätimen signaali

  Signaalin kulku

5-041-958-73(1) Copyright 2022 Sony Corporation

Videonäyttö1.

Tabletti2.

Tietokone3.

Tukiasema4.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Yksittäisen laitteen hallinta ulkoisella kaukosäätimellä

Laitetta voi hallita etänä kaukosäätimellä.

 Videosignaali
 Kaukosäätimen signaali

  Signaalin kulku

5-041-958-73(1) Copyright 2022 Sony Corporation

Videonäyttö1.

RM-IP500-kaukosäädin2.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Useiden laitteiden hallinta ulkoisella kaukosäätimellä

Yhdellä kaukosäätimellä voi hallita etänä jopa sataa laitetta.

 Videosignaali
 Kaukosäätimen signaali
 Tally-/yhteysmerkkivalo

  Signaalin kulku

5-041-958-73(1) Copyright 2022 Sony Corporation

Videonäyttö1.

Videon vaihtaja2.

Ethernet-keskitin3.

RM-IP500-kaukosäädin4.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Näkymä laitteen edestä

Tässä osiossa käsitellään laitteen etuosassa sijaitsevien osien sijaintia ja toimintaa.

Vihje

Tämä kuvaus viittaa laitteen kuvaan ilman kiinnitettyä objektiivia.

Kamerapää

Huomautus

Älä kohdista kamerapäähän voimakkaita iskuja.

1.

Tallennuksen merkkivalo
Kun merkkivalo on määritetty tallennuksen merkkivaloksi, se palaa punaisena muistikortille tallentamisen aikana.
Merkkivalo vilkkuu, kun tallennusvälineen jäljellä oleva vapaa tila on vähissä tai tapahtuu virhe.

2.
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Lisätietoja on kohdassa ”Virhe-/varoitusviestit”.

Kun merkkivalo on määritetty Tally-merkkivaloksi, se palaa punaisena tai vihreänä ulkoisen Tally-signaalin mukaan.

Lisätietoja on kohdassa ”Tally-merkkivalosignaalin yhdistäminen”.
Kuva-anturi

Huomautus

Älä kosketa suoraan käsin.

3.

Objektiivin vapautuspainike
Irrota objektiivi painamalla.

Lisätietoja on kohdassa ”Objektiivin irrottaminen”.

4.

Objektiivin signaalikoskettimet

Huomautus

Älä kosketa suoraan käsin.

5.

POWER-merkkivalo6.

NETWORK-merkkivalo
POWER- ja NETWORK-merkkivalon tilat ja värit (palaa, vilkkuu, ei pala) osoittavat laitteen eri tiloja.

7.

POWER-
merkkivalo

NETWORK-
merkkivalo Laitteen tila

Palaa
vihreänä*1

Palaa vihreänä Virta kytketty (verkkoyhteys)

Ei pala Virta kytketty (ei verkkoyhteyttä)

Vilkkuu vihreänä Ei pala Käynnistyy

Palaa oranssina Ei pala Virran valmiustila

Vilkkuu
keltaisena

Ei pala Ohjelmistoa päivitetään

Vilkkuu hitaasti
oranssina*2

Vilkkuu hitaasti
vihreänä*2

Laite ei voi toimia normaalisti. Lisätietoja on järjestelmälokissa. Jos ongelma
jatkuu myös sen jälkeen, kun laite on asetettu valmiustilaan tai virta on
katkaistu ja laitettu uudelleen päälle, ota yhteys Sonyn palveluedustajaan.

Vilkkuu nopeasti
oranssina*3

Vilkkuu nopeasti
vihreänä*3 Laitteessa tapahtui virhe. Ota yhteyttä Sonyn palveluedustajaan.

Vilkkuu vihreänä, kun laite vastaanottaa komennon toimitukseen sisältyvästä infrapunakaukosäätimestä.*1

Vilkkuu hitaasti: Vilkahtaa kerran sekunnissa*2

Vilkkuu nopeasti: Vilkahtaa neljä kertaa sekunnissa*3

Infrapunakaukosäätimen sensori
Vastaanottaa komennon mukana toimitettavasta infrapunakaukosäätimestä.

8.

Ilmantuloaukko

Huomautus

9.
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Aiheeseen liittyvää

Virhe-/varoitusviestit

Tally-merkkivalosignaalin yhdistäminen

Objektiivin irrottaminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Älä estä ilman virtausta. Se voi aiheuttaa toimintahäiriön.

23



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Näkymä laitteen takaa

Tässä osiossa käsitellään laitteen takaosassa sijaitsevien osien sijaintia ja toimintaa.

Aiheeseen liittyvää

Näkymä laitteen sivusta

5-041-958-73(1) Copyright 2022 Sony Corporation

Kamerapään lukitusvipu
Lukitsee kamerapään eteen/taakse suuntautuvan liikkeen.

Huomautus

Aseta aina lukitusasentoon, kun et ole vaihtamassa objektiivia.

Irrota objektiivi ja aseta vipu lukitusasentoon aina kun kuljetat laitetta.

Sammuta laitteen virta ja lukitse kamerapää vaakatasoon panoroinnin/kallistuksen lukitusvivun avulla ennen lukitusvivun
käyttämistä, jotta sormet eivät jää puristuksiin. Lisätietoja panoroinnin/kallistuksen lukitusvivusta on kohdassa
”Panoroinnin/kallistuksen lukitusvipu” osiossa ”Näkymä laitteen sivusta”.

1.

Liukualusta2.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Liitäntälohko

Tässä osiossa käsitellään laitteen liitäntälohkossa sijaitsevien osien sijaintia ja toimintaa.

 (maadoitus) liitäntä
Liitä maahan yhdistämällä virtalähteen maadoitusliittimeen tai maadoitustankoon.

1.

DC IN -liitin (DC-vakioliitäntä)
Yhdistä AC-verkkolaitteeseen.

Huomautus

Älä käytä muuta kuin toimitukseen sisältyvää AC-verkkolaitetta. Muun verkkolaitteen yhdistäminen voi aiheuttaa tulipalon tai
toimintavirheen.

2.

 LAN (verkko) -liitin (RJ-45)
Yhdistä verkkokaapeli (luokka 5e tai korkeampi) verkkoviestintää ja PoE++*-virtalähdettä varten.

Speed LED -näytön tila
Ilmaisee verkkoyhteyden nopeuden.

3.

PoE++: Power over Ethernet Plus Plus, virta Ethernet Plus Plus -lähteestä. Vastaa IEEE802.3bt (Type 4 Class 8) -vaatimuksia. Lisätietoja
yhteyden muodostamisesta on virransyöttölaitteen käyttöohjeessa.

*
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Link/ACT LED -näytön tila
Ilmaisee verkkoyhteyden tilan.

Huomautus

Yhdistä tuote internetiin suojaustoiminnolla varustetun järjestelmän, esimerkiksi reitittimen tai palomuurin, kautta.
Yhdistäminen ilman tällaista suojausta voi johtaa tietoturvaongelmiin.

Näyttö  Yhteyden nopeus

Ei pala
10 Mb/s:n yhteys

100 Mb/s:n yhteys

Palaa oranssina 1 000 Mb/s:n yhteys

Näyttö  Yhteyden tila

 Ei pala Ei linkkiä

Vilkkuu vihreänä Linkki muodostettu, tiedonsiirto aktiivinen

Palaa vihreänä Aktiivinen linkki

TC IN -liitin
Ulkoisen aikakoodisignaalin tulo.

Lisätietoja on kohdassa ”Aikakoodin lukitseminen muihin laitteisiin”.

4.

HDMI-liitin
Videon lähtö laitteesta HDMI-signaalina.

Lisätietoja on kohdassa ”HDMI-liitin (Type A -liitin)” osiossa ”Ulkoisten näyttöjen ja tallennuslaitteiden liittäminen”.

5.

HDMI-kaapelin pidikelevyn kiinnitysruuvi
Jotta HDMI-kaapelia ei voi irrottaa, kiinnitä mukana toimitettava HDMI-kaapelin pidikelevy mukana toimitettavalla
kiinnitysruuvilla (M2.6×6) ja kiinnitä HDMI-kaapeli kaupasta saatavalla nippusiteellä tai nauhalla.

Lisätietoja HDMI-kaapelin pidikelevyn kiinnittämisestä on kohdassa ”Liitäntäjohdot”.

6.

OPTION-liitin
Käytetään ulkoisesta laitteesta tulevan Tally-signaalin tai objektiivin ohjaimen liittämiseen.

Lisätietoja on kohdissa ”Tally-merkkivalosignaalin yhdistäminen” ja ”Objektiivin ohjaimen liittäminen”.

7.

Johtolukko
Käytetään verkkolaitteen johdon kiinnittämiseen.

8.

RESET-kytkin
Nollaa laitteen asetukset tehdasasetuksiin painamalla kynänkärjellä tai muulla vastaavalla vähintään viiden sekunnin
ajan.
SETUP-kytkin 1:llä voit valita, nollataanko vain verkkoyhteysasetukset vai kaikki asetukset.

9.

OPTICAL-lähtöliitin
Lähettää optiseen muotoon muunnetun SDI-signaalin, kun SFP+-moduuli (lisävaruste) on liitetty.

Lisätietoja on kohdassa ”Optisen kuitusignaalin lähettäminen”.

10.
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SETUP-kytkimet

Määrittää seuraavat asetukset.
Kytkin 1: Määrittää, mitkä asetukset nollataan RESET-kytkintä painamalla.

Kytkin 2: Määrittää, kytketäänkö +48 V -virransyöttö (phantom-virta) päälle / pois päältä, kun äänitulolaite on
kytkettynä. Asetus otetaan heti käyttöön.
Tämä toiminto on käytössä, kun kameran valikon kohdan [Audio] > [Audio Input] > [AUDIO IN Select] asetuksena on
[MIC].

Huomautus

Jos kytkin 2 asetetaan ON-asentoon eikä liitetty mikrofoni ole yhteensopiva +48 V -lähteen kanssa, liitetty laite voi vaurioitua.
Tarkista asetus ennen laitteen liittämistä.

Kytkin 3: Ottaa VISCA over IP -toiminnon käyttöön/pois käytöstä. Asetukset otetaan käyttöön, kun kameraan
kytketään virta.
Asettamalla ON-asentoon laitetta voidaan käyttää, kun se on kytkettynä kaukosäätimeen (RM-IP500).

Huomautus

Jos pääkäyttäjän salasanaa ei ole määritetty, VISCA over IP -toiminto on pois käytöstä kytkimen asennosta riippumatta.
Lisätietoja pääkäyttäjän salasanan määrittämisestä on kohdassa ”Laitteen alustaminen”.

Kytkin 4: Muuttaa infrapunakaukosäätimestä lähetettyjen panorointi-/kallistustoimintojen nopeutta. Asetus otetaan
heti käyttöön.

11.

Asetus Kuvaus

OFF
(oletus)

Palauttaa ainoastaan verkkoyhteysasetukset. Laitteen verkkoasetukset, turvallisuusasetukset ja
käyttäjätiedot (käyttäjänimi ja salasana) nollataan.

ON Palauttaa kaikki asetukset tehdasasetuksiin.

Asetus Kuvaus

OFF
(oletus)

Älä syötä +48 V -virtaa (phantom-virransyöttö). Määritä tämä asetus, kun käytössä on ulkoinen
äänilaite (esim. mikseri), dynaaminen mikrofoni tai mikrofoni, jossa on sisäinen akku.

ON
Syötä +48 V -virtaa (phantom-virransyöttö) phantom-virtaa tukevaan mikrofoniin, joka on yhdistetty
AUDIO IN -liittimeen (CH-1 tai CH-2).

Asetus Kuvaus

OFF (oletus) Ei vastaa VISCA over IP -komentoihin.

ON Hyväksyy VISCA over IP -komennot.
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Aiheeseen liittyvää

Aikakoodin lukitseminen muihin laitteisiin

Ulkoisten näyttöjen ja tallennuslaitteiden liittäminen

Liitäntäjohdot

Tally-merkkivalosignaalin yhdistäminen

Objektiivin ohjaimen liittäminen

Optisen kuitusignaalin lähettäminen

Laitteen alustaminen

Videosignaalin vaiheiden synkronointi (tahtilukitus)

Ulkoisen mikrofonin tai ulkoisen äänilaitteen liittäminen
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Asetus Kuvaus

OFF (oletus) Toimii normaalinopeudella.

ON Toimii enimmäisnopeudella.

SDI OUT -liitin
Videon lähtö laitteesta 12G/6G/3G/HD-SDI-signaalina.
Laite voidaan määrittää myös RAW-signaalilähdölle.

Lisätietoja on kohdassa ”SDI OUT -liitin (BNC-tyyppi)” osiossa ”Ulkoisten näyttöjen ja tallennuslaitteiden
liittäminen”.

12.

 Infrapunakaukosäätimen sensori (takaosa)
Infrapunasensori mukana toimitettavalle infrapunakaukosäätimelle.

13.

Tuuletin/ilmanpoistoaukko
Poistaa lämpöä laitteen sisältä.

Huomautus

Älä peitä ilmanpoistoaukkoa. Se voi aiheuttaa toimintahäiriön.

Huomaa, että ilmanpoistoaukkoa ympäröivä alue voi kuumentua.

14.

GENLOCK-liitin
Käytetään ulkoisen synkronointisignaalin tuloon.

Lisätietoja on kohdassa ”Videosignaalin vaiheiden synkronointi (tahtilukitus)”.

15.

AUDIO IN -liitin (XLR-tyypin 5-nastainen liitin)
Käytetään signaalin tuloon ulkoisesta mikrofonista tai äänilaitteesta.
Toimii AUDIO IN CH-1 -liittimenä tai AUDIO IN CH-2 -liittimenä.

Lisätietoja on kohdassa ”Ulkoisen mikrofonin tai ulkoisen äänilaitteen liittäminen”.

16.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Näkymä laitteen sivusta

Tässä osiossa käsitellään laitteen sivussa sijaitsevien osien sijaintia ja toimintaa.

Vihje

Tämä kuvaus viittaa laitteen kuvaan ilman kiinnitettyä objektiivia.

Panoroinnin/kallistuksen lukitusvipu
Lukitsee laitteen panorointi-/kallistusmekanismin. Käytä seuraavissa tapauksissa.

Kun laitetta siirretään tai pakataan.
Kun objektiivia kiinnitetään tai irrotetaan. Lisätietoja on kohdassa ”Objektiivin kiinnittäminen” tai ”Objektiivin
irrottaminen”.
Kun käytetään objektiivia, joka ei tue panorointi-/kallistustoimintoa (esim. Sony SEL100400GM / SEL200600G /
SEL400F28GM / SEL600F40GM -objektiivit).
Irrota objektiivi ja aseta vipu lukitusasentoon aina kun kuljetat laitetta.

1.
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Aiheeseen liittyvää

Objektiivin kiinnittäminen

Objektiivin irrottaminen

Muistikorttien asettaminen

Verkkosovelluksen käyttäminen verkkoselaimella

5-041-958-73(1) Copyright 2022 Sony Corporation

Vihje

Panorointi-/kallistusliike voidaan lukita seuraaviin kulmiin.

Liukualusta2.

Ruuvien reiät ulkoisille laitteille (4 paikkaa)
Enintään 6 mm:n pituisille M3-ruuveille.

Huomautus

Älä käytä 6 mm:ä pidempiä ruuveja. Se voi aiheuttaa toimintahäiriön.

3.

Käytön ilmaisin A4.

Käytön ilmaisin B
Ilmaisinvalo palaa tai vilkkuu, kun tallennusväline asetetaan.

Lisätietoja on kohdassa ”Muistikorttien asettaminen”.

5.

CFexpress Type A / SD -korttipaikka (A)6.

CFexpress Type A / SD -korttipaikka (B)
Käytetään tallennusvälineiden asettamiseen.

Lisätietoja on kohdassa ”Muistikorttien asettaminen”.

7.

QR-koodi verkkoyhteyttä varten
Käytetään alkuasetusten määrittämiseen.

Lisätietoja on kohdassa ”Verkkosovelluksen käyttäminen verkkoselaimella”.

8.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Näkymä laitteen päältä

Tässä osiossa käsitellään laitteen päällä sijaitsevien osien sijaintia ja toimintaa.

Vihje

Tämä kuvaus viittaa laitteen kuvaan ilman kiinnitettyä objektiivia.

5-041-958-73(1) Copyright 2022 Sony Corporation

Ruuvien reiät ulkoisille laitteille (2 paikkaa)
Yhteensopiva kolmijalan 1/4-20 UNC -ruuvien kanssa.
Pituus enintään 6 mm.

1.

ɸ (kuvakennomerkki)
Kuvakennomerkki on samalla tasolla kuin kuvakenno.
Käytä kuvakennomerkkiä kiintopisteenä, kun haluat mitata tarkasti laitteen ja kohteen välisen etäisyyden.

2.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Näkymä laitteen alapuolelta

Tässä osiossa käsitellään laitteen pohjassa sijaitsevien osien sijaintia ja toimintaa.

Vihje

Tämä kuvaus viittaa laitteen kuvaan ilman kiinnitettyä objektiivia.

Kattotelineen kiinnitysruuvien reiät (6 paikkaa, kierteen hyötysyvyys 5,5 mm)
Kun laitetta kiinnitetään kattoon tai korkealla sijaitsevaan hyllyyn, kiinnitä runkoteline (lisävaruste) laitteen pohjaan
kuudella runkotelineen kiinnitysruuvilla näiden ruuvinreikien kautta.

Lisätietoja kiinnittämisestä on kohdissa ”Kiinnittäminen korkealle kiinteään paikkaan” ja ”Kattoon kiinnittäminen”.

1.

Kolmijalan kiinnitysruuvit (2 paikkaa)
Käytetään laitteen kiinnittämiseksi kameran kolmijalkaan (lisävaruste, enintään 5,5 mm:n pituiset 1/4-20 UNC -ruuvit).

Huomautus

2.
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Aiheeseen liittyvää

Kiinnittäminen korkealle kiinteään paikkaan

Kattoon kiinnittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Älä käytä 5,5 mm:ä pidempiä ruuveja. Se voi aiheuttaa toimintahäiriön.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektiivin tuki

Tässä osiossa käsitellään laitteen objektiivin tuen osien sijaintia ja toimintaa.

Vihje

Tämä kuvaus viittaa laitteen kuvaan ilman kiinnitettyä objektiivia.

Objektiivin tukivarsi (2)
Tukee objektiivia.
Voidaan myös käyttää yleisten Ø15-lisävarsien kiinnittämiseen.

1.
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Objektiivin tukilaite
Objektiivin tuki voi liukua eteen/taakse objektiivin mukaan ja kiinnittyä sitten paikalleen.

2.

Objektiivin tukijalustan kiinnikeruuvi
Kiinnitä objektiivin tukijalustaan. Ruuvia voi säätää ylös/alas objektiivin tukijalustan korkeuden mukaisesti.

3.

Objektiivin tukivarren kiinnikevipu (2 paikkaa)
Vakauttaa objektiivin tukilaitteen asennon etu-/takasuunnassa.

4.

Objektiivin tukijalustan kiinnikeruuvin vipu
Vakauttaa objektiivin tukijalustan kiinnikeruuvin asennon pystysuunnassa.

Vihje

Jos vivun asento hankaloittaa jalustan kääntämistä, avaa vipu ja käännä se asentoon, jossa jalustan käyttäminen on
helpompaa. Kun haluttu asento on saavutettu, sulje kiinnikevipu.

A: Objektiivin tukijalustan kiinnikeruuvin vipu
B: Objektiivin tukivarren kiinnikevipu

Huomautus

Jotta objektiivin tukilaite ei haittaa panorointi-/kallistustoimintoa, siirrä objektiivin tukilaite kamerapäätä vasten, kun sitä ei
käytetä, ja siirrä objektiivin tukijalustan kiinnikeruuvi korkeimpaan asentoon (lähimmäksi objektiivia).

5.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Infrapunakaukosäätimen (mukana) osien sijainti ja toiminta

Tässä osiossa käsitellään infrapunakaukosäätimen (mukana) osien sijaintia ja toimintaa.

REC● (tallennuksen START/STOP) -painike
Aloita tai lopeta tallentaminen painamalla.

1.

MENU-painike
Näytä tai piilota kameran valikko painamalla.

2.

GUI-hallintapainikkeet
Painamalla voit suorittaa toimintoja kameran valikossa, painikkeita sisältävissä dialogiviesteissä ja muissa näytön
toiminnoissa.

3.

CANC./BACK-painike
Painamalla voit peruuttaa asetuksen tai palata edelliseen näyttöön laitteen kameran valikossa.

4.
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Infrapunakaukosäätimen paristo

Infrapunakaukosäädin tarvitsee kaksi AA (LR6) -paristoa.
Aseta paristot infrapunakaukosäätimeen alla olevan kaavion mukaisesti.

Panoroinnin ja kallistuksen hallintapainikkeet
Hallinnoi kameran panorointia/kallistusta painamalla nuolipainikkeita. Palauta kameran suunta eteenpäin painamalla
HOME-painiketta.

5.

Esiasetusvalintojen hallintapainikkeet
Tallenna kameran suunta, zoom ja tarkennuksen säätötila numeropainikkeeseen pitämällä PRESET-painiketta
painettuna ja painamalla yhtä painikkeista 1–3.
Hae tallennettu tila painamalla numeropainiketta, johon asetukset on tallennettu.

6.

Tarkennuksen hallintapainikkeet
Käytä tarkennuksen säätämiseen.
Säädä tarkennusta automaattisesti painamalla AF-painiketta.
Säädä tarkennusta käsin painamalla MF-painiketta ja tarkenna sitten joko kaukana oleviin kohteisiin painamalla F
(kauas) -painiketta tai lähellä oleviin kohteisiin painamalla N (lähelle) -painiketta.

7.

Ohjelmoitavat painikkeet 1–3
Suorittaa ohjelmoitaville painikkeille kameran valikossa ohjelmoidut toiminnot.
Jos ohjelmoit [Direct Menu] -toiminnon ohjelmoitavalle painikkeelle, voit säätää valotusta, valkotasapainoa ja muita
asetuksia käyttämällä GUI-hallintapainikkeita.

Lisätietoja ohjelmoinnista kameran valikossa on kohdassa ”Ohjelmoitavat painikkeet”.

Lisätietoja suoravalikosta on kohdassa ”Suoravalikon toiminnot”.

8.

 (virta) -painike
Käynnistä laite tai vaihda virransyöttö virransäästötilaan.

9.

THUMBNAIL-painike
Näyttää pikkukuvanäytön, jolla näkyvät laitteen muistikortille tallennetut leikkeet.

Lisätietoja pikkukuvanäytöstä on kohdassa ”Pikkukuvanäyttö”.

Voit valita leikkeitä ja hallita toistoa pikkukuvanäytöllä GUI-hallintapainikkeiden avulla.

Lisätietoja leikkeiden valinnasta ja toiston hallinnasta on kohdissa ”Tallennettujen leikkeiden toistaminen” ja
”Tallennettujen leikkeiden toiminnot.”

10.

SLOT SEL (muistikorttipaikan (A)/(B) valinta) -painike
Kun asetettuna on kaksi muistikorttia, vaihda tallennusta korttien välillä painamalla painiketta.
Vaihda näytettävien muistikorttien välillä painamalla tätä painiketta, kun pikkukuvanäyttö on näkyvissä.

11.

P/T RESET (panoroinnin/kallistuksen nollaus) -painike
Nollaa panorointi-/kallistustoiminnot. Paina painiketta, kun POWER- ja NETWORK-merkkivalot vilkkuvat
samanaikaisesti tai kun [Execute Pan-Tilt Reset] -painike tulee näkyviin verkkosovelluksen rajauksen
hallintapaneelissa.

12.

Zoomin hallintapainikkeet
Zoomaa lähemmäs painamalla T (telekuva) -painiketta.
Zoomaa kauemmas painamalla W (laajakulma) -painiketta.

13.
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Huomautus

Älä käytä muita kuin mangaani- tai alkaliparistoja, sillä ne voivat puhjeta.

Hävitä käytetyt paristot maan tai alueen lakien ja asetusten mukaisella tavalla.

Aiheeseen liittyvää

Ohjelmoitavat painikkeet

Suoravalikon toiminnot

Pikkukuvanäyttö

Tallennettujen leikkeiden toistaminen

Tallennettujen leikkeiden toiminnot

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Yleistä verkkosovellusnäytöstä

Yhdistämällä tablettiin tai tietokoneeseen voit panoroida/kallistaa, zoomata, tallentaa, toistaa tallennettua videota ja tehdä
laitteeseen määrityksiä verkkoselaimesta käsin (jäljempänä tätä toimintoa kutsutaan ”verkkosovellukseksi”).

Lisätietoja verkkosovelluksen ottamisesta käyttöön on kohdassa ”Verkkosovelluksen käyttäminen verkkoselaimella”.

Huomautus

Verkkosovellus ei tule kameran äänen tuloa.

Kun verkkosovellus käynnistyy, näkyviin tulee suora käyttönäkymä.

Suora käyttönäkymä

Lisätietoja suorasta käyttönäkymästä on osiossa ”Suora käyttönäkymän rakenne”.
Suoran käyttönäkymän ja toistotoimintojen näytön yhteiset painikkeet näkyvät näytön yläosassa.

Lisätietoja näkymien yhteisestä osasta on osiossa ”Näyttöjen yleisen alueen rakenne”.
Voit vaihtaa näyttöjen välillä painamalla näytönvaihtovälilehtiä yhteisessä osassa.
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Toistotoimintojen näyttö

Tuo toistotoimintojen näyttö näkyviin painamalla [Playback]-välilehteä.

Lisätietoja toistotoimintojen näytöstä on osiossa ”Toistotoimintojen näytön rakenne”.

Asetusnäyttö

Tuo asetusnäyttö (jäljempänä verkkovalikko) näkyviin painamalla [Settings]-välilehteä.
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Huomautus

Verkkovalikon asetukset eivät tule voimaan ennen kuin painat [OK]-painiketta. Jos muutat asetuksia sivulla, jolla on [OK]-painike,
varmista, että painat [OK]-painiketta.

Lisätietoja asetusnäytöstä on osiossa ”Asetusnäytön rakenne”.
Tässä ohjekirjassa verkkosovelluksen asetusnäytöstä käytetään nimitystä ”verkkovalikko”.

Aiheeseen liittyvää
Verkkosovelluksen käyttäminen verkkoselaimella

Suoran käyttönäkymän rakenne

Näyttöjen yleisen alueen rakenne

Toistotoimintojen näytön rakenne

Asetusnäytön rakenne

5-041-958-73(1) Copyright 2022 Sony Corporation

41



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Näyttöjen yleisen alueen rakenne

Tässä osiossa käsitellään näyttöjen yleisen alueen rakennetta.

Kameran nimi
Näyttää kameran nimen.
Voit muuttaa nimeä verkkovalikon kohdassa [Network] > [Camera Name].
Taustaväri muuttuu ulkoisen Tally-signaalin mukaan.

1.

Virtakytkin
[Power ON] on näkyvissä, kun laite on käynnissä. Painamalla kytkintä ja valitsemalla [Power Standby] voit määrittää
laitteen virtalähteen virransäästötilaan.
Kun näkyvissä on [Power Standby], voit käynnistää laitteen virtalähteen painamalla kytkintä ja valitsemalla [Power
ON].

2.

Toimintanäytön vaihtovälilehdet
Tuo kukin toimintanäyttö näkyviin painamalla vastaavaa välilehteä.
[Live]-välilehti: Näyttää suoran käyttönäkymän.
[Playback]-välilehti: Näyttää toistotoimintojen näytön.
[Settings]-välilehti: Näyttää asetusnäytön (verkkovalikon).

3.

Ilmoitusmerkki
Viestin saapuessa ilmoitusmerkki muuttuu alla näkyvällä tavalla.

 (Ilmoitukset käytössä)
Suorita kameran kuvapaneelissa näkyvän viestin mukaiset tarvittavat toiminnot.

Huomautus

Viestejä ei näytetä, kun verkkovalikon kohdan [Monitoring] > [Output Display] > [HDMI/Stream] asetuksena on [Off]. Vaihda
asetukseksi [On], niin näet viestien sisällön.

4.

 (Kameran tila) -painike
Näytä kameran tallentaman kuvan / lähtökuvan signaalitiedot, objektiivitiedot ja objektiivin ohjaimen (lisävaruste) tilan
eri näytöllä.

5.
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Objektiivin ohjaimeen (lisävaruste) liittyvien ilmoitusten yhteydessä ilmaisin muuttuu alla näkyvällä tavalla.

Näyttötoimintojen lukkokytkin
 (Toimintoja ei ole lukittu): Kun kytkin on vasemmalla, suorassa käyttönäkymässä ja toistotoimintonäkymässä

voi suorittaa toimintoja.
 (Toiminnot lukittu): Kun kytkin on oikealla, suoran käyttönäkymän ja toistotoimintonäkymän toiminnot on lukittu

vahinkotoimintojen välttämiseksi.

6.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Suoran käyttönäkymän rakenne

Tässä osiossa käsitellään suoran käyttönäkymän rakennetta.

Esiasetusvalintojen hallintapaneeli
Näyttää esiasetuksen rekisteröidyn asennon pikkukuvan avulla. Palaa esiasetukseen tallennettuun asentoon
napauttamalla pikkukuvaa kahdesti.

Lisätietoja esiasetetusta asennosta on kohdassa ”Panoroinnin/kallistuksen, zoomausasennon ja tarkennuksen
asetusten tallentaminen/palauttaminen verkkosovelluksen avulla”.
Lisätietoja PTZ Trace -toiminnosta on kohdassa ”Kameran rajaustoimintojen tallennus verkkosovelluksella”.

1.

Kameran kuvapaneeli
Näyttää nykyisen kameran kuvan ja laitteen tilan.
Näyttää saman kuvan kuin HDMI-lähtö.
Seuraava tila näkyy kuvan yläpuolella. Punainen tai vihreä kehys näytetään lisäksi kuvan ympärillä vastaanotetun
ulkoisen tally-signaalin mukaisesti.

2.
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[Display]-painike
Painamalla tätä painiketta kameran tiedot näytetään kuvassa.
Painamalla uudelleen kameran tiedot piilotetaan, kun kameran tiedot ovat näkyvissä.

Merkkien lisäksi näkyvissä on automaattitarkennukseen liittyviä ilmaisimia ja viestejä. Näitä ei voi piilottaa [Display]-
painikkeella.

Lisätietoja näytettävistä kameran tiedoista on kohdassa ”Kameran näyttö”.

Reaaliaikaisen seurannan AF -pysäytyspainike
Lopeta kohteen seuraaminen painamalla painiketta.

Nro Näyttö Kuvaus

2-1 Tarkennustilan ilmaisin Ks. ”Tarkennustilan ilmaisin” kohdassa ”Kameran näyttö”.

2-2
Tallennustilan, A-/B-paikan, Interval
Rec -tallennusvälin ilmaisin

Ks. ”Tallennustilan, A-/B-paikan, Interval Rec -tallennusvälin ilmaisin”
kohdassa ”Kameran näyttö”.

2-3 Suoratoiston tilan ilmaisin
Näytetään suoratoiston aikana (vain kun kohdan [Stream Setting]
asetuksena on [RTMP] tai [SRT-Caller]).

2-4 RAW-lähdön toimintatilan ilmaisin
Näyttää RAW-signaalin lähtötilan. Lisätietoja RAW:sta on kohdassa
”RAW-videon tallentaminen”.

2-5 Tietovälineen jäljellä olevan
kapasiteetin ilmaisin

Ks. ”Tietovälineen jäljellä olevan kapasiteetin ilmaisin” kohdassa
”Kameran näyttö”.

2-6 Zoomausasennon ilmaisin

Ks. ”Zoomausasennon ilmaisin” kohdassa ”Kameran näyttö”.
Kun objektiivin ohjain (lisävaruste) on liitettynä, näkyvissä on . Jos
objektiivin ohjaimessa (lisävaruste) ilmenee virhe, näkyviin tulee 
.

2-7 AE-tilan/AE-tason ilmaisin Ks. ”AE-tilan/AE-tason ilmaisin” kohdassa ”Kameran näyttö”.
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Lisätietoja on kohdassa ”Määritetyn kohteen seuraaminen (Realtime Tracking AF)”.
Tallennuksen START/STOP-painike
Aloita tallennus painamalla painiketta. Tallennuksen aikana tallennuksen START/STOP-painikkeessa on punainen
valo.
Pysäytä tallennus painamalla painiketta tallennuksen aikana.
Voita määrittää Hold-kytkimen Hold-tilaan, jotta tallennuksen START/STOP-painiketta ei paineta turhaan.

3.

Kameran perusmäärityspaneeli
Näyttää painikkeilla kuvaamiseen tarvittavien perustoimintojen asetukset. Painamalla painiketta saat näkyviin
vastaavat määritysnäytöt kullekin toiminnolle alla olevassa kameran perusmääritysten säätöpaneelissa (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Lisätietoja on kunkin toiminnon kuvauksessa.

4.

Toiminto Viite

FPS ”Hidastus ja nopeutus”

ISO/Gain
”Perusherkkyyden määrittäminen”, ”Herkkyysvahvistuksen säätäminen automaattisesti” ja
”Herkkyysvahvistuksen säätäminen käsin” osiossa ”Herkkyysvahvistuksen säätäminen”

Exposure
Index

”Perusherkkyyden määrittäminen” ja ”Tummien ja kirkkaiden alueiden jakauman muuttaminen
tallennetussa kuvassa”

Shutter
”Sulkimen säätäminen automaattisesti” ja ”Sulkimen säätäminen käsin” osiossa ”Sulkimen
säätäminen”

Iris
”Himmentimen säätäminen automaattisesti” ja ”Himmentimen säätäminen käsin” osiossa
”Himmentimen säätäminen”

ND Filter ”Tietoja ND-suodattimesta” osiossa ”Valon määrän säätäminen (ND-suodatin)”

Scene File ”Yleistä ulkoasusta” ja muut kohdat osiossa ”Kuvaaminen halutulla ulkoasulla”

Base
Look/LUT

”Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä”
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Toiminto Viite

White
Balance

”Valkotasapainon säätöpaneeli”

Ohjelmoitavat painikkeet / Kameran perusmääritysten säätöpaneeli
Näyttää ohjelmoitavat painikkeet normaalin toiminnan aikana. Näytä vastaavat määrityskohteet painamalla kameran
perusmäärityspaneelin painikkeita (kohde 4). Palaa ohjelmoitavien painikkeiden näyttöön painamalla [X]-painiketta tai
painamalla uudelleen Camera setup panel -painiketta.

Lisätietoja ohjelmoitavista painikkeista on kohdassa ”Ohjelmoitavat painikkeet”.
Lisätietoja kameran perusmääritysten säätöpaneelista on kunkin toiminnon kuvauksessa.

5.

Rajauksen hallintapaneeli / GUI-hallintapaneeli
Vaihda rajauksen hallintapaneelin / GUI-hallintapaneelin välillä yläreunassa olevien välilehtien avulla.
Voit piilottaa hallintapaneelin tahattoman käytön estämiseksi painamalla oikean yläkulman  (Sulje) -painiketta. Jos
hallintapaneeli ei ole näkyvissä, tuo se näkyviin painamalla  (Avaa) -painiketta.
Säädä rajausta käyttämällä rajauksen hallintapaneelia. Näytä rajauksen hallintapaneeli painamalla 
(Panorointi/kallistus/zoomaus) -painiketta.

Lisätietoja toiminnasta on kohdassa ”Rajauksen säätäminen”.

Vihje

Rajauksen hallintapaneelin ohjausvipuosa näkyy alla olevalla tavalla, kun panorointi-/kallistustoiminto on pois käytöstä ja kun
panoroinnin/kallistuksen alustamista tarvitaan.

Kun panorointi-/kallistustoiminto on lukittu panoroinnin/kallistuksen lukitusvivulla

Kun panorointi-/kallistustoimintoa ei ole alustettu

6.
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Kun panorointi-/kallistustoiminto on nollattava

Kun panorointi-/kallistustoiminto ei ole käytössä

Kun panorointia/kallistustoimintoa ei ole alustettu tai se täytyy nollata, saat kameran hallintapaneelin 
(Panoroinnin/kallistuksen nollaus) -painikkeen nopeasti käyttöön painamalla ohjausvivun alla näkyvää viestiä.

Käytä GUI-hallintapaneelia kameran valikon, leikkeen toiston ja muiden toimintojen hallinnoimiseen. Näytä GUI-
hallintapaneeli painamalla  (Kameran GUI) -välilehteä.

Lisätietoja toiminnosta on kohdissa ”Kameran valikon käyttäminen” ja ”Tallennettujen leikkeiden toistaminen”.
Kameran hallintapaneeli
Käytetään kameran käyttämiseen tarvittavien toimintojen määrittämiseen.
Vaihda näyttöjen välillä yläreunassa olevien välilehtien avulla.
Voit piilottaa hallintapaneelin tahattoman käytön estämiseksi painamalla oikean yläkulman  (Sulje) -painiketta. Jos
hallintapaneeli ei ole näkyvissä, tuo se näkyviin painamalla  (Avaa) -painiketta.

7.
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Lisätietoja on kunkin toiminnon kuvauksessa.

  (Main) -välilehti
Näyttää usein käytettyjen toimintojen määrityskohteet.
Ylempää ja alempaa liukusäädintoimintoa voi muuttaa painamalla [▼]-painiketta ja valitsemalla näkyviin tulevasta
listasta. Valittavissa ovat seuraavat toiminnot.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

  (Focus) -välilehti
Näyttää tarkennukseen liittyvät määrityskohteet.

  (Audio) -välilehti

Näyttää ääneen liittyvät määrityskohteet.

Näytetään valikkoasetusten mukaisesti.*

49



 (Stream) -välilehti
Näyttää suoratoistoon liittyvät määrityskohteet.
Näytettävät kohteet vaihtelevat suoratoistomuodon asetuksista riippuen.
Kun tila on [RTMP] tai [SRT-Caller], suoratoiston voi aloittaa/pysäyttää tältä näytöltä.

Lisätietoja on kohdassa ”Tietoja suoratoistosta” ja muista kohdista osiossa ”Suoratoiston määrittäminen”.
Virhetiedot tulevat näkyviin, jos tapahtuu yhteysvirhe. Lisätietoja virhetiedoista on kohdassa
”Virhe-/varoitusviestit”.

 (Others) -välilehti
Näyttää muihin toimintoihin liittyvät määrityskohteet.
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Aiheeseen liittyvää

Panoroinnin/kallistuksen, zoomausasennon ja tarkennuksen asetusten tallentaminen/palauttaminen
verkkosovelluksen avulla

Kameran rajaustoimintojen tallennus verkkosovelluksella

Kameran näyttö

RAW-videon tallentaminen

Määritetyn kohteen seuraaminen (Realtime Tracking AF)

Hidastus ja nopeutus

Perusherkkyyden määrittäminen

Herkkyysvahvistuksen säätäminen automaattisesti

Herkkyysvahvistuksen säätäminen käsin

Tummien ja kirkkaiden alueiden jakauman muuttaminen tallennetussa kuvassa

Sulkimen säätäminen automaattisesti

Sulkimen säätäminen käsin

Himmentimen säätäminen automaattisesti

Himmentimen säätäminen käsin

Tietoja ND-suodattimesta

Yleistä ulkoasusta

Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä

Valkotasapainon säätöpaneeli

Ohjelmoitavat painikkeet

Tallennettujen leikkeiden toistaminen

Kameran valikon käyttäminen

Tietoja suoratoistosta

Virhe-/varoitusviestit

5-041-958-73(1) Copyright 2022 Sony Corporation

[Full Screen Display] -painikkeen painaminen avaa verkkoselaimessa uuden välilehden ja näyttää kameran
kuvapaneelin kuvan koko näytössä.
Kuva on vain tarkastelua varten; kosketus-AF ja muut toiminnot eivät ole käytettävissä.

Huomautus

Alkuperäisen välilehden suora käyttönäkymä toimii edelleen. Välilehti on suositeltavaa sulkea samanaikaisten yhteyksien
vähentämiseksi, jos toimintoja ei ole tarpeen tehdä.

Alusta objektiivin ohjain (kolmannen osapuolen lisävaruste) painamalla  (Alusta objektiivin ohjain) -
painiketta. Tämä painike on käytössä vain, kun verkkovalikon kohdan [Technical] > [Lens Controller] > [Zoom] >
[Setting] asetuksena on [On].
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Toistotoimintojen näytön rakenne

Tässä osiossa käsitellään toistotoimintojen näytön rakennetta.

Kameran kuvapaneeli
Näyttää toistettavan kuvan ja siihen liittyvät tiedot. Kun toisto pysäytetään, kamerakuvan näyttö tulee näkyviin.

1.
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1-1 Kuvauksen päivämäärä ja aika
1-2 Toiston tilan ilmaisin
1-3 Toistomuodon (kuvakoko) ilmaisin
1-4 Toistomuodon (koodekki) ilmaisin
1-5 Leikkeen nimen näyttö
1-6 Leikkeen numero / leikkeiden kokonaismäärä
1-7 LUT-nimen näyttö
1-8 Suoratoiston tilan ilmaisin
1-9 Toistomuodon (kuvataajuus ja hakumenetelmä) ilmaisin
1-10 Tallennusulkoasun ilmaisin

Toiston hallintapaneeli

Näyttää toiston hallintapainikkeet.

[Display]-painike
Painamalla voit vaihtaa kuvan näyttöä.
[Thumbnail]-painike
Näyttää muistikortille tallennetut leikkeet kameran kuvapaneelissa pikkukuvina.

2.

Painike Toiminto

 (Toisto/Tauko) -painike Toistaa leikkeen. Pysäyttää leikkeen toiston aikana.

 (Pikakelaus eteenpäin) -painike, 
(Pikakelaus taaksepäin) -painike

Toistaa leikkeen suurella nopeudella. Kun painiketta painetaan,
toistonopeus muuttuu kolmessa vaiheessa.

 (Seuraava) -painike,  (Edellinen) -
painike

Siirtyy leikkeen alkuun tai edelliseen/seuraavaan leikkeeseen.

 (Pysäytä)-painike Lopettaa toiston.
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Aiheeseen liittyvää

Pikkukuvanäyttö

Ohjelmoitavat painikkeet

Tallennettujen leikkeiden toistaminen

5-041-958-73(1) Copyright 2022 Sony Corporation

[Thumbnail]-painikkeen painallus pikkukuvanäytöllä sulkee pikkukuvanäytön ja palaa kameran kuvaan.

Lisätietoja pikkukuvanäytöstä on kohdassa ”Pikkukuvanäyttö”.

[Slot Select] -painike
Vaihtaa toistettavaa kohdetietovälinettä.

Ohjelmoitavat painikkeet
Näyttää laitteen toiminnoille ohjelmoidut painikkeet.

Lisätietoja ohjelmoitavista painikkeista on kohdassa ”Ohjelmoitavat painikkeet”.

3.

GUI-hallintapaneeli
Käytä GUI-hallintapaneelia kameran valikon, leikkeen toiston ja muiden toimintojen hallinnoimiseen.

Lisätietoja toiminnosta on kohdissa ”Kameran valikon käyttäminen” ja ”Tallennettujen leikkeiden toistaminen”.

4.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Asetusnäytön rakenne

Käytä asetusnäyttöä laitteen eri kohteiden määrittämiseen, mukaan lukien aloitusasetukset, verkkoasetukset ja
kuvaus-/toistoasetukset, verkkovalikon avulla.

Huomautus

Yleisenä sääntönä verkkovalikon asetukset eivät tule voimaan ennen kuin painat [OK]-painiketta. Jos muutat asetuksia sivulla,
jolla on [OK]-painike, varmista, että painat [OK]-painiketta.

Lisätietoja asetusnäytöstä on osiossa ”Verkkovalikko ja tarkemmat asetukset”.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameran valikko

Tuo kameran valikko näkyviin kameran kuvapaneelissa painamalla suoran käyttönäkymän tai toistotoimintojen näytön
GUI-hallintapaneelissa [Menu]-painiketta.

Voit määrittää kuvaamiseen ja toistoon tarvittavat asetukset kameran valikon avulla.
Piilota kameran valikko painamalla [Menu]-painiketta, kun kameran valikko on näkyvissä.
Kameran valikkoa hallitaan GUI-hallintapaneeli avulla.

Lisätietoja kameran valikosta on osiossa ”Kameran valikko ja tarkemmat asetukset”.

Huomautus

Kun verkkovalikon kohdan [Monitoring] > [Output Display] > [HDMI/Stream] asetuksena on Off (näytön päällekkäiset tiedot on
poistettu käytöstä), kameran valikkoa ei enää näytetä kameran kuvapaneelissa. Huomioi kuitenkin, että GUI-hallintapaneelin
valikkotoiminnot ovat edelleen aktiivisia. Vältä tahattomia toimintoja varmistamalla, että valikkotoimintoja ei suoriteta GUI-
hallintapaneelin avulla silloin, kun kohdan [HDMI/Stream] asetuksena on Off.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameran näyttö

Voit näyttää laitteen tilan ja asetukset kameran lähtökuvan päällä. Voit asettaa lähdöt käytössä olevalle näytölle
verkkovalikon kohdassa [Monitoring] > [Output Display].
Voit näyttää/piilottaa tiedot [Display]-painikkeella. Myös piilotettuna ne tulevat näkyviin, kun suoravalikon toimintoja
suoritetaan.
Voit näyttää/piilottaa yksittäisiä kohteita kameran valikon kohdassa [Monitoring] > [Display On/Off].

Näytöllä kuvaamisen aikana näkyvät tiedot

Latauksen ilmaisin / jäljellä olevien tiedostojen ilmaisin

Lisätietoja tiedostojen siirtämisestä on kohdassa ”Tietoja tiedoston siirrosta” ja muista kohdista osiossa
”Tiedostojen siirtäminen”.

1.

Tarkennusalueen ilmaisin
Näyttää tarkennusalueen automaattitarkennusta varten.

Lisätietoja automaattitarkennuksesta on kohdassa ”Säätäminen automaattisesti verkkosovelluksen avulla” ja
muissa kohdissa osiossa ”Tarkennuksen säätäminen automaattisesti (Auto Focus)”.

2.

Tallennustilan, A-/B-paikan, Interval Rec -tallennusvälin ilmaisin

Lisätietoja Interval Rec -toiminnosta on kohdassa ”Videon tallentaminen jaksottaisesti (Interval Rec)”.

3.

Näyttö Merkitys

●Rec Tallentaminen

Stby Tallentamisen valmiustila

Terävyysalueen ilmaisin4.
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Kuvakennon käyttötilan ilmaisin
 (ristiriita) -merkki tulee näkyviin, jos objektiivin piirtoympyrän koon ja kuvakennon käyttötila-asetuksen todellisen

kuvakoon välillä on ristiriita.
Kun kuvakennon käyttötilan asetuksena on FF, ”C”-merkki näkyy tiloissa, joiden kuvakulma on kapeampi (rajattu).
Rajaaminen on käytettävissä seuraavissa tiloissa.

Kun tallennusmuotona on 3840×2160 ja S&Q Motion-kuvataajuus on 100 fps tai 120 fps
Kun kohdan [Codec] asetuksena on RAW tai RAW & XAVC-I ja RAW-lähtömuoto on 3840×2160
Lisätietoja kuvakennon käyttötilasta on kohdassa ”Kuvakennon käyttötilan määrittäminen” kohdassa
”Perustoimintojen määrittäminen”.

5.

RAW-lähdön toimintatilan ilmaisin
Näyttää RAW-signaalin lähtötilan.

Lisätietoja RAW:sta on kohdassa ”RAW-videon tallentaminen”.

6.

Hidastetun ja nopeutetun kuvaamisen kuvataajuuden ilmaisin

Lisätietoja Hidastus ja nopeutus -toiminnosta on kohdassa ”Hidastus ja nopeutus”.

7.

Tarkennuskohdan ilmaisin

Näyttää tarkennuskohdan.

8.

Tarkennustilan ilmaisin

Kasvojen-/silmientunnistuksen AF

Lisätietoja kasvojen-/silmientunnistuksen AF:stä on kohdassa ”Tarkentaminen käyttämällä
kasvojen-/silmientunnistusta (Face/Eye Detection AF)”.

9.

Näyttö Merkitys

Focus Hold Focus Hold -tila

MF MF-tila

AF AF-tila

 (Reaaliaikaisen seurannan AF-tila) Reaaliaikaisen seurannan AF -tila

Näyttö Merkitys

 (Kasvojen-/silmientunnistuksen AF) Ilmaisee, että kasvojen-/silmientunnistuksen AF on aktiivinen

 (Vain kasvojen/silmien AF) Ilmaisee, että vain kasvojen/silmien AF on aktiivinen

 (Tallennetut seurantakasvot) Ilmaisee, että seurantakasvot on tallennettu

 (AF keskeytetty) Ilmaisee, että AF on keskeytetty*

Näkyvissä, kun tallennettuja seurantakasvoja ei ole eikä järjestelmä tunnista niitä tai kun seurantakasvot on tallennettu mutta järjestelmä ei
tunnista seurattavan kohteen kasvoja.

*

Zoomausasennon ilmaisin
Näyttää zoomausasennon alueella 0 (laajakulma)…99 (tele) (jos liitettynä on objektiivi, joka tukee zoomausasennon
näyttöä).

10.
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Voit myös muuttaa ilmaisimen palkki- tai tarkennusaikanäyttöön käyttämällä [Technical] > [Lens] > [Zoom Position
Display] -asetusta kameran valikossa.
Näytössä näkyvät lisäksi seuraavat kohteet, kun Clear Image Zoom on käytössä.

Lisätietoja zoomista on kohdassa ”Zoomityypin määrittäminen” ja muissa kohdissa osiossa ”Zoomin säätäminen”.

Näyttö Merkitys

 (Clear Image Zoom on käytössä) Clear Image Zoom on käytössä

Suurennusarvo Kun Clear Image Zoom -zoomausta käytetään

Kuvanvakautustilan ilmaisin11.

SDI-lähdön/HDMI-lähdön Rec Control -tilan ilmaisin
Näyttää REC-ohjaussignaalin lähdön tilan.

Lisätietoja on kohdassa ”Ulkoisten näyttöjen ja tallennuslaitteiden liittäminen”.

12.

Tarkennuksen ilmaisin

Lisätietoja on kohdassa ”Yksittäisen automaattitarkennuksen käyttäminen (Push Auto Focus (AF-S))” osiossa
”Tarkennuksen säätäminen”.

13.

Tietovälineen jäljellä olevan kapasiteetin ilmaisin
 (suojaus) -kuvake tulee näkyviin, jos muistikortti on kirjoitussuojattu.

14.

Valkotasapainotilan ilmaisin15.

Näyttö Merkitys

 (ATW) Automaattitila

 (ATW Hold) Automaattitila keskeytetty

W:P Esiasetettu tila

W:A Muisti A -tila

Aikakoodin ulkoisen lukituksen ilmaisin / aikatiedon näyttö
Näytössä näkyy ”EXT-LK”, kun lukittu ulkoisen laitteen aikakoodiin.

Lisätietoja aikakoodeista on kohdassa ”Aikatietojen määrittäminen”.

16.

ND-suodattimen ilmaisin

Lisätietoja ND-suodattimista on kohdassa ”Valon määrän säätäminen (ND-suodatin)”.
Lisätietoja boken hallinnasta on kohdassa ”Boken hallinta (Bokeh Control -toiminto)”.

17.

Näyttö Merkitys

 (A) Automaattitila

 (B) Boken hallintatila

Kohtaustiedoston ilmaisin18.
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Lisätietoja kohtaustiedostoista on kohdassa ”Yleistä ulkoasusta” ja muissa kohdissa osiossa ”Kuvaaminen
halutulla ulkoasulla”.

Himmentimen ilmaisin
Näyttää himmentimen sijainnin (F-arvo) (jos liitettynä on objektiivi, joka tukee himmenninasetuksen näyttöä).

Lisätietoja himmentimestä on kohdissa ”Himmentimen säätäminen automaattisesti” ja ”Himmentimen säätäminen
käsin”.

19.

Videotason varoituksen ilmaisin20.

Herkkyysvahvistuksen ilmaisin
Näyttää EI-arvon Cine EI/Cine EI Quick -tilassa.

Lisätietoja herkkyysvahvistuksesta on kohdissa ”Herkkyysvahvistuksen säätäminen automaattisesti” ja
”Herkkyysvahvistuksen säätäminen käsin”.
Lisätietoja Cine EI/Cine EI Quick -tilasta on kohdassa ”Kuvaustilan määrittäminen” osiossa ”Perustoimintojen
määrittäminen”.

21.

Näyttö Merkitys

 (A) Automaattitila

L Esiasetettu L-tila

 (Tilapäinen säätö -tila) Tilapäinen säätö -tila

 (B) Boken hallintatila

Leikkeen nimen näyttö
Näyttää tallennettavana olevan tai seuraavaksi tallennettavan leikkeen nimen.
Jos se vilkkuu, viimeisen tallennusvälineellä olevan leikkeen ja [Camera ID]- tai [Reel Number] -asetusten välillä on
ristiriita. Lisätietoja on kohdan [Clip Name Format] > [Auto Naming] kuvauksessa.

22.

Sulkimen ilmaisin

Lisätietoja sulkimesta on kohdissa ”Sulkimen säätäminen automaattisesti” ja ”Sulkimen säätäminen käsin”.

23.

AE-tilan/AE-tason ilmaisin

Lisätietoja automaattisesta valotuksesta (AE) on kohdassa ”Automaattisen kirkkaussäädön tavoitetason
määrittäminen”.

24.

Vaakatason ilmaisin
Näyttää vaakatason ±1°:een lisäyksin aina ±15°:een saakka.

25.

Äänitasomittari
Näyttää kunkin kanavan äänitason.

26.

Videosignaalin näyttö
Näyttää aaltomuodon, vektoriskoopin ja histogrammin.
Oranssi viiva ilmaisee kirkkaustason markkerille määritetyn arvon.
Log-kuvaustiloissa tavoitenäytön LUT-tyyppi näkyy näytön yläpuolella.

Lisätietoja on kohdassa ”Videosignaalin näyttö”.
Lisätietoja Log-kuvaustiloista on kohdassa ”Kuvaustilan määrittäminen” osiossa ”Perustoimintojen
määrittäminen”.

27.
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Näytöllä toiston aikana näkyvät tiedot

Seuraavat tiedot näkyvät toistettavan kuvan päällä.

Base Sensitivity -ilmaisin / Base ISO -ilmaisin
Custom-tilassa se näyttää perusherkkyyden, joka on määritetty kameran perusmäärityspaneelin [ISO/Gain /
Exposure Index] -painikkeella tai kameran valikon kohdassa [Shooting] > [ISO/Gain/EI] > [Base Sensitivity].
Log-kuvaustiloissa se näyttää Base ISO -herkkyyden, joka on määritetty kameran perusmäärityspaneelin [ISO/Gain /
Exposure Index] -painikkeella tai kameran valikon kohdassa [Shooting] > [ISO/Gain/EI] > [Base ISO].

Lisätietoja perusherkkyyden valitsemisesta on kohdassa ”Perusherkkyyden valitseminen”.
Lisätietoja Log-kuvaustiloista on kohdassa ”Kuvaustilan määrittäminen” osiossa ”Perustoimintojen
määrittäminen”.

28.

Monitoring-ulkoasun ilmaisin
Log-kuvaustiloissa se näyttää näytön LUT-asetuksen.

Lisätietoja LUT-asetuksesta on kohdassa ”Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä” ja muissa
asiaan liittyvissä kohdissa.
Lisätietoja Log-kuvaustiloista on kohdassa ”Kuvaustilan määrittäminen” osiossa ”Perustoimintojen
määrittäminen”.

29.

Perusulkoasun/tallennusulkoasun ilmaisin
Näyttää perusulkoasun asetuksen.
Log-kuvaustiloissa se näyttää muistikorteille tallennettavan videosignaalin.

Lisätietoja perusulkoasusta on kohdassa ”Yleistä ulkoasusta” osiossa ”Kuvaaminen halutulla ulkoasulla”.
Lisätietoja Log-kuvaustiloista on kohdassa ”Kuvaustilan määrittäminen” osiossa ”Perustoimintojen
määrittäminen”.

30.

Välityspalvelintilan ilmaisin31.

Tallennusmuodon (koodekki) ilmaisin
Näyttää muistikorteille tallennuksen muodon nimen.
Aseta tallennusmuoto (koodekki) verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] > [Codec].

32.

Tallennusmuodon (kuvataajuus ja hakumenetelmä) ilmaisin33.

Tallennusmuodon (kuvakoko) ilmaisin
Näyttää muistikorteille tallentamisen kuvakoon.
Aseta tallennusmuoto (kuvakoko) verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] > [Codec].

34.

Tally-ilmaisin
Näyttää punaisen tai vihreän kehyksen kuvan ympärillä vastaanotetun ulkoisen tally-signaalin mukaisesti.

35.
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Aiheeseen liittyvää

Tietoja tiedoston siirrosta

Säätäminen automaattisesti verkkosovelluksen avulla

Videon tallentaminen jaksottaisesti (Interval Rec)

Perustoimintojen määrittäminen

RAW-videon tallentaminen

Hidastus ja nopeutus

Latauksen ilmaisin / jäljellä olevien tiedostojen ilmaisin1.

Leikkeen numero2.

Toiston tilan ilmaisin3.

Toistomuodon (kuvataajuus ja hakumenetelmä) ilmaisin4.

Toistomuodon (kuvakoko) ilmaisin5.

Toistomuodon (koodekki) ilmaisin6.

Tietovälineen ilmaisin
 (suojaus) -kuvake tulee näkyviin, jos muistikortti on kirjoitussuojattu.

7.

Aikatietojen näyttö8.

Leikkeen nimen näyttö9.

Gammanäytön avustuksen ilmaisin10.

Äänitasomittari
Näyttää toiston äänitason.

11.

Perusulkoasun/tallennusulkoasun ilmaisin12.

Tally-ilmaisin13.
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Tarkentaminen käyttämällä kasvojen-/silmientunnistusta (Face/Eye Detection AF)

Zoomityypin määrittäminen

Ulkoisten näyttöjen ja tallennuslaitteiden liittäminen

Yksittäisen automaattitarkennuksen käyttäminen (Push Auto Focus (AF-S))

Aikatietojen määrittäminen

Yleistä ulkoasusta

Himmentimen säätäminen automaattisesti

Himmentimen säätäminen käsin

Herkkyysvahvistuksen säätäminen automaattisesti

Herkkyysvahvistuksen säätäminen käsin

Sulkimen säätäminen automaattisesti

Sulkimen säätäminen käsin

Automaattisen kirkkaussäädön tavoitetason määrittäminen

Videosignaalin näyttö

Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä

Clip Name Format

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kiinnittäminen pystyasentoon kiinteään paikkaan

Tässä osiossa käsitellään laitteen kiinnittämistä työpöydälle tai kolmijalkaan.

Asennushuomautus
Suojaa objektiivia ja objektiivin liitäntälohkoa laitteessa pitämällä laitteen suojus ja kansi paikoillaan, kunnes objektiivi
on kiinnitetty.
Välttääksesi objektiivin toimintahäiriöitä älä pidä kiinni objektiivin osista työskentelyn aikana.
Välttääksesi laitteen toimintahäiriöitä älä pidä kiinni kamerapäästä työskentelyn aikana.

Tarkista kiinnitystila.

Työpöydälle kiinnitettäessä
Kiinnitä tämä laite tasaiselle pinnalle, ja ota huomioon objektiivin kääntämiseen ja laitteen takaosan johtoihin
tarvittava tila.

Huomautus

Kiinnitä se vakaalle alustalle, johon ei kohdistu tärinää. Paikat, joihin kohdistuu tärinää, voivat aiheuttaa kuvan tärinää.

Jos laite on kiinnitettävä kaltevalle pinnalle, kallista sitä korkeintaan ±15° vaakatasosta ja huolehdi, ettei laite pääse
kaatumaan.

Kolmijalkaan kiinnitettäessä
Kiinnitä kolmijalka pohjassa olevaan kolmijalan kiinnitysruuvin reikään.
Käytä kolmijalan kiinnitysruuvia siten, että se ulkonee seuraavien mittojen verran kiinnityspinnasta, ja kiristä se
käsin ruuvimeisselillä.

A: Kolmijalan kiinnitysruuvit 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Ulkonema (4,5 mm–5,5 mm)

1
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Kiinnitä seuraavaksi objektiivi. Ks. ”Objektiivin kiinnittäminen” ja ota huomioon kohdissa ”Muistettavaa objektiivin
liittämistä/irrottamista koskien”, ”Objektiivin kytkinten tarkistaminen” ja ”Muistettavaa zoom-objektiivin käyttöä koskien”
annetut tiedot.

Aiheeseen liittyvää

Muistettavaa objektiivin liittämistä/irrottamista koskien

Objektiivin kytkinten tarkistaminen

Muistettavaa zoom-objektiivin käyttöä koskien

Objektiivin kiinnittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Älä käytä kolmijalan ruuveja laitteen kiinnittämiseen korkealle.

Huomautus

Valitse kolmijalka, joka ei kaadu, vaikka objektiivi kääntyy.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kiinnittäminen korkealle kiinteään paikkaan

Tässä osiossa käsitellään laitteen kiinnittämistä pystyasentoon korkealle kattotelineen avulla (CIB-PCM1 (lisävaruste)).

Pyydä ammattitaitoista asentajaa kiinnittämään laite korkealle.
Varmista korkealle kiinnittäessä, että kiinnityspinta ja kiinnitysmateriaalit (lisävarusteita lukuun ottamatta) kestävät
vähintään 200 kg:n painon, ja kiinnitä laite tässä ohjekirjassa kuvatulla tavalla. Jos kiinnitys ei ole riittävän tukeva,
laite voi pudota ja aiheuttaa vakavia vammoja.
Liitä CIB-PCM1-kattotelineeseen (lisävaruste) mukana toimitettava putoamisenestovaijeri, joka estää laitetta
putoamasta.
Kun laite on kiinnitetty korkealle, tarkista vuosittain, että kiinnitys ei ole löystynyt. Lyhennä tarkastusten väliä
käyttöolosuhteiden mukaan.

Asennushuomautus
Suojaa objektiivia ja objektiivin liitäntälohkoa laitteessa pitämällä objektiivinsuojus ja -kansi paikoillaan, kunnes
objektiivi on kiinnitetty.
Välttääksesi objektiivin toimintahäiriöitä älä pidä kiinni objektiivin osista työskentelyn aikana.
Välttääksesi laitteen toimintahäiriöitä älä pidä kiinni kamerapäästä työskentelyn aikana.

Tarkista korkean kiinnityksen lisävarusteet ja kiinnitystila.

CIB-PCM1 -kattotelinesarja (lisävaruste)
Tarkista ennen aloittamista, että seuraavat osat ovat saatavilla.

Runkoteline (1)
Kattoteline (1)
Objektiivin vapautuspainikkeen kansi (1)
Putoamisen estävä vaijeri (1)
+PSW M3×8 ruuvia (9)
+PSW M4×8 ruostumaton teräsruuvi putoamisen estävää vaijeria varten (1)

1
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Huomautus

Putoamisen estävä vaijeri on suunniteltu laitteen tukemiseen, kun se on ripustettuna. Älä kohdista siihen muuta kuin laitteen
paino.

Kiinnitystila
Tutustu seuraavaan piirrokseen kiinnityksen sijaintia ja suuntaa valitessa, ja ota huomioon objektiivin kääntämiseen
ja laitteen takaosan johtoihin tarvittava tila.

A: Kamerapään liikelaajuus (esim. SEL70200GM2 (kun SEL20TC on liitettynä): Ø370)
B: Kattoteline (reikä kiinnitettävän pinnan puolella (Ø150))
C: Kiinnityksen kohdistusreikä

Huomautus

Kiinnitä se vakaalle alustalle, johon ei kohdistu tärinää. Paikat, joihin kohdistuu tärinää, voivat aiheuttaa kuvan tärinää.

Jos laite on kiinnitettävä kaltevalle pinnalle, kallista sitä korkeintaan ±15° vaakatasosta ja huolehdi, ettei laite pääse
kaatumaan.

Liu’uta panoroinnin/kallistuksen lukitusvipu LOCK-asentoon lukitaksesi kamerapään
panoroinnin/kallistuksen.

2
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Huomautus

Jos kamerapään panorointi/kallistus ei lukitu, kun lukitusvipu on LOCK-asennossa, siirrä kamerapäätä käsin, kunnes se
lukittuu paikalleen.

Liitä runkoteline laitteen pohjaan mukana toimitettavien kuuden ruuvin (M3×8) avulla.3
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Käytä mukana toimitettavia ruuveja. Muiden kuin mukana toimitettujen ruuvien käyttäminen saattaa vaurioittaa
laitteen sisäpuolta.

Kiinnitä putoamisen estävä vaijeri runkotelineeseen.4
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A: Mukana toimitettava vaijeri　
B: Mukana toimitettava Phillips-ruuvi (M4×8)
C: Vaijerin metallilenkki

Käytä mukana toimitettavaa ruuvia. Muun kuin mukana toimitetun ruuvin käyttäminen saattaa heikentää
vaijeritoiminnon tehoa.

Kiinnitä kattoteline pintaan, johon laite kiinnitetään, esimerkiksi hyllyyn.5
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A: Seinä　
B: △-merkki (kameran suunta eteenpäin)
C: Reikä liitäntäkaapeleita varten
D: Hylly tai muu kiinnityspinta

Kiinnitä putoamisen estävä vaijeri lähellä kiinnityspintaa olevaan kohteeseen.

Käytä M5 (3/16 tuuman) kuusiokolokantaruuvia (lisävaruste) ja kiinnitä se kohteeseen lähelle hyllyä tai pintaa, johon
kattoteline on kiinnitetty.

6
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A: Vaijeri　
B: Kuusiokolokantaruuvi (M5, 3/16 tuumaa)

Kohdista runkotelineen etuosassa oleva 〇-ruuvinreikä kattotelineessä olevaan ◇-reikään, aseta laite
paikalleen ja kiinnitä runkoteline kattotelineeseen väliaikaisesti kääntämällä laitetta myötäpäivään.

7
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A: 〇-reikä
B: △-reikä

Liitä runkoteline ja kattoteline mukana toimitettavien kolmen kääntölukkoruuvin (M3×8) avulla.8
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Kiinnitä seuraavaksi objektiivi. Ks. ”Objektiivin kiinnittäminen” ja ota huomioon kohdissa ”Muistettavaa objektiivin
liittämistä/irrottamista koskien”, ”Objektiivin kytkinten tarkistaminen” ja ”Muistettavaa zoom-objektiivin käyttöä koskien”
annetut tiedot.

Huomautus

Kun objektiivi on kiinnitetty, tarkista, että objektiivi on tiukasti kiinni.
Objektiivia ei ole suojattu putoamiselta. Sony ei ota vastuuta siitä, jos objektiivi irtoaa laitteesta.

Aiheeseen liittyvää

Muistettavaa objektiivin liittämistä/irrottamista koskien

Objektiivin kytkinten tarkistaminen

Muistettavaa zoom-objektiivin käyttöä koskien

Objektiivin kiinnittäminen

Tarkista kiinnityksen tila.

Tarkista erityisesti seuraavat kohteet. 

Kiinnitysruuvit on kiinnitetty kunnolla.
Putoamisen estävä vaijeri on kunnolla kiinnitetty eikä se ole kiertynyt.
Laite on kiinnitetty tasaiselle alustalle (ilman kallistusta tai heilumista).
Laite ei käänny vapaasti käännettäessä.

9
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kattoon kiinnittäminen

Tässä osiossa käsitellään laitteen kiinnittämistä kattoon kattotelineen avulla (CIB-PCM1 (lisävaruste)).

Pyydä ammattitaitoista asentajaa kiinnittämään laite kattoon.
Varmista kattoon kiinnittäessä, että kiinnityspinta ja kiinnitysmateriaalit (lisävarusteita lukuun ottamatta) kestävät
vähintään 200 kg:n painon, ja kiinnitä laite tässä ohjekirjassa kuvatulla tavalla. Jos kiinnitys ei ole riittävän tukeva,
laite voi pudota ja aiheuttaa vakavia vammoja.
Liitä CIB-PCM1-kattotelineeseen (lisävaruste) mukana toimitettava putoamisenestovaijeri, joka estää laitetta
putoamasta.
Kun laite on kiinnitetty kattoon, tarkista vuosittain, että kiinnitys ei ole löystynyt. Lyhennä tarkastusten väliä
käyttöolosuhteiden mukaan.

Asennushuomautus
Suojaa objektiivia ja objektiivin liitäntälohkoa laitteessa pitämällä objektiivinsuojus ja -kansi paikoillaan, kunnes
objektiivi on kiinnitetty.
Välttääksesi objektiivin toimintahäiriöitä älä pidä kiinni objektiivin osista työskentelyn aikana.
Välttääksesi laitteen toimintahäiriöitä älä pidä kiinni kamerapäästä työskentelyn aikana.

Tarkista kattokiinnityksen lisävarusteet ja kiinnitystila.

CIB-PCM1 -kattotelinesarja (lisävaruste)
Tarkista ennen aloittamista, että seuraavat osat ovat saatavilla.

Runkoteline (1)
Kattoteline (1)
Objektiivin vapautuspainikkeen kansi (1)
Putoamisen estävä vaijeri (1)
+PSW M3×8 ruuvia (9)
+PSW M4×8 ruostumaton teräsruuvi putoamisen estävää vaijeria varten (1)

1
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Huomautus

Putoamisen estävä vaijeri on suunniteltu laitteen tukemiseen, kun se on ripustettuna. Älä kohdista siihen muuta kuin laitteen
paino.

Kiinnitystila
Tutustu seuraavaan piirrokseen kiinnityksen sijaintia ja suuntaa valitessa, ja ota huomioon objektiivin kääntämiseen
ja laitteen takaosan johtoihin tarvittava tila.

A: Kamerapään liikelaajuus (esim. SEL70200GM2 (kun SEL20TC on liitettynä): Ø370)
B: Kattoteline (reikä katon puolella (Ø150))
C: Kiinnityksen kohdistusreikä

Huomautus

Kiinnitä kattoon (kuten betoniin), joka on tarpeeksi kestävä.

Jos laite kiinnitetään kattoon, joka ei ole tarpeeksi kestävä, on käytettävä riittävää vahviketta.

Kiinnitä se vakaalle alustalle, johon ei kohdistu tärinää. Paikat, joihin kohdistuu tärinää, voivat aiheuttaa kuvan tärinää.

Jos laite on kiinnitettävä kaltevalle pinnalle, kallista sitä korkeintaan ±15° vaakatasosta ja huolehdi, ettei laite pääse
kaatumaan.

Kattotelineessä olevan △-reiän vastakkainen sivu on kuvaussuunta (kameran etupuoli).

Liu’uta panoroinnin/kallistuksen lukitusvipu UNLOCK-asentoon poistaaksesi panoroinnin/kallistuksen
lukituksen ja kääntääksesi kamerapäätä 180° kallistuksen suuntaan.

2

Liu’uta panoroinnin/kallistuksen lukitusvipu LOCK-asentoon lukitaksesi kamerapään
panoroinnin/kallistuksen.

3
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Kamerapäätä käännetty 180°

Huomautus

Jos kamerapään panorointi/kallistus ei lukitu, kun lukitusvipu on LOCK-asennossa, siirrä kamerapäätä käsin, kunnes se
lukittuu paikalleen.

Liitä runkoteline laitteen pohjaan mukana toimitettavien kuuden ruuvin (M3×8) avulla.4
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Käytä mukana toimitettavia ruuveja. Muiden kuin mukana toimitettujen ruuvien käyttäminen saattaa vaurioittaa
laitteen sisäpuolta.

Kiinnitä kattoteline kiinnityslaattaan (lisävaruste) ja kiinnitä sitten laatta kattoon.5
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A: Kattoteline
B: Katto
C: Kiinnityslaatta
D: △-reikä
Kiinnitä teline kattotelineen suunnan mukaisesti
Huomaa, että kun kamera on kiinnitetty kattoon, sen etuosa on vastakkaisella puolella kuin normaalissa
pystyasentoisessa kiinnityksessä. Suorita kiinnitys oikein tutustumalla kaavioon, joka osoittaa kiinnityssuunnan.

A: Etuosa pystyasentoon kiinnitettäessä (△-reiän suunta)
B: Etuosa kattoon kiinnitettäessä

Huomautus

Kiinnityspinnan materiaali on asiakkaan vastuulla.

Kiinnitä putoamisen estävä vaijeri kattoon.6

80



A: Kattoteline
B: Kuusiokolokantaruuvi (M5, 3/16 tuumaa)
C: Vaijeri (toimitetaan mukana)
D: Kiinnityslaatta
E: Katto

Vedä putoamisen estävä vaijeri kattotelineen keskellä olevasta reiästä ja kiinnitä se runkotelineeseen.

Pujota putoamisen estävä vaijeri runkotelineessä olevasta vaijerin metallilenkistä ja kiinnitä se tiukasti telineeseen
mukana toimitettavan ruostumattoman teräsruuvin avulla (M4×8).

A: Mukana toimitettava vaijeri
B: Mukana toimitettava Phillips-ruuvi (M4×8)
C: Vaijerin metallilenkki

7
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Käytä mukana toimitettavaa ruuvia. Muun kuin mukana toimitetun ruuvin käyttäminen saattaa heikentää
vaijeritoiminnon tehoa.

Huomautus

On suositeltavaa, että yksi henkilö kannattelee laitetta alla olevan kaavion mukaisesti samalla, kun toinen henkilö kiinnittää
laitteen.

Älä pidä kiinni kamerapäästä tai objektiivin tuesta laitetta kiinnittäessä. Jos laite pudotetaan tai putoaa, voi syntyä vahinko
tai vammoja.

Varmista johtoja kytkettäessä, että sähköliitännät ja -kaapelit eivät joudu oikosulkuun putoamisen estävän vaijerin vuoksi.

Kiinnitys kestää enintään 8,8 kg:n ripustetun massan (objektiivi mukaan lukien). Älä ylitä odotettua enimmäiskuormaa, jotta
laite ei putoa.

Kohdista runkotelineen ruuvinreikä (A) kattotelineen ◇-reikään (B), liitä laite ja käännä sitä myötäpäivään
noin 60 astetta, kunnes ruuvinreikä (A) ja ruuvinreikä (C) ovat kohdakkain.

8
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A: Runkotelineen ruuvinreikä
B: Kattotelineen ruuvinreikä (◇-reikä)
C: Ruuvinreikä
D: Katto
E: Kiinnityslaatta

Liitä runkoteline ja kattoteline mukana toimitettavien kolmen kääntölukkoruuvin (M3×8) avulla.9
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Kiinnitä seuraavaksi objektiivi. Ks. ”Objektiivin kiinnittäminen” ja ota huomioon kohdissa ”Muistettavaa objektiivin
liittämistä/irrottamista koskien”, ”Objektiivin kytkinten tarkistaminen” ja ”Muistettavaa zoom-objektiivin käyttöä koskien”
annetut tiedot.

Huomautus

Jotta panorointi/kallistus toimii oikein, kun laite on kiinnitetty kattoon, aseta kohdan [Pan-Tilt] > [Direction] > [Ceiling] valinnaksi
[On] verkkovalikossa.

Kun objektiivi on kiinnitetty, tarkista, että objektiivi on tiukasti kiinni.
Objektiivia ei ole suojattu putoamiselta. Sony ei ota vastuuta siitä, jos objektiivi irtoaa laitteesta.

Aiheeseen liittyvää
Muistettavaa objektiivin liittämistä/irrottamista koskien

Tarkista kiinnityksen tila.

Tarkista erityisesti seuraavat kohteet.

Kiinnitysruuvit on kiinnitetty kunnolla.
Putoamisen estävä vaijeri on kunnolla kiinnitetty eikä se ole kiertynyt.
Laite on kiinnitetty tasaiselle alustalle (ilman kallistusta tai heilumista).
Laite ei käänny vapaasti käännettäessä.

10
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Objektiivin kytkinten tarkistaminen

Muistettavaa zoom-objektiivin käyttöä koskien

Objektiivin kiinnittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Muistettavaa objektiivin liittämistä/irrottamista koskien

Älä suuntaa objektiivia kohti aurinkoa. Suora auringonvalo voi kulkeutua objektiivin läpi, kohdistua laitteeseen ja
aiheuttaa tulipalon.

Huomautus

Kiinnitä/irrota objektiivi, kun laite on sammutettuna.

Objektiivi on tarkkuuskomponentti. Älä aseta objektiivia millekään pinnalle siten, että objektiivin pidike on alaspäin. Kiinnitä
mukana toimitettu objektiivinpidikkeen suojus.

Vihje

Lisätietoja laitteeseen soveltuvista objektiiveista saat ottamalla yhteyttä Sonyn palveluedustajaan.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
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Objektiivin kytkinten tarkistaminen

Seuraavat tarkistukset ja asetukset ovat pakollisia objektiivin tyypistä riippuen.

Objektiivi, jossa on tarkennustilakytkin

Siirrä kytkin AF/MF- tai AF-asentoon.
Kun kytkin on MF- tai Full MF -asennossa, tarkennusta voidaan säätää vain objektiivirenkaan avulla.

Huomautus

Kun käytetään A-pidikkeellistä objektiivia, käsisäätö kauko-ohjaimesta ei ehkä ole käytettävissä.

Objektiivi, jossa on zoom-kytkin

Siirrä kytkin SERVO-asentoon.
Kun kytkin on MANUAL-asennossa, zoomia voidaan säätää vain zoomausrenkaan avulla. Zoomin hallinnalla laitteesta
käsin ei ole vaikutusta.

Objektiivi, jossa on Auto Iris -kytkin

Siirrä kytkin AUTO-asentoon.
Kun kytkin ei ole AUTO-asennossa, himmennintä voidaan säätää vain objektiivirenkaan avulla. Himmentimen käytöllä
laitteesta käsin ei ole vaikutusta.

Objektiivi, jossa on kuvanvakautuskytkin

Siirrä kytkin OFF-asentoon.
Kun kytkin on ON-asennossa, panorointi-/kallistustoimintojen aikana voi esiintyä odottamatonta toimintaa.

SELP28135G

A: Siirrä tarkennusrengas etuasentoon (AF/MF-tila).
B: Siirrä ZOOM-kytkin SERVO-asentoon.
C: Siirrä himmentimen rengas A-asentoon ja IRIS LOCK -kytkin LOCK-asentoon.
D: Siirrä kuvanvakautuskytkin OFF-asentoon.
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Muistettavaa zoom-objektiivin käyttöä koskien

Käytettäessä muuta zoom-objektiivia kuin moottorizoom-objektiivia, zoomin asento voi vaihdella kiinnitysympäristöstä
riippuen. Vakauta zoomausrengas paikoilleen käyttämällä tarkoitukseen sopivaa teippiä.

Muovinen filmiteippi: 471 BLA 50 tai vastaava

5-041-958-73(1) Copyright 2022 Sony Corporation

89



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektiivin kiinnittäminen

Tässä osiossa käsitellään E-pidikkeellisen tai A-pidikkeellisen objektiivin liittämistä.

Huomautus

Älä kuljeta laitetta objektiivi kiinnitettynä.

Kun käytät A-pidikkeellistä objektiivia, himmennin määrittyy manuaalisesti ja tarkennukseksi määrittyy MF.

Liu’uta panoroinnin/kallistuksen lukitusvipu LOCK-asentoon lukitaksesi kamerapään
panoroinnin/kallistuksen.

Huomautus

Jos kamerapään panorointi/kallistus ei lukitu, kun lukitusvipu on LOCK-asennossa, siirrä kamerapäätä käsin, kunnes se
lukittuu paikalleen.

1

Löysää lukkoa kääntämällä objektiivin tukijalustan kiinnikeruuvin vipua vastapäivään ja siirrä objektiivin
tukijalustan kiinnikeruuvi asentoon, jossa se ei haittaa objektiivia.

2
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A: Oikein
B: Väärin

Avaa kamerapään lukitus kääntämällä kamerapään lukitusvipua nuolen suuntaan.

Huomautus

Ennen kuin kamerapää lukittuu uudelleen, se saattaa liikkua oman painonsa ansiosta. Tue kamerapäätä kädellä, kun
suoritat tehtävää.

3

Liu’uta kamerapää etummaiseen asentoon.4

Lukitse kamerapää kääntämällä kamerapään lukitusvipua nuolen suuntaan.5
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Huomautus

Varmista, että kamerapään lukitusvipu ei joudu kosketuksiin muiden osien kanssa, jotta kallistus ei häiriinny.

Irrota laitteen ja objektiivin suojukset.6

Kohdista objektiivin asennusmerkki (valkoinen) laitteeseen, aseta objektiivi varovasti paikalleen
kamerapäähän ja käännä objektiivia myötäpäivään, kunnes se naksahtaa lukitusasentoon.

A: Asennusmerkit (valkoinen)

Huomautus

Jos haluat käyttää A-pidikkeellistä objektiivia, kiinnitä ensin objektiivin asennussovite (lisävaruste) laitteeseen ja kiinnitä
sitten A-pidikkeellinen objektiivi.

7

Avaa kamerapään lukitus kääntämällä kamerapään lukitusvipua nuolen suuntaan.8
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Huomautus

Ennen kuin kamerapää lukittuu uudelleen, se saattaa liikkua oman painonsa ansiosta. Tue kamerapäätä kädellä, kun
suoritat tehtävää.

Tasapainota kamerapää etu-/takasuunnassa, jotta liukualusta on vaakatasossa.

Jos käytät jotakin seuraavista objektiiveista, voit alustavasti tasapainottaa laitteen ja objektiivin liukualustassa
olevan vaa’an avulla.

9

Vaa’an asemointi Objektiivin nimi

0,5 SEL70200GM (SEL20TC liitettynä)

1,7 SEL70200GM

2,0 SEL70200GM2 (SEL20TC liitettynä)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Huomautus

Käytä liukualustan vaakaa viitteenä alustavalle tasapainotukselle.

Kun kiinnität objektiivia, säädä tasapainoa tarpeen mukaan, jotta laite ei kallistu eteen- tai taaksepäin.

Säädä tasapainoa vaakatasossa olevalla alustalla.

Irrota objektiivin tukilaite käytettäessä SELC1635G:tä.

Vaa’an asemointi Objektiivin nimi

5,0 tai enemmän SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Lukitse kamerapää kääntämällä kamerapään lukitusvipua nuolen suuntaan.

Huomautus

Varmista, että kamerapään lukitusvipu ei joudu kosketuksiin muiden osien kanssa, jotta kallistus ei häiriinny.
Varmistustapa: siirrä panoroinnin/kallistuksen lukitus UNLOCK-asentoon, käännä kameralohko käsin osoittamaan ylöspäin
ja tarkista silmämääräisesti, ettei lohko kosketa muita osia. Jos vipu koskettaa muita osia, käännä kamerapään lukitusvipua
taas nuolen suuntaan.

10

Löysää objektiivin tukilaitetta kääntämällä objektiivin tukikiinnikkeen vipua vastapäivään.11
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A: Objektiivin tukivarren kiinnikevipu (2 paikkaa)
B: Objektiivin tukilaite

Käännä objektiivin tukilaitetta niin, että objektiivin tukijalusta on linjassa objektiivin tukijalustan
kiinnikeruuvin kanssa, ja vakauta sitten objektiivin tukijalusta kääntämällä ruuvia myötäpäivään.

Huomautus

Varmista, että objektiivin tukijalusta on kohtisuorassa objektiivin tukijalustan kiinnikeruuviin nähden ja kiristä ruuvi.

12

Lukitse objektiivin tukijalustan kiinnikeruuvi kääntämällä objektiivin tukijalustan kiinnikeruuvin vipua
myötäpäivään.

A: Objektiivin tukijalustan kiinnikeruuvi
B: Kiinnikeruuvin reikä
C: Objektiivin tukijalustan kiinnikeruuvin vipu

Vihje

Jos vivun asento hankaloittaa jalustan kääntämistä, avaa vipu ja käännä se asentoon, jossa jalustan käyttäminen on
helpompaa. Kun haluttu asento on saavutettu, sulje kiinnikevipu.

13
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Aiheeseen liittyvää

E-pidikkeellisen objektiivin kalibrointi

5-041-958-73(1) Copyright 2022 Sony Corporation

A: Objektiivin tukijalustan kiinnikeruuvin vipu
B: Objektiivin tukivarren kiinnikevipu

Vakauta objektiivin tukilaite kääntämällä kahta objektiivin tukivarren kiinnikevipua myötäpäivään.14

Varmista, että molemmat vivut on kiristetty eivätkä ne ole löysällä, objektiivi on kiinnitetty oikein ja
objektiivin vivut on asetettu oikein.

Jos jokin vipu on löysällä tai objektiivia ei ole kiinnitetty oikein, objektiivi voi pudota ja vaurioitua.
E-pidikkeellistä moottorizoom-objektiivia käytettäessä objektiivi on lisäksi kalibroitava erikseen, jotta kameraan
esiasetetut zoomausasennot voidaan palauttaa oikein. Lisätietoja saat kohdasta ”E-pidikkeellisen objektiivin
kalibrointi”.

15
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Objektiivin irrottaminen

Irrota objektiivi noudattamalla objektiivin kiinnitysmenettelyä käänteisessä järjestyksessä.

Huomautus

Tartu objektiiviin tukevasti, jotta se ei putoa.

Jos tilalle ei saman tien kiinnitetä toista objektiivia, kiinnitä aina rungon suojus.

Aiheeseen liittyvää

Objektiivin kiinnittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Varmista, että panorointi/kallistus on lukittu.1

Löysää lukkoa kääntämällä objektiivin tukijalustan kiinnikeruuvin vipua vastapäivään.2

Irrota objektiivin tukijalustan kiinnikeruuvi objektiivin tukilaitteesta ja siirrä se asentoon, jossa se ei haittaa
objektiivia.

3

Avaa kamerapään lukitus ja liu’uta kamerapää etummaiseen asentoon.

Lisätietoja on vaiheissa 3–5 kohdassa ”Objektiivin kiinnittäminen”.

4

Pidä objektiivin vapautuspainiketta painettuna ja käännä objektiivia vastapäivään pidellen sitä samalla
tukevasti.

5

Kun kameran ja objektiivin kiinnitysmerkit (valkoiset) ovat linjassa, vedä objektiivia eteenpäin.6
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Liitäntäjohdot

Tässä osiossa käsitellään johtoliitäntöjä.

5-041-958-73(1) Copyright 2022 Sony Corporation

Liitä tarpeelliset johdot takapaneelin liittimiin.

Jotta HDMI-kaapelia ei voi irrottaa, irrota HDMI-kaapelin pidikelevyn kiinnikeruuvi (M2.6×6) liitäntälohkosta ja
kiinnitä mukana toimitettu HDMI-kaapelin pidikelevy kiinnikeruuvilla. Kiinnitä HDMI-kaapeli HDMI-kaapelin
pidikelevyyn kaupasta saatavalla nippusiteellä tai nauhalla.

A: HDMI-kaapelin pidikelevyn kiinnitysruuvi (M2.6×6, musta)
B: Kaupasta saatava nippuside tai nauha
C: HDMI-kaapelin pidikelevy (mukana)

1
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Laitteen yhdistäminen verkkolaitteeseen kaapelilla

Tässä osiossa käsitellään laitteen yhdistämistä verkkolaitteeseen kaapelilla.

5-041-958-73(1) Copyright 2022 Sony Corporation

Yhdistä laite verkkolaitteeseen (kuten Wi-Fi-tukiasemaan tai keskittimeen) vähintään kategorian 5e LAN-
kaapelilla.

1
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Verkkovirran käyttäminen

Tässä osiossa käsitellään laitteen virransyöttötoimintoa verkkovirran avulla.

Liu’uta panoroinnin/kallistuksen lukitusvipu LOCK-asentoon lukitaksesi kamerapään
panoroinnin/kallistuksen.

1

Liitä AC-verkkovirtalaite (mukana) laitteen DC IN -liittimeen ja kytke virtajohto (mukana)
vaihtovirtalähteeseen.

A: DC IN -liitin
B: Virtajohto
C: AC-verkkovirtalaite

2

Kiinnitä AC-verkkovirtalaite johtolukolla, jos haluat estää johdon irtoamisen.

Avaa johtolukko, vie johto lukon läpi alla kuvatulla tavalla ja lukitse johtolukko.

3
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Huomautus

Älä käytä muita kuin toimitukseen sisältyviä AC-verkkovirtalaitetta tai virtajohtoa. Muun verkkovirtalaitteen tai virtajohdon
yhdistäminen voi aiheuttaa tulipalon tai toimintavirheen.

Älä liitä ja käytä verkkovirtalaitetta ahtaissa tiloissa, kuten seinän ja huonekalun välissä.

Älä aiheuta oikosulkua verkkovirtalaitteen pistokkeen metalliosiin. Se voi aiheuttaa toimintahäiriön.

Liitä verkkovirtalaite lähimpään vaihtovirtalähteeseen. Jos käytön aikana ilmenee ongelmia, irrota virtajohto välittömästi
vaihtovirtalähteestä.

A: Johtolukko
B: Johtolukon lukko-osa
C: Verkkovirtalaitteen johto

Tarkista, että laitteen etuosan vihreä POWER-merkkivalo muuttuu vilkkuvasta jatkuvasti palavaksi ja että
käynnistys on päättynyt.

Kun laite on käynnistynyt normaalisti ja liitetty verkkoon, vihreä NETWORK-merkkivalo syttyy.

Kun käytät objektiivia, joka ei tue panorointi-/kallistustoimintoa, lukitse panoroinnin/kallistuksen lukitusvipu ja jätä
seuraavat vaiheet huomiotta. Lisätietoja panorointiin/kallistukseen soveltuvista objektiiveista saat ottamalla
yhteyttä jälleenmyyjään tai Sonyn palveluedustajaan.

4

Liu’uta panoroinnin/kallistuksen lukitusvipu UNLOCK-asentoon poistaaksesi kamerapään
panoroinnin/kallistuksen lukituksen.

5

Nollaa panorointi/kallistus.

Lisätietoja on kohdassa ”Panoroinnin/kallistuksen nollaaminen”.

6
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Kun irrotat verkkovirtalaitteen kamerasta, tartu pistokkeeseen ja vedä se suoraan ulos. Johdosta vetäminen voi aiheuttaa
toimintahäiriön.

Aiheeseen liittyvää

Panoroinnin/kallistuksen nollaaminen

5-041-958-73(1) Copyright 2022 Sony Corporation
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PoE++-virran käyttäminen

Kun laite on liitetty PoE++-yhteensopivaan virrantuottolaitteeseen, virta johdetaan laitteeseen kaupasta saatavalla
verkkojohdolla.
Tämä menetelmä mahdollistaa virran johtamiseen laitteeseen ilman virtalähdejohtoja ympäristöissä, joissa
kiinnityspaikan lähellä ei ole virtalähdettä.

Liu’uta panoroinnin/kallistuksen lukitusvipu LOCK-asentoon lukitaksesi kamerapään
panoroinnin/kallistuksen.

1

Liitä laite PoE++-yhteensopivaan virrantuottolaitteeseen kaupasta saatavalla verkkojohdolla.

A: Verkkokaapeli
B: PoE++-yhteensopiva virrantuottolaite

2

Tarkista, että laitteen etuosan vihreä POWER-merkkivalo muuttuu vilkkuvasta jatkuvasti palavaksi ja että
käynnistys on päättynyt.

Kun laite on käynnistynyt normaalisti ja liitetty verkkoon, vihreä NETWORK-merkkivalo syttyy.

Huomautus

3

103



Huomautus

Laite täyttää IEEE802.3bt Type 4 Class 8 -vaatimukset. Lisätietoja vahvistetuista, yhteensopivista PoE++-virrantuottolaitteista
saat ottamalla yhteyttä jälleenmyyjään tai Sonyn palveluedustajaan.

Laite on yhteensopiva kevyen tunnistamisen (LLDP) kanssa, mutta verkkolaitteiden konfigurointia saatetaan tarvita (IEEE802.3bt-
yhteensopiva).

Älä liitä AC-verkkovirtalaitetta, kun käytössä on PoE++-virransyöttö ja kevyt tunnistaminen (LLDP).

Jos AC-verkkovirtalaite ja PoE++-virransyöttölaite on yhdistetty samanaikaisesti, virta syötetään AC-verkkovirtalaitteesta.

Kun virta syötetään PoE++:n kautta, käytä vähintään kategorian 5e verkkokaapelia.

Odota 10 sekuntia, ennen kuin käynnistät laitteen uudelleen, kun virta syötetään PoE++:n kautta.

Kun virransyöttöön käytetään PoE++:tä, kiinnitä maadoitusliitin maahan.

Kun virransyöttöön käytetään PoE++:tä, älä yhdistä johtoja ulkona.

Aiheeseen liittyvää
Panoroinnin/kallistuksen nollaaminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Kun virta tuotetaan PoE++:n avulla, alustava tunnistaminen tehdään sillä välin, kun käynnistystä suoritetaan loppuun.

Kun käytät objektiivia, joka ei tue panorointi-/kallistustoimintoa, lukitse panoroinnin/kallistuksen lukitusvipu ja jätä seuraavat
vaiheet huomiotta. Lisätietoja panorointiin/kallistukseen soveltuvista objektiiveista saat ottamalla yhteyttä jälleenmyyjään tai
Sonyn palveluedustajaan.

Liu’uta panoroinnin/kallistuksen lukitusvipu UNLOCK-asentoon poistaaksesi kamerapään
panoroinnin/kallistuksen lukituksen.

4

Nollaa panorointi/kallistus.

Lisätietoja on kohdassa ”Panoroinnin/kallistuksen nollaaminen”.

5
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Panoroinnin/kallistuksen nollaaminen

Voit nollata panoroinnin/kallistuksen esimerkiksi vaihtaessasi objektiivia seuraavien ohjeiden avulla.

5-041-958-73(1) Copyright 2022 Sony Corporation

Liu’uta panoroinnin/kallistuksen lukitusvipu UNLOCK-asentoon ja tarkista, että kamerapään
panoroinnin/kallistuksen lukitus on auki.

1

Suorita panoroinnin/kallistuksen nollaustoiminto.

Panoroinnin/kallistuksen nollaus voidaan suorittaa infrapunakaukosäätimestä, verkkosovelluksesta tai RM-IP500-
kaukosäätimestä (lisävaruste).

Suoritus infrapunakaukosäätimellä: Paina P/T RESET -painiketta.
Suoritus verkkosovelluksella: Paina  (Panoroinnin/kallistuksen nollaus) -painiketta suoran
käyttönäkymän  (Others) -välilehdessä kameran hallintapaneelissa.
Suoritus RM-IP500-kaukosäätimellä: Tutustu RM-IP500:n käyttöohjeeseen.

Huomautus

Panoroinnin/kallistuksen nollauksen suorittaminen aiheuttaa kamerapään ja objektiivin kääntymisen. Tarkista ennen
suorittamista, että objektiivin edessä ei ole esteitä.

Laitteessa on toiminto, joka rajoittaa panorointi-/kallistusaluetta, mutta tämä toiminto on pois päältä, kun laite käynnistetään
tai panorointi/kallistus nollataan.

Vihje

Kun panoroinnin/kallistuksen nollaus on valmis, laite palaa suoritusta edeltävään asentoon.

2
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Verkkosovelluksen käyttäminen verkkoselaimella

Yhdistämällä laitteen tablettiin tai tietokoneeseen voit käyttää laitetta ja tehdä siihen määrityksiä verkkoselaimesta käsin.

Tarkista, tukeeko tablettisi tai tietokoneesi verkkosovellustoimintoja.

Huomautus

Jos vaadittu ympäristö on vajaa tai tabletin/tietokoneen käytöstä riippuen, se voi haitata videon näyttöä verkkoselaimessa.

Tämän laitteen verkkosovellus käyttää JavaScriptiä. Jos tabletissa/tietokoneessa on viruksentorjuntaohjelma, verkkosivu ei
välttämättä näy kunnolla.

1

Kohde Vaatimukset

Näyttö
Suositus: 1080×810 pikseliä tai enemmän
Tabletin suositettu näyttökoko: 10 tuumaa
tai suurempi

Tuetut käyttöjärjestelmät ja
verkkoselaimet

Windows
Käyttöjärjestelmä Windows 10 tai uudempi

Verkkoselain Google Chrome

Mac

Käyttöjärjestelmä macOS 10.15 tai uudempi

Verkkoselain
Google Chrome
Safari

iPad

Käyttöjärjestelmä iPadOS 15 tai uudempi

Verkkoselain
Google Chrome
Safari

Android
Käyttöjärjestelmä Android 12 tai uudempi

Verkkoselain Google Chrome

Tarkista, että laite, tabletti tai tietokone ja oheislaitteet ovat käynnissä.2

Tarkista, että laite ja tabletti tai tietokone on yhdistetty Wi-Fin tai langallisen LAN-yhteyden välityksellä.3

Muodosta yhteys laitteeseen tabletin tai tietokoneen verkkoselaimesta.

Yhteyden muodostaminen QR-koodilla
Skannaa laitteen sivussa olevaan tietovälinesuojukseen painettu QR-koodi tabletin kameralla.

4
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Huomautus

Jos HTTP-porttinumeroksi on vaihdettu muu kuin 80, syötä osoitekenttään ”http://laitteen IP-osoite:porttinumero”.

Kun yhteys muodostetaan QR-koodin avulla tai syöttämällä URL-osoite verkkoselaimen osoitekenttään, käytä laitetta, joka tukee
mDNS:ää*.

Vihje

Myöhemmin voit siirtyä laitteen käyttöön helposti verkkoselaimen kirjanmerkkitoiminnon avulla.

5-041-958-73(1) Copyright 2022 Sony Corporation

Avaa tabletissa näkyvä linkki.
Tabletin verkkoselain käynnistyy ja näkyviin tulee laitteen verkkosovellus.

Yhteyden muodostaminen syöttämällä URL-osoite verkkoselaimen osoitekenttään
Avaa tabletin tai tietokoneen verkkoselain ja syötä laitteen sivussa olevaan tietovälinesuojukseen painettu URL-
osoite.
Verkkoselaimeen pitäisi tulla laitteen verkkosovelluksen näyttö.

Yhteyden muodostaminen syöttämällä laitteen IP-osoite verkkoselaimen osoitekenttään
Avaa tabletin tai tietokoneen verkkoselain ja syötä osoitekenttään ”http://laitteen IP-osoite”.
Verkkoselaimeen pitäisi tulla laitteen verkkosovelluksen näyttö.

mDNS: Viestintäprotokolla, jota käytetään paikallisverkon isäntänimen määrittämiseen IP-osoitteesta.*
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Laitteen alustaminen

Varmista, että laite määritetään ensimmäisellä käyttökerralla seuraavia vaiheita noudattamalla.

Vihje

Jos vara-akku tyhjenee kokonaan, alkuasetukset on määritettävä uudelleen.

Muodosta yhteys laitteeseen tabletista tai tietokoneesta ja käynnistä verkkosovellus.

Kun laitetta käytetään ensimmäistä kertaa, verkkoselaimeen on syötettävä käyttäjänimi ja salasana. Syötä
seuraavat asetukset.

Käyttäjänimi: admin
Salasana: (jätä tyhjäksi)

Määritä alkuasetukset noudattamalla näytöllä näkyviä ohjeita.

1

Syötä pääkäyttäjän (Administrator) käyttäjänimi ja salasana ja paina [OK]-painiketta.

1: Syötä pääkäyttäjän käyttäjänimi.
2: Aseta pääkäyttäjän salasana.
3: Vahvista antamalla sama salasana uudelleen.

Huomautus

Käyttäjänimessä ja salasanassa voi käyttää seuraavia merkkejä. Salasanan tulee sisältää vähintään yksi iso kirjain, yksi
pieni kirjain ja yksi numero, ja siinä pitää olla 8–64 merkkiä.

Kirjaimet ja numerot

2
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Kuvaustoimintojen suoranäyttö tulee näkyviin. Jatka laitteen perustoimintojen määrittämistä toimintatilan mukaisesti.

Vihje

Joissakin tapauksissa, esimerkiksi käytettäessä laitetta ja tablettia parina, voi olla helpompaa käyttää laitteella kiinteää IP-
osoitetta.

Symbolit (!$%`*+-./<=>?@[]^_{|}~)

Verkkoselain päivittyy ja saat kehotuksen antaa käyttäjänimen ja salasanan.

Syötä vaiheessa 2 määrittämäsi käyttäjänimi ja salasana.

Kielen ja kellon asetusnäyttö tulee näkyviin.

3

Määritä seuraavat asetukset ja paina [OK]-painiketta.

[Language]
Valitse verkkosovelluksen ja kameran kuvanäkymän kieli. Kun kieltä vaihdetaan, verkkosovelluksen näyttökieli
vaihtuu.
[Date & Time Format]
Valitse päivämäärän ja ajan näyttömuoto seuraavista vaihtoehdoista.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
”yyyy” ilmaisee vuoden, ”mm” ilmaisee kuukauden, ”dd” ilmaisee päivän, ”hh” ilmaisee tunnin, ”mm” ilmaisee
minuutin ja ”ss” ilmaisee sekunnin.
[12 h/24 h]
Valitse ajan näyttömuodoksi [12 h] (12 tunnin kello) tai [24 h] (24 tunnin kello).
[Time Setting]
Valitse päivämäärän ja ajan asetustapa.
[Synchronize with PC]: Synkronoi tietokoneen tai tabletin päivämäärään/kellonaikaan.
[Manual setting]: Aseta käsin. Kun tämä vaihtoehto valitaan, päivämäärän ja kellonajan asetuskentät tulevat
näkyviin.
[Time Zone]
Valitse aikavyöhyke.

4
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Jotta voit määrittää kiinteän IP-osoitteen, [Network] > [Wired LAN] > [IPv4] > [DHCP] on ensin poistettava käytöstä (liukusäädin
vasemmalla) verkkovalikossa.

Kiinteän IP-osoitteen määritysasetukset tulevat näkyviin. Määritä ne ja paina sitten [OK]-painiketta.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Perustoimintojen määrittäminen

Tässä osiossa käsitellään laitteen perustoimintojen määrittämistä.

Kuvaustilan määrittäminen

Laitteen kuvaustilan voi valita työnkulkuun sopivaksi.

Custom-tila: kuvia voi luoda joustavasti kuvauksen aikana.
Log-kuvaustilat: S-Log-sisällön kuvaamiseen.

Flexible ISO -tila: valotusasetukset määritetään säätämällä ISO-arvoa kuvauskohteen mukaisesti.
Cine EI -tila / Cine EI Quick -tila: laitetta käytetään samalla tavalla kuin filmikameraa (kuvia ei luoda kokonaan
kuvauksen aikana) ja kuva-aineisto kehitetään jälkikäsittelyssä.

Cine EI Quick -tilassa valotusindeksiasetukselle sopiva perusherkkyys valitaan automaattisesti.
Vaihda kuvaustilaa verkkovalikon tai kameran valikon kohdassa [Project] > [Base Setting] > [Shooting Mode].

Custom -tila
Voit valita videostandardin.
Vaihda verkkovalikon tai kameran valikon kohdassa [Project] > [Base Setting] > [Target Display].

[SDR(BT.709)]: kuvaaminen HD-lähetysstandardin mukaan
[HDR(HLG)]: kuvaaminen seuraavan sukupolven 4K-lähetysstandardin mukaan

Lisätietoja on kohdassa ”Yleistä ulkoasusta” ja muissa kohdissa osiossa ”Kuvaaminen halutulla ulkoasulla”.

Log-kuvaustilat
(Flexible ISO -tila / Cine EI -tila / Cine EI Quick -tila)
Log-kuvaustiloissa valitaan perusvärialue tallennussignaalille ja lähtösignaalille. Tässä valittu värialue on videolähdön
värialue, kun kohdan [LUT On/Off] asetuksena on [MLUT Off].
Voit vaihtaa värialuetta kameran valikon kohdassa [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut].

[S-Gamut3.Cine/SLog3]: helposti säädettävä värialue digitaaliseen elokuvaan (DCI-P3).
[S-Gamut3/SLog3]: Sonyn laaja värialue, joka kattaa ITU-R BT.2020 -värialueen.

Lisätietoja on kohdassa ”Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä”.
 
Kussakin kuvaustilassa tuetut toiminnot näkyvät seuraavassa taulukossa.
●: tuettu, –: ei tuettu

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (linkitetty EI-asetukseen)

Exposure Index – – ● ●
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Vihje

Cine EI Quick- ja Cine EI -tilassa kuvaaminen tapahtuu ISO-perusherkkyydellä ilman herkkyysvahvistusta, jotta kuvakennon
toiminta on paras mahdollinen. Kirkkautta säädetään valaistuksen ja ND-suodattimen avulla, joilla säädellään kuvakennoon
ulottuvan valon määrää.

Järjestelmän taajuuden määrittäminen

Vaihda verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] > [Frequency]. Laite voi vaihtamisen jälkeen
käynnistyä automaattisesti uudelleen valitusta arvosta riippuen.

Huomautus

Järjestelmän taajuutta ei voida vaihtaa tallennuksen tai toiston aikana.

Kuvakennon käyttötilan määrittäminen

Voit määrittää kuvakennon todellisen kuvakoon ja tarkkuuden.
Vaihda verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] > [Imager Scan Mode].
[FF]:: Täysikokoinen.
[S35]:: Super 35mm -koko.

Huomautus

Kuvakennon käyttötilaa ei voida vaihtaa tallennuksen tai toiston aikana.

Kun asetuksena on S35, videomuodoksi on rajoitettu 1920×1080.

Koodekin määrittäminen

Voit määrittää tallennuksen koodekin.
Vaihda verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] > [Codec].

Huomautus

Koodekkia ei voi vaihtaa tallennuksen tai toiston aikana.

Videomuodon määrittäminen

Voit määrittää tallennuksen videomuodon ja kameran tulon tulomuodon.

Vaihda tallennuksen videomuotoa verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] > [Video
Format].
Vaihda SDI OUT- ja HDMI OUT -liitinten tulomuoto verkkovalikon tai kameran valikon kohdassa [Monitoring] >
[Output Format].

Custom Flexible ISO Cine EI Cine EI Quick

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(ei Base Look)

● – – –
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Huomautus

Videomuotoa ei voida vaihtaa tallennuksen tai toiston aikana.

SDI OUT- ja HDMI OUT -liittimien signaaleihin voi kohdistua rajoitteita videomuotoasetuksesta riippuen.

Aiheeseen liittyvää

Yleistä ulkoasusta

Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä

5-041-958-73(1) Copyright 2022 Sony Corporation
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Tuetut muistikortit

Laite tallentaa ääntä ja videokuvaa korttipaikkoihin asetetuille CFexpress Type A -muistikorteille (saatavilla erikseen) tai
SDXC-muistikorteille (saatavilla erikseen). Muistikortteja käytetään myös välityspalvelimelle tallentamiseen.

CFexpress Type A -muistikortit

Käytä laitteessa Sony CFexpress Type A -muistikortteja*, jotka on lueteltu kohdassa ”Suositeltavat tallennusvälineet”.
Tietoja muiden valmistajien tietovälineiden toiminnasta saat kyseisen tietovälineen käyttöohjeesta tai tutustumalla
valmistajan antamiin tietoihin.

SDXC-muistikortit

Käytä laitteessa SDXC-muistikortteja*, jotka on lueteltu kohdassa ”Suositeltavat tallennusvälineet”.

Suositeltavat tallennusvälineet

Taatut käyttöolosuhteet vaihtelevat Rec Format- ja Recording-asetuksista riippuen.

CFexpress Type A
VPG400-yhteensopiva
Tuetaan kaikilla laitteen tallennusmuodoilla.

SDXC
Tuetaan alla olevassa taulukossa asetettujen ehtojen mukaisesti. ”●” ilmaisee, että toiminto on vahvistettu, ja ”–”
ilmaisee, että toimintaa ei voida taata.

RAW Out & XAVC-I, 4096×2160 Class 300, normaalitila

RAW Out & XAVC-I, 3840×2160 Class 300, normaalitila

Viitataan tässä ohjekirjassa nimityksellä ”CFexpress-kortit”.*

Viitataan tässä ohjekirjassa nimityksellä ”SD-kortit”.*

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps tai alempi)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Varmistettua tietovälinettä ei saatavilla.

XAVC-I, 4096×2160 Class 300, normaalitila

XAVC-I, 4096×2160 Class 300, S&Q (60 fps tai alempi)

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, normaalitila

XAVC-I, 3840×2160 Class 300, S&Q (60 fps tai alempi)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Varmistettua tietovälinettä ei saatavilla.

XAVC-I, 1920×1080 Class 100, normaalitila

XAVC-I, 1920×1080 Class 100, S&Q (60 fps tai alempi)

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

116



XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Varmistettua tietovälinettä ei saatavilla.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Varmistettua tietovälinettä ei saatavilla.

XAVC-L, 3840×2160 420, normaalitila

XAVC-L, 3840×2160 420, S&Q (60 fps tai alempi)

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, normaalitila

XAVC-L, 1920×1080 HD50, S&Q (60 fps tai alempi)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, normaalitila

XAVC-L, 1920×1080 HD35, S&Q (60 fps tai alempi)

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-958-73(1) Copyright 2022 Sony Corporation

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Järjestelmän taajuus Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Muistikorttien asettaminen

Tässä osiossa käsitellään muistikorttien asettamista koskevia varoituksia.

Avaa muistikorttiosion tietovälinekansi.1

Aseta muistikortti.

CFexpress-korteissa tarrapuoli tulee ylöspäin.

Huomautus

Kattoon kiinnitetyssä laitteessa tarrapuoli tulee alaspäin.

SD-korteissa tarrapuoli tulee alaspäin.

Huomautus

Kattoon kiinnitetyssä laitteessa tarrapuoli tulee ylöspäin.

Käytön ilmaisin palaa punaisena ja muuttuu sitten vihreäksi, jos kortti on käytettävissä.

2
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Huomautus

Muistikortti, muistikorttipaikka ja muistikortin kuvatiedot voivat vaurioitua, jos kortti pakotetaan aukkoon väärinpäin.

Kun tallennat molempiin CFexpress Type A / SD -korttipaikkoihin A ja B asetetuille tietovälineille, aseta molempiin paikkoihin
tietoväline, jota suositellaan käytettäväksi kyseisellä tallennusmuodolla.

5-041-958-73(1) Copyright 2022 Sony Corporation

Huomautus

Jos käytön merkkivalo vilkkuu punaisena jatkuvasti eikä muutu vihreäksi, sammuta laite hetkeksi, poista muistikortti ja aseta
se takaisin.

Sulje tietovälinekansi.3
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ILME-FR7 / ILME-FR7K

Muistikortin poistaminen

Avaa muistikorttiosion tietovälinekansi ja paina muistikorttia kevyesti, jotta se poistuu.

Huomautus

Jos laite sammutetaan tai muistikortti poistetaan, kun muistikortti on käytössä, kortin tietojen eheyttä ei voida taata. Kaikki kortille
tallennettu tieto voi hävitä. Varmista aina, että käytön ilmaisin palaa vihreänä tai on sammunut, ennen kuin sammutat laitteen tai
poistat muistikortin.

Kun poistat muistikortin heti tallentamisen päätyttyä, muistikortti voi olla kuuma, mutta se ei ole merkki ongelmasta.

5-041-958-73(1) Copyright 2022 Sony Corporation
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ILME-FR7 / ILME-FR7K

Muistikorttien formatoiminen (alustaminen)

Jos laitteeseen asetetaan formatoimaton muistikortti tai eri määrityksillä formatoitu muistikortti, kameran kuvapaneeliin
ilmestyy viesti ”Media Needs to be Formatted”.
Formatoi kortti seuraavan menettelyn mukaisesti.

Huomautus

Muistikortin formatointi pyyhkii kaikki tiedot, mukaan lukien tallennettujen videoiden tiedot ja asennustiedostot.

Suorituksen aikana voi tulla näkyviin viestejä formatointiprosessin kestosta riippuen.

Jos formatoiminen epäonnistuu
Muistikortteja, joita laite ei tue, ei voida formatoida.
Näkyviin tulee varoitusviesti. Vaihda kortti tuettuun muistikorttiin noudattamalla ohjeita.

Laitteessa formatoidun kortin käyttäminen toisessa laitteessa
Tee kortista ensin varmuuskopio ja formatoi kortti uudelleen käytettävässä laitteessa.

5-041-958-73(1) Copyright 2022 Sony Corporation

Valitse kameran valikossa [TC/Media] > [Format Media].1

Valitse Media(A) (paikka A) tai Media(B) (paikka B) ja valitse sitten formatointimenetelmä (Full Format tai
Quick Format).

Näkyviin tulee vahvistusviesti.
[Full Format]: Alustaa tietovälineen kokonaan, mukaan lukien tietoalueeseen ja tiedonhallintaan liittyvät tiedot.
[Quick Format]: Alustaa vain tietovälineen tiedonhallintaan liittyvät tiedot.

2

Valitse [Execute].

Kun formatointi on meneillään, näkyvissä on viesti ja käytön ilmaisin palaa punaisena.
Kun formatointi on tehty, näkyviin tulee viesti päättymisestä.

3
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Jäljellä olevan tallennusajan tarkistaminen

Kuvaamisen aikana (tallentaminen/valmiustila) aikana voit tarkkailla kuhunkin korttipaikkaan asetetun muistikortin jäljellä
olevaa kapasiteettia käyttämällä kameran kuvapaneelissa olevia paikan A/B tietovälineen jäljellä olevan kapasiteetin
ilmaisimia.
Jäljellä oleva tallennusaika lasketaan kunkin paikan tietovälineen jäljellä olevan kapasiteetin ja käytössä olevan
tallennusmuodon (tallennuksen bittinopeus) perusteella, ja se näytetään minuutteina.

Muistikortin vaihdon ajoittaminen
Kun kahden muistikortin jäljellä oleva tallennusaika on yhteensä alle 5 minuuttia, näkyviin tulee viesti ”Media Near Full”
(tietoväline lähes täynnä) ja tallennuksen merkkivalo alkaa vilkkua varoitukseksi.
Vaihda tietovälineeseen, jossa on tyhjää tilaa.
Jos jatkat tallentamista siihen saakka, että jäljellä oleva tallennusaika saavuttaa nollan, viestiksi muuttuu ”Media Full”
(tietoväline täynnä) ja tallentaminen pysähtyy.

Huomautus

Yhdelle muistikortille voidaan tallentaa enintään noin 600 leikettä.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Muistikorttien palauttaminen

Jos muistikortissa jostakin syystä ilmenee virhe, kortti on palautettava ennen käyttöä.
Kun lataat muistikortin, joka on palautettava, kameran kuvapaneeliin ilmestyy viesti, jossa kysytään, haluatko palauttaa
sen.

Kortin palauttaminen
Valitse [Execute] käyttämällä GUI-hallintapaneelin nuolipainikkeita ja paina [Set]-painiketta.
Kun formatointi on meneillään, näkyvissä on viesti ja etenemisen tila (%), ja käytön ilmaisin palaa punaisena.
Kun palauttaminen on tehty, näkyviin tulee viesti päättymisestä.

Jos palauttaminen epäonnistuu
Muistikortteja, joissa on ilmennyt muistivirheitä, ei voida palauttaa. Näkyviin tulee varoitusviesti. Vaihda kortti
muistikorttia noudattamalla ohjeita.
Muistikortit, joissa on ilmennyt muistivirheitä, voidaan saada käyttökelpoisiksi formatoimalla ne uudelleen.
Joissakin tapauksissa jotkut leikkeet voidaan palauttaa ja joitakin ei. Palautettuja leikkeitä voidaan toistaa normaalisti.

Huomautus

Tällä laitteella tallennettujen tietovälineiden palauttamiseen on käytettävä tätä laitetta.

Muilla kuin tällä laitteella tallennettujen tai eri laiteversiolla (vaikka kyse olisi samasta mallista) tallennettujen tietovälineiden
palauttaminen ei välttämättä onnistu tällä laitteella.

Alle 2 sekunnin mittaisia leikkeitä ei voida palauttaa.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Tallentamisen aloittaminen/lopettaminen

Tässä osiossa käsitellään tallentamisen aloittamista/lopettamista.

Kiinnitä tarvittavat laitteet ja tarkista, että laite ja oheislaitteet saavat virtaa.1

Aseta muistikortti (-kortit).2

Tarkista laitteen virtatila verkkosovelluksen vasemmassa yläkulmassa.

Kun virtalähde on päällä
Kun laite on käynnissä, [Power ON] on näkyvissä verkkosovelluksen yläreunassa olevassa virtakytkimessä.

POWER-merkkivalo syttyy laitteen etuosassa ja kameran kuva tulee näkyviin verkkosovelluksen suorassa
käyttönäkymässä.

Huomautus

Jos pääkäyttäjän salasanaa ei ole määritetty, näkyviin tulee ruutu, jossa se pyydetään määrittämään. Ks. ”Laitteen
alustaminen”.

Kun virtalähde on virransäästötilassa
Kun laitteen virtalähde on virransäästötilassa, [Power Standby] on näkyvissä verkkosovelluksen virtakytkimessä.

Paina tällöin virtakytkintä ja valitse [Power ON]. Laite käynnistyy, POWER-merkkivalo syttyy vihreänä laitteen
etuosassa ja kameran kuva tulee näkyviin verkkosovelluksen suorassa käyttönäkymässä.

Vihje

Laitteen voi käynnistää myös mukana toimitetun infrapunakaukosäätimen virtapainikkeella.

3
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Laitteen virransyötön kytkeminen virransäästötilaan
Painamalla verkkosovelluksen virtakytkintä ja valitsemalla [Power Standby] voit määrittää laitteen virtalähteen
virransäästötilaan.

Vihje

Virtalähteen voi määrittää virransäästötilaan myös mukana toimitetun infrapunakaukosäätimen virtapainikkeella.

Aiheeseen liittyvää

Laitteen alustaminen

Paina tallennuksen START/STOP-painiketta.

Tallennus alkaa ja laitteen tallennuksen merkkivalo (2 paikkaa) syttyy.
Tallennuksen aikana tallennuksen START/STOP-painikkeessa on valo. Lisäksi kohdetallennusvälineen kuvake ja
[●Rec] ovat näkyvissä.

4

Lopeta tallentaminen painamalla tallennuksen START/STOP-painiketta uudelleen.

Tallennus loppuu ja laitteen tallennuksen merkkivalo (2 paikkaa) sammuu.
Tallennuksen virransäästötilan aikana tallennuksen START/STOP-painikkeessa ei ole valoa. Lisäksi
kohdetallennusvälineen kuvake ja [Stby] ovat näkyvissä.

Vihje

Tallennuksen voi aloittaa/lopettaa myös mukana toimitetun infrapunakaukosäätimen START/STOP-painikkeella.

5
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Vaihtaminen muistikorttien välillä

Kun asetettuna on kaksi muistikorttia, muistikorttia voi vaihtaa painamalla [Slot Select] -painiketta verkkosovelluksen
toistonhallintapaneelissa.

Vihje

Muistikortteja voi vaihtaa myös painamalla mukana toimitetun infrapunakaukosäätimen SLOT SEL (muistikorttipaikan (A)/(B)
valinta) -painiketta.

Tietoja vuorotallennuksesta

Tallennettaessa laite alkaa tallentaa automaattisesti toiselle muistikortille juuri ennen kuin ensimmäisen kortin jäljellä
oleva kapasiteetti laskee nollaan (vuorotallennus). Voit jatkaa tallentamista katkottomasti muistikorttien vaihtuessa
korvaamalla täyttynyt muistikortti uudella muistikortilla.

Huomautus

Muistikorttia ei voi vaihtaa toistotilassa. Lisäksi paikan A ja paikan B tietovälineille tallentuneen leikkeen katkotonta toistamista ei
tueta.

Tietoja tallennetuista tiedoista

Kun lopetat tallentamisen, video, ääni ja niihin liittyvät tiedot tallennuksen alusta loppuun saakka tallennetaan yhdeksi
”leikkeeksi” muistikortille.

Tallennettujen tietojen leikkeen nimi

Jokainen laitteen tallentama leike saa automaattisesti nimen kameran valikon kohdassa [TC/Media] > [Clip Name
Format].

Leikkeen enimmäispituus

Enintään 6 tuntia leikettä kohti.
Jatkuvan tallennuksen enimmäispituus on sama kuin leikkeen enimmäispituus. Jos tallennuspituus ylittää leikkeen
enimmäispituuden, järjestelmä luo automaattisesti uuden leikkeen ja tallentaminen jatkuu. Uusi leike näkyy
pikkukuvanäytössä erillisenä leikkeenä.
Vuorotallennuksen aikana tallennetaan useita leikkeitä peräkkäin, mutta tallentaminen päättyy automaattisesti noin
24 tunnin kuluttua.

Huomautus

Älä poista muistikorttia silloin kun siihen juuri tallennetaan. Tallentamisen aikana voi vaihtaa muistikorttia vain siitä korttipaikasta,
jossa käytön merkkivalo ei pala.

Kun tallennettavan muistikortin jäljellä oleva kapasiteetti on alle yksi minuutti ja toiseen korttipaikkaan on asetettu
tallennuskelpoinen muistikortti, näkyviin tulee viesti ”Will Switch Slots Soon”. Viesti poistuu sen jälkeen, kun käytettävä
korttipaikka on vaihtunut.

Vuorotallennus ei ehkä toimi, jos tallentaminen alkaa silloin kun muistikortin jäljellä oleva kapasiteetti on alle yksi minuutti. Jotta
vuorotallennus onnistuisi, tarkista ennen tallennuksen aloittamista, että muistikortin jäljellä oleva kapasiteetti on enemmän kuin
yksi minuutti.

Laitteen vuorotallennustoiminnolla luotua videota ei voida toistaa katkottomasti laitteessa.
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Yhdistä laitteen vuorotallennustoiminnolla luotu video ”Catalyst Browse” -ohjelmistolla.
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Äänen tarkistaminen

Ääni lähetetään laitteen SDI- ja HDMI-liittimistä. Valitse HDMI-liittimestä lähetettävien äänikanavien yhdistelmä kameran
valikon kohdassa [Audio] > [Audio Output] > [HDMI/Stream Output CH].
CH1/CH2: CH1 ja CH2 -yhdistelmä
CH3/CH4: CH3 ja CH4 -yhdistelmä
Käytä äänen valvomiseen verkkosovelluksessa kameran kuvan oikeassa alakulmassa olevaa äänenvoimakkuusmittaria.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Aikatietojen määrittäminen

Tässä osiossa käsitellään aikatietojen määrittämistä.

Aikakoodin asettaminen

Määritä tallennettava aikakoodi kameran valikon kohdassa [TC/Media] > [Timecode].

Nimitietojen asettaminen

Voit lisätä tallennettuun kuvaan nimitiedoksi 8 merkkiä pitkän heksadesimaalinumeron. Voit asettaa nimitietoihin myös
nykyisen kellonajan. Aseta kameran valikon kohdassa [TC/Media] > [Users Bit].

Aikatietojen näyttäminen

Määritä näytettävä aikakoodi kameran valikon kohdassa [TC/Media] > [TC Display] > [Display Select].
Kun painat ohjelmoitavaa painiketta, johon [DURATION/TC/U-BIT] on ohjelmoitu, näytöllä näkyvät vuorotellen aikakoodi,
nimitiedot ja kesto.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Tallennuksen tarkasteleminen (Rec Review)

Voit tarkastella viimeisimpänä tallennettua leikettä näytöllä (tallennuksen tarkastelu).

Huomautus

Rec Review -toimintoa ei tueta, jos videomuotoa on muutettu leikkeen tallentamisen jälkeen.

Rec Review -toiminnon alkamiskohdan määrittäminen

Voit määrittää toistamisen alkamiskohdaksi jonkin seuraavista kameran valikon kohdassa [Technical] > [Rec Review].

Leikkeen viimeiset 3 sekuntia
Leikkeen viimeiset 10 sekuntia
Leikkeen alku

Vihje

Jos haluat tarkastella tiettyä leikettä sen jälkeen, kun olet tallentanut useita leikkeitä, näytä pikkukuvanäyttö painamalla
[Thumbnail]-painiketta ja valitse leike, jonka toisto aloitetaan.

Pikkukuvanäytön voi näyttää myös painamalla mukana toimitetun infrapunakaukosäätimen THUMBNAIL-painiketta.

Rec Review -menettely

Ohjelmoi Rec Review -toiminto etukäteen jollekin ohjelmoitavista painikkeista perusmääritysten säätöpaneelissa.

Lisätietoja ohjelmoinnista on kohdassa ”Ohjelmoitavat painikkeet” osiossa ”Hyödyllisiä toimintoja”.

Lopeta tallennus ja aloita edellisen tallennetun leikkeen toisto painamalla Rec Review -toiminnolle ohjelmoitua painiketta.
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Leike toistetaan loppuun saakka, Rec Review päättyy ja laite palaa Stby-tilaan (valmiustila).

Rec Review -toiminnon lopettaminen
Paina Rec Review -toiminnolle ohjelmoitua painiketta tai [Cancel/Back]-painiketta.
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Vihje

Rec Review -toiminnon voi lopettaa myös painamalla mukana toimitetun infrapunakaukosäätimen [Cancel/Back]-painiketta.

Aiheeseen liittyvää

Ohjelmoitavat painikkeet

5-041-958-73(1) Copyright 2022 Sony Corporation
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Rajauksen säätönäyttö

Rajausta säädetään seuraavien suoran käyttönäkymän osien avulla.

Huomautus

Kameran suunnasta, objektiivin tarkennusajasta ja zoomausasennosta riippuen osa laitteesta tai liitäntäyksikköön liitetyistä
kaapeleista saattaa olla näkyvillä. Tarkista ennen kuvaamista käyttämäsi objektiivin näkökenttä ja tarkennusaika. Voit myös hallita
panorointi-/kallistusaluetta verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit]. Kun laite on päällä tai panorointi/kallistus
nollataan, tämä asteikkorajoitusasetus jätetään huomiotta. Lisätietoja on verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit].

Vihje

Rajausta voi myös hallita etänä mukana toimitetulla infrapunakaukosäätimellä.

5-041-958-73(1) Copyright 2022 Sony Corporation

Esiasetusvalintojen hallintapaneeli1.

 (Main) -välilehti /  (Others) -välilehti2.

Rajauksen hallintapaneeli3.
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Kuvaussuunnan säätäminen verkkosovelluksen avulla

Kameran liikuttamista vaakatasossa kutsutaan panoroimiseksi ja kameran liikuttamista pystytasossa kallistamiseksi.
Kuvaussuuntaa voi säätää käyttämällä panorointi-/kallistustoimintoja.

Vihje

Jos ohjainsauvan alla näkyy [Execute Pan-Tilt Reset], on tapahtunut ristiriita laitteen panoroinnin/kallistuksen lähteen tiedoissa.
Päivitä lähteen tiedot suorittamalla panoroinnin/kallistuksen nollaus. Lisätietoja on kohdassa ”Panoroinnin/kallistuksen
nollaaminen”.

Kameran suuntaaminen takaisin eteen
Paina  (Panoroinnin/kallistuksen aloitusasento) -painiketta kameran hallintapaneelin  (Others) -välilehdessä.

Huomautus

Kameran suunnasta, objektiivin tarkennusajasta ja zoomausasennosta riippuen osa laitteesta tai liitäntäyksikköön liitetyistä
kaapeleista saattaa olla näkyvillä. Tarkista ennen kuvaamista käyttämäsi objektiivin näkökenttä ja tarkennusaika. Voit myös hallita
panorointi-/kallistusaluetta verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit]. Kun laite on päällä tai panorointi/kallistus
nollataan, tämä asteikkorajoitusasetus jätetään huomiotta. Lisätietoja on verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit].

Aiheeseen liittyvää
Panoroinnin/kallistuksen nollaaminen
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Tuo ohjainsauva näkyviin painamalla  (Panorointi/kallistus/zoomaus) -välilehteä rajauksen
hallintapaneelissa.

1

Vedä ohjainsauvan keskipistettä haluamaasi suuntaan samalla, kun tarkkailet kameran kuvapaneelia.

Kameran suunta ja nopeus muuttuvat vetosuunnan ja -tason mukaan.
Voit säätää panorointia/kallistusta tarkemmin painamalla ohjainsauvan reunoja.

2
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Panoroinnin/kallistuksen käyttönopeuden määrittäminen

Panoroinnin/kallistuksen käyttönopeutta voi muuttaa kameran hallintapaneelin [Pan-Tilt Speed] -liukusäätimellä
rajauksen hallintapaneelin ohjaussauvan avulla.

Huomautus

Jos kameran liikeradalla on seinä tai muu este, varo, ettei kamera tai objektiivi osu siihen panorointi-/kallistustoiminnon aikana.

Panoroinnin/kallistuksen kiihdytys riippuu fyysisistä ominaisuuksista, kuten objektiivin painon jakautumisesta. Voit muuttaa
kiihdytysasetuksia verkkovalikon tai kameran valikon kohdassa [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve].

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina  (Main) -välilehteä kameran hallintapaneelissa.1

Valitse luettelosta [Pan-Tilt Speed].

Jos [Pan-Tilt Speed] -liukusäädin ei ole näkyvissä, tuo liukusäädin näkyviin valitsemalla jompikumpi liukusäätimen
valintapainikkeista.

2

Siirrä liukusäätimen nuppia vasemmalle tai oikealle.

Nupin liikuttaminen vasemmalle pienentää käyttönopeutta, kun taas nupin liikuttaminen oikealle suurentaa
käyttönopeutta.

3
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Panorointi-/kallistustoiminnon kiihdytyksen määrittäminen

Kiihdytystoiminnon voi määrittää yhdeksällä tasolla verkkovalikon tai kameran valikon kohdassa [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve]. Arvon suurentaminen lisää nopeampia nopeusvaihtoja, ja arvon pienentäminen lisää
hitaampia nopeusvaihtoja.
Jos haluat parempaa reagointia panorointia/kallistusta käyttäessä, valitse arvo väliltä 7–9.
Jos haluat tarkempaa asemoitumista esiasetettuun asentoon liikkeen alussa/lopussa, suosituksena on arvo 1–6.

Lisätietoja esiasetetusta asennosta on kohdassa ”Panorointi-/kallistus- ja zoomausasennon
tallentaminen/palauttaminen”.

Huomautus

Kun asetettu arvo on suuri, toiminto ei välttämättä toimi kunnolla, jos kiinnitetty objektiivi on painava. Tarkasta toiminto ennen
varsinaista käyttöä.

[Ramp Curve] -asetuksen ja panorointi-/kallistustoiminnon välinen suhde

Kun panorointi/kallistus on toiminnassa

Kun palataan esiasetettuun asentoon
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Kuvaussuunnan säätäminen mukana toimitettavan infrapunakaukosäätimen avulla

Kuvaussuuntaa voi säätää mukana toimitettavan infrapunakaukosäätimen panorointi-/kallistuspainikkeiden avulla.

Kameran suuntaaminen takaisin eteen
Paina HOME-painiketta.

Huomautus

Kameran suunnasta, objektiivin tarkennusajasta ja zoomausasennosta riippuen osa laitteesta tai liitäntäyksikköön liitetyistä
kaapeleista saattaa olla näkyvillä. Tarkista ennen kuvaamista käyttämäsi objektiivin näkökenttä ja tarkennusaika. Voit myös hallita
panorointi-/kallistusaluetta verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit]. Kun laite on päällä tai panorointi/kallistus
nollataan, tämä asteikkorajoitusasetus jätetään huomiotta. Lisätietoja on verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit].
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Hallinnoi panorointia/kallistusta painamalla nuolipainikkeita.

Paina nuolipainiketta haluamaasi suuntaan samalla, kun tarkkailet kameran kuvaa.
Liikuta vähän matkaa painamalla nuolipainiketta lyhyesti.
Liikuta pitkän matkaa pitämällä nuolipainiketta painettuna.
Liikuta kulmittain pitämällä  (nuoli ylös)- tai  (nuoli alas) -painiketta painettuna ja painamalla  (nuoli
vasempaan)- tai  (nuoli oikeaan) -painiketta.

1
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Zoomityypin määrittäminen

Asta zoomityyppi kameran valikon kohdassa [Technical] > [Zoom] > [Zoom Type].
Zoomityyppi vaihtelee kiinnitetyn objektiivityypin mukaisesti.

Huomautus

Clear Image Zoom ei ole saatavilla seuraavissa tapauksissa.

Kun kohdan [Shooting] > [S&Q Motion] > [Setting] asetuksena on On ja kameran valikon [Frame Rate] -asetus on suurempi
kuin 60 fps
Kun kameran valikon kohdan [Project] > [Rec Format] > [Codec] asetuksena on [RAW] tai RAW-muodon sisältävä vaihtoehto

SERVO/MANUAL-valintakytkimen käyttö objektiivissa palauttaa Clear Image Zoomin asetukseksi 1×.

AF-S:ää ei tueta Clear Image Zoomin aikana.

Clear Image Zoom

Laitteessa on kuvasignaalin käsittelyä hyödyntävä zoomaustoiminto nimeltään Clear Image Zoom. Kun Clear Image
Zoom on käytössä, zoomausta tuetaan kiinteätarkennusobjektiiveissa. Sitä voidaan käyttää myös moottorizoom-
objektiivin optisen alueen pidentämiseen.
Clear Image Zoom -toimintoa hyödyntävä suurin zoomaussuhde vaihtelee tallennustarkkuuden mukaan.

QFHD/4K-tallennustarkkuus: 1,5×
HD-tallennustarkkuus: 2×
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Kiinnitetyn objektiivin tyyppi
[Zoom Type]-asetus

[Optical Zoom Only] [On(Clear Image Zoom)]

Kiinteätarkennusobjektiivi / manuaalinen zoom-
objektiivi

Zoom-toimintoa ei
tueta.

Clear Image Zoom on tuettu.

Moottorizoom-objektiivi
Vain optista zoomia
tuetaan.

Optinen zoomi ja Clear Image Zoom
ovat tuettuja.
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Zoomin säätäminen verkkosovelluksen avulla

Laitteen zoomia voi muuttaa käyttämällä optista zoomia tai Clear Image Zoomia. Tässä osiossa käsitellään säätöjen
tekemistä verkkosovelluksen avulla. Lisätietoja Clear Image Zoomista on osiossa ”Zoomityypin määrittäminen”.

Huomautus

Kameran suunnasta, objektiivin tarkennusajasta ja zoomausasennosta riippuen osa laitteesta tai liitäntäyksikköön liitetyistä
kaapeleista saattaa olla näkyvillä. Tarkista ennen kuvaamista käyttämäsi objektiivin näkökenttä ja tarkennusaika. Voit myös hallita
panorointi-/kallistusaluetta verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit]. Kun laite on päällä tai panorointi/kallistus
nollataan, tämä asteikkorajoitusasetus jätetään huomiotta. Lisätietoja on verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit].

Todellinen zoomausnopeus ja tarkkuus vaihtelevat objektiivin mukaan. Tarkasta toiminto ennen käyttöä.

Vihje

Manuaalisen zoom-objektiivin zoomia voi ohjata tämän laitteen kanssa yhteensopivalla objektiivin ohjaimella (lisävaruste).
Lisätietoja on kohdissa ”Objektiivin ohjaimen liittäminen” ja ”Zoomin säätäminen objektiivin ohjaimella”.

Aiheeseen liittyvää

Zoomityypin määrittäminen

Objektiivin ohjaimen liittäminen

Zoomin säätäminen objektiivin ohjaimella

5-041-958-73(1) Copyright 2022 Sony Corporation

Tuo panoroinnin/kallistuksen hallintapaneeli näkyviin painamalla  (Panorointi/kallistus/zoomaus) -
välilehteä rajauksen hallintapaneelissa.

1

Säädä zoomia liu’uttamalla [Zoom]-liukusäätimen nuppia [T] (telekuva) -suuntaan tai [W] (laajakulma) -
suuntaan.

Zoomausnopeus vaihtelee liukusäätimen liikkuessa.

2
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Zoomauksen käyttönopeuden määrittäminen

Rajauksen hallintapaneelin [Zoom]-liukusäätimen zoomauksen käyttönopeutta voi muuttaa kameran hallintapaneelin
[Zoom Speed] -liukusäätimen avulla.

Huomautus

Todellinen zoomausnopeus ja tarkkuus vaihtelevat objektiivin mukaan. Tarkasta toiminto ennen käyttöä.

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina  (Main) -välilehteä kameran hallintapaneelissa.1

Valitse luettelosta [Zoom Speed].

Jos [Zoom Speed] -liukusäädin ei ole näkyvissä, tuo liukusäädin näkyviin valitsemalla jompikumpi liukusäätimen
valintapainikkeista.

 

2

Siirrä [Zoom Speed] -liukusäätimen nuppia vasemmalle tai oikealle.

Nupin liikuttaminen vasemmalle pienentää käyttönopeutta, kun taas nupin liikuttaminen oikealle suurentaa
käyttönopeutta.

3
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Zoomin säätäminen mukana toimitettavan infrapunakaukosäätimen avulla

Laitteen zoomia voi muuttaa käyttämällä optista zoomia tai Clear Image Zoomia. Tässä osiossa käsitellään säätöjen
tekemistä mukana toimitettavan infrapunakaukosäätimen avulla. Lisätietoja Clear Image Zoomista on osiossa
”Zoomityypin määrittäminen”.

Huomautus

Kameran suunnasta, objektiivin tarkennusajasta ja zoomausasennosta riippuen osa laitteesta tai liitäntäyksikköön liitetyistä
kaapeleista saattaa olla näkyvillä. Tarkista ennen kuvaamista käyttämäsi objektiivin näkökenttä ja tarkennusaika. Voit myös hallita
panorointi-/kallistusaluetta verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit]. Kun laite on päällä tai panorointi/kallistus
nollataan, tämä asteikkorajoitusasetus jätetään huomiotta. Lisätietoja on verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit].

Vihje

Manuaalisen zoom-objektiivin zoomia voi ohjata tämän laitteen kanssa yhteensopivalla objektiivin ohjaimella (lisävaruste).
Lisätietoja on kohdissa ”Objektiivin ohjaimen liittäminen” ja ”Zoomin säätäminen objektiivin ohjaimella”.

Aiheeseen liittyvää

Zoomityypin määrittäminen

Objektiivin ohjaimen liittäminen

Zoomin säätäminen objektiivin ohjaimella

5-041-958-73(1) Copyright 2022 Sony Corporation

Säädä zoomia painamalla zoom-painiketta.

Säädä zoomia painamalla T (telekuva)- tai W (laajakulma) -painiketta samalla, kun tarkkailet näyttöä.
Zoomaa lähemmäs painamalla T-painiketta.
Zoomaa kauemmas painamalla W-painiketta.

1
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E-pidikkeellisen objektiivin kalibrointi

Kalibrointi korjaa zoomausasennon eroja, jotka johtuvat yksittäisten objektiivien eroista, kun käytetään E-pidikkeellistä
moottorizoom-objektiivia.
Jotta zoomausasento voidaan laskea oikein, kalibroi objektiivi yksittäisten erojen korjaamiseksi seuraavien vaiheiden
avulla.

Kalibrointitiedot
Laitteeseen voi tallentaa enintään viiden objektiivin kalibrointitiedot. Vanhimmat tiedot korvataan, kun kuudes tai sitä
useampi objektiivi kalibroidaan.
Voit tarkistaa, ovatko kiinnitetyn objektiivin kalibrointitiedot saatavilla, painamalla  (Kameran tila) -painiketta
verkkosovellusnäytön yleisellä alueella ja valitsemalla [Lens] > [Calibration Data].

5-041-958-73(1) Copyright 2022 Sony Corporation

Jos objektiivissa on SERVO/MANUAL-kytkin, aseta se SERVO-asentoon.

Huomautus

Objektiivi ei voi vastaanottaa zoomausohjeita laitteesta, jos kytkin on MANUAL-asennossa.

1

Suorita kalibrointi kameran valikon kohdassa [Technical] > [Lens] > [Lens Calibration].

Kalibroinnin aikana zoom-objektiivi liikkuu automaattisesti ja mitataan.

2
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Panoroinnin/kallistuksen, zoomausasennon ja tarkennuksen asetusten
tallentaminen/palauttaminen verkkosovelluksen avulla

Panoroinnin/kallistuksen, zoomausasennon ja tarkennuksen asetukset voi tallentaa ja palauttaa tarvittaessa
verkkosovelluksen avulla (esiasetusvalinta).

Lisätietoja kohteista, jotka voi tallentaa/palauttaa, on kohdassa ”Esiasetusvalintojen tallennetut kohteet.”

Huomautus

Esiasetusvalintaa ei voi tallentaa, jos Clear Image Zoom -suhde on suurempi kuin 1×.

Jos verkkovalikon kohdan [Pan-Tilt] > [P/T Direction] > [Ceiling] asetusta muutetaan, kaikki tallennetut esiasetusvalinnat
poistetaan.

Aseta PTZ assist -tilaksi [Pos.] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.1

Määritä asema, jonka haluat tallentaa, panorointi-/kallistus- ja zoomaustoimintojen avulla.2

Paina [+]-painiketta esiasetusvalintojen hallintapaneelissa.

Kuva, jossa on tallennettu asento, näytetään esiasetusvalintojen hallintapaneelissa.

Vihje

Jos esiasetusvalintojen hallintapaneeli ei ole näkyvissä, tuo se näkyviin painamalla  (Avaa) -painiketta.

Asennot tallennetaan järjestyksessä alkaen numerosta [Preset1].

Jos esiasetusjärjestyksessä on käyttämättömiä esiasetuksia, asennot tallennetaan esiasetuksiin käyttämättömistä
esiasetuksista aloittaen. Jos esiasetusvalintoja on tallennettu esimerkiksi kohtiin [Preset1] ja [Preset3], mutta ei kohtaan
[Preset2], seuraava esiasetusvalinta tallennetaan kohtaan [Preset2] ja sitä seuraava kohtaan [Preset4].

3
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Esiasetusvalinnan palautustoiminnon peruuttaminen
Peruuta palautustoiminto sen aikana painamalla esiasetusvalintojen hallintapaneelissa näkyvää  (Peruuta palautus) -
painiketta. Säädä rajausta ohjainsauvalla ja [Zoom]-liukusäätimellä.

Esiasetusvalintoja voidaan tallentaa enintään 100.

Kunkin esiasetusvalinnan voi nimetä uudelleen. Lisätietoja on kohdassa ”Esiasetusvalintojen nimeäminen uudelleen
verkkosovelluksella”.

Palauta tallennettu asento.

Paina kahdesti sen asennon pikkukuvaa, jonka haluat palauttaa, esiasetusvalintojen hallintapaneelissa
palauttaaksesi vastaavan asennon.

Vihje

Voit palauttaa asennon myös painamalla kuvaa, painamalla näkyviin tulevaa  (Esiasetusvalinta-valikko) -painiketta ja
valitsemalla [Recall].

Siirtymisnopeus tallennettuun asentoon määräytyy verkkovalikon asetuksen [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt
Speed for Common] mukaan asennon tallennushetkellä. Siirtymisnopeutta voi myös muuttaa tallentamisen jälkeen.
Lisätietoja on kohdassa ”Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen esiasetusvalintaa
palautettaessa”.

Panorointi-/kallistusasennon muutosastetta esiasetettuun asentoon muutettaessa voi säätää siirtymisnopeus- ja [Ramp
Curve] -asetuksilla. Lisätietoja on kohdissa ”Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen
esiasetusvalintaa palautettaessa” ja ”Panorointi-/kallistustoiminnon kiihdytyksen määrittäminen”.

Jos esiasetuksen toiston aikana palautetaan toinen esiasetus, ensimmäisen palautetun esiasetuksen toiminto pysäytetään
ja uuden palautetun esiasetuksen toiminto alkaa.

Huomautus

Jos ympäristön lämpötila on muuttunut merkittävästi esiasetusvalinnan tallennushetken ja toistohetken välillä, rajauksessa
voi ilmetä poikkeamia.

Esiasetusvalinnan palautuksen aikana ei voida tehdä muita toimintoja, vaan vain esiasetusvalinnan palauttaminen tai
peruuttaminen on mahdollista.

4
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Aiheeseen liittyvää
Esiasetusvalintojen tallennetut kohteet

Esiasetusvalintojen nimeäminen uudelleen verkkosovelluksella

Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen esiasetusvalintaa palautettaessa

Panorointi-/kallistustoiminnon kiihdytyksen määrittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation
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Esiasetusvalintojen nimeäminen uudelleen verkkosovelluksella

Tallennettuja esiasetusvalintoja voi nimetä uudelleen.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta PTZ assist -tilaksi [Pos.] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.1

Paina esiasetusvalintaa, jonka haluat nimetä uudelleen.

 (Esiasetusvalinta-valikko) -painike ilmestyy kuvan oikeaan yläkulmaan.

2

Paina  (Esiasetusvalinta-valikko) -painiketta ja valitse näkyviin tulevasta valikosta [Rename].3

Syötä uusi esiasetuksen nimi.4
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Tallennetun esiasetusvalinnan korvaaminen uudella asennolla verkkosovelluksen
avulla

Tallennetun esiasetusvalinnan voi korvata uudella asennolla.
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Aseta PTZ assist -tilaksi [Pos.] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.1

Määritä asema, jonka haluat tallentaa, panorointi-/kallistus- ja zoomaustoimintojen avulla.2

Paina sen asennon kuvaa, jonka haluat korvata, esiasetusvalintojen hallintapaneelissa.

 (Esiasetusvalinta-valikko) -painike ilmestyy kuvan oikeaan yläkulmaan.

3

Paina  (Esiasetusvalinta-valikko) -painiketta ja valitse näkyviin tulevasta valikosta [Replace].

Uusi asento korvaa aiemmat asetukset.

4
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Tallennetun esiasetusvalinnan poistaminen verkkosovelluksen avulla

Tallennettuja esiasetusvalintoja voi poistaa.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta PTZ assist -tilaksi [Pos.] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.1

Paina sen asennon kuvaa, jonka haluat poistaa, esiasetusvalintojen hallintapaneelissa.

 (Esiasetusvalinta-valikko) -painike ilmestyy kuvan oikeaan yläkulmaan.

2

Paina  (Esiasetusvalinta-valikko) -painiketta ja valitse näkyviin tulevasta valikosta [Delete].

Tallennettu asento poistetaan.

3
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Panorointi-/kallistustoiminnon ja zoomaus-/tarkennustoiminnon synkronointi
esiasetusvalintaa palautettaessa

Panorointi-/kallistustoiminto ja zoomaus-/tarkennustoiminto voidaan synkronoida tallennettua esiasetusvalintaa
palautettaessa, jotta rajaus on sujuvampaa.

Vihje

Voit määrittää esiasetusvalinnan rekisteröinnissä käytettävät asetukset ennalta. Aseta verkkovalikon kohdan [Pan-Tilt] > [P/T
Preset] > [Default] > [Zoom Sync] asetukseksi [On].

Kun kohdan [Pan-Tilt] > [P/T Preset] > [Speed Select] asetuksena on [Common], kaikki esiasetusvalinnat palautetaan kohdassa
[Pan-Tilt] > [P/T Preset] > [Common Speed] asetetulla nopeudella.

Kun zoomausliike on tehty, kamera siirtyy tallennettuun tarkennusasentoon.

Kun liike on tehty, [AF Transition Speed] palaa alkuperäiseen asetukseen.

Aseta PTZ assist -tilaksi [Pos.] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.1

Paina sen esiasetusvalinnan kuvaa, jonka siirtymisnopeutta haluat vaihtaa.

 (Esiasetusvalinta-valikko) -painike ilmestyy kuvan oikeaan yläkulmaan.

2

Paina  (Esiasetusvalinta-valikko) -painiketta ja valitse näkyviin tulevasta valikosta [Edit…].

Valitun esiasetusvalinnan määritysnäyttö tulee näkyviin.

3

Ota toiminto käyttöön liu’uttamalla [Zoom Sync] -kytkin oikealle ja paina [OK]-painiketta.

Seuraavan kerran, kun tallennettu asento palautetaan, kamera liikkuu määritetyllä nopeudella.

4
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Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen
esiasetusvalintaa palautettaessa

Siirtymisnopeutta (panorointi/kallistus, zoomaus, tarkennus) voi muuttaa tallennettua esiasetusvalintaa palautettaessa.

Vihje

Kun kohdan [Pan-Tilt] > [P/T Preset] > [Speed Select] asetuksena on [Common], kaikki asennot palautetaan kohdassa [Pan-Tilt] >
[P/T Preset] > [Common Speed] asetetulla nopeudella.

Kun zoomausliike on tehty, kamera siirtyy tallennettuun tarkennusasentoon.

Kun liike on tehty, [AF Transition Speed] palaa alkuperäiseen asetukseen.

Aseta verkkovalikon kohdan [Pan-Tilt] > [P/T Preset] > [Speed Select] asetukseksi [Separate].1

Aseta PTZ assist -tilaksi [Pos.] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.2

Paina sen esiasetusvalinnan kuvaa, jonka siirtymisnopeutta haluat vaihtaa.

 (Esiasetusvalinta-valikko) -painike ilmestyy kuvan oikeaan yläkulmaan.

3

Paina  (Esiasetusvalinta-valikko) -painiketta ja valitse näkyviin tulevasta valikosta [Edit…].

Valitun esiasetusvalinnan määritysnäyttö tulee näkyviin.

4

Muuta haluamiasi siirtymisnopeuksia (panorointi-kallistus/zoomaus/tarkennus) liukusäätimillä tai antamalla
arvot suoraan ja paina [OK]-painiketta.

Seuraavan kerran, kun tallennettu asento palautetaan, kamera liikkuu määritetyllä nopeudella.

5
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Panorointi-/kallistus- ja zoomausasennon tallentaminen/palauttaminen mukana
toimitettavan infrapunakaukosäätimen avulla

Panorointi-/kallistus- ja zoomausasennon voi tallentaa ja palauttaa tarvittaessa mukana toimitettavan
infrapunakaukosäätimen avulla.

Aiheeseen liittyvää

Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen esiasetusvalintaa palautettaessa

Säädä kameran panorointi/kallistus ja zoomaus.1

Aseta verkkosovelluksessa PTZ assist -tilaksi [Pos.] esiasetusvalintojen hallintapaneelin yläosassa
olevasta pudotusvalikosta.

2

Pidä PRESET-painiketta painettuna ja painama yhtä painikkeista 1–3.

Asento tallennetaan.

3

Palauta tallennettu asento.

Palauta haluamasi esiasetusvalinta painamalla jotakin painikkeista 1–3.

Vihje

Siirtymisnopeus tallennettua esiasetusvalintaa palautetta määräytyy verkkovalikon kohdan [Pan-Tilt] > [P/T Preset] > [Pan-
Tilt Speed] arvon mukaan. Siirtymisnopeutta voi muuttaa arvon tallentamisen jälkeen. Lisätietoja on kohdassa
”Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen esiasetusvalintaa palautettaessa”.

4
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Kameran rajaustoimintojen tallennus verkkosovelluksella

Kameran rajaustoimintoja voi tallentaa verkkosovelluksella.

Säädä kameran toiminnon aloitusasentoa.1

Aseta PTZ assist -tilaksi [Trace] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.2

Paina [+]-painiketta esiasetusvalintojen hallintapaneelissa.

Pikkukuva lisätään, ka kamera siirtyy tallennuksen valmiustilaan.

Vihje

Voit poistua tallennuksen valmiustilasta ja palata normaaliin toimintatilaan painamalla pikkukuvan  (Sulje) -painiketta.

3
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Vihje

Jäljellä oleva tallennusaika näkyy kameran kuvapaneelin yläosassa tallennuksen aikana.

Huomautus

Tallennetut rajaustoiminnot poistetaan, jos siirryt kattokiinnitykseen.

Järjestelmän taajuuden muuttaminen saattaa poistaa rajaustoimintoja.

Zoomaustoimintoa ei tallenneta, kun objektiivin ohjain (lisävaruste) on liitettynä.

Yhden rajaustoiminnon enimmäiskesto on 3 minuuttia. Tallennus päättyy automaattisesti, kun 3 minuutin tallennusaika täyttyy.

Rajaustoiminnon tallennusta ei voida aloittaa, jos Clear Image Zoom -suhde on suurempi kuin 1×.

Jos kameraa käytetään toisesta laitteesta rajaustoiminnon tallennuksen aikana, myös toisesta laitteesta tehdyt toiminnot
tallennetaan. Lisätietoja kolmannen osapuolen kaukosäätimellä tehtyjen toimintojen tallentamisesta saat kyseiseltä valmistajalta.

Tämä toiminto ei tallenna tarkennus ja kuvanlaatuasetuksia.

Panorointi-/kallistus-/zoomaustoimintoja, jotka on tallennettu rajaustoiminnon tallennuksen aikana, ei voida toistaa tarkasti
rajauksen toiston aikana.

Jos asetat panorointi-/kallistusalueen rajoja verkkovalikon kohdassa [Pan-Tilt] > [P/T Range Limit] rajaustoiminnon tallennuksen
jälkeen, panorointi-/kallistusalueen rajaa ei sovelleta rajauksen toiston aikana. Jos haluat käyttää rajaustoimintoa ja
panoroinnin/kallistuksen rajatoimintoa yhdessä, aseta panorointi-/kallistusalueen raja ennen rajaustoiminnon tallentamista.

Tallennettuja rajaustoimintoja ei voida toistaa, kun RAW-videolähtö on valittu.

Aloita rajaus ohjainsauvalla ja [Zoom]-liukusäätimellä.

Tallennus alkaa samalla hetkellä kuin rajaustoiminto.

4

Lopeta tallennus painamalla pikkukuvan  (Pysäytä tallennus) -painiketta.5
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Tallennettuja rajaustoimintoja ei voida toistaa, kun videosignaalia ei lähetetä SDI-lähtöliittimestä.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Kameran rajaustoimintojen toistaminen verkkosovelluksella

Tallennetun kameran rajaustoiminnon voi toistaa verkkosovelluksella.

Aseta PTZ assist -tilaksi [Trace] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.1

Valitse sen rajaustoiminnon pikkukuva, jonka haluat toistaa.

Pikkukuvaan ilmestyy  (Valmistele) -painike.

2

Paina  (Valmistele) -painiketta.

Kamera liikkuu rajaustoiminnon aloitusasentoon ja siirtyy toiston valmiustilaan.

3

Paina pikkukuvan  (Toista) -painiketta.4
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Vihje

Toiston valmiustilassa ja toiston aikana voit peruuttaa toiston ja palata normaaliin toimintatilaan jollakin seuraavista tavoista.

Paina  (Pysäytä) -painiketta pikkukuvassa tai esiasetusvalintojen hallintapaneelissa.
Käytä ohjainsauvaa.
Käytä [Zoom]-liukusäädintä.

Kulunut toistoaika näkyy kameran kuvapaneelin yläosassa toiston aikana.

Huomautus

Toisto voi toimia odottamattomalla tavalla, jos rajaustoimintojen tallennuksen ja toiston Clear Image Zoom -asetukset poikkeavat
toisistaan.

Zoomaustoiminnon toistoa ei tueta, kun objektiivin ohjain on liitettynä. Zoomin käyttö pysäyttää rajaustoimintojen toiston.

Rajaustoiminnon toiston aikana panorointi-/kallistusalueen rajan muuttamisella verkkovalikon kohdassa [Pan-Tilt] > [P/T Range
Limit] ei ole vaikutusta. Aseta panorointi-/kallistusalueen raja ennen rajaustoiminnon tallentamista.

5-041-958-73(1) Copyright 2022 Sony Corporation

Rajauksen toisto alkaa.
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Tallennettujen kameran rajaustoimintojen poistaminen verkkosovelluksella

Tallennettuja kameran rajaustoimintoja voidaan poistaa verkkosovelluksella.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta PTZ assist -tilaksi [Trace] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.1

Valitse sen rajaustoiminnon pikkukuva, jonka haluat poistaa.

Pikkukuvaan ilmestyy  (Seurantavalikko) -painike.

2

Paina  (Seurantavalikko) -painiketta.

Valikko tulee näkyviin.

3

Valitse valikosta [Delete].

Valittu rajaustoiminto poistetaan.

4
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Kameran rajaustoimintojen tallentaminen mukana toimitettavan
infrapunakaukosäätimen avulla

Kameran rajaustoimintoja voi tallentaa mukana toimitettavan infrapunakaukosäätimen avulla.

Lisätietoja tallennetun rajaustoiminnon toistamisesta on kohdassa ”Kameran rajaustoimintojen toistaminen mukana
toimitettavan infrapunakaukosäätimen avulla”.

Huomautus

Yhden rajaustoiminnon enimmäiskesto on 3 minuuttia. Tallennus päättyy automaattisesti, kun 3 minuutin tallennusaika täyttyy.

Jos kameraa käytetään toisesta laitteesta rajaustoiminnon tallennuksen aikana, myös toisesta laitteesta tehdyt toiminnot
tallennetaan rajaustoiminnon osana.

Jos kuvanlaatua säädetään rajaustoiminnon tallennuksen aikana, muutosta ei tallenneta.

Aiheeseen liittyvää

Kameran rajaustoimintojen toistaminen mukana toimitettavan infrapunakaukosäätimen avulla

5-041-958-73(1) Copyright 2022 Sony Corporation

Siirry verkkosovelluksen suoraan käyttönäkymään.1

Aseta PTZ assist -tilaksi [Trace] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.2

Säädä kameran toiminnon aloitusasentoa infrapunakaukosäätimellä.3

Pidä PRESET-painiketta painettuna ja paina yhtä painikkeista POSITION1–3.

Kamera siirtyy tallentamisen valmiustilaan.

4

Suorita rajaustoiminto, jonka haluat tallentaa.5

Lopeta tallennus pitämällä PRESET-painiketta painettuna ja painamalla vaiheessa 4 valitsemaasi POSITION-
painiketta.

6

166



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameran rajaustoimintojen toistaminen mukana toimitettavan
infrapunakaukosäätimen avulla

Tallennetun kameran rajaustoiminnon voi toistaa mukana toimitettavan infrapunakaukosäätimen avulla.

Huomautus

Kameran panoroinnin/kallistuksen/zoomauksen käyttö pysäyttää toiston.

Aiheeseen liittyvää

Kameran rajaustoimintojen tallentaminen mukana toimitettavan infrapunakaukosäätimen avulla

5-041-958-73(1) Copyright 2022 Sony Corporation

Siirry verkkosovelluksen suoraan käyttönäkymään.1

Aseta PTZ assist -tilaksi [Trace] esiasetusvalintojen hallintapaneelin yläosassa olevasta pudotusvalikosta.2

Paina jotakin POSITION1–3-painiketta, jolle on tallennettu rajaustoiminto.

Kameran panorointi/kallistus/zoomaus siirtyy toiston aloitusasentoon.

3

Kun kamera on siirtynyt toiston aloitusasentoon, paina samaa POSITION-painiketta uudelleen.

Toisto alkaa.

4
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Tarkennuksen säätönäyttö

Tarkennusta säädetään seuraavien suoran käyttönäkymän osien avulla.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kameran kuvapaneeli
Tarkennusta voi säätää koskettamalla kameran kuvaa. Kosketustoiminnon voi poistaa käytöstä verkkosovelluksessa
kääntämällä [Touch Focus] -kytkimen pois päältä  (Focus) -välilehdessä kameran hallintapaneelissa.

1.

Kameran hallintapaneeli –  (Focus) -välilehti2.

GUI-hallintapaneeli3.
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Säätäminen käsin verkkosovelluksen avulla

Tarkennusta voi säätää käsin esimerkiksi seuraavissa tapauksissa.

Kohteet, jotka peittyvät osin vesipisaroiden taakse
Kohteet, joilla on pieni kontrasti taustaa vasten
Kohteet, jotka sijaitsevat lähellä olevia kohteita kauempana

Huomautus

Manuaalista tarkennusta ei voi ohjata verkkosovelluksesta zoomauksen ollessa meneillään.

Vihje

Voit käyttää myös automaattitarkennusta, vaikka manuaalinen säätö on pääasiallinen käyttömenetelmä. Lisätietoja on kohdassa
”Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen avulla”.

Aiheeseen liittyvää

Objektiivin kytkinten tarkistaminen

Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen avulla

5-041-958-73(1) Copyright 2022 Sony Corporation

Jos kiinnitettynä on objektiivi, jossa on tarkennuksen valintakytkin, siirrä kytkin joko ”AF/MF”- tai ”AF”-
asentoon.

Huomautus

Jos kytkin on ”Full MF”- tai ”MF”-asennossa, objektiivin tarkennustoimintoa ei voida käyttää laitteesta. Ks. ”Objektiivi, jossa
on tarkennustilakytkin” osiossa ”Objektiivin kytkinten tarkistaminen”.

1

Kytke automaattitarkennus pois päältä liu’uttamalla [Auto Focus] -kytkin vasemmalle kameran
hallintapaneelissa.

Manuaalitarkennustila aktivoituu.

 (MF)

2

Säädä  (Focus) -välilehden alaosassa olevalla liukusäätimellä.3

169



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Säätäminen käsin mukana toimitettavan infrapunakaukosäätimen avulla

Tarkennusta voi säätää käsin mukana toimitettavan infrapunakaukosäätimen avulla.

Vihje

Voit käyttää myös automaattitarkennusta, vaikka manuaalinen säätö on pääasiallinen käyttömenetelmä. Lisätietoja on kohdassa
”Tarkentaminen käsin automaattitarkennuksen aikana mukana toimitettavan infrapunakaukosäätimen avulla”.

Aiheeseen liittyvää

Tarkentaminen käsin automaattitarkennuksen aikana mukana toimitettavan infrapunakaukosäätimen avulla

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina infrapunakaukosäätimen MF-painiketta.1

Säädä tarkennusta käsin F (kauas)- ja N (lähelle) -painikkeilla.

Tarkenna kaukana olevaan kohteeseen painamalla F-painiketta.
Tarkenna lähellä olevaan kohteeseen painamalla N-painiketta.

2

170



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tarkennuksen säätäminen määrittämällä tarkennuskohta (Spot Focus)

Manuaalitarkennustilassa voit määrittää säädettävän tarkennuskohdan kameran kuvapaneelissa.

Huomautus

Spot Focus -toiminto ei toimi, jos objektiivi on asetettu manuaalitarkennukselle.

Vihje

Painamalla pistetarkennustilassa ohjelmoitavaa painiketta, johon [Push AF/MF] on ohjelmoitu, voit pysäyttää pistetarkennuksen
hetkellisesti ja ottaa käyttöön automaattitarkennuksen painikkeen painamisen ajaksi. Kun vapautat painikkeen, tarkennus palaa
manuaalitilaan.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta verkkovalikon tai kameran valikon kohdan [Shooting] > [Focus] > [Touch Function in MF] asetukseksi
[Spot Focus].

1

Ota toiminto käyttöön liu’uttamalla [Touch Focus] -kytkin oikealle  (Focus) -välilehdessä.2

Ota toiminto pois käytöstä liu’uttamalla [Auto Focus] -kytkin vasemmalle  (Focus) -välilehdessä.3

Määritä tarkennuskohta.

Pistetarkennusmerkki tulee näkyviin ja kuvan tarkennus säädetään kyseiseen kohtaan.

Esimerkki kohdan määrittämisestä koskettamalla

4
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Automaattitarkennuksen käyttäminen tilapäisesti (Push Auto Focus (AF))

Manuaalisessa tarkennustilassa voit säätää tarkennusta väliaikaisesti automaattitarkennuksella painamalla [Push AF/MF]
-painiketta, jolloin tarkennus tapahtuu automaattisesti painikkeen ollessa painettuna.
Toiminto on hyödyllinen, kun haluat siirtää tarkennusta hitaasti yhdestä kohteesta toiseen manuaalitarkennuksen aikana.

Huomautus

Push Auto Focus -toiminto ei toimi, jos objektiivi on asetettu manuaalitarkennukselle.

Vihje

Samaa toimintoa tuetaan ohjelmoitavalla painikkeella, johon [Push AF/MF] on ohjelmoitu.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta kameran valikon kohdan [Shooting] > [Focus] > [Push AF Mode] asetukseksi [AF].1

Ota toiminto pois käytöstä liu’uttamalla [Auto Focus] -kytkin vasemmalle  (Focus) -välilehdellä.2

Paina [Push AF/MF]-painiketta.

Automaattitarkennus on aktiivinen painikkeen ollessa painettuna.

Push Auto Focus -toiminto päättyy ja tarkennus palaa manuaalitilaan, kun painike vapautetaan.

3
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Yksittäisen automaattitarkennuksen käyttäminen (Push Auto Focus (AF-S))

Paina manuaalitarkennustilassa [Push AF/MF]-painiketta tarkentaaksesi automaattisesti suurella nopeudella.
Tämä toiminto on käytännöllinen, kun haluat tarkentaa kohteeseen ennen kuvausta.

Huomautus

Push Auto Focus -toiminto ei toimi, jos objektiivi on asetettu manuaalitarkennukselle.

Tarkennusalueen kehystä ei piiloteta, kun käytetään [Display]-painiketta.

Aseta verkkovalikon tai kameran valikon kohdan [Shooting] > [Focus] > [Push AF Mode] asetukseksi
[Single-shot AF(AF-S)].

1

Määritä kohta, jonka tarkennusta haluat säätää, kameran valikon kohdassa [Shooting] > [Focus] > [Focus
Area (AF-S)].

Vihje

Voit vaihtaa kohtaa painamalla ohjelmoitavaa painiketta, johon [Focus Setting] on ohjelmoitu, jolloin tarkennusalueen
ympärille tulee oranssi kehys ja voit valita kohdan koskettamalla.

2

Ota toiminto pois käytöstä liu’uttamalla [Auto Focus] -kytkin vasemmalle  (Focus) -välilehdellä.3

Paina [Push AF/MF]-painiketta.

Jos lopetat painikkeen painamisen ennen kuin tarkennus on valmis, Push Auto Focus -toiminto keskeytyy.

Tarkennuksen ilmaisin osoittaa tarkennuksen tilan Push Auto Focus -toiminnon aikana.
Palaa: tarkennus lukittunut tarkennuskohtaan.
Vilkkuu: ei tarkennusta. Koska laite ei tarkenna automaattisesti, muuta kuvan sommittelua ja tarkennusasetuksia,
jotta tarkentaminen onnistuu.
Kun vapautat painikkeen, tarkennus palaa manuaalitilaan.

4
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[Focus Area (AF-S)] -kehyksen paikkaa ei voi määrittää Clear Image Zoom -toiminnon aikana. Myös tilapäisen
automaattitarkennustoiminnon aikana automaattitarkennus tarkentaa ensisijaisesti keskiosaan.

Vihje

Samaa toimintoa tuetaan ohjelmoitavalla painikkeella, johon [Push AF/MF] on ohjelmoitu.

Voit myös ohjelmoida [Push AF Mode]-toiminnon ohjelmoitavaan painikkeeseen.

Voit myös ohjelmoida [Focus Area (AF-S)]-toiminnon ohjelmoitavaan painikkeeseen.

Voit näyttää/piilottaa tarkennusalueen kehyksen kameran valikon kohdassa [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-
S)].

5-041-958-73(1) Copyright 2022 Sony Corporation
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Säätäminen automaattisesti verkkosovelluksen avulla

Laite käyttää vaiheentunnistukseen perustuvaa automaattitarkennusta nopeaan tarkentamiseen ja kontrastiin perustuvaa
automaattitarkennusta tarkkaan tarkentamiseen.
Näiden kahden automaattitarkennusmenetelmän yhdistelmä mahdollistaa automaattisen tarkennuksen sekä nopeasti
että tarkasti.

Huomautus

Automaattitarkennusta tukeva objektiivi vaaditaan.

Tarkkuutta ei välttämättä saavuteta kuvausolosuhteista riippuen.

Tarkennusta ei voida säätää automaattisesti A-pidikkeellisissä objektiiveissa.

Vihje

Automaattitarkennustilassa voit säätää tarkennusta Focus-liukusäätimellä kameran hallintapaneelissa. Lisätietoja on kohdassa
”Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen avulla”.

Aiheeseen liittyvää

Objektiivin kytkinten tarkistaminen

Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen avulla

5-041-958-73(1) Copyright 2022 Sony Corporation

Jos kiinnitettynä on objektiivi, jossa on tarkennuksen valintakytkin, siirrä kytkin joko ”AF/MF”- tai ”AF”-
asentoon.

Huomautus

Jos kytkin on ”Full MF”- tai ”MF”-asennossa, objektiivin tarkennustoimintoa ei voida käyttää laitteesta. Ks. ”Objektiivi, jossa
on tarkennustilakytkin” osiossa ”Objektiivin kytkinten tarkistaminen”.

1

Kytke toiminto päälle liu’uttamalla [Auto Focus] -kytkin oikealle kameran hallintapaneelissa.

Automaattinen tarkennustila aktivoituu.

 (AF)

2
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Automaattinen säätäminen mukana toimitettavan infrapunakaukosäätimen avulla

Tarkennusta voi säätää automaattisesti mukana toimitettavan infrapunakaukosäätimen avulla.

Huomautus

Voit käyttää myös automaattitarkennusta, vaikka manuaalinen säätö on pääasiallinen käyttömenetelmä. Lisätietoja on kohdassa
”Tarkentaminen käsin automaattitarkennuksen aikana mukana toimitettavan infrapunakaukosäätimen avulla”.

Aiheeseen liittyvää
Tarkentaminen käsin automaattitarkennuksen aikana mukana toimitettavan infrapunakaukosäätimen avulla

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina infrapunakaukosäätimen AF-painiketta.

Kohteen tarkennusta säädetään automaattisesti.

1
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Automaattitarkennusalueen/-kohdan määrittäminen (Focus Area)

Voit määrittää tavoitealueen automaattitarkennukselle ja säätää kyseisen alueen tarkennusta.

Avaa kameran valikko painamalla GUI-hallintapaneelin [Menu]-painiketta.1

Määritä automaattitarkennuksen kohdealue kameran valikon kohdassa [Shooting] > [Focus] > [Focus Area].

[Wide]:
Hakee kohdetta tarkennettaessa kuvan laajakulmasta. Kehystä ei näy.

[Zone]:
Hakee automaattisesti tarkennuskohdan määritetyltä alueelta.
Kun valinta on tehty, määritä asema käyttämällä GUI-hallintapaneelin nuolipainikkeita.

Voit palauttaa tarkennuksen keskikohtaan painamalla [Set]-painiketta pitkään.
[Flexible Spot]:
Tarkentaa kuvan tiettyyn kohtaan.
Kun valinta on tehty, määritä asema käyttämällä GUI-hallintapaneelin nuolipainikkeita.

2
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Huomautus

Tarkennusalueen kehystä ei piiloteta, kun käytetään [Display]-painiketta kameran kuvapaneelissa.

Clear Image Zoom -toiminnon aikana tarkennusalueeksi määritetään [Wide] (kiinteä).

Vihje

Voit näyttää/piilottaa tarkennusalueen kehyksen kameran valikon kohdassa [Monitoring] > [Display On/Off] > [Focus Area
Indicator].

5-041-958-73(1) Copyright 2022 Sony Corporation

Voit palauttaa tarkennuksen keskikohtaan painamalla [Set]-painiketta pitkään.
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Tarkennusalueen vaihtaminen nopeasti (Focus Setting)

Voit vaihtaa automaattitarkennusalueen sijaintia ja kokoa nopeasti kuvaamisen aikana ohjelmoimalla [Focus Setting] -
toiminnon ohjelmoitavaan painikkeeseen.

Lisätietoja ohjelmoitavista painikkeista on kohdassa ”Ohjelmoitavat painikkeet”.

Toiminta vaihtelee tarkennusalueasetuksesta riippuen.

Kun kameran valikon kohdan [Shooting] > [Focus] > [Focus Area] asetuksena on [Flexible
Spot] tai [Zone]

Voit vaihtaa tarkennusalueen sijaintia painamalla ohjelmoitavaa painiketta, johon [Focus Setting] on ohjelmoitu, ja
säätämällä GUI-hallintapaneelin nuolipainikkeilla. Voit palauttaa tarkennusalueen keskikohtaan, kun säädät kohtaa,
painamalla [Set]-painiketta.
Voit muuttaa tarkennusalueen kokoa painamalla pitkään ohjelmoitavaa painiketta, johon [Focus Setting] on
ohjelmoitu. Koon muuttamisen jälkeen voit muuttaa tarkennusalueen sijaintia painamalla [Set]-painiketta. Kun olet
valmis, palaa alkuperäiseen näyttöön painamalla ohjelmoitavaa painiketta, johon [Focus Setting] on ohjelmoitu.

Kun kameran valikon kohdan [Shooting] > [Focus] > [Focus Area] asetuksena on [Wide]

Voit muuttaa vain tarkennusalueen kokoa painamalla pitkään ohjelmoitavaa painiketta, johon [Focus Setting] on
ohjelmoitu. Myös sijaintia voidaan muuttaa vaihtamalla tyypiksi ensin [Flexible Spot] tai [Zone].

Vihje

Kun kameran valikon kohdan [Shooting] > [Focus] > [Push AF Mode] asetuksena on [Single-shot AF(AF-S)] ja [Auto Focus] -
kytkin on asetettu Off-asentoon (manuaalinen tarkennustila), voit muuttaa [Focus Area (AF-S)] -tarkennusalueen sijaintia.

Tarkennusalueen kehys näkyy oranssina, kun tarkennusalueen sijaintia voidaan muuttaa.

Aiheeseen liittyvää
Ohjelmoitavat painikkeet

5-041-958-73(1) Copyright 2022 Sony Corporation
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Tarkennusalueen kehyksen siirtäminen kosketustoiminnoilla (kosketustarkennusalue)

Voit vaihtaa kosketusalueen sijaintia painamalla ohjelmoitavaa painiketta, johon [Focus Setting] ohjelmoitu, jotta
tarkennusalueen näyttö muuttuu oranssiksi, ja siirtää tarkennusalueen kehystä kameran kuvapaneelin
kosketustoiminnoilla.
Napauta näyttöä, niin tarkennusalueen keskikohta siirtyy napautuskohtaan. Vedä tarkennusalue sormella haluamaasi
kohtaan näytöllä.

Vihje

Voit ottaa kuvausnäytön kosketusalueen käyttöön tai poistaa sen käytöstä käyttämällä ohjelmoitavaa painiketta, johon [Focus
Setting] on ohjelmoitu.

Napauta mitä tahansa kohtaa.

Tarkennusalue keskitetään napautettuun kohtaan.

1

Siirrä tarkennusaluetta vetämällä, se seuraa sormeasi.2
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Huomautus

Jos napautat näyttöä tai vedät tarkennusalueen kohtaan, joka on asetusalueen ulkopuolella, tarkennusalueeksi määrittyy
asetusalueen ylä-/ala-/oikea/vasen reuna.

Toiminto ei ole saatavilla seuraavissa olosuhteissa.

Kun [Touch Focus] -kytkin on pois päältä kameran hallintapaneelissa
Kun tarkennusalueen kehys näkyy harmaana tai sitä ei näy lainkaan

5-041-958-73(1) Copyright 2022 Sony Corporation
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Automaattitarkennustoimintojen säätäminen (AF-siirtymisnopeus, AF-
kohteenvaihtumisherkkyys)

Automaattitarkennustoimintoja voi säätää muuttamalla siirtymisnopeutta ja kohteenvaihtumisherkkyyttä.

Automaattitarkennuksen siirtymisnopeuden määrittäminen

Voit määrittää tarkennusnopeuden tilanteisiin, joissa kohde vaihtuu, käyttämällä kameran hallintapaneelin [AF Transition
Speed] -painiketta.

Valitse nopeus välillä [Speed 1] (hidas) – [Speed 7] (nopea) 1 askeleen välein. Pienennä arvoa (hidasta) painamalla <-
painiketta tai suurenna arvoa (nopeuta) painamalla >-painiketta.
Kun asetus on määritetty pienelle nopeudelle, tarkennus siirtyy hitaasti, kun tarkennettava kohde vaihtuu, mikä
mahdollistaa vaikuttavan kuvailmaisun kuvattaessa.
Kun se on määritetty suurelle nopeudelle, tarkennus kohteiden välillä vaihtuu nopeasti. Alla olevassa esimerkissä
tarkennus siirtyy nopeasti taustalla olevasta rakennuksesta etualalla kävelevään henkilöön. Kamera tarkentaa
välittömästi kehykseen saapuvaan kohteeseen, joten tämä asetus sopii erinomaisesti nopeaa tarkennusta edellyttävään
dokumentaariseen kuvaukseen.

Automaattitarkennuksen kohteenvaihtumisherkkyys

Voit määrittää kohteenvaihtumisherkkyyden käyttämällä [AF Subj. Shift Sens.]-painiketta kameran hallintapaneelissa.
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Valitse herkkyys välillä [Sens 1] (lukittu) – [Sens 5] (muuttuva) 1 askeleen välein. Pienennä arvoa (muuta hitaasti)
painamalla <-painiketta tai suurenna arvoa (muuta nopeasti) painamalla >-painiketta.
Kun asetus on määritetty matalalle herkkyydelle, tarkennus ei siirry herkästi, vaikka toinen kohde saapuu tarkennettavan
kohteen eteen.

Kun se on määritetty korkealle herkkyydelle, tarkennus siirtyy etualalle saapuvaan kohteeseen.

Vihje

Jos [AF Speed/Sens.] on ohjelmoitu ohjelmoitavaan painikkeeseen, arvojen säätöpalkit tulevat näkyviin kameran kuvapaneeliin
seuraavassa järjestyksessä aina kun painiketta painetaan, jotta voit muuttaa automaattitarkennuksen siirtymisnopeuden ja
automaattitarkennuksen kohteenvaihtumisherkkyyden asetuksia.
Automaattitarkennuksen siirtymisnopeus → Automaattitarkennuksen kohteenvaihtumisherkkyys → Ei näyttöä…

5-041-958-73(1) Copyright 2022 Sony Corporation
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Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen
avulla

Kun tarkennusta on siirretty ja säädetty käsin, voit asettaa tarkennuksen hallinnan automaattiseksi tarkennuksen
hienosäätöä varten.

Huomautus

Automaattitarkennuksen avustustilassa tarkennuksen siirtäminen on hankalampaa riippumatta kameran valikon kohdan
[Shooting] > [Focus] > [AF Subj. Shift Sens.] asetuksesta.

Automaattitarkennuksen avustustila peruutetaan seuraavasti.

Kun [Focus]-liukusäätimellä tarkennettu kohde ei ole enää näkyvissä
Kun siirrytään manuaalitarkennukseen
Kun reaaliaikaisen seurannan AF aloitetaan

Vihje

Automaattitarkennuksen avustustila voidaan peruuttaa nopeasti ohjelmoitavalla painikkeella, johon [Push AF/MF] on ohjelmoitu.

Aseta kameran valikon kohdan [Shooting] > [Focus] > [AF Assist] asetukseksi [On].1

Aseta verkkovalikon kohdan [Shooting] > [Focus] > [AF Assist Control] asetukseksi [On].2

Kytke toiminto päälle liu’uttamalla [Auto Focus] -kytkin oikealle kameran hallintapaneelissa.

Automaattinen tarkennustila aktivoituu.

3

Aseta tarkennuksen kohde [Focus]-liukusäätimellä kameran hallintapaneelissa.

[Near]: Tarkenna lähellä olevaan kohteeseen.
[Far]: Tarkenna kaukana olevaan kohteeseen.

Automaattitarkennuksen avustustilassa kohteeseen, joka on [Focus]-liukusäätimellä määritetyn etäisyyden päässä,
tarkennetaan automaattisesti.

4
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Reaaliaikaisen seurannan AF päättyy, kun [Focus]-liukusäädintä käytetään.

Face/Eye Only AF -tilassa automaattitarkennus tarkentaa [Focus]-liukusäätimen tarkennuskohtaa lähimpänä oleviin kasvoihin.

5-041-958-73(1) Copyright 2022 Sony Corporation

185



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tarkentaminen käsin automaattitarkennuksen aikana mukana toimitettavan
infrapunakaukosäätimen avulla

Kun kameran valikon kohdan [Shooting] > [Focus] > [AF Assist] asetuksena on [On], voit säätää tarkennusta kohteeseen
myös automaattitarkennuksen aikana käyttämällä mukana toimitettavan infrapunakaukosäätimen F (kauas) -painiketta ja
N (lähelle) -painiketta.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Manuaalitarkennuksen käyttäminen tilapäisesti automaattitarkennuksen aikana (Push
Manual Focus)

Paina automaattitarkennustilassa [Push AF/MF] -painiketta tarkentaaksesi käsin, kun painike on painettuna. Kun
vapautat painikkeen, tarkennus palaa automaattitilaan.
Näin voit tilapäisesti pysäyttää automaattitarkennuksen ja tarkentaa käsin, kun jokin kulkee kuvauskohteen edestä.

Vihje

Samaa toimintoa tuetaan ohjelmoitavalla painikkeella, johon [Push AF/MF] on ohjelmoitu.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Tarkentaminen käyttämällä kasvojen-/silmientunnistusta (Face/Eye Detection AF)

Laite voi tunnistaa ihmisten kasvot ja silmät seurattavaksi kohteeksi ja säätää sitten tarkennuksen tarkennusalueella
oleviin kasvoihin tai silmiin.
Kun järjestelmä tunnistaa kasvot, näkyviin tulevat harmaat kasvojen-/silmientunnistuksen kehykset. Kun automaattinen
tarkentaminen on mahdollista, kehykset muuttuvat valkoisiksi ja seuranta alkaa. Kun järjestelmä tunnistaa silmät ja
tarkennus on säätynyt, kasvojen-/silmientunnistuksen kehykset näkyvät silmien kohdassa. Kun järjestelmä havaitsee
useita henkilöitä, pääasiallinen kohde määrittyy automaattisesti.
Toiminto on saatavilla vain tarkennuksen ollessa AF-tilassa tai tilapäisen automaattitarkennuksen aikana.

Vihje

Kun tarkennusalueeksi on asetettu [Zone] tai [Flexible Spot] ja kasvot tai silmät osuvat määritetylle tarkennusalueelle,
kasvojen-/silmientunnistuksen kehykset muuttuvat valkoisiksi ja laite tarkentaa kyseisiin kasvoihin/silmiin automaattisesti.

Kun käytetään tilapäistä automaattitarkennusta (AF-S), tarkennettaviin kasvoihin/silmiin kohdistuvat
kasvojen-/silmientunnistuksen kehykset muuttuvat vihreiksi.

Määrittäminen käyttämällä [Face/Eye Detection AF] -painiketta kameran hallintapaneelissa

Paina [Face/Eye Detection AF] -painiketta ja määritä kasvojen-/silmientunnistuksen automaattitarkennus.

[Face/Eye Only AF]: Kamera tunnistaa kohteiden (ihmisten) kasvot/silmät ja seuraa vain niitä / tarkentaa vain niihin. Kun
järjestelmä ei havaitse kasvoja tai silmiä, automaattitarkennus keskeytyy väliaikaisesti ja näkyviin tulee  (Face/Eye
Only AF -tilan automaattitarkennus keskeytetty) -kuvake. Tämä tila on kätevä, kun haluat tarkentaa automaattisesti vain
kasvoihin/silmiin ja seurata niitä.
[Face/Eye Priority AF]: Kamera tunnistaa kohteiden (ihmisten) kasvot/silmät ja priorisoi kasvojen/silmien
tarkennuksen/seurannan. Kun järjestelmä ei havaitse kasvoja/silmiä, tarkennus on AF-tilassa (oletusasetus).
[AF]: Kasvojen-/silmientunnistuksen automaattitarkennus on poissa käytöstä.

Huomautus

Tilapäisen automaattitarkennuksen aikana [Face/Eye Priority AF] -asetus on aktiivisena, vaikka valittuna olisi parhaillaan
[Face/Eye Only AF] -asetus.

Kun [Auto Focus] -kytkin on Off-asennossa, kasvojen-/silmientunnistuksen automaattitarkennus on poissa käytöstä (paitsi
tilapäisen automaattitarkennustoiminnon aikana).
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Jos sammutat videokameran, kun valittuna on [Face/Eye Only AF] -asetus, tilaksi vaihtuu automaattisesti [Face/Eye Priority AF],
kun videokamera seuraavan kerran kytketään päälle.

Vihje

Voit määrittää kasvojen-/silmientunnistuksen automaattitarkennustoiminnon kameran valikon kohdassa [Shooting] > [Focus] >
[Face/Eye Detection AF].

Kasvojen-/silmientunnistuksen kehysten piilottaminen
Voit näyttää/piilottaa kasvojen-/silmientunnistuksen kehykset kameran valikon kohdassa [Monitoring] > [Display On/Off] >
[Face/Eye Detection Frame].

Huomautus

Vihreät kasvojen-/silmientunnistuksen kehykset näkyvät tilapäisen automaattitarkennuksen (AF-S) tarkentamille kasvoille ja
silmille eikä niitä piiloteta [Display]-painikkeella tai kun [Face/Eye Detection Frame] -asetuksena on [Off].

Kasvojen-/silmientunnistuksen automaattitarkennuksen vaihtaminen ohjelmoitavalla painikkeella
Ohjelmoi [Face/Eye Detection AF] ohjelmoitavaan painikkeeseen. Voit tämän jälkeen vaihtaa
kasvojen-/silmientunnistuksen automaattitarkennuksen asetukseksi [Face/Eye Priority AF], [Face/Eye Only AF] tai [AF]
jokaisella painikkeen painalluksella tässä järjestyksessä.

Asettaminen käyttämällä suoravalikkoa

Voit määrittää kasvojen-/silmientunnistuksen automaattitarkennuksen myös suoravalikon kautta.

Lisätietoja suoravalikosta on kohdassa ”Suoravalikon toiminnot”.

Aiheeseen liittyvää

Suoravalikon toiminnot

5-041-958-73(1) Copyright 2022 Sony Corporation
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Määritetyn kohteen seuraaminen (Realtime Tracking AF)

Voit pitää tarkennuksen kohteessa määrittämällä kohteen koskettamalla tai valitsemalla kasvojentunnistuskehyksen
kameran hallintapaneelissa.
Kun kohde on valittu, näkyviin tulee valkoinen seurantakehys ja seuranta alkaa.

Vihje

Kohdetta seurataan koko kuva-alalla tarkennusalueasetuksesta riippumatta.

Kun verkkovalikon tai kameran valikon kohdan [Shooting] > [Focus] > [Touch Function in MF] asetuksena on [Tracking AF],
reaaliaikaisen seurannan AF:ää tuetaan myös tarkennuksen ollessa MF-tilassa.

Seurantakohdetta käsitellään seuraavasti kasvojen ja kasvojen-/silmientunnistuksen automaattitarkennustilan asetusten
mukaan.

[Face/Eye Only AF] tai [Face/Eye Priority AF]: Määritetyn kohteen tarkennus ja seuranta.
Jos seurantakohde on ihminen ja kamera tunnistaa kasvot/silmät, kamera tarkentaa niihin.
Kun seurantakasvot/-silmät tunnistetaan, seurantakasvot tallennetaan. Kun kasvot on tallennettu,  (tallennettujen
seurantakasvojen kuvake) tulee näkyviin.

Huomautus

Jos seuranta-AF aloitetaan manuaalisen tarkennuksen aikana, tarkennuskasvoja ei tallenneta.

[AF]: Määritetyn kohteen tarkennus ja seuranta. Kasvoja/silmiä ei tunnisteta vaikka seurantakohde olisi ihminen.

Huomautus

Realtime Tracking AF -toiminto ei toimi, jos objektiivi on asetettu manuaalitarkennukselle.

Reaaliaikaisen seurannan AF:n aloittaminen

Kun tietty kohde määritetään seurantakohteeksi, sen seuraaminen alkaa.

Määrittäminen koskettamalla
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Ota toiminto käyttöön liu’uttamalla [Touch Focus] -kytkin oikealle kameran hallintapaneelin  (Focus) -välilehdessä ja
napauta seurattavaa kohdetta seurataksesi sitä jossakin seuraavista tiloista.

Manuaalitarkennustilassa tai tilapäisessä manuaalitarkennustilassa ja kun verkkovalikon tai kameran valikon kohdan
[Shooting] > [Focus] > [Touch Function in MF] asetuksena on [Tracking AF]
Automaattitarkennustilassa tai tilapäisessä automaattitarkennustilassa (AF)

Määrittäminen kasvojentunnistuskehyksen valinnalla
Siirrä kasvojenvalintakohdistin (oranssi alleviivaus) seurattavaan kohteeseen GUI-hallintapaneelin nuolinäppäimillä ja
paina [Set]-painiketta.

A: Kasvojentunnistuksen kehykset (harmaa)
B: Seurantakehys
C: Kasvojenvalintakohdistin (oranssi)

Huomautus

Manuaalisen tarkennuksen aikana seurantaa ei voi aloittaa kasvojentunnistuskehyksen valinnalla.

Vihje

Seurattavaa kohdetta voi myös vaihtaa reaaliaikaisen seurannan AF -tilassa.

Reaaliaikaisen seurannan AF:n pysäyttäminen

Paina  (reaaliaikaisen seurannan AF:n pysäytys) -painiketta.

Vihje

Reaaliaikaisen seurannan AF pysähtyy seuraavissa tapauksissa:

Kun objektiivin [Auto Focus]-kytkintä tai AUTO/MANUAL-säädintä käytetään
Kun tarkennustilaa vaihdetaan
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Kun käytetään automaattitarkennuksen avustustoimintoa
Kun tarkennusalueasetusta tai kasvojen/silmientunnistuksen automaattitarkennustoimintoa vaihdetaan
Kun painetaan ohjelmoitavaa painiketta, johon [Push AF/MF] on ohjelmoitu
Kun seurantakohde ei ole kuvausnäytössä tai kohde ei ole tarkennettuna muutamaan sekuntiin

Kun tarkennuskasvot tallennetaan (kun  (tallennettujen seurantakasvojen kuvake) näkyy), reaaliaikaisen seurannan AF jatkuu,
kun tallennetut seurantakasvot tulevat kuva-alueelle. Jos haluat tyhjentää seurantakasvot, pysäytä reaaliaikaisen seurannan AF
edellä kuvatulla tavalla.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Kirkkauden säätönäyttö

Voit säätää kirkkautta säätämällä himmennintä, herkkyysvahvistusta ja suljinaikaa sekä ND-suodattimilla valon määrää
seuraavissa verkkosovelluksen suoran käyttönäkymän hallintapaneeleissa. Kirkkautta voi myös säätää automaattisesti.

Huomautus

Herkkyysvahvistusta ei voi säätää, kun kohdan [Shooting Mode] asetuksena on [Cine EI Quick] tai [Cine EI]. Kirkkautta ei voida
säätää automaattisesti myöskään suljinajan avulla, kun asetuksena on [Cine EI Quick] tai [Cine EI]. Kirkkauden automaattista
säätämistä himmentimellä ja ND-suodattimella tuetaan.

Vihje

Cine EI on tila, jossa kuvaaminen tapahtuu perusherkkyydellä ilman herkkyysvahvistusta, jotta kuvakennon toiminta on paras
mahdollinen. Kirkkautta säädetään valaistuksen ja ND-suodattimen avulla, joilla säädellään kuvakennoon ulottuvan valon

Kameran hallintapaneeli –  (Main) -välilehti1.

Kameran perusmäärityspaneeli
Näyttää painikkeilla kuvaamiseen tarvittavien perustoimintojen asetustilan. Painamalla painiketta saat näkyviin
vastaavat määritysnäytöt kullekin toiminnolle alla olevassa kameran perusmääritysten säätöpaneelissa.

2.

Kameran perusmääritysten säätöpaneeli
Näyttää kameran perusmäärityspaneelissa valitun asetuskohteen säätöpaneelin.

3.
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määrää. Lisätietoja Exposure Index (EI) -toiminnosta on kohdassa ”Tummien ja kirkkaiden alueiden jakauman muuttaminen
tallennetussa kuvassa”.

Aiheeseen liittyvää

Tummien ja kirkkaiden alueiden jakauman muuttaminen tallennetussa kuvassa

5-041-958-73(1) Copyright 2022 Sony Corporation
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Perusherkkyyden määrittäminen

Voit määrittää perusherkkyyden ennen kirkkauden säätämistä.

Kun kohdan [Shooting Mode] asetuksena on [Custom]

Paina [ISO/Gain] -painiketta kameran perusmäärityspaneelissa ja aseta ISO/herkkyysvahvistuksen säätöpaneelin
kohdan [Base Sensitivity] asetukseksi [High] tai [Low].
Valitse normaalissa valaistuksessa asetus [Low] ja vähäisessä valaistuksessa asetus [High].
Näyttö, kun [AGC] ei ole käytössä

Näyttö, kun [AGC] on käytössä

Kun kohdan [Shooting Mode] asetuksena on [Flexible ISO] tai [Cine EI]

Paina [Base ISO/Exposure Index] -painiketta kameran perusmäärityspaneelissa ja aseta Base ISO/Exposure Index -
säätöpaneelin kohdan [Base ISO] -asetukseksi [ISO 12800] tai [ISO 800].
Valitse normaalissa valaistuksessa asetus [ISO 800] ja vähäisessä valaistuksessa asetus [ISO 12800].

Vihje
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Voit määrittää asetuksen myös  (Main) -välilehdessä kameran hallintapaneelissa.

Asetuksen voi määrittää myös kameran valikon kohdassa [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] tai [Base ISO].

Voit myös ohjelmoida [Base ISO/Sensitivity]-toiminnon ohjelmoitavaan painikkeeseen.

[Cine EI Quick] -kuvaustilassa perusherkkyys asetetaan automaattisesti valotusindeksin asetuksen mukaan.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Automaattisen kirkkaussäädön tavoitetason määrittäminen

Automaattisen kirkkaussäädön tavoitetaso määritetään kameran hallintapaneelin [AE Level]-liukusäätimellä.

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina  (Main) -välilehteä kameran hallintapaneelissa.

Jos [AE Level] -liukusäädin ei ole näkyvissä, tuo liukusäädin näkyviin valitsemalla jompikumpi liukusäätimen
valintapainikkeista ja valitsemalla [AE Level] -liukusäädin listalta.

[AE Level] -liukusäädin tulee näkyviin.

1

Aseta tavoitetaso liukusäätimellä.

Tummenna kuvaa siirtämällä liukusäätimen nuppia vasemmalle. Kirkasta kuvaa siirtämällä liukusäätimen nuppia
oikealle.

Vihje

Asetuksen voi määrittää myös kameran valikon kohdassa [Shooting] > [Auto Exposure] > [Level].

2
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Himmentimen säätäminen automaattisesti

Kirkkautta voi säätää automaattisesti kohteen mukaan. Yhteensopiva objektiivi tarvitaan.

Huomautus

Himmennintä ei voida säätää automaattisesti A-pidikkeellisissä objektiiveissa.

Vihje

Voit myös ohjelmoida [Auto Iris]-toiminnon ohjelmoitavaan painikkeeseen.

5-041-958-73(1) Copyright 2022 Sony Corporation

Jos kameraan kiinnitetään Auto Iris -kytkimellä varustettu objektiivi, siirrä kytkin AUTO-asentoon.1

Paina [Iris]-painiketta kameran perusmäärityspaneelissa.

[Iris]-painikkeen kehys muuttuu oranssiksi.

Iris-säätöpaneeli tulee näkyviin.

2

Kytke toiminto päälle liu’uttamalla [Auto]-kytkin oikealle.

Himmennin siirtyy automaattisen säädön tilaan. Automaattisesti säädetty himmentimen arvo näkyy kytkimen
oikealla puolella.

3
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Himmentimen säätäminen käsin

Kirkkautta voi säätää käsin.

Himmentimen väliaikainen säätäminen automaattisesti
Voit painaa Iris-säätöpaneelin [Push Auto] -painiketta säätääksesi himmennintä automaattisesti, kun painike on
painettuna.

Jos kameraan kiinnitetään Auto Iris -kytkimellä varustettu objektiivi, siirrä kytkin AUTO-asentoon.

Huomautus

Kun objektiivin Auto Iris -kytkin on MANUAL-asennossa, laitteen [Auto Iris]- ja [Push Auto Iris] -toiminnoilla ei ole vaikutusta.
Myöskään laitteen manuaalisilla himmenninsäädöillä ei ole vaikutusta.

1

Paina [Iris]-painiketta kameran perusmäärityspaneelissa.

[Iris]-painikkeen kehys muuttuu oranssiksi.

Iris-säätöpaneeli tulee näkyviin.

2

Kytke toiminto pois päältä liu’uttamalla [Auto]-kytkin vasemmalle.

Himmennin siirtyy manuaalisen säädön tilaan.

3

Säädä himmennintä [Iris]-liukusäätimellä tai [Iris]-säätöpainikkeilla.

Vihje

Liukusäätimen ja säätöpainikkeen asetukset on linkitetty.

Voit ohjelmoida himmentimen liukusäätimeen myös  (Main) -välilehdessä kameran hallintapaneelissa.

4
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Vihje

Paina ohjelmoitavaa painiketta, johon [Push Auto Iris] -toiminto on ohjelmoitu, säätääksesi himmennintä automaattisesti, kun
painike on painettuna.
Kun vapautat painikkeen, himmennin palaa manuaaliseen tilaan.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Herkkyysvahvistuksen säätäminen automaattisesti

Voit säätää kirkkautta automaattisesti herkkyysvahvistusasetuksen avulla, kun kohdan [Shooting Mode] asetuksena on
[Custom] tai [Flexible ISO].

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta verkkovalikon tai kameran valikon kohdan [Project] > [Shooting Mode] asetukseksi [Custom].1

Paina [ISO/Gain]-painiketta kameran perusmäärityspaneelissa.

[ISO/Gain]-painikkeen kehys muuttuu oranssiksi.

ISO/Gain-säätöpaneeli tulee näkyviin.

2

Kytke toiminto päälle liu’uttamalla [AGC]-kytkin oikealle.

Herkkyysvahvistus siirtyy automaattisen säädön tilaan. Automaattisesti säädetty herkkyysvahvistuksen arvo näkyy
kytkimen oikealla puolella.

Vihje

Voit suorittaa saman toimenpiteen myös kameran valikossa asettamalla kohdan [Shooting] > [Auto Exposure] > [AGC]
asetukseksi [On].

Voit myös ohjelmoida [AGC]-toiminnon ohjelmoitavaan painikkeeseen.

3
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Herkkyysvahvistuksen säätäminen käsin

Voit säätää kirkkautta käsin herkkyysvahvistusasetuksen avulla, kun kohdan [Shooting Mode] asetuksena on [Custom]
tai [Flexible ISO].
Voit hallita herkkyysvahvistusta, kun haluat säätää valotusta himmenninasetuksen ollessa lukittu tai kun haluat estää
herkkyysvahvistuksen suurenemista AGC-toiminnon vuoksi.

Herkkyysvahvistuksen väliaikainen säätäminen käsin
Voit myös säätää herkkyysvahvistusta väliaikaisesti ohjelmoimalla [ISO/Gain]-toiminnon liukusäätimen
valintapainikkeeseen  (Main) -välilehdessä kameran hallintapaneelissa ja käyttämällä liukusäädintä.
Tämä on hyödyllinen, kun haluat säätää valotusta vähän kerrallaan muuttamatta terävyysaluetta.
Säädön tulos palautuu esiasetettuun arvoon, joka on määritetty kohdassa [ISO/Gain<L>], kun jokin seuraavista
toimenpiteistä suoritetaan.

Aseta verkkovalikon tai kameran valikon kohdan [Project] > [Shooting Mode] asetukseksi [Custom].1

Paina [ISO/Gain]-painiketta kameran perusmäärityspaneelissa.

[ISO/Gain]-painikkeen kehys muuttuu oranssiksi.

ISO/Gain-säätöpaneeli tulee näkyviin.

2

Kytke toiminto pois päältä liu’uttamalla [AGC]-kytkin vasemmalle.

Herkkyysvahvistus siirtyy manuaalisen säädön tilaan.

3

Säädä herkkyysvahvistusta [ISO/Gain]-liukusäätimellä tai [ISO/Gain]-säätöpainikkeilla.

Vihje

Liukusäätimen ja säätöpainikkeen asetukset on linkitetty.

4
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ISO/Gain-säätökohteiden muuttaminen
Perusherkkyyden vaihtaminen
AGC-kytkimen siirtäminen On-asentoon
Laitteen virransyötön kytkeminen virransäästötilaan

Herkkyysvahvistuksen väliaikainen säätäminen automaattisesti ohjelmoidulla painikkeella
Paina ohjelmoitavaa painiketta, johon [Push AGC] -toiminto on ohjelmoitu, säätääksesi herkkyysvahvistusta
automaattisesti, kun painike on painettuna.
Kun vapautat painikkeen, herkkyysvahvistus palaa manuaalitilaan.
Säädön tulos palautuu esiasetettuun arvoon, joka on määritetty kohdassa [ISO/Gain<L>], kun jokin seuraavista
toimenpiteistä suoritetaan.

ISO/Gain-säätökohteiden muuttaminen
Perusherkkyyden vaihtaminen
AGC-kytkimen siirtäminen On-asentoon
Laitteen virransyötön kytkeminen virransäästötilaan

Huomautus

Tätä toimintoa ei voi suorittaa, kun kameran valikon kohdan [Shooting] > [Iris] > [Bokeh Control] asetuksena on [On].

5-041-958-73(1) Copyright 2022 Sony Corporation
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Sulkimen säätäminen automaattisesti

Voit säätää suljinta automaattisesti kuvan kirkkauden perusteella.

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina [Shutter]-painiketta kameran perusmäärityspaneelissa.

[Shutter]-painikkeen kehys muuttuu oranssiksi.

Shutter-säätöpaneeli tulee näkyviin.

1

Paina [Shutter Type] -painiketta ja valitse listalta [Auto].

Vihje

Voit suorittaa saman toimenpiteen myös kameran valikossa asettamalla kohdan [Shooting] > [Auto Exposure] > [Auto
Shutter] asetukseksi [On].

Voit myös ohjelmoida [Auto Shutter]-toiminnon ohjelmoitavaan painikkeeseen.

2
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Sulkimen säätäminen käsin

Suljinta voi säätää käsin.

Paina [Shutter]-painiketta kameran perusmäärityspaneelissa.

[Shutter]-painikkeen kehys muuttuu oranssiksi.

Shutter-säätöpaneeli tulee näkyviin.

1

Paina [Shutter Type] -painiketta ja valitse listalta [Speed].2

Säädä suljinta [Speed]-liukusäätimellä tai [Speed]-säätöpainikkeilla.

Säädä valotusaika vastaamaan kuvaväliä valitsemalla vaiheessa 2 asetukseksi [Off]. Voit myös määrittää kiinteän
arvon valitsemalla [ECS] (taajuus) tai säätää sitä automaattisesti valitsemalla [Auto].
Esimerkki: asetus valitsemalla [ECS] (taajuus)

Vihje

Liukusäätimen ja säätöpainikkeen asetukset on linkitetty.

Käytä kohtaa [Angle] kohdan [Speed] tai [Off] sijasta asettamalla kameran valikon kohdan [Shooting] > [Shutter] > [Mode]
asetukseksi [Angle].

3
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Tietoja ND-suodattimesta

Liian kirkkaasti valaistuissa olosuhteissa voit määrittää sopivan kirkkauden muuttamalla ND-suodatinta.
Kun kuvataan kirkkaasti valaistua kohdetta, liiallinen himmentimen sulkeminen voi aiheuttaa diffraktiota, jolloin tarkennus
muuttuu epäselväksi (yleinen ilmiö kameroissa). Voit estää ilmiön ja saada paremman kuvaustuloksen käyttämällä ND-
suodatinta.
Laitteessa on seuraavat ND-suodattimen tilat.
Esiasetettu tila

Ks. ”Säätäminen esiasetetussa tilassa”.

Muuttuva tila (automaattinen säätö)

Ks. ”Automaattinen säätäminen muuttuvassa tilassa”.

Muuttuva tila (manuaalinen säätö)

Ks. ”Säätäminen käsin muuttuvassa tilassa”.

Aiheeseen liittyvää

Säätäminen esiasetetussa tilassa

Automaattinen säätäminen muuttuvassa tilassa

Säätäminen käsin muuttuvassa tilassa

5-041-958-73(1) Copyright 2022 Sony Corporation
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Säätäminen esiasetetussa tilassa

Voit valita kolme ND-suodattimen läpäisykerroinarvoa etukäteen ja vaihtaa niiden välillä nopeasti kuvauksen aikana.

Vihje

Kun painetaan ohjelmoitavaa painiketta, johon [ND Filter Position] on ohjelmoitu, ND-suodatin muuttuu järjestyksessä [Clear] →
[Preset1] → [Preset2] → [Preset3] → [Clear].

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta kameran valikon kohdan [Shooting] > [ND Filter] > [Mode] asetukseksi [Preset].1

Paina [ND Filter]-painiketta kameran perusmäärityspaneelissa.

[ND Filter]-painikkeen kehys muuttuu oranssiksi.

ND Filter-säätöpaneeli tulee näkyviin.

2

Paina [ND Filter] -painiketta ja valitse listalta jokin seuraavista.

[Clear]: Ei ND-suodatinta.
[Preset1]: Läpäisykerroin asetettu kameran valikon kohdassa [Shooting] > [ND Filter] > [Preset1].
[Preset2]: Läpäisykerroin asetettu kameran valikon kohdassa [Shooting] > [ND Filter] > [Preset2].
[Preset3]: Läpäisykerroin asetettu kameran valikon kohdassa [Shooting] > [ND Filter] > [Preset3].

Kun jokin ND-suodattimen valinnoista [Preset1]–[Preset3] on valittu, läpäisykertoimen arvo näkyy ND-suodattimen
nimen vieressä.

3
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Automaattinen säätäminen muuttuvassa tilassa

Voit ottaa käyttöön automaattisen valotuksensäädön ND-suodattimella.

Huomautus

Kun ND-suodatin siirtyy kuvaamisen aikana joko [Clear]-tilaan tai siitä muuhun tilaan, kuvassa näkyy ND-suodattimen kehys ja
käytön merkkiääni kuuluu.

Vihje

Voit myös ohjelmoida [Auto ND Filter] -toiminnon ohjelmoitavaan painikkeeseen ja vaihtaa [Auto]-tilasta [Manual]-tilaan ja takaisin
painamalla painiketta.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta kameran valikon kohdan [Shooting] > [ND Filter] > [Mode] asetukseksi [Variable].1

Paina [ND Filter]-painiketta kameran perusmäärityspaneelissa.

[ND Filter]-painikkeen kehys muuttuu oranssiksi.

ND Filter-säätöpaneeli tulee näkyviin.

2

Paina [ND Filter] -painiketta ja valitse listalta [Auto].

Automaattisesti säädetty ND-suodattimen läpäisykertoimen arvo näkyy [ND Filter] -painikkeen vieressä.

3
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Säätäminen käsin muuttuvassa tilassa

Voit suorittaa manuaalisen valotuksensäädön ND-suodattimella.

Automaattinen säätäminen tilapäisesti
Voit ohjelmoida [Push Auto ND] -toiminnon ohjelmoitavaan painikkeeseen ja ottaa Auto ND Filter -asetukset tilapäisesti
käyttöön pitämällä painiketta painettuna. Kun vapautat painikkeen, Auto ND Filter -asetus palaa takaisin Off-tilaan.
Aseta ND-suodattimen asetukseksi [Manual].

Huomautus

Kun ND-suodatin siirtyy kuvaamisen aikana joko [Clear]-tilaan tai siitä muuhun tilaan, kuvassa näkyy ND-suodattimen kehys ja
käytön merkkiääni kuuluu.

Aseta kameran valikon kohdan [Shooting] > [ND Filter] > [Mode] asetukseksi [Variable].1

Paina [ND Filter]-painiketta kameran perusmäärityspaneelissa.

[ND Filter]-painikkeen kehys muuttuu oranssiksi.

ND Filter-säätöpaneeli tulee näkyviin.

2

Paina [ND Filter] -painiketta ja valitse listalta [Manual].3

Säädä ND-suodattimen läpäisykerrointa [ND Filter] -liukusäätimellä tai [ND Filter] -säätöpainikkeilla.

Vihje

Liukusäätimen ja säätöpainikkeen asetukset on linkitetty.

Voit säätää ND-suodatinta myös  (Main) -välilehdessä kameran hallintapaneelissa.

4
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Vihje

Voit myös ohjelmoida [ND Filter Position] -toiminnon ohjelmoitavaan painikkeeseen ja vaihtaa [Manual]-tilasta [Clear]-tilaan ja
takaisin painamalla painiketta.

Voit painaa ND Filter-säätöpaneelin [Push Auto] -painiketta ottaaksesi ND-suodattimen käyttöön, kun painike on painettuna.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Valkotasapainon säätöpaneeli

Voit säätää valkotasapainoa verkkosovelluksen suorassa käyttönäkymässä. Oikea valkotasapaino saa kuvan
näyttämään luonnollisemmalta.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kameran perusmäärityspaneeli1.

Kameran perusmääritysten säätöpaneeli
Näyttää kameran perusmäärityspaneelissa valitun asetuskohteen säätöpaneelin.

2.
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Valkotasapainon säätäminen automaattisesti

Sopivasti säädetyn valkotasapainon voi saavuttaa milloin tahansa käyttämällä ATW-toimintoa (automaattisen seurannan
valkotasapaino).
Kun ATW on käytössä, valkotasapaino säätyy automaattisesti, kun valonlähteen värilämpötila muuttuu.

Huomautus

ATW-toimintoa ei voi käyttää, kun kohdan [Shooting Mode] asetuksena on [Cine EI] tai [Cine EI Quick].

Sopivan värisävyn säätäminen ATW-toiminnolla ei ehkä onnistu valaistuksesta ja kohteen tilasta riippuen.
Esimerkkejä:

Kun jokin yksittäinen väri hallitsee kohdetta, kuten taivas, meri, maa tai kukat.
Kun värilämpötila on erittäin suuri tai pieni.

Jos ATW-toiminnon automatiikka on hidas tai sopivaa vaikutusta ei saada, suorita automaattinen valkotasapaino painamalla [WB
SET] -painiketta.

Vihje

Voit valita vasteajan ATW-tilassa viidestä tasosta (1, 2, 3, 4, 5) kameran valikon kohdassa [Shooting] > [White Setting] > [ATW
Speed]. Mitä pienempi numero, sitä nopeampi vasteaika.

Voit lukita nykyisen valkotasapainoasetuksen ohjelmoimalla [ATW Hold] -toiminnon ohjelmoitavaan painikkeeseen ja keskeyttää
ATW-tilan tilapäisesti painamalla ohjelmoitavaa painiketta.

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina [White Balance]-painiketta kameran perusmäärityspaneelissa.

[White Balance]-painikkeen kehys muuttuu oranssiksi.

White Balance-säätöpaneeli tulee näkyviin.

1

Paina [White Mode] -painiketta ja valitse listalta [ATW].2
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Valkotasapainon säätäminen käsin

Valkotasapainoa voi säätää käsin.

Paina [White Balance]-painiketta kameran perusmäärityspaneelissa.

[White Balance]-painikkeen kehys muuttuu oranssiksi.

White Balance-säätöpaneeli tulee näkyviin.

1

Paina [White Mode] -painiketta ja valitse listalta jokin seuraavista.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Säädä valkotasapainoa liukusäätimillä tai säätöpainikkeilla.

Vihje

Liukusäätimen ja säätöpainikkeen asetukset on linkitetty.

[Memory A(T/T)]- ja [Memory A(R/B)] -asetusten ero on erilainen säätöakseli, mutta säätötulokset on linkitetty.

[Memory A(T/T)]-asetus
Tämä tila säätää valkotasapainon muistiin A tallennettuun asetukseen säätämällä värilämpötilaa (Temp) ja Tint-
arvoa.
Värilämpötilan voi määrittää 20 K:n välein välillä 2000–5600 K. Arvon 5600 K ylittävät arvot voidaan määrittää
värimuutoksen määrää (mired) vastaavin välein välillä 5580–5600 K.

3
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[Reset] -painikkeen painaminen asetuksen [Temp] tai [Tint] oikealla puolella palauttaa kyseisen asetuksen
oletusarvoon.
[Memory A(R/B)]-asetus
Tämä tila säätää valkotasapainon muistiin A tallennettuun asetukseen säätämällä R Gain- ja B Gain-arvoa.
[Reset]-painikkeen painaminen nollaa vastaavan herkkyysvahvistusasetuksen oletusarvoon.
[Preset]-asetus
Tämä tila säätää värilämpötilan esiasetettuun arvoon.
Arvon voi määrittää 100 K:n välein.
Esiasetetussa tilassa voit myös ohjelmoida [Preset White Select] -toiminnon ohjelmoitavaan painikkeeseen ja
vaihtaa ennalta määritettyyn esiasetettuun arvoon painamalla painiketta.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…

215



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Automaattisen valkotasapainon suorittaminen

Muisti A -tilassa tallennettava valkotasapaino säätyy automaattisesti.

Paina [White Balance]-painiketta kameran perusmäärityspaneelissa.

[White Balance]-painikkeen kehys muuttuu oranssiksi.

White Balance -säätöpaneeli tulee näkyviin.

1

Paina [White Mode] -painiketta ja valitse listalta [Memory A(T/T)] tai [Memory A(R/B)].

[Memory A(T/T)]

[Memory A(R/B)]

2

Aseta valkoinen paperi (tai muu esine) paikkaan, jossa on sama valaistus ja samat olosuhteet kuin
kohteella, ja zoomaa sitten paperiin, jotta näytössä näkyy valkoista.

3

Säädä kirkkautta.

Säädä himmennintä kohdassa ”Himmentimen säätäminen käsin” esitetyllä tavalla.

4

Paina [WB SET] -painiketta valkotasapainon säätöpaneelissa.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Huomautus

Jos säätäminen ei onnistu, näyttöön ilmestyy virheviesti noin kolmen sekunnin ajaksi. Jos virheviesti ilmestyy edelleen toistuvien
valkotasapainonsäätöyritysten jälkeen, ota yhteyttä Sonyn palveluedustajaan.

Vihje

Sen voi suorittaa myös ATW-tilassa. Sitä voi käyttää, kun haluat nopeasti säätää valkotasapainoa ATW-toiminnan aikana.
Säätämisen jälkeen tila palautuu normaaliin ATW-toimintaan.

Aiheeseen liittyvää

Himmentimen säätäminen käsin

5-041-958-73(1) Copyright 2022 Sony Corporation

Jos automaattinen valkotasapaino suoritetaan muistitilassa, automaattisen säädön tulos tallentuu muistiin A.
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Äänen määritysnäyttö

Laitteen tallentaman äänen tasoa voi säätää verkkosovelluksen suorassa käyttönäkymässä. Määritä laitteen
liitäntälohkon kytkimet ja määritä ääni kameran valikon tai verkkosovelluksen avulla.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kameran hallintapaneeli –  (Audio) -välilehti1.
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Äänen tulolähteen valitseminen

Määritä seuraavat kytkimet AUDIO IN -liittimeen liitetyn laitteen mukaan.

Huomautus

Ääntä ei tallenneta Interval Rec -tilassa eikä hidastus- ja nopeutustilassa.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kun kytkettynä on mikrofoni, aseta SETUP-kytkin 2 laitteen takaosan liitäntälohkossa.

CH-1:lla ja CH-2:lla on yhteiset asetukset.

1

Asetus Kuvaus

OFF
(oletus)

Valitse, kun käytössä on dynaaminen mikrofoni tai paristokäyttöinen mikrofoni. Tämä poistaa +48 V -
phantom-virransyötön käytöstä ja määrittää LINE- tai MIC-tulon CH-1- ja CH-2-äänilähteeksi.

ON
Valitse, kun käytössä on +48 V phantom-virtaa tukeva mikrofoni. Tämä ottaa +48 V -phantom-
virransyötön käyttöön ja määrittää phantom-virtaa tukevan mikrofonin CH-1- ja CH-2-äänilähteeksi.

Aseta liitetyn laitteen tyyppi kameran valikon kohdassa [Audio] > [Audio Input] > [AUDIO IN Select].2

Valitse äänen tulo asettamalla verkkovalikon tai kameran valikon kohdan [Audio] > [Audio Input] > [CH1
Input Select] asetukseksi [CH4 Input Select].

3
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Äänitystason säätäminen automaattisesti

Aseta kanava, jonka äänitystason haluat säätää automaattisesti, asentoon [Auto] verkkovalikon sivulla [Audio] tai
asettamalla kameran valikon kohdan [Audio] > [Audio Input] > [CH1 Level Control] asetukseksi [CH4 Level Control].
Automaattista säätöä varten osoitetut kanavat ilmaistaan vastaavien kanavien vieressä olevalla  (Auto) -kuvakkeella
suoran käyttönäkymän  (Audio) -välilehdessä.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Äänitystason säätäminen käsin

Äänitystasoa voi säätää käsin.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta kanava, jonka äänitystason haluat säätää käsin, asentoon [Manual] verkkovalikon sivulla [Audio] tai
asettamalla kameran valikon kohdan [Audio] > [Audio Input] > [CH1 Level Control] asetukseksi [CH4 Level
Control].

1

Paina  (Audio) -välilehteä kameran hallintapaneelissa.2

Aseta niiden kanavien äänitystaso, joiden äänitystason haluat säätää käsin, kameran hallintapaneelin
[Audio]-näytön liukusäätimellä tai säätöpainikkeilla.

Huomautus

Kanavat, joiden kohdalla  (Auto) -kuvake on näkyvissä, säädetään automaattisesti. Arvoihin liukusäätimellä tai
painikkeilla tehtyjä muutoksia ei sovelleta tallennettuun ääneen.

Vihje

Kunkin rivin liukusäätimen ja säätöpainikkeen asetukset on linkitetty.

Voit tarkistaa äänitulon tason reaaliaikaisesti kuvausnäytön äänitasomittarin näytöltä.

3
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Suoravalikon toiminnot

Voit tarkistaa laitteen tilan ja asetukset kameran kuvan päältä sekä valita ja muuttaa asetuksia infrapunakaukosäätimen
GUI-hallintapainikkeilla.
Seuraavat kohteet ovat määritettävissä.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter]-arvo
[Auto Iris]
[Iris]-arvo
[AGC]
[Gain]-arvo
[ISO]-arvo
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]-arvo
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] ja [Frame Rate]

Vihje

Voit myös suorittaa saman toiminnon ohjelmoitavalla painikkeella ja verkkosovelluksen GUI-hallintapaneelilla.

Paina infrapunakaukosäätimen ohjelmoitavaa painiketta, johon [Direct Menu] -toiminto on ohjelmoitu.

[Direct Menu] -painike on ohjelmoitu tehdasasetuksena ohjelmoitavaan painikkeeseen 1.
Vain näytöllä näkyvät kohteet, joita voidaan määrittää käyttämällä suoravalikkoa, ovat valittavissa oranssin
kohdistimen avulla.

1

Siirrä kohdistin haluamasi kohteen kohdalle GUI-hallintapaneelin nuolipainikkeilla ja vahvista asetus
painamalla [Set]-painiketta.

Joko valikko tai kohde näkyy valkoisella taustalla.

2

Valitse asetus nuolipainikkeilla ja paina [Set]-painiketta.

Valikko tai valkoinen tausta häviää ja näkyviin tulee uusi asetus ja oranssi kohdistin.
Poistu suoravalikosta painamalla uudelleen ohjelmoitavaa painiketta, johon [Direct Menu] on ohjelmoitu, tai
odottamalla 3 sekuntia tekemättä mitään.

3
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Ohjelmoitavat painikkeet

Laitteen verkkosovelluksessa on kymmenen ohjelmoitavaa painiketta, joihin voi ohjelmoida toimintoja.
Ohjelmoitavat painikkeet ovat näkyvissä suorassa käyttönäkymässä ja toistotoimintonäkymässä.

Huomautus

Ohjelmoitavien painikkeiden listaa ei näytetä, kun kameran perustoimintojen paneelin asetuksia määritetään suorassa
käyttönäkymässä. Päätä toiminto painamalla [X]-painiketta säätöpaneelin oikeassa yläkulmassa.

Tehdasasetuksissa painikkeille on ohjelmoitu seuraavat oletustoiminnot.
Painike 1: [Direct Menu]
Painike 2: [Focus Setting]
Painike 3: [Rec Review]

Painikkeet 1–3 vastaavat samoja numeropainikkeita mukana toimitettavassa infrapunakaukosäätimessä.

Painike 4: [Push Auto ND]
Painike 5: [Crop Select]
Painike 6: [Marker]
Painike 7: [Video Signal Monitor]
Painike 8: [Clip Flag OK]
Painike 9: [Color Bars]
Focus Hold -painike: [Focus Hold]

Focus Hold -painike vastaa Focus Hold -painiketta E-pidikkeellisessä objektiivissa.

Painikkeen toiminnon vaihtaminen
Käytä kohtaa [Project] > [Assignable Button] kameran valikossa.
Kun ohjelmointia muutetaan, ohjelmoitavien painikkeiden listanäkymä muuttuu.
Lisätietoja ohjelmoitavista painikkeista on kohdassa ”Assignable Button” osiossa ”Kameran valikko ja tarkemmat
asetukset”.

Aiheeseen liittyvää

Assignable Button

5-041-958-73(1) Copyright 2022 Sony Corporation
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Hidastus ja nopeutus

Kun tallennusmuodolle on asetettu seuraavat arvot, voit määrittää eri arvoja kuvaamisen kuvataajuudelle ja toiston
kuvataajuudelle.
Seuraavassa taulukossa näkyvät määritettävät kuvataajuudet.

Järjestelmän taajuus: 59.94/50/29.97/25/23.98, kuvakennon käyttötila: FF

Järjestelmän taajuus: 59.94/50/29.97/25/23.98, kuvakennon käyttötila: S35

Järjestelmän taajuus: 24, kuvakennon käyttötila: FF

Huomautus

Hidastusta ja nopeutusta ei voida määrittää tallennuksen tai toiston aikana eikä pikkukuvanäytön näkyessä.

Äänitystä ei tueta hidastus- ja nopeutustilassa.

Automaattihimmennin- ja automaattisuljintoiminto ovat hidastus- ja nopeutustilassa poissa käytöstä.

Automaattitarkennuksella on seuraavat rajoitukset hidastus- ja nopeutustilassa.

Objektiivin malliin, järjestelmän taajuuteen ja kuvaamisen kuvataajuuteen liittyvät rajoitukset

Koodekki Videomuoto Määritettävät kuvataajuudet

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Koodekki Videomuoto Määritettävät kuvataajuudet

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Koodekki Videomuoto Määritettävät kuvataajuudet

XAVC-I 4096×2160P 1–60
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Automaattitarkennus on tilapäisesti poissa käytöstä, jos himmentimen asetus on F18 tai suurempi.

Lisätietoja RAW-lähdön käyttämisestä on kohdassa ”RAW-videon tallentaminen”.

Aiheeseen liittyvää

RAW-videon tallentaminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Sony-objektiivi Järjestelmän taajuus AF:n käytettävyys

Muu kuin SEL16F28 – Tuettu: 7 fps tai suurempi

SEL16F28

59.94/29.97/23.98 Tuettu: 30, 60, 120, 240 fps

50,00/25,00 Tuettu: 25, 50, 100, 200 fps

24.00 Ei tuettu
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Videon tallentaminen jaksottaisesti (Interval Rec)

Interval Rec -toiminnolla voit kuvata videota jaksottaisesti laitteen sisäiseen muistiin. Toiminto on tehokas keino kuvata
hitaasti liikkuvia kohteita.
Kun aloitat tallentamisen, laite tallentaa automaattisesti määrätyn määrän kuvia (Number of Frames) määrätyn
ajanjakson (Interval Time) aikana.

A: Kuvausväli (Interval Time)
B: Kuvien lukumäärä yhdellä kuvauskerralla (Number of Frames)

Huomautus

Kerrallaan voidaan käyttää vain yhtä erikoistallennustoimintoa, kuten Interval Rec -tallennusta.

Jos jokin toimen erikoistallennustila otetaan käyttöön, kun Interval Rec on käytössä, Interval Rec poistuu automaattisesti käytöstä.

Interval Rec -tila poistuu automaattisesti käytöstä, kun muutetaan järjestelmäasetuksia, kuten videomuotoa.

Interval Rec -asetuksia ei voida muuttaa tallennuksen tai toiston aikana eikä pikkukuvanäytön näkyessä.

Rajoitukset tallentamisen aikana
Ääntä ei tallenneta.
Tallennuksen tarkasteleminen (Rec Review) ei ole mahdollista.

Jos laite sammutetaan tallentamisen aikana
Jos laitteen virransyöttö asetetaan virransäästötilaan, tietoväline on käytössä useita sekunteja siihen mennessä
tallennettujen kuvien muistiin tallentamista varten, ja sitten laite siirtyy automaattisesti virransäästötilaan.
Jos virtajohto on irrotettu, virta on sammutettu verkkovirtalaitteesta tai PoE++-virtalähde on irrotettu, siihen mennessä
kuvattu materiaali voi hävitä (enintään 10 sekuntia). Huolellisuutta on noudatettava.

Kuvien määrän ja välin määrittäminen ennen kuvausta

Aseta verkkovalikon kohdan [Project] > [Interval Rec] > [Setting] asetukseksi [On] ja määritä [Number of Frames] ja
[Interval Time].
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Laite poistuu Interval Rec -tilasta, kun sen virta on sammutettu, mutta [Number of Frames]- ja [Interval Time] -asetukset
säilyvät. Niitä ei tarvitse määrittää uudelleen seuraavalla kerralla, kun kuvaat Interval Rec -tilassa.

Vihje

Asetuksen voi määrittää myös kameran valikon kohdassa [Project] > [Interval Rec].

Kuvaamisen aloittaminen

Aloita tallennus painamalla tallennuksen START/STOP-painiketta. ”Int●Rec” ja ”Int●Stby” tulevat vuorotellen näkyviin.

Kuvaamisen lopettaminen

Lopeta tallentaminen.
Kun kuvaaminen päättyy, siihen mennessä muistiin tallennettu videodata tallentuu tietovälineeseen.
Poistu Interval Rec -tilasta tekemällä jokin seuraavista.

Kytke laitteen virransyöttö virransäästötilaan.
Aseta tallentamisen valmiustilassa kohdan [Project] > [Interval Rec] > [Setting] asetukseksi [Off].

Lisäksi Interval Rec -tila poistuu automaattisesti käytöstä, kun laite käynnistetään uudelleen.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Kuvien tallentaminen välimuistiin (Picture Cache Rec)

Picture Cache Rec -toiminnolla voit tallentaa videota takautuvasti kuvauksen alussa ylläpitämällä tietyn pituista sisäistä
välimuistia kuvauksen aikana.

Välimuistin koon määrittäminen

Aseta verkkovalikon kohdan [Project] > [Picture Cache Rec] > [Setting] asetukseksi [On] ja määritä välimuistin koko
kohdassa [Cache Size].

Huomautus

Picture Cache Rec -tilaa ei voi käyttää yhdessä Interval Rec- toiminnon, 2 paikan samanaikaisen tallennustoiminnon tai
välityspalvelimelle tallentamisen kanssa. Kun Picture Cache Rec on tilassa On, nämä muut erikoistallennustilat pakotetaan tilaan
Off.

Picture Cache Rec -tilaa ei voi valita tallennuksen tai Rec Review -toiminnon aikana.

Kun Picture Cache Rec on tilassa On, aikakoodi tallennetaan [Free Run] -tilassa, vaikka asetuksena olisi [Regen] tai [Rec Run].

[Output Format] -asetusta ei välttämättä voi määrittää Picture Cache Rec -tilassa. Jos näin tapahtuu, kytke Picture Cache Rec
tilapäisesti tilaan Off ja muuta sitten asetusta.

Vihje

Välimuistin kesto voi olla lyhyempi tietyillä tallennusmuodoilla. Tarkista näytettävä aika verkkovalikon kohdassa [Project] > [Picture
Cache Rec] > [Cache Rec Time].

Asetuksen voi määrittää myös kameran valikon kohdassa [Project] > [Picture Cache Rec].

Voit kytkeä [Picture Cache Rec] -tilan asetukseksi On tai Off myös ohjelmoitavalla painikkeella.

Picture Cache Rec -tilan käynnistäminen

Kun [Picture Cache Rec] -tilan asetuksena on On, ”●Cache” (● on vihreä) tulee näkyviin.
Kun painat tallennuksen START/STOP-painiketta, tallennus alkaa ja video kirjoitetaan muistikorteille aloittaen välimuistiin
tallennetusta videosta.

Huomautus

Tallennusmuodon tai perusulkoasun vaihtaminen poistaa välimuistiin siihen asti tallennetun videon ja aloittaa uuden videon
tallennuksen välimuistiin. Tämän vuoksi kuvien tallennus välimuistiin ennen muodon vaihtamista ei ole mahdollista vaikka kuvaus
aloitettaisiin välittömästi muodon vaihtamisen jälkeen.

[Cache Size]-asetus Välimuistin kesto (arvioitu)

[Short] 5 sekuntia

[Medium] 10 sekuntia

[Long] 20 sekuntia

[Max] Kunkin tallennusmuodon enimmäisarvo
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Jos Picture Cache Rec kytketään päälle tai pois päältä heti muistikortin asettamisen jälkeen, välimuistin tiedot eivät ehkä tallennu
kortille.

Video tallennetaan välimuistiin, kuin Picture Cache Rec -toiminnon asetukseksi valitaan On. On-tilan valintaa edeltävää videota ei
tallenneta välimuistiin.

Videota ei tallenneta välimuistiin, kun muistikortti on käytössä, esimerkiksi toiston, Rec Review -toiminnon tai pikkukuvanäytön
aikana. Videon kuvien tallennus välimuistiin ei ole mahdollista tänä aikana.

Picture Cache Rec -tilan peruuttaminen

Aseta verkkovalikon kohdan [Project] > [Picture Cache Rec] > [Setting] asetukseksi [Off] tai paina ohjelmoitua painiketta,
johon [Picture Cache Rec] -toiminto on ohjelmoitu.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Muistikorteille A ja B tallentaminen samanaikaisesti (2 paikan Simul Rec)

Voit tallentaa samanaikaisesti sekä muistikortille A että muistikortille B asettamalla verkkovalikon tai kameran valikon
kohdan [Project] > [Simul Rec] > [Setting] asetukseksi [On].

Muistikorteille A ja B tallentaminen erikseen

Tallennus kummallekin muistikortille voidaan aloittaa ja lopettaa erikseen tallennuksen START/STOP-painikkeella tai [2nd
Rec START/STOP] -painikkeella  (Others) -välilehdessä.
Tehdasoletuksena molemmat painikkeet on määritetty aloittamaan/lopettamaan samanaikainen tallennus muistikorteille A
ja B.
Kun painikkeet määritetään ohjaamaan tallennusta eri muistikorteille, [SDI/HDMI Rec Control] -toiminnon tallennuksen
alkamisen/päättymisen ohjaus seuraa paikan A tallennustilaa.

Asetuksen muuttaminen

Aseta seuraavat kameran valikon kohdassa [Project] > [Simul Rec] > [Rec Button Set].

5-041-958-73(1) Copyright 2022 Sony Corporation

[Rec Button Set]-
asetus Painikkeet ja muistikortit

Rec Button:<Slot
A> <Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Aloittaa/lopettaa tallennuksen muistikorteille A ja B samanaikaisesti kummalla tahansa
painikkeella.

Rec Button:<Slot
A>
2nd Rec Button:
<Slot B>

Tallennuksen START/STOP-painike aloittaa/lopettaa tallennuksen muistikortille A, ja [2nd Rec
START/STOP] -painike  (Others) -välilehdessä aloittaa/lopettaa tallennuksen muistikortille B.

Rec Button:<Slot
B>
2nd Rec Button:
<Slot A>

Tallennuksen START/STOP-painike aloittaa/lopettaa tallennuksen muistikortille B, ja [2nd Rec
START/STOP] -painike  (Others) -välilehdessä aloittaa/lopettaa tallennuksen muistikortille A.
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Videosignaalin näyttö

Voit määrittää videosignaalin tyypin näkymään kameran kuvapaneelissa aaltomuotona, vektoriskooppina tai
histogrammina kameran valikon kohdassa [Monitoring] > [Video Signal Monitor] > [Setting].
Oranssi viiva ilmaisee merkeille [Level Marker 1] ja [Level Marker 2] määritetyn arvon.
Voit myös ohjelmoida [Video Signal Monitor] -toiminnon ohjelmoitavaan painikkeeseen.

Tavoitenäytön tarkkaileminen
Log-kuvaustiloissa värialueen asetuksen tai näytön LUT-asetuksen tiedot näytetään videosignaalin näytön oikeassa
yläkulmassa osoittamassa tarkkailun tavoitetta.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Leikeliput

Voit lisätä [OK]-leikelipun leikkeeseen painamalla ohjelmoitavaa painiketta, johon [Clip Flag OK] on ohjelmoitu, ja
valitsemalla [Add OK].
Voit poistaa [OK]-leikelipun painamalla painiketta kahdesti ja valitsemalla [Delete Clip Flag].

Vihje

Lisäksi voit lisätä leikelipun kameran valikon kohdassa [Thumbnail] > [Set Clip Flag].

Pikkukuvanäyttö voidaan lajitella leikkeen lipun tyypin mukaan (suodatettu leikkeiden pikkukuvanäyttö). Lisätietoja on kohdassa
”Tallennettujen leikkeiden toiminnot” osiossa ”Pikkukuvanäyttö”.

Aiheeseen liittyvää

Tallennettujen leikkeiden toiminnot

5-041-958-73(1) Copyright 2022 Sony Corporation

233



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hengityksen kompensaatio

Kameran valikon kohdassa [Technical] > [Lens] > [Breathing Compensation] voit määrittää, käytetäänkö objektiivin
kanssa hengityksen kompensaatiota.
Tämä toiminto korjaa ilmiön, jossa kuvakulma vaihtelee tarkennuskohdan muuttuessa.
Kun hengityksen kompensaatiota käytetään, osa kuvasta rajataan elektronisesti vakaan kuvakulman säilyttämiseksi
siten, ettei hengitysilmiötä esiinny.

Huomautus

Kun hengityksen kompensaatio on käytössä, kuvakulma ja kuvanlaatu voivat muuttua hieman.

Joillakin objektiiveilla kuvakulman muutosta ei ehkä ole mahdollista korjata hengityksen kompensaation ollessa käytössä.

Kompensaatio ei ole mahdollista käytettäessä objektiivia, joka ei tue hengityksen kompensaatiota.

Tämän toiminnon asetuksena on Off (pysyvästi) seuraavissa tilanteissa.

Kun kameran valikon kohdan [Technical] > [Lens] > [Distortion Comp.] asetuksena on [Off]
Kun verkkovalikon tai kameran valikon kohdan [Shooting] > [S&Q Motion] > [Setting] asetuksena on [On]
Kun verkkovalikon tai kameran valikon kohdan [Project] > [Rec Format] > [Codec] asetuksena on [RAW] tai [RAW & XAVC-I]

5-041-958-73(1) Copyright 2022 Sony Corporation
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Yleistä välityspalvelimelle tallentamisesta

Tällä toiminnolla voit tallentaa pienen tarkkuuden välityspalvelindataa samalla kun tallennat suuren tarkkuuden
alkuperäistä videodataa.

Lisätietoja tuetuista muistikorteista, muistikorttien formatoinnista ja jäljellä olevan kapasiteetin tarkistamisesta on
kohdassa ”Tuetut muistikortit” osiossa ”Muistikorttien valmisteleminen”.

Tietoja tallennetusta tiedostosta
Tiedostonimen pääte on ”.mp4”.
Myös aikakoodi tallentuu samanaikaisesti.

Tallennetun tiedoston tallennuskohde
Tallennettu tiedosto tallennetaan seuraavaan hakemistoon.

Tietoja tiedostonimestä
Tiedostonimi sisältää muistikortille tallennetun leikkeen nimen ja liitteen ”S03”.
Leikkeiden nimet ovat kohdassa [TC/Media] > [Clip Name Format] kameran valikossa.

Aiheeseen liittyvää

Tuetut muistikortit

5-041-958-73(1) Copyright 2022 Sony Corporation

Tallennusväline Kansion polku

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Välityspalvelimen tallentaminen

Tallentamisen voi aloittaa, kun välityspalvelimelle tallentaminen on otettu käyttöön.

Kuvaamisen lopettaminen
Lopeta tallentaminen.

Äänikanavan määrittäminen välityspalvelimelle tallentamista varten
Valitse kameran valikossa kohta [Project] > [Proxy Rec] > [Audio Channel] ja määritä äänikanava välityspalvelimelle
tallentamista varten.

5-041-958-73(1) Copyright 2022 Sony Corporation

Aseta verkkovalikon tai kameran valikon kohdan [Project] > [Proxy Rec] > [Setting] asetukseksi [On].1

Aseta muistikortti CFexpress Type A- / SD -korttipaikkaan.

CFexpress-kortit syötetään tarrapuoli ylöspäin.
SD-kortit syötetään tarrapuoli alaspäin.

Huomautus

Proxy Rec -asetukseksi ei voi määrittää On samalla, kun S&Q Motion tai Interval Rec on käytössä. Kun Proxy Rec -
asetukseksi määritetään On, muut tallennustilat pakotetaan tilaan Off.

2

Paina tallennuksen START/STOP-painiketta.

Välityspalvelimelle tallentaminen alkaa.

Huomautus

Jos laite sammutetaan tai muistikortti poistetaan, kun muistikortti on käytössä, kortin tietojen eheyttä ei voida taata.
Kaikki muistikortille tallennettu tieto voi hävitä. Varmista aina, että muistikortin käytön ilmaisin on sammunut, ennen kuin
sammutat laitteen tai poistat muistikortin.

Varmista, että muistikortti ei ponnahda ulos, asetat tai poistat sitä.

3
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Yleistä ulkoasusta

Kun laite on Custom-tilassa, voit lisätä säätöjä mustaan, matriisiin ja muihin parametreihin luodaksesi perusulkoasuun
perustuvan ulkoasun.

Voit myös nopeasti valita eri ulkoasun tallentamalla kohtaustiedostoihin eri asetusyhdistelmiä.
Laitteessa on yhteensä seitsemän esiasetettua ulkoasua.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ulkoasun valitseminen

Tässä osiossa käsitellään ulkoasun valitsemista.

Tarkista, että verkkovalikon tai kameran valikon kohdan [Project] > [Base Setting] > [Shooting Mode]
asetuksena on [Custom].

Vihje

[Custom]-tilassa [ISO/Gain]-painike ja [Scene File] -painike näkyvät kameran perusmäärityspaneelissa.

1

Paina [Scene File]-painiketta kameran perusmäärityspaneelissa.

[Scene File]-painikkeen kehys muuttuu oranssiksi.

Scene File-säätöpaneeli tulee näkyviin.

2

Paina säätöpaneelin [Scene File] -painiketta ja valitse listalta kohtaustiedosto, jossa on haluttu ulkoasu.

Seuraavat esiasetukset on määritetty tehdasoletuksena.

Vihje

Voit valita ulkoasun myös kameran valikon kohdassa [Paint/Look] > [Scene File] > [Recall]. Lisäksi voit palauttaa
esiasetetun ulkoasun kohdassa [Scene File] > [Preset Recall].

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Kohtaustiedosto 1 [S-Cinetone] [HLG Live]

Kohtaustiedosto 2 [Standard] [HLG Natural]

Kohtaustiedosto 3 [Still] (Ei rekisteröity)

Kohtaustiedosto 4 [ITU709] (Ei rekisteröity)

Kohtaustiedosto 5 [709tone] (Ei rekisteröity)

Kohtaustiedosto 6–16 (Ei rekisteröity) (Ei rekisteröity)
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Huomautus

Kohtaustiedoston 5 esiasetus on [709tone] ohjelmistoversiolla 2.0 tai uudemmalla. Se näkyy, kun verkkovalikon kohta
[Maintenance] > [Reset] > [Factory Default] suoritetaan.
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Halutun perusulkoasun tuominen

Voit tuoda perusulkoasuksi tietokoneella tai muulla laitteella luodun 3D LUT -tiedoston. Enintään 16 tiedostoa voidaan
tuoda.
Tiedostomuoto: 17 ruudukon tai 33 ruudukon 3D LUT CUBE-tiedostona (*.cube), joka on luotu Catalyst Browse-, RAW
Viewer- tai DaVinci Resolve -ohjelmalla* (Blackmagic Design Pty. Ltd.).

Tulon värialue/gamma: [S-Gamut3.Cine/S-Log3] tai [S-Gamut3/S-Log3]

Alivalotuksen säätäminen

Varmistettu Resolve-versioilla V9.0, V10.0 ja V11.0.*

Tallenna 3D LUT -tiedosto laitteelle, jossa verkkosovellusta käytetään.1

Avaa [Paint/Look] > [Base Look] verkkovalikossa.

Rekisteröityjen perusulkoasujen lista tulee näkyviin.

2

Paina [Import]-painiketta sillä rivillä, johon haluat tuoda tiedoston.

Tiedoston valintaruutu tulee näkyviin.

3

Valitse valmisteltu 3D LUT -tiedosto.

Tuodusta 3D LUT -tiedostosta tulee laitteen perusulkoasu.

4

Valitse tuotu 3D LUT -tiedosto kameran valikon kohdassa [Paint/Look] > [Base Look] > [Select].5

Määritä kameran valikon kohdat [Paint/Look] > [Base Look] > [Input] ja [Output] vastaamaan tuodun 3D
LUT -tiedoston määreitä.

6

240



Jos kuvalla on taipumus alivalottua, kun tuotua perusulkoasua käytettäessä valittuna on automaattinen valotus, säädä
ulkoasua verkkovalikon kohdassa [Paint/Look] > [Base Look] > [AE Level Offset].

Huomautus

Pelkkä 3D LUT -tiedoston tuonti ei vaikuta kuvaan. Lataa tuotu 3D LUT -tiedosto kameran valikon kohdassa [Paint/Look] > [Base
Look] > [Select].

Jos [Input]-asetusta ei ole määritetty oikein, ulkoasu ei ole oikeanlainen.

[Input], [Output] ja [AE Level Offset] -valikkokohteiden asetukset otetaan käyttöön valitussa perusulkoasussa valitsemalla [Select].
Jos tuodaan useita 3D LUT -tiedostoja, valitse kukin 3D LUT -tiedosto [Select]-valinnalla ja määritä [Input], [Output] ja [AE Level
Offset] erikseen kullekin tiedostolle.

Määritetyt [Input], [Output], ja [AE Level Offset] -asetukset tallentuvat kullekin 3D LUT -tiedostolle.

Perusulkoasu-/LUT-valintavaihtoehdot tuoduille 3D LUT -tiedostoille ovat yhteisiä [SDR(BT.709)]-, [HDR(HLG)]- ja Log-
kuvaustiloille, mutta värialue- ja gammamuunnosta ei suoriteta näiden tilojen mukaisesti.

3D LUT -tiedostoja ei poisteta, kun verkkovalikossa suoritetaan [Maintenance] > [Reset] > [All Reset (except for Network
Settings)].

 (3D LUT -tiedoston liittämisvirhe) [Base Look Name] -näytön edessä ilmaisee, että 3D LUT -tiedostoja ei voida liittää Log-
kuvaustiloissa tallennettuihin leikkeisiin. Tuo 3D LUT -tiedosto uudelleen.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ulkoasun mukauttaminen

Voit mukauttaa perusulkoasuun perustuvaa ulkoasua käyttämällä [Master Black], [R Black] ja [B Black] -liukusäätimiä
kameran perusmäärityspaneelin Scene File-säätöpaneelissa ja kameran valikon kohtaa [Paint/Look] > [Matrix] ja muita
määritettäviä kohteita.
Liitä laite televisioon tai näyttöön ja säädä kuvanlaatua samalla kun tarkkailet television tai näytön kuvaa.

1: [R Black]-liukusäädin / ohjelmoitavat painikkeet
2: [B Black]-liukusäädin / ohjelmoitavat painikkeet
3: [Master Black]-liukusäädin / ohjelmoitavat painikkeet

Huomautus

Kun tuot 3D LUT -tiedoston ja käytät sitä kuvassa, 3D LUT -tiedostossa määritettyä haluttua ulkoasua ei saada aikaan, jos
asetusta kohdassa [Paint/Look] > [Matrix] ja muita kuin perusulkoasun asetuksia kameran valikossa on muutettu.

Voit nollata kaikki mukautetut asetukset kameran valikon kohdassa [Paint/Look] > [Reset Paint Settings] > [Reset without Base
Look].

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ulkoasun tallentaminen

Voit tallentaa nykyisen ulkoasun kohtaustiedostona sisäiseen muistiin kameran valikon kohdassa [Paint/Look] > [Scene
File] > [Store].
Voit palauttaa tallennetun ulkoasun nopeasti Scene File -säätöpaneelin tai suoravalikon toimintojen avulla.

Huomautus

Jos valitset toisen ulkoasun tallentamatta nykyistä ulkoasua, nykyinen ulkoasu häviää.

Vihje

Voit korvata esiasetettuja kohtaustiedostoja. Palauta esiasetettu kohtaustiedosto lataamalla palautettava ulkoasu kameran valikon
kohdassa [Paint/Look] > [Scene File] > [Preset Recall] ja tallentamalla kohtaustiedosto sitten kohdassa [Scene File] > [Store].

Tallennetun ulkoasun poistaminen
Voit poistaa sisäiseen muistiin tallennetun kohtaustiedoston kameran valikon kohdassa [Paint/Look] > [Scene File] >
[Delete].

Vihje

Poiston jälkeen se ei enää näy Scene File -säätöpaneelissa tai suoravalikossa.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Perusulkoasun poistaminen

Voit poistaa tuotuja 3D LUT -tiedostoja yksitellen kameran valikon kohdassa [Paint/Look] > [Base Look] > [Delete].
Voit poistaa kaikki tuodut 3D LUT -tiedostot kameran valikon kohdassa [Paint/Look] > [Base Look] > [Delete All].

Huomautus

Tarkista ennen poistamista, että perusulkoasu ei ole käytössä missään kohtaustiedostossa. Jos käytössä oleva perusulkoasu
poistetaan, kyseisten kohtaustiedostojen ulkoasu on virheellinen.

Tuotuja 3D LUT -tiedostoja ei poisteta, kun verkkovalikossa suoritetaan [Maintenance] > [Reset] > [All Reset (except for Network
Settings)].

Poistettua perusulkoasua ei voi enää käyttää LUT-asetuksena Log-kuvaustiloissa.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Kuvaaminen ja ulkoasun säätäminen jälkikäsittelyssä

Käyttämällä laitetta Log-kuvaustiloissa*1 ja tallentamalla sävyjyrkkyydet tasaisesti tummista alueista kirkkaisiin alueisiin
voit tehdä jälkikäsittelyssä hienosäätöjä, kuten palauttaa tummien ja vaaleiden alueiden sävyjyrkkyydet.
Kuitenkin kun tarkastelet tallennettuja kuvia perinteisellä näytöllä, kokonaiskontrasti näkyy pienenä, mikä tekee
tarkennuksen ja valotuksen säädöstä vaikeaa.
Voit käyttää LUT-tiedostoa laitteen tavoitenäytössä, jossa se avustaa eri säädöissä kuvaamisen aikana. Voit myös
käyttää kuvaamisen aikana käytettyä LUT-tiedostoa automaattisesti toistossa tarkistaaksesi valmiin tuloksen nopeasti.
Seuraavat järjestelmät käyttävät LUT-tiedostoja. Kuitenkin vain yhtä LUT-tiedostoa voidaan käyttää.

SDI-lähtö
HDMI-lähtö ja suoratoisto
Tallennusvälineeseen tallennettu välityspalvelinleike
Tallennusvälineeseen tallennettu korkearesoluutioinen (main) leike

5-041-958-73(1) Copyright 2022 Sony Corporation

Yleistermi Flexible ISO -tilalle/Cine EI -tilalle/Cine EI Quick -tilalle*1
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LUT-tiedoston käyttäminen HDMI-lähdössä ja suoratoistossa

LUT-tiedostoa voi käyttää HDMI-lähdössä ja suoratoistossa.

Huomautus

Verkkosovelluksen kameran kuvapaneelin kuva sisältyy myös suoratoistokuvaan.

Vihje

Asetuksen voi määrittää myös kameran valikon kohdassa [Shooting] > [LUT On/Off] > [HDMI/Stream].

Määritä SDI-lähtö samalla tavalla.

Tallennusvälineen videossa voit määrittää asetuksen kameran valikon kohdissa [Shooting] > [LUT On/Off] > [Internal Rec] ja
[Proxy].

 (3D LUT -tiedoston liittämisvirhe) [Base Look/LUT] -näytön edessä ilmaisee, että 3D LUT -tiedostoja ei voida liittää Log-
kuvaustiloissa tallennettuihin leikkeisiin. Tuo 3D LUT -tiedosto uudelleen.
Tämä kuvake näkyy myös silloin, kun liittäminen epäonnistuu tilapäisen käsittelyruuhkan vuoksi.

Tarkista, että verkkovalikon tai kameran valikon kohdan [Project] > [Base Setting] > [Shooting Mode]
asetuksena on [Flexible ISO], [Cine EI] tai [Cine EI Quick].

Vihje

Log-kuvaustiloissa [Base ISO/Exposure Index] -painike ja [Base Look/LUT] -painike näkyvät kameran
perusmäärityspaneelissa.

1

Paina [Base Look/LUT]-painiketta kameran perusmäärityspaneelissa.

[Base Look/LUT]-painikkeen kehys muuttuu oranssiksi.

Base Look/LUT-säätöpaneeli tulee näkyviin.

2

Valitse [HDMI/Stream] > [MLUT].3
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LUT-tiedoston vaihtaminen

Voit vaihtaa käytettävää LUT-tiedostoa.

Vihje

Laitteessa on LUT-esiasetuksina [s709], [709(800%)] ja [S-Log3].

Voit myös tuoda 3D LUT -tiedoston ja käyttää sitä. Lisätietoja on kohdissa ”Halutun perusulkoasun tuominen” ja ”Perusulkoasun
poistaminen”.

Asetuksen voi määrittää myös kameran valikon kohdassa [Paint/Look] > [Base Look] > [Select].

Aiheeseen liittyvää
Halutun perusulkoasun tuominen

Perusulkoasun poistaminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Paina [Base Look/LUT]-painiketta kameran perusmäärityspaneelissa.

[Base Look/LUT]-painikkeen kehys muuttuu oranssiksi.

Base Look/LUT -säätöpaneeli tulee näkyviin.

1

Paina [Base Look/LUT] -painiketta ja valitse käytettävä perusulkoasu.2
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Tummien ja kirkkaiden alueiden jakauman muuttaminen tallennetussa kuvassa

Cine EI- ja Cine EI Quick -kuvaustiloissa voit vaihtaa tummien alueiden ja vaaleiden alueiden jakaumaa, jos esimerkiksi
haluat priorisoida tummien alueiden sävyä kirkkaiden alueiden sijasta, muuttamalla perusherkkyyden Exposure Index -
asetusta.

Paina [Base Look/LUT]-painiketta kameran perusmäärityspaneelissa.

[Base Look/LUT]-painikkeen kehys muuttuu oranssiksi.

Base Look/LUT-säätöpaneeli tulee näkyviin.

1

Valitse [HDMI/Stream] > [MLUT].

LUT-tiedostoa käytetään HDMI-lähdössä ja suoratoistossa.

2

Paina [Base ISO/Exposure Index]-painiketta kameran perusmäärityspaneelissa.

[Base ISO/Exposure Index]-painikkeen kehys muuttuu oranssiksi.

Base ISO/Exposure Index -säätöpaneeli tulee näkyviin.

3

Säädä valotusindeksiä halutun tummien ja kirkkaiden alueiden jakauman mukaisesti [Exposure Index] -
liukusäätimellä tai [Exposure Index] -säätöpainikkeilla.

[Cine EI]-asetus

[Cine EI Quick]-asetus
Perusherkkyys asetetaan automaattisesti määritetyn valotusindeksin mukaan.

4
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Vihje

Asetuksen voi määrittää myös kameran valikon kohdassa [Shooting] > [ISO/Gain/EI] > [Exposure Index].

SDI-lähtöä voi käyttää samalla tavalla.

Asetuksen toinen numeroarvo osoittaa, miten monta kirkkaustasoa suunnataan kirkkaille alueille (kirkkaus suurempi kuin 18%:n
harmaa). Niitä kirkkaammat alueet ovat ylivalottuneita.
Esimerkki: Asetuksella ”400EI/5.0E” kirkkaalle alueelle suunnataan 5,0 kirkkaustasoa.

Voit myös käyttää tätä ohjeena tummien ja kirkkaiden alueiden tarkistuksessa kuvaamisen aikana. Muista palauttaa alkuperäinen
EI-arvo valotuksen tarkistamisen jälkeen. Cine EI Quick -tilassa on myös syytä varoa, ettet heikennä perusherkkyyttä.

5-041-958-73(1) Copyright 2022 Sony Corporation

Säädä valaistusta ja/tai ND-suodatinta niin, että kameran kuvalähdöllä [HDMI/Stream]-lähteestä on sopiva
valotus.

5
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RAW-videon tallentaminen

Voit tallentaa RAW-videosignaalin lähdön laitteen SDI OUT -liittimestä tuettuun ulkoiseen tallentimeen.
Tuetut RAW-lähtömuodot näkyvät alla.

Järjestelmän taajuus [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Liitä ulkoinen RAW-tallennin laitteen SDI OUT -liittimeen.1

Aseta verkkovalikon tai kameran valikon kohdan [Project] > [Base Setting] > [Shooting Mode] asetukseksi
[Cine EI], [Cine EI Quick] tai [Flexible ISO].

2

Aseta kuvakulma tilaan (vain FF) verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] >
[Imager Scan Mode].

3

Aseta verkkovalikon tai kameran valikon kohdan [Project] > [Rec Format] > [Codec] asetukseksi [RAW].

Jos valintana on [RAW & XAVC-I], video tallentuu ulkoiseen RAW-tallentimeen ja samalla laitteen muistikorteille.

4

Aseta resoluutio verkkovalikon tai kameran valikon kohdassa [Project] > [Rec Format] > [RAW Output
Format].

5

Tarkista, että ulkoinen tallennin on päällä, ja paina sitten suorassa käyttönäkymässä tallennuksen
START/STOP-painiketta.

RAW-videotallennuksen tila ilmaistaan kuvakkeella kameran kuvapaneelissa.

6
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Huomautus

Kun tallennus ulkoiselle tallentimelle on alkanut ilman tallennuksen START/STOP-painikkeen painallusta suorassa
käyttönäkymässä, leikkeitä ei ehkä tallenneta kunnolla.

5-041-958-73(1) Copyright 2022 Sony Corporation

Huomautus

Tallennuksen ohjaussignaali lähtee laitteen SDI OUT -liittimestä, mutta ulkoisen tallentimen tilaa ei voi saada näkyviin.
Samoin laite voi näyttää, että RAW-videon tallennus on meneillään, vaikka ulkoinen tallennin ei tallenna. Tarkista ulkoisen
tallentimen ilmaisin, jotta saat oikean toimintatilatiedon.
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RAW-videon tallentaminen Hidastus ja nopeutus -tilassa

RAW-videota voi tallentaa Hidastus ja nopeutus -tilassa.

Tietoja tuetuista kuvaamisen kuvataajuuksista, ks. ”Hidastus ja nopeutus”.

Aiheeseen liittyvää

Hidastus ja nopeutus

5-041-958-73(1) Copyright 2022 Sony Corporation
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Boken hallintatoiminnon kytkeminen päälle / pois päältä

Voit säätää boken määrää helposti linkittämällä ND-suodattimen ja herkkyysvahvistuksen himmentimen toimintaan.

Boken hallintatoiminnon kytkeminen päälle / pois päältä

Tämän toiminnon voi ottaa käyttöön vain, kun valotusta säädetään manuaalisesti. Aseta ND-suodatin muuttuvaan tilaan
ja aseta sitten himmennin, herkkyysvahvistus, suljin ja ND-suodatin manuaaliseen säätötilaan.
Voit kytkeä boken hallintatoiminnon päälle / pois päältä kameran valikon kohdassa [Shooting] > [Iris] > [Bokeh Control].
Kun boken hallintatoiminnon asetuksena on On, ND-suodattimen ja herkkyysvahvistuksen ilmaisimessa näkyy kuvake

 (B).

Huomautus

Tämä toiminto on käytössä vain E-pidikkeellisissä objektiiveissa, jotka voivat viestiä laitteen kanssa.

Toiminnon täysi vaikutus saadaan käyttämällä Sonyn E-pidikkeellistä objektiivia.

Boken hallintatoiminto on kytkettynä tilaan Off seuraavissa tilanteissa.

Kun laite on sammutettuna
Kun himmennin, herkkyysvahvistus, suljin tai ND-suodatin on tilassa Auto
Kun kuvaustilaa vaihdetaan
Kun ND-suodatin on Clear-tilassa tai esiasetetussa tilassa
Kun objektiivi irrotetaan
Kun laite käynnistyy uudelleen esimerkiksi taajuuden vaihtamisen jälkeen

Vihje

Voit myös ohjelmoida [Bokeh Control] -toiminnon ohjelmoitavaan painikkeeseen ja kytkeä boken hallintatoiminnon tilaan On tai
Off painikkeella.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Boken määrän säätäminen

Säädä asetuksia kohdissa 2–4 tarpeen mukaan.

Huomautus

Ulkoasu voi vaihdella toiminnon nopeuden, objektiivin, kuvausasetusten ja kohteen mukaan, ja myös kirkkaus voi muuttua. On
ehdottoman suositeltavaa tehdä koekuvaus kameralla ennen kuvaamista.

Kirkkaus voi muuttua, kun himmentimen käyttösuunta muuttuu, esimerkiksi kun se avataan sulkemisen jälkeen tai suljetaan
avaamisen jälkeen. Säädä tässä tapauksessa ensin hieman tarvetta enemmän ja palaa hieman takaisin, tarkista kirkkaus ja aloita
sitten kuvaus. Jos esimerkiksi haluat avata himmentimen F8-aukkoon ja sumentaa taustan, sulje aukkoa ensin F8:n ohi ja palaa
sitten F8:aan, tarkista kirkkaus ja aloita kuvaus.

Tee boken hallintatoiminnot hitaasti. Jos haluat nopeuttaa toimintoa, yritä tehdä säädöt asteittain tarkistaen samalla kuvan
muutokset.

Vihje

Kun boken hallintatoiminnon asetuksena on On, ND-suodatin ja herkkyysvahvistus kompensoivat yhdessä himmentimen säädön
aiheuttamia valotusmuutoksia mahdollistaen näin boken määrän muuttamisen.

Boken hallinta linkitetään ensin ND-suodattimeen reaktiona himmentimen toimintaan. Kun ND-suodatinta ei voida muuttaa
enempää, linkitetään herkkyysvahvistus.

MF-tilassa on suositeltavaa avata ensin himmennin ja säätää sitten tarkennusta.

Jos käytät automaattista ND-suodatinta boken hallintatoiminnon sijaan, ND-suodatin noudattaa kohteen kirkkauden muutoksia.

Näyttö herkkyysvahvistuksen linkitystoiminnon aikana
Kun boken hallintatoiminto on tilassa On, herkkyysvahvistus saattaa muuttua himmennintä säädettäessä.
Kun herkkyysvahvistuksen linkitys on käytössä ja herkkyysvahvistus muuttuu, näytön yläosaan tulee ilmoitus ja
herkkyysvahvistuksen ilmaisimen  (B) -kuvake vilkkuu.

Kytke boken hallintatoiminto tilaan On.1

Avaa himmennin kokonaan.2

Aseta ND-suodattimen asetukseksi 1/128.3

Aseta herkkyysvahvistukseksi 0 dB ja varmista oikea valotus valaistuksen avulla.4

Säädä tarkennusta.5

Säädä himmennintä.

Boken määrä muuttuu.

6
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Yleistä määritystietojen tallentamisesta ja lataamisesta

Voit tallentaa laitteen asetukset määritystietoina verkkosovelluksella. Näin voit nopeasti palauttaa kulloiseenkin
tilanteeseen sopivat valikkoasetukset.
Tällä laitteella voit tallentaa lähes kaikki kameran toimintoihin liittyvät asetukset ALL-tiedostona (tiedosto, joka sisältää
kaikki asetukset), lukuun ottamatta alla olevaa huomautusta.

Huomautus

Verkon toimintoasetuksia ja tunnistautumistietoja ei tallenneta. Lisätietoja tallennetuista kohteista on kohdassa ”Valikkokohteiden
luettelo”.

Aiheeseen liittyvää

Valikkokohteiden luettelo

5-041-958-73(1) Copyright 2022 Sony Corporation
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ALL-tiedoston tallentaminen

Tässä osiossa käsitellään ALL-tiedoston tallentamista.

5-041-958-73(1) Copyright 2022 Sony Corporation

Avaa [Project] > [All File] verkkovalikossa.1

Paina [Save All File] > [Save]-painiketta.

Verkkoselain lataa tiedoston nimeltä all-file.ALL.

2

Määritä ladatulle all-file.ALL-tiedostolle sijainti ja tiedostonimi ja tallenna tiedosto.

Tietoja tiedostotoiminnoista saat laitteen käyttöohjeesta.

3
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ALL-tiedoston lataaminen

Tässä osiossa käsitellään ALL-tiedoston lataamista.

Huomautus

Laite käynnistyy automaattisesti uudelleen määritystietojen lataamisen jälkeen. Lataa sivu uudelleen verkkoselaimessa
uudelleenkäynnistyksen jälkeen.
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Avaa [Project] > [All File] verkkovalikossa.1

Paina [Load All File] > [Load]-painiketta.

Avaa tiedosto -valintaikkuna tulee näkyviin laitteella, jossa verkkosovellusta käytetään.

2

Avaa tiedosto, jonka haluat ladata.

Tietoja tiedostotoiminnoista saat laitteen käyttöohjeesta.

3

Kun Lataa tiedoston nimi -vahvistusnäyttö tulee näkyviin, paina [OK]-painiketta.4

Kun Toiminnan tulos -näyttö tulee näkyviin, paina [OK]-painiketta.5

Odota, että laite käynnistyy uudelleen, ja yhdistä sitten uudelleen verkkosovellukseen.6
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Tietoja tiedoston siirrosta

Voit ladata laitteeseen tallennetun alkuperäisen tiedoston tai välityspalvelintiedoston internetissä tai paikallisverkossa
sijaitsevalle palvelimelle.

Huomautus

Kun virransyöttö on virransäästötilassa, tiedostonsiirrot keskeytetään, vaikka laitteeseen syötetään edelleen virtaa.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Tiedostonsiirtokohteen rekisteröiminen

Siirron kohdepalvelimen voi rekisteröidä ennen tiedostonsiirron aloittamista.

Valitse verkkovalikossa [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (tai [Server
Settings2], [Server Settings3]).

Vihje

Valintavaihtoehdon nimi muuttuu seuraavassa vaiheessa määritettävän kohdan [Display Name] mukaan.

1

Määritä seuraavat kohteet verkkovalikon kohdassa [Network] > [FTP Server 1]–[FTP Server 3].

[Display Name]
Syötä palvelimen nimi, joka näytetään siirrettävien töiden listassa siirron kohdepalvelinta valittaessa.
[Service]
Näyttää palvelimen tyypin.
[FTP]: FTP-palvelin
[Host Name]
Syötä palvelimen osoite tai isäntänimi.
[Port]
Syötä palvelimen yhdistettävän portin numero.
[User Name]
Syötä käyttäjänimi.
[Password]
Syötä salasana.
[Passive Mode]
Kytke passiivitila päälle / pois päältä.
[Destination Directory]
Syötä kohdepalvelimen hakemiston nimi.

Huomautus

Jos [Destination Directory] -kohtaan syötetään kohdepalvelimella epäkelpoja merkkejä, tiedostot siirretään käyttäjän
kotihakemistoon. Epäkelvolliset merkit vaihtelevat palvelinkohtaisesti.

[Using Secure Protocol]
Määritä, suoritetaanko suojattu FTP-siirto.
[Root Certificate]
Lataa/tyhjennä varmenne.
[Load]: Lataa myöntäjän varmenne. Lataa PEM-muotoiset varmenteet.
[Clear]: Tyhjennä myöntäjän varmenne.
[None]: Älä lataa tai tyhjennä varmennetta.

Huomautus

Määritä laitteen kellonaika oikeaksi ennen myöntäjän varmenteen lataamista.

Kun tallennetaan tilassa XAVC-I 4096×2160P/3840×2160P 59.94/50P, [Load] ei ole valittavissa.

[Root Certificate Status]: Näyttää varmenteen latauksen tilan.

2
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[Reset]: Palauttaa Server Settings -asetukset oletuksiksi.
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Välityspalvelintiedoston lataaminen muistikortille pikkukuvanäytöstä

Välityspalvelintiedostoja voi ladata muistikortille yksittäin pikkukuvanäytöstä.

Huomautus

Enintään 200 siirtotyötä voidaan rekisteröidä.
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Paina [Thumbnail]-painiketta verkkosovelluksen suorassa käyttönäkymässä.

Näyttö muuttuu kameran kuvasta pikkukuvanäytöksi.

1

Valitse kameran valikossa [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip].

Siirrä kaikki välityspalvelintiedostot yhtä aikaa valitsemalla [Transfer Clip (Proxy)] > [All Clips].
Leikkeitä voidaan siirtää pikkukuvanäytöstä tai suodatetusta leikkeiden pikkukuvanäytöstä.

2

Valitse [Set]-painikkeen avulla leike, jonka haluat siirtää, ja paina sitten [Menu]-painiketta.

Näkyviin tulee siirronvahvistusnäyttö.

3

Valitse [Execute].

Valittua leikettä vastaava välityspalvelintiedosto rekisteröidään siirtotyöksi ja lataaminen alkaa.
Kun siirtotyö on onnistuneesti rekisteröity, näkyviin tulee siirtotulosnäyttö.

4

Paina [OK]-painiketta.5
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Alkuperäistiedoston lataaminen muistikortille pikkukuvanäytöstä

Alkuperäistiedoston voi ladata muistikortille pikkukuvanäytöstä.

Huomautus

Enintään 200 siirtotyötä voidaan rekisteröidä.
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Paina [Thumbnail]-painiketta verkkosovelluksen suorassa käyttönäkymässä.

Näyttö muuttuu kameran kuvasta pikkukuvanäytöksi.

1

Valitse kameran valikossa [Thumbnail] > [Transfer Clip] > [Select Clip].

Siirrä kaikki alkuperäistiedostot yhtä aikaa valitsemalla [Transfer Clip] > [All Clips].
Leikkeitä voidaan siirtää pikkukuvanäytöstä tai suodatetusta leikkeiden pikkukuvanäytöstä.

2

Valitse [Set]-painikkeen avulla leike, jonka haluat siirtää, ja paina sitten [Menu]-painiketta.

Näkyviin tulee siirronvahvistusnäyttö.

3

Valitse [Execute].

Valitun leikkeen alkuperäistiedosto rekisteröidään siirtotyöksi ja lataaminen alkaa.
Kun siirtotyö on onnistuneesti rekisteröity, näkyviin tulee siirtotulosnäyttö.

4

Paina [OK]-painiketta.5

264



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tiedostonsiirron tilan tarkistaminen

Voit tarkistaa tiedostonsiirron tilan valitsemalla kameran valikossa kohdan [Network] > [File Transfer] > [View Job List].

Huomautus

Enintään 200 siirtotyötä voidaan rekisteröidä.

Siirrettävät työt säilytetään, kun laite kytketään virransäästötilaan, mutta jopa 10 minuuttia äskettäisen etenemisen tiedosta voi
hävitä, jos virta kytketään pois jollakin muulla tavalla.

Jos siirron aikana ilmenee virhe, siirretyn leikkeen kanssa samannimisen leikkeen siirtoon palaaminen ei ehkä onnistu riippuen
asetuksista ja siirron kohdepalvelimen tilasta. Tarkista siinä tapauksessa siirron kohdepalvelimen asetukset ja tila.

Vihje

Jos kameran valikon kohdan [Network] > [File Transfer] > [Auto Upload (Proxy)] asetuksena on [On] ja verkkoyhteys on
muodostettu, välityspalvelintiedostot ladataan tallentamisen päättyessä automaattisesti palvelimelle, joka on määritetty kohdassa
[Default Upload Server].

5-041-958-73(1) Copyright 2022 Sony Corporation
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Lataaminen käyttämällä suojattua FTP:tä

Voit ladata FTPS-salattuja tiedostoja Explicit-tilassa (FTPES) kohdetiedostopalvelinyhteyttä varten.
Määritä salattua FTP-siirtoa varten kohdetiedostopalvelimen [Using Secure Protocol] -asetukseksi [On] ja lataa
varmenne.

Lisätietoja määrityksestä on kohdassa ”Tiedostonsiirtokohteen rekisteröiminen”.

Aiheeseen liittyvää
Tiedostonsiirtokohteen rekisteröiminen

5-041-958-73(1) Copyright 2022 Sony Corporation
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Tietoja suoratoistosta

Laite voi suoratoistaa HDMI-liittimestä lähetettävää kuvaa ja ääntä yhtä aikaa.

Huomautus

Jos haluat käyttää suoratoistoa päävideona aseta verkkovalikon kohdan [Monitoring] > [Output Display] > [SDI] asetukseksi [On]
ja kohdan [HDMI/Stream] asetukseksi [Off] ja tarkkaile kameran tilaa SDI-näytöltä.

Jos HDMI-liittimeen on kytkettynä näyttö, joka ei tule verkkovalikon tai kameran valikon [Monitoring]-valikossa määritettyä HDMI-
lähtömuotoa, kameran kuvaa ei lähetetä verkkosovellukseen. Suoratoistovideota ei myöskään voida lähettää.

Suoratoiston resoluutio ei voi olla suurempi kuin HDMI-lähtösignaalin resoluutio.

Kun kuvaa näytetään useille käyttäjille, se voi vääristyä koodekkiasetuksista riippuen.

Laite tukee seuraavia suoratoistomenetelmiä. Valittavana olevat videokoodekit näytetään suluissa.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Määritä suoratoistomuodon asetus, videokoodekin asetus ja äänikoodekin asetus tässä järjestyksessä.

●: käytössä, –: pois käytöstä

Vihje

Verkkosovelluksen kameran kuvapaneelin kuva on myös suoratoistojärjestelmä.

Suoratoistomuoto
Koodekkiasetus

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Web App – – ● –

RTMP voidaan valita, kun verkkovalikon valikon kohdan [Stream] > [Audio Stream] asetuksena on [On] .*1

Kun järjestelmän taajuus on 59.94 tai 50 ja HDMI-lähtömuoto on vähintään 3840×2160, video 2 -lähtö ei ole käytettävissä.*2
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Suoratoistomuodon määrittäminen

Aseta suoratoistomuoto verkkovalikon kohdassa [Stream] > [Stream] > [Stream Setting] > [Setting].

Kun kohdan [Setting] asetuksena on [RTSP]

RTSP-suoratoistossa yksittäisen kameran kuva voidaan näyttää samanaikaisesti enintään viidelle käyttäjälle.
Voit määrittää enintään kaksi videokoodekkitilaa.
[Port Number]
Määrittää RTSP-suoratoistoon käytettävän porttinumeron. Oletusarvona on 554.
Asetuksen muuttaminen käynnistää RTSP-palvelimen uudelleen.
[Time Out]
Määrittää RTSP-suoratoiston Keep-Alive-komennon aikakatkaisuajan. Aikakatkaisuaika voidaan määrittää välille 0–600
sekuntia. Oletusarvona on 60 sekuntia.
Kun ajaksi asetetaan 0 sekuntia, Keep-Alive-komennon aiheuttamaa aikakatkaisua ei tapahdu.
[Authentication]
Määrittää, tarvitaanko tunnistautumista.
[Video Port Number 1], [Video Port Number 2]
Määrittää RTSP-täsmälähetyssuoratoistossa käytettävän kuvatietoviestinnän porttinumeron. Kohdan Video Port Number
1 tehdasasetusarvo on 51000. Kohdan Video Port Number 2 tehdasasetusarvo on 53000. Syötä parillinen luku välillä
1024–65534. Tässä asetettu luku ja sitä seuraava pariton luku, joka saadaan lisäämällä 1, ovat ne kaksi porttinumeroa,
joita käytetään kuvatietoviestintään ja -hallintaan.
[Video Port Number 1] ja [Video Port Number 2] vastaavat kohtia [Stream] > [Video Stream] > [Video Stream 1] ja [Video
Stream 2].
[Audio Port Number]
Määrittää RTSP-täsmälähetyssuoratoistossa käytettävän äänitietoviestinnän porttinumeron. Oletusarvona on 57000.
Syötä parillinen luku välillä 1024–65534. Tässä asetettu luku ja sitä seuraava pariton luku, joka saadaan lisäämällä 1,
ovat ne kaksi porttinumeroa, joita käytetään äänitietoviestintään ja -hallintaan.

Kun kohdan [Setting] asetuksena on [RTMP]

RTMP:llä voidaan käyttää vain videokoodekkitilaa H.264. Jos haluat käyttää RTMP:tä, verkkovalikon kohdan [Stream] >
[Audio Stream] asetukseksi on valittava [On].
[Server URL]
Määrittää lähetyksen kohde-URL:n. Määritä merkkijono, joka alkaa ”rtmp://” tai ”rtmps://”.
[Stream Key]
Anna käyttämältäsi sivustolta saamasi suoratoistoavain. [Clear]-painikkeen painaminen tyhjentää kentän.

Huomautus

Ole varovainen suoratoistoavaimen käsittelyssä. Jos se joutuu kolmannen osapuolen tietoon, hän saattaa häiritä suoratoistoa.

[Root Certificate]
Tuo RTMPS-protokollaa käyttävässä suoratoistossa tarvittavan juurivarmenteen. Tuo juurivarmenne painamalla [Load]-
painiketta ja valitsemalla juurivarmenne. Tuo valittu tiedosto laitteeseen painamalla tiedostonvalintaikkunassa [OK]-
painiketta. Jos laitteeseen on jo tuotu juurivarmenne, se päivitetään. Jos haluat poistaa tuodun juurivarmenteen, paina
määritysnäytössä [Delete]-painiketta. Juurivarmenteen tila näkyy kohdassa [Root Certificate Status].

Huomautus

Tuo suoratoistopalvelun edellyttämä juurivarmenne.
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Kun kohdan [Setting] asetuksena on [SRT-Caller] tai [SRT-Listener]

Videon koodekkitila on ainoastaan H.264.
[Destination]
Näytetään, kun suoratoistotilan asetuksena on [SRT-Caller]. Määrittää yhteyden kohde-URL:n.
[Port Number]
Näytetään, kun suoratoistotilan asetuksena on [SRT-Listener]. Määrittää kuunneltavan portin numeron. Oletusarvona on
4201.
[Latency]
Määrittää viiveen välille 20–8000 ms. Oletusarvona on 120.
[TTL]
Määrittää TTL-arvon välille 1–255. Oletusarvona on 64.
[Encryption]
Valitsee salausmenetelmän. Valitse Off, AES128 tai AES256. Oletusarvona on Off.
[Passphrase]
Määrittää salaukseen käytettävän salasanan. [Clear]-painikkeen painaminen nollaa määritetyn salasanan.
[ARC]
Ota käyttöön Mukautuva nopeuden hallinta (ARC) -toiminto valitsemalla asetukseksi On.
Kun ARC-toiminto on käytössä, viestintälinjan tukosten aiheuttamia kuvahäiriöitä voidaan vähentää.

Kun kohdan [Setting] asetuksena on [NDI|HX]

Laite on yhteensopiva NewTekin NDI|HX-version 2 kanssa.
NDI|HX:n käyttöä varten on ostettava lisenssiavain.
Lisenssiavaimen ostaminen
Osta seuraavasta NewTek -URL-osoitteesta.
https://www.newtek.com/ndihx/products/upgrade/

Huomautus

Lataa uusin NDI|HX-ajuri ja asenna se NewTek -tuotteeseen.

Lisätietoja NDI|HX:n rekisteröinnistä ja toiminnasta on NewTek -tuotteen käyttöohjeessa.

[License]
Näyttää käyttöön otetun lisenssin lisenssitiedot.
[Source Name]
Näyttää lähteen nimen.
[Group]
Ota NDI-ryhmittelytoiminto käyttöön asettamalla arvoksi On.
[Group Name]: Määrittää NDI-ryhmän nimen. Useita asetuksia voidaan määrittää erottamalla ne pilkulla.
[Discovery Server 1], [Discovery Server 2]
Määrittää NDI-hakupalvelimen 1 ja NDI-hakupalvelimen 2.
[Reliable UDP Mode]
Ota Reliable UDP-tila käyttöön asettamalla arvoksi On.
[Multicast Mode]
Ota monilähetyssuoratoisto käyttöön asettamalla arvoksi On.
[Multicast Prefix]: Määrittää monilähetyssuoratoistossa käytettävän etuliitteen.
[Multicast Netmask]: Määrittää verkkomaskin, joka määrää monilähetyksen osoitevälin.
[Multicast TTL]: Määrittää monilähetyssuoratoiston TTL-arvon välille 1–256. Oletusarvona on 3.
[Multi-TCP Mode]
Ota Multi-TCP-tila käyttöön asettamalla arvoksi On.
[Unicast UDP Mode]
Ota Unicast UDP -tila käyttöön asettamalla arvoksi On.

Tietoja kolmannen osapuolen palveluista ja ohjelmistoista
Eri käyttöehtoja saatetaan soveltaa.
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Palveluiden ja ohjelmistopäivitysten toimittaminen voidaan keskeyttää tai lopettaa ilman ennakkoilmoitusta.
Palveluiden ja ohjelmistojen kuvausta voidaan muuttaa ilman ennakkoilmoitusta.
Erillistä rekisteröintiä ja tilausta saatetaan edellyttää.

Sony ei ole vastuussa mistään vaateista, joita käyttäjät tai kolmannet osapuolet tekevät muiden yritysten palveluiden ja
ohjelmistojen käytön vuoksi.
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Videokoodekin määrittäminen suoratoistoa varten

Määritä videokoodekki verkkovalikon kohdassa [Stream] > [Video Stream].

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Voit määrittää enintään kolme kuvakoodekkitilaa. Määritä seuraavat asetukset erikseen kullekin kuvatilalle.
[Video Stream 3] on käytössä verkkosovelluksen kameran kuvapaneelissa.

Huomautus

Kun kohdan [Stream] > [Stream Setting] > [Setting] asetuksena on [RTMP], [SRT-Caller] tai [SRT-Listener], jotkin [Video Stream
1]-, [Video Stream 2]- ja [Video Stream 3] -asetuksista ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) ovat
oletusarvoissa.

[Codec 1], [Codec 2], [Codec 3]
Valitse [H.264], [H.265] tai [Off]. Huomaa, että kohdan [Codec 1] asetuksena ei voi olla [Off]. Lisäksi kohdan [Codec 3]
asetuksena on [JPEG] (kiinteä).

Huomautus

Seuraavia oireita voi ilmetä eri asetusten yhdistelmistä riippuen, kuten kohtien [Codec 1], [Codec 2] ja [Codec 3] kuvakoosta,
kuvataajuudesta ja bittinopeudesta.

Lisääntynyt videoviive.
Kuvan ohittaminen videotoiston aikana.
Jaksottainen ääni.
Kameran hidas vaste eri komentoihin.
Kameran hidas vaste kaukosäätimen toimintoihin.
Kuvaruudun hitaat näyttö- ja määritystoiminnot.

Jos näitä oireita esiintyy, ratkaise ongelma pienentämällä kuvakoon, kuvataajuuden ja bittinopeuden parametrejä tai muuttamalla
muiden asetusparametrien arvoja.

Kun kohdan [Stream] > [Stream Setting] > [Setting] asetuksena on [RTMP], [SRT-Caller] tai [SRT-Listener], kohdan [Codec 1]
asetuksena on [H.264] (kiinteä). Kohdan [Codec 2] asetuksena on [Off] (kiinteä).

Kun HDMI-lähdön kuvakokoa tai järjestelmän taajuutta muutetaan, kohdan [Codec 2] asetuksena on [Off].

[Size 1], [Size 2], [Size 3]
Valitsee kamerasta suoratoistettavan kuvakoon.
Saatavilla olevat kuvakokovaihtoehdot vaihtelevat HDMI-lähdön kuvakoon mukaan.

Huomautus

Kun HDMI-lähdön kuvakokoa tai järjestelmän taajuutta muutetaan, suurin kuvakoko valitaan.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Määrittää kuvan kuvataajuuden.
”fps”-yksiköt osoittavat suoratoistettavien kuvien määrän sekunnissa.
Saatavilla olevat kuvataajuusvaihtoehdot vaihtelevat HDMI-lähdön kuvakoon mukaan.

Huomautus
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Kun HDMI-lähdön kuvakokoa tai järjestelmän taajuutta muutetaan, suurin kuvataajuus valitaan.

[I-Picture Mode 1], [I-Picture Mode 2]
Asettaa menetelmäksi, jolla H.264:n ja H.265:n I-kuvan syöttöintervalli määritetään, joko [Time] tai [Frame].
Ei voida määrittää kohteelle [Codec 3].
[Time]: Määrittää I-kuvan syöttöintervallin aikana.
[Frame]: Määrittää I-kuvan syöttöintervallin kuvien määränä.
[I-Picture Interval 1], [I-Picture Interval 2]
Määrittää I-kuvan syöttöintervallin sekuntiyksiköinä. Määrittää arvon välille 1–5 sekuntia. Oletusarvona on 1 sekunti.
Ei voida määrittää kohteelle [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Määrittää H.264:n ja H.265:n I-kuvan syöttöintervallin kuvien määränä välillä 15–300. Oletusarvona on 300 kuvaa.
Ei voida määrittää kohteelle [Codec 3].
[Profile 1], [Profile 2]
Määrittää H.264:n tai H.265:n kuvakoodekkiprofiilin.
[H.264]: Valitse profiili [high], [main] tai [baseline].
[H.265]: Valitse profiili [main] tai [main10]. Kun käytössä on kaksi videokoodekkia, vain [main]-profiilivalinta on
käytettävissä.
Kuvanpakkaustehokkuus nousee järjestyksessä [high], [main] ja [baseline]. Valitse profiili, jota järjestelmäsi tukee.
Kun kohdan [H.265] asetuksena on [main10], toimintatila on [main10], kun HDMI-lähtö on YCrCb, tai [main], kun HDMI-
lähtö on RGB.
Ei voida määrittää kohteelle [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Valitse [CBR] tai [VBR].
Jos haluat vakaan bittinopeuden, valitse [CBR]. Jos haluat säilyttää kuvanlaadun, valitse [VBR].
Ei voida määrittää kohteelle [Codec 3].

Huomautus

Todelliset suoratoistettavat kuvataajuus ja bittinopeus voivat olla eri kuin asetetut arvot kuvakoosta, kuvauskohtauksesta,
verkkoympäristöstä ja muista tekijöistä riippuen.

Kun kohdan [Stream] > [Stream Setting] > [Setting] asetuksena on [RTMP], [SRT-Caller] tai [SRT-Listener], kohdan [Bit Rate
Compression Mode 1] asetuksena on [CBR] (kiinteä).

[Bit Rate 1], [Bit Rate 2]
Voit määrittää videotoistokohtaisen bittinopeuden, kun kohdan [Bit Rate Compression Mode] asetuksena on [CBR].
Suuren bittinopeuden määrittäminen mahdollistaa korkealaatuisen videokuvan suoratoistamisen.
Ei voida määrittää kohteelle [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Määrittää kuvanlaadun välille 1–10. Arvo 10 määrittää parhaan kuvanlaadun. Oletusarvona on 6.
Laatuasetuksille [Quality 1] ja [Quality 2] voit määrittää H.264-kuvanlaadun asettamalla kohdan [Bit Rate Compression
Mode] asetukseksi [VBR] ja kohdan [Codec] asetukseksi [H.264]. Voit määrittää H.265-kuvanlaadun asettamalla kohdan
[Bit Rate Compression Mode] asetukseksi [VBR] ja kohdan [Codec] asetukseksi [H.265].
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Äänikoodekin määrittäminen suoratoistoa varten

Määritä äänikoodekki verkkovalikon kohdassa [Stream] > [Audio Stream].
[Setting]
Ota äänen suoratoisto käyttöön asettamalla arvoksi On.

Huomautus

Jotta voit valita RTMP:n, valitse asetukseksi aina ennalta On.

[Codec]
Valitsee äänen suoratoistoon käytettävän koodekin tyypin.
[AAC (256kbps)]: Valitse, jos haluat priorisoida äänen laadun.
[AAC (128kbps)]: Valitse, jos haluat priorisoida datakapasiteetin.
Tällä asetuksella ei ole vaikutusta laitteen tallentamaan leikkeeseen tai HDMI/SDI-signaaliin upotettuun äänisignaaliin.
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Suoratoiston aloittaminen/lopettaminen

Asetuksille [RTSP], [SRT-Listener] ja [NDI|HX]

Laite odottaa suoratoiston toimituspyyntöä.
Käynnistä asiakassovellus suoratoiston katselua varten ja siirry seuraavassa taulukossa olevaan URL-osoitteeseen.
Syötä laitteeseen määritetyt käyttäjänimi ja salasana.

<camera_address>: laitteen IP-osoite
<Port>: Kuuntelijan portti, joka on määritetty valikossa [Port Number]

Huomautus

Toistoa kaikissa sovelluksissa tai laitteissa ei taata.

Asetuksille [RTMP] ja [SRT-Caller]

Aloita suoratoisto painamalla [Stream now] -painiketta suoran käyttönäkymän  (Stream) -välilehdessä. Painikkeen
nimeksi tulee [Stop stream], ja [Stream]-kuvake tulee näkyviin kameran kuvapaneelin yläreunaan.
Lopeta suoratoisto painamalla [Stop stream] -painiketta suoratoiston aikana. Painikkeen nimeksi tulee jälleen [Stream
now], ja [Stream]-kuvake katoaa kameran kuvapaneelin yläreunasta.

Huomautus

Toistoa kaikissa sovelluksissa tai laitteissa ei taata.
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Suoratoistomuoto URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Tutustu NDI|HX-yhteensopivan asiakaslaitteen käyttöohjeeseen.
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Pikkukuvanäyttö

Kun painat toistotoimintojen näytön [Thumbnail]-painiketta tai infrapunakaukosäätimen THUMBNAIL-painiketta,
muistikortille tallennetut leikkeet näkyvät kameran kuvapaneelissa. Tätä kameran kuvapaneelin näkymää kutsutaan
pikkukuvanäytöksi.
Voit valita leikkeen pikkukuvanäytöltä ja ryhtyä toistamaan sitä.
[Thumbnail]-painikkeen painallus pikkukuvanäytöllä sulkee pikkukuvanäytön ja palaa kuvausnäkymään.

Huomautus

Vain parhaillaan valittuna olevassa tallennusmuodossa tallennetut leikkeet näytetään pikkukuvanäytöllä. Jos valittua tallennettua
leikettä ei näytetä, tarkista tallennusmuoto. Huomioi tämä erityisesti ennen tietovälineen formatointia (alustusta).

Näytön rakenne

Valitun leikkeen pikkukuva näytetään oranssilla taustalla.
Valitun leikkeen tiedot näytetään näytön alaosassa.
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Valittu muistikortti
Lukkokuvake tulee näkyviin oikeaan reunaan, jos muistikortti on kirjoitussuojattu.

1.

Leikkeen numero / leikkeiden kokonaismäärä2.

Pikkukuva (hakemistokuva)
Näyttää leikkeen hakemistokuvan. Kun leike tallennetaan, sen ensimmäinen kuva asetetaan automaattisesti
hakemistokuvaksi.
Leikkeen/kuvan tiedot näkyvät pikkukuvan alla. Voit vaihtaa näytettävät tiedot kameran valikon kohdassa [Thumbnail]
> [Customize View] > [Thumbnail Caption].

3.

Leikkeen nimi
Näyttää valitun leikkeen nimen.

4.

Tallennusmuoto
Näyttää valitun leikkeen tiedostomuodon.

5.

Erityiset tallennustiedot
Näyttää tallennusmuodon vain, jos leike tallennettiin käyttämällä erikoistallennustilaa.
Hidastetuissa ja nopeutetuissa leikkeissä kuvataajuus näkyy oikealla.

6.

Leikkeen kesto7.

Luontipäivä8.
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Tallennettujen leikkeiden toistaminen

Voit toistaa tallennettuja leikkeitä, kun laite on tallentamisen valmiustilassa (Stby).
Tässä osiossa käsitellään tallennettujen leikkeiden toistamista GUI-hallintapaneelin avulla.

Toista asettamalla muistikortti.1

Paina [Thumbnail]-painiketta.

Leikkeiden pikkukuvat tulevat näkyviin.

2

Siirrä kohdistin GUI-hallintapaneelin nuolipainikkeilla toistettavan leikkeen pikkukuvaan.3
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Huomautus

Leikkeiden välikohdissa voi olla hetkellisiä kuvavääristymiä tai näkyä still-kuvia. Tällöin laitetta ei voi käyttää.

Kun valitset leikkeen pikkukuvanäytöstä ja aloitat toiston, leikkeen alussa voi olla hetkellisiä kuvavääristymiä. Voit katsoa leikkeen
alun ilman vääristymiä keskeyttämällä toiston, palaamalla  (Edellinen) -painikkeen avulla leikkeen alkuun ja käynnistämällä
toiston uudelleen.
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Huomautus

Leikkeitä ei voi valita kosketustoiminnolla.

Paina GUI-hallintapaneelin [Set]-painiketta.

Toisto alkaa valitun leikkeen alusta.

4

Käytä toiston hallintapaneelia tarpeen mukaan.

Vihje

Voit myös hallita toimintoja GUI-hallintapaneelin avulla.

Toisto: Paina [Set]-painiketta.
Toiston keskeytys: Paina [Set]-painiketta toiston aikana. Palaa normaaliin toistoon painamalla uudelleen.
Siirtyminen leikkeen alkuun / seuraavan leikkeen alkuun: Paina vasenta/oikeaa painiketta.
Pikakelaus taakse/eteen: Pidä vasenta/oikeaa painiketta painettuna. Toisto palautuu normaalinopeuteen, kun painike
vapautetaan.
Toiston lopetus: Paina [Cancel/Back]-painiketta.

5

Painike Toiminto

 (Toisto/Tauko) -painike Toistaa leikkeen. Pysäyttää leikkeen toiston aikana.

 (Pikakelaus eteenpäin) -painike, 
(Pikakelaus taaksepäin) -painike

Toistaa leikkeen suurella nopeudella. Kun painiketta painetaan,
toistonopeus muuttuu kolmessa vaiheessa.

 (Edellinen) -painike,  (Seuraava) -
painike

Siirtyy leikkeen alkuun tai edelliseen/seuraavaan leikkeeseen.

 (Pysäytä)-painike Lopettaa toiston ja siirtyy kuvausnäyttöön.
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Tallennettujen leikkeiden toiminnot

Pikkukuvanäytössä voit tehdä leikkeille toimintoja tai tarkistaa leikkeen ominaisuudet kameran valikon [Thumbnail]-
valikossa.
Tuo kameran valikko näkyviin kameran kuvapaneelissa painamalla toistotoimintojen näytön [Menu]-painiketta.
Voit suorittaa seuraavia toimintoja kameran valikon [Thumbnail]-valikon avulla.
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Vihje

Voit tuoda kameran valikon näkyviin myös painamalla suoran käyttönäkymän [Menu]-painiketta.

Kameran valikon [Thumbnail]-valikon avulla suoritettava toiminnot
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Valitse suoritettava toiminto käyttämällä GUI-hallintapaneelin nuolipainikkeita ja paina [Set]-painiketta.
Palaa edelliseen näyttöön painamalla [Cancel/Back]-painiketta.

Huomautus

Joitakin kohteita ei voida valita riippuen siitä, missä tilassa valikko näytetään.

Leiketoimintojen valikkokohteet

Kameran valikon [Thumbnail]-valikossa on seuraavat leiketoimintoihin liittyvät valikkokohteet.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Lisätietoja kustakin valikkokohteesta on kohdassa ”[Thumbnail]-valikko”.

Leikkeen ominaisuusnäytön näyttäminen
Näytä leikkeen ominaisuudet valitsemalla kameran valikossa [Thumbnail] > [Display Clip Properties].
Siirry seuraavaan/edelliseen leikkeeseen painamalla  (Edellinen) -painiketta tai  (Seuraava) -painiketta.

Leikelippujen lisääminen
Voit lisätä leikkeisiin leikelippuja (OK-, NG- tai KP-merkkejä), jotta voit suodattaa näytettäviä leikkeitä leikelippujen avulla.
Valitse sen leikkeen pikkukuva, johon haluat lisätä leikelipun, ja valitse sitten leikelippu kameran valikon kohdassa
[Thumbnail] > [Set Clip Flag].

Vihje

Voit lisätä leikelippuja myös käyttämällä ohjelmoitavaa painiketta, johon leikelipputoiminto on ohjelmoitu.

Suodatetun pikkukuvanäytön näyttäminen
Näytä vain tietyllä lipulla varustetut leikkeet valitsemalla kameran valikossa [Thumbnail] > [Filter Clips] ja valitsemalla
leikelipputyyppi.
Näytä kaikki leikkeet valitsemalla [All].
Voit myös lajitella pikkukuvanäkymän lippujen mukaan painamalla [Display]-painiketta.

Leikkeiden poistaminen
Voit poistaa leikkeitä muistikorteilta.
Valitse kameran valikossa [Thumbnail] > [Delete Clip] > [Select Clip] tai [All Clips].
[Select Clip]: Poistaa valitun leikkeen. Useiden leikkeiden valitsemista tuetaan.
[All Clips]: Poistaa kaikki näytettävät leikkeet.

Pikkukuvanäytössä näkyvien tietojen muuttaminen
Voit muuttaa pikkukuvan alla näkyviä leikkeen/kuvan tietoja.

Asetus Lisätty leikelippu

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Valitse kameran valikossa [Thumbnail] > [Customize View] > [Thumbnail Caption] ja valitse näytettävät tiedot.
[Date Time]: Näyttää päivämäärän ja kellonajan, jolloin leike on luotu ja viimeksi muokattu.
[Time Code]: Näyttää aikakoodin.
[Duration]: Näyttää leikkeen keston.
[Sequential Number]: Näyttää kunkin pikkukuvan järjestysnumeron.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Kameran valikon määritykset

Kun GUI-hallintapaneelin [Menu]-painiketta tai infrapunakaukosäätimen MENU-painiketta painetaan, kameran valikko
vaadittujen kuvaus- ja toistoasetusten määrittämiseen tulee näkyviin kameran kuvapaneelissa.

Valikko sisältää seuraavat valikot.

Valikon määritykset

[User]-valikko
Sisältää käyttäjän määrittämät valikkokohteet.
Muokattavissa [Edit User Menu] -toiminnon avulla.
[Edit User]-valikko
Sisältää valikkokohteet [User]-valikon muokkaamiseen.
[Shooting]-valikko
Sisältää kuvaamiseen liittyvät asetukset.
[Project]-valikko
Sisältää projektin perusasetukset.
[Paint/Look]-valikko
Sisältää kuvanlaatuun liittyvät asetukset.
[Pan-Tilt]-valikko
Sisältää panerointiin/kallistukseen liittyvät asetukset.
[TC/Media]-valikko
Sisältää aikakoodeihin ja tallennusvälineisiin liittyvät asetukset.
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[Monitoring]-valikko
Sisältää videolähtöön ja kuvanäyttöön liittyvät asetukset.
[Audio]-valikko
Sisältää ääneen liittyvät asetukset.
[Thumbnail]-valikko
Sisältää pikkukuvanäyttöön liittyvät asetukset.
[Technical]-valikko
Sisältää teknisten kohteiden asetukset.
[Network]-valikko
Sisältää verkkoihin liittyvät asetukset.
[Maintenance]-valikko
Sisältää laiteasetukset, kuten kellon ja kielen.

Kameran valikon määritykset ja hierarkia

Taso 1 Taso 2

User
(tehdasasetukset)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Taso 1 Taso 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Taso 1 Taso 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Taso 1 Taso 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Kameran valikon käyttäminen

Kun GUI-hallintapaneelin [Menu]-painiketta tai infrapunakaukosäätimen MENU-painiketta painetaan, kameran valikko
vaadittujen kuvaus- ja toistoasetusten määrittämiseen tulee näkyviin kameran kuvapaneelissa.
Valikkoa käytetään GUI-hallintapaneelin painikkeiden avulla.

[Menu]-painike: Näytä kameran valikko. Piilota valikko painamalla uudelleen, kun kameran valikko on näkyvissä.
Nuolipainikkeet: Siirrä kohdistinta ylös/alas/vasemmalle/oikealle kameran valikossa painamalla nuolipainikkeita, jotta
voit valita valikkokohteita tai asetuksia.
[Set]-painike: Vahvista valittu kohde.
[Cancel/Back]-painike: Palaa edelliseen valikkoon. Vahvistamaton muutos peruuntuu.

Huomautus

Joitakin kohteita ei voida valita riippuen siitä, missä tilassa valikko näytetään.

Valikkokohteiden määrittäminen

Siirrä kohdistin haluamasi kohteen kohdalle GUI-hallintapaneelin nuolipainikkeilla ja vahvista asetus painamalla [Set]-
painiketta.

Valikkokohteen valinta-alue näyttää enintään kahdeksan riviä. Jos kohteen saatavilla olevat vaihtoehdot eivät näy
samaan aikaan, vieritä näyttöä siirtämällä kohdistinta ylös/alas.
Alakohteissa, joissa on suuri asetusalue (esimerkiksi −99–+99), asetusalue ei ole näkyvissä. Nykyinen asetus on
korostettu, mikä tarkoittaa, että arvoa voidaan muuttaa.
Kun valitset toiminnolle kohdan [Execute], kyseinen toiminto suoritetaan.
Jos valitset kohteen, joka edellyttää vahvistusta ennen suorittamista, valikko piilotetaan tilapäisesti ja vahvistusviesti
tulee näkyviin. Tarkista viesti ja valitse sitten, haluatko suorittaa vai peruuttaa toiminnon.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Merkkijonon syöttäminen

Kun valitset kohteen, kuten tiedostonimen, joka edellyttää merkkien syöttämistä, näkyviin tulee merkkiensyöttönäyttö.

5-041-958-73(1) Copyright 2022 Sony Corporation

Valitse merkkityyppi ja vahvista asetus käyttämällä GUI-hallintapaneelin nuolipainikkeita.

[ABC]: Aakkosmerkit isoin kirjaimin
[abc]: Aakkosmerkit pienin kirjaimin
[123]: Numeromerkit
[!#$]: Erikoismerkit

1

Valitse merkki ja vahvista asetus painamalla [Set]-painiketta.

Kohdistin siirtyy seuraavaan kenttään.
[Space]: Lisää välilyönnin kohdistimen kohdalle.
[←] [→]: Siirtää kohdistinta.
[BS]: Poistaa merkin kohdistimen vasemmalta puolelta (askelpalautin).

2

Kun olet valmis, ota asetukset käyttöön painamalla [Done]-painiketta.

Merkkijono vahvistetaan ja merkkiensyöttönäyttö poistuu.

3
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User

Tässä osiossa käsitellään kunkin valikkokohteen toimintoja ja asetuksia.

Huomautus

Voit lisätä ja poistaa valikkokohteita [User] -valikossa käyttämällä [Edit User] -valikkoa. Enintään 20 kohdetta voidaan määrittää.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Kuvaus

Base Setting Project > Base Setting

Focus Shooting > Focus

S&Q Motion Shooting > S&Q Motion

LUT On/Off Shooting > LUT On/Off

Simul Rec Project > Simul Rec

Proxy Rec Project > Proxy Rec

Interval Rec Project > Interval Rec

Picture Cache Rec Project > Picture Cache Rec

Assignable Button Project > Assignable Button

Scene File Project > Scene File

Base Look Paint/Look > Base Look

P/T Acceleration Pan-Tilt > P/T Acceleration

Clip Name Format TC/Media > Clip Name Format

Format Media TC/Media > Format Media

Video Signal Monitor Monitoring > Video Signal Monitor

Marker Monitoring > Marker

Zoom Technical > Zoom

Lens Technical > Lens

Edit User Menu Näyttää Edit User -valikon.
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Edit User

[Edit User] -valikko näkyy yläosassa, kun [User]-valikosta on valittuna [Edit User Menu].

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Add Item
Lisää kohde [User]-valikkoon

– – Lisää tason 2 kohteen [User]-valikkoon.

Customize Reset
Nollaa [User]-valikon kohteet

– –
Palauttaa [User]-valikkoon rekisteröidyt
valikkokohteet tehdasasetuksin.

Muokkauksen aikana valittu
tason 2 valikkokohde

Delete –
Poistaa rekisteröidyn tason 2 valikkokohteen
[User]-valikosta.

Move –
Järjestää rekisteröidyt valikkokohteet uudelleen
[User]-valikossa.

Edit Sub Item –
Muokkaa (rekisteröi/poistaa) rekisteröidyn tason 3
valikon alakohteen [User]-valikosta.
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ISO/Gain/EI

Määrittää herkkyysvahvistusasetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Mode ISO/dB dB
Valitsee herkkyysvahvistusasetuksen
tilan.

ISO/Gain<L>

Lisätietoja asetuksista on
kohdassa ”ISO/Gain -
asetukset ja oletusarvot”.

– Määrittää herkkyysvahvistuksen
esiasetetun arvon <L>.

Exposure
Index<L>

Kun Base ISO on ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Kun Base ISO on ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Kun Base ISO on ISO
800: 800EI / 6.0E
Kun Base ISO on ISO
12800: 12800EI / 6.0E

Määrittää Exposure Index<L> -arvon.

Shockless
Gain

On / Off Off
Kytkee herkkyysvahvistuksen siirtymän
pehmennystoiminnon päälle / pois päältä.

Base
Sensitivity

High / Low Low
Määrittää perusherkkyyden Custom-
tilassa.

Base ISO ISO 12800 / ISO 800 ISO 800
Määrittää ISO perusherkkyyden Cine
EI/Flexible ISO -tilassa.
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Aiheeseen liittyvää
ISO/Gain -asetukset ja oletusarvot

5-041-958-73(1) Copyright 2022 Sony Corporation
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ND Filter

Määrittää ND-suodattimen esiasetetut arvot.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Mode Preset / Variable Variable Valitsee ND-suodatintilan.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Määrittää ND-suodattimen esiasetuksen 1 arvon.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Määrittää ND-suodattimen esiasetuksen 2 arvon.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Määrittää ND-suodattimen esiasetuksen 3 arvon.
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Shutter

Määrittää elektronisen sulkimen toiminnan.
Käytetään nopeasti liikkuvien kohteiden kuvaamiseen selkeästi.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Mode Speed / Angle Speed

Valitsee tilan suljinajan
määrittämiseksi sekunteina
(Speed) tai suljinkulmana
(Angle).

Shutter
Speed
On/Off

On / Off Off

Määrittää, vastaako valotusaika
Speed-tilassa [Shutter Speed] -
arvoa vai määritetäänkö se
täydelle valotukselle.

Shutter
Speed

64F–1/8000
Saatavilla olevat asetukset riippuvat valitun
videomuodon kuvataajuudesta.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250
/ 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 / 1/96
/ 1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Määrittää suljinajan, kun Speed-
tila on valittuna.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° / 210.0°
/ 180.0° / 172.8° / 150.0° / 144.0° / 120.0° / 90.0°
/ 86.4° / 72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0°
Määrittää suljinkulman, kun
Angle-tila on valittuna.

ECS On/Off On / Off Off
Kytkee Extended Clear Scan -
toiminnon päälle / pois päältä.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

ECS
Frequency

23.99–8000
Saatavilla olevat asetukset riippuvat valitun
tallennusmuodon kuvataajuudesta.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Määrittää ECS-taajuuden, kun
kohdan Mode asetuksena ECS
Frequency.
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Iris

Määrittää himmenninasetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Bokeh Control On / Off Off Kytkee boken hallintatoiminnon päälle / pois päältä.
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Auto Exposure

Määrittää automaattivalotuksen säädän asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 /
+1.75 / +1.5 / +1.25 / +1.0 / +0.75 /
+0.5 / +0.25 / ±0 / −0.25 / −0.5 /
−0.75 / −1.0 / −1.25 / −1.5 / −1.75 /
−2.0 / −2.25 / −2.5 / −2.75 / −3.0

±0
Määrittää kirkkaustason automaattisesti
havaittua valotusta varten.

Mode Backlight / Standard / Spotlight Standard

Määrittää automaattivalotuksen säädön
toimintatilan.
Backlight: Taustavalotila (tila vähentää
kohteen tummenemista, kun kohde on
taustavalaistu)
Standard: Vakiotila
Spotlight: Kohdevalotila (tila vähentää
valkoisten alueiden leikkautumista, kun kohde
on kohdevalaistu)

Speed −99–+99 ±0 Määrittää automaattivalotuksen säädön
säätönopeuden.

AGC On / Off Off
Kytkee AGC-toiminnon (automaattinen
herkkyysvahvistuksensäätö) päälle / pois
päältä.

AGC Limit

Lisätietoja asetuksista on
kohdassa ”AGC Limit -asetukset
ja oletusarvot”.

–
Määrittää AGC-toiminnon
enimmäisherkkyysvahvistuksen.

AGC Point F2.8 / F4 / F5.6 F2.8
Määrittää himmentimen aukkoarvon, jossa
AGC:n toiminta alkaa, kun AGC-toiminnon
asetuksena on On.

Auto
Shutter

On / Off Off
Kytkee automaattisen
sulkimenhallintatoiminnon päälle / pois päältä.

A.SHT
Limit

1/100 / 1/150 / 1/200 / 1/250 /
1/2000

1/2000
Määrittää automaattisen suljintoiminnon
nopeimman suljinajan.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Määrittää himmentimen aukkoarvon, jossa
automaattisen sulkimen toiminta alkaa.

Clip High
light

On / Off Off
Kytkee päälle / pois päältä toiminnon, joka
jättää huomiotta kirkkaimmat alueet
tasatakseen vastetta suurella luminanssilla.

299



Aiheeseen liittyvää

AGC Limit -asetukset ja oletusarvot
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Määrittää valonmittausalueen valotuksen
automaattiseen säätämiseen kohteen
kirkkauden mukaan. (Ei saatavilla, kun
valotusta säädetään käsin)

Detect
Window
Indication

On / Off Off
Kytkee valonmittausalueen ilmaisimen
päälle / pois päältä.

Custom
Width

40–999 500 Määrittää valonmittausalueen leveyden.

Custom
Height

70–999 500 Määrittää valonmittausalueen korkeuden.

Custom H
Position

−479–+479 ±0
Määrittää valonmittausalueen
vaakasuunnassa.

Custom V
Position

−464–+464 ±0 Määrittää valonmittausalueen pystysuunnassa.
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White

Määrittää valkotasapainon asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Preset
White

2000K–
15000K

3200K Määrittää valkotasapainon esiasetetun arvon.

Color
Temp <A>

2000K–
15000K

3200K

Määrittää muistiin A tallennetun valkotasapainon värilämpötilan.

Huomautus

Koska Color Temp leikkautuu arvoissa 2000K ja 15000K R Gain/B Gain
-toiminnon aikana, R Gain/B Gain -arvolle ei välttämättä voida näyttää
oikeaa Color Temp -arvoa.

Tint<A> −99–+99 ±0

Määrittää muistiin A tallennetun valkotasapainon sävyn arvon.

Huomautus

Koska Tint leikkautuu arvossa ±99 R Gain/B Gain-toiminnon aikana, R
Gain/B Gain-arvolle ei välttämättä voida näyttää oikeaa sävyarvoa.

R Gain
<A>

−99.0–+99.0 ±0.0
Määrittää muistiin A tallennetun valkotasapainon R-
herkkyysvahvistusarvon.

B Gain
<A>

−99.0–+99.0 ±0.0
Määrittää muistiin A tallennetun valkotasapainon B-
herkkyysvahvistusarvon.
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White Setting

Säätää valkotasapainon asetuksia.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Shockless
White

Off / 1 / 2 / 3 2

Määrittää valkotasapainon vasteajan, kun valkotasapainotilaa
muutetaan.
Off: Vaihtuu välittömästi.
1–3: Vaihtuu sitä hitaammin mitä suurempi numero.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Määrittää vasteajan ATW-tilassa.
Nopein vastenopeus on 1 ja hitain vastenopeus on 5.
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Offset White

Määrittää valkotasapainon poikkeama-asetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Offset White <A> On / Off Off
Valitsee, lisätäänkö (On) vai eikö lisätä (Off) poikkeama-arvo
valkotasapainolle muistissa A.

Offset Color
Temp<A>

−99–+99 ±0
Määrittää värilämpötilan poikkeaman, joka lisätään
valkotasapainoon muistissa A, kun kohdan [Offset White <A>]
asetuksena on On.

Offset Tint<A> −99–+99 ±0
Määrittää sävyarvon poikkeaman, joka lisätään
valkotasapainoon muistissa A, kun kohdan [Offset White <A>]
asetuksena on On.

Offset
White<ATW>

On / Off On
Valitsee, lisätäänkö (On) vai eikö lisätä (Off) poikkeama-arvo
ATW-valkotasapainolle.

Offset Color
Temp<ATW>

−99–+99 ±0
Määrittää värilämpötilan poikkeaman, joka lisätään ATW-
valkotasapainoon, kun kohdan [Offset White<ATW>]
asetuksena on On.

Offset Tint<ATW> −99–+99 ±0
Määrittää sävyarvon poikkeaman, joka lisätään ATW-
valkotasapainoon, kun kohdan [Offset White<ATW>]
asetuksena on On.
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Focus

Määrittää tarkennusasetukset.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
Määrittää tarkennusnopeuden tilanteisiin, joissa kohde vaihtuu
automaattitarkennuksen aikana.

AF Subj.
Shift Sens.

1(Locked On) / 2 /
3 / 4 /
5(Responsive)

5(Responsive)
Määrittää kohteenvaihtumisherkkyyden automaattitarkennuksen
aikana.

Focus Area Wide / Zone /
Flexible Spot

Wide

Määrittää tavoitealueen automaattitarkennukselle ja tilapäiselle
automaattitarkennukselle (AF).

Ks. ”Tarkennuksen säätäminen automaattisesti (Auto
Focus)” ja ”Automaattitarkennusalueen/-kohdan
määrittäminen (Focus Area)”.

Wide: Hakee kohdetta tarkennettaessa kuvan laajakulmasta.
Zone: Hakee automaattisesti tarkennuskohdan määritetyltä
alueelta.
Flexible Spot: Tarkentaa kuvan tiettyyn kohtaan.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Määrittää tavoitealueen tilapäiselle automaattitarkennukselle
(AF-S).

Face/Eye
Detection
AF

Face/Eye Only AF
/
Face/Eye Priority
AF / Off

Face/Eye
Priority AF

Ottaa käyttöön / poistaa käytöstä kasvojentunnistuksen
automaattitarkennuksen.

Ks. ”Tarkentaminen käyttämällä kasvojen-/silmientunnistusta
(Face/Eye Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Määrittää tilapäisen automaattitarkennuksen tilan.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Määrittää toiminnon, kun kameran kuvanäyttöä kosketetaan
MF-tilassa verkkosovelluksen suorassa käyttönäkymässä.

AF Assist On / Off On

Kun asetuksena on On, sallii automaattitarkennuksen tilapäisen
ohituksen ja tarkentamisen käsin.

Ks. ”Automaattitarkennuksen kohteen asettaminen käsin
(AF Assist) verkkosovelluksen avulla” ja ”Tarkentaminen
käsin automaattitarkennuksen aikana mukana toimitettavan
infrapunakaukosäätimen avulla”.
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Aiheeseen liittyvää
Automaattitarkennusalueen/-kohdan määrittäminen (Focus Area)

Tarkentaminen käyttämällä kasvojen-/silmientunnistusta (Face/Eye Detection AF)

Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen avulla

Tarkentaminen käsin automaattitarkennuksen aikana mukana toimitettavan infrapunakaukosäätimen avulla

5-041-958-73(1) Copyright 2022 Sony Corporation
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S&Q Motion

Määrittää hidastus- ja nopeutustilan asetukset (ks. ”Hidastus ja nopeutus”).

Aiheeseen liittyvää
Hidastus ja nopeutus
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off
Kytkee hidastus- ja nopeutustilan päälle / pois
päältä.

Frame
Rate

1fps – 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Määrittää hidastetun ja nopeutetun kuvaamisen
kuvataajuuden.

Huomautus

Saatavilla olevat asetukset riippuvat valitusta
järjestelmän taajuudesta, koodekista ja
videomuodosta.
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LUT On/Off

Määrittää LUT-asetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

SDI MLUT On / MLUT Off MLUT Off
Valitsee, lisätäänkö Monitor LUT -tiedosto SDI-
lähtövideoihin.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Valitsee, lisätäänkö Monitor LUT -tiedosto HDMI:n
ja suoratoiston lähtövideoihin.

Proxy MLUT On / MLUT Off MLUT Off
Valitsee, lisätäänkö Monitor LUT -tiedosto
välityspalvelimelle tallennettaviin videoihin.

Internal Rec MLUT On / MLUT Off MLUT Off Valitsee, lisätäänkö Monitor LUT -tiedosto
pääasiallisiin tallennettaviin videoihin.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI
ja HDMI/Stream

HDMI/Stream
Määrittää tavoitelähdön, jota hallitaan
ohjelmoitavalla painikkeella, johon LUT On/Off on
ohjelmoitu.
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Noise Suppression

Määrittää kohinanpoiston asetukset.

Vihje

[Setting(Custom)]- ja [Level(Custom)]-asetukset vaikuttavat [Target Display] -asetukseen.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting(Custom) On / Off On
Kytkee kohinanpoistotoiminnon päälle / pois päältä
Custom-tilassa.

Level(Custom) Low / Mid / High Mid Määrittää kohinanpoistotason Custom-tilassa.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Kytkee kohinanpoistotoiminnon päälle / pois päältä
Log-kuvaustilassa.

Level (Cine EI/Flex.
ISO) Low / Mid / High Mid Määrittää kohinanpoistotason Log-kuvaustilassa.
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Flicker Reduce

Määrittää värinänkorjausasetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Mode Auto / On / Off Off Määrittää värinänkorjaustilan.

Frequency 50Hz / 60Hz 60Hz
Määrittää valoa tuottavan, värinää aiheuttavan virtalähteen
taajuuden.
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SteadyShot

Määrittää kuvanvakautusasetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting
Active / Standard
/ Off

Off

Määrittää kuvanvakautustoiminnon.

Huomautus

Käytössä, kun yhteensopiva objektiivi on kiinnitettynä.

Kun asetuksena on Active tai Standard, panorointi-/kallistustoimintojen
aikana voi esiintyä odottamatonta toimintaa.
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Base Setting

Määrittää perusasetukset.

Aiheeseen liittyvää

Perustoimintojen määrittäminen
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Määrittää kuvaustilan.

Ks. ”Kuvaustilan määrittäminen” osiossa
”Perustoimintojen määrittäminen”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Määrittää tallennuksen/lähdön värialueen Custom-
tilassa.
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Rec Format

Määrittää tallennusmuodon asetukset.

[RAW Output Format] -asetukset

Oletusarvot näytetään lihavoituna.
Ehdot, joissa [RAW Output Format] ei ole määritettävissä, on jätetty pois.

[Video Format] -asetukset

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94 Valitsee järjestelmän taajuuden.

Imager Scan
Mode

FF / S35 FF Valitsee kuvakennon koon.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Määrittää leikkeen tallennus-/toistokoodekin.

Huomautus

Kun kohdan [Imager Scan Mode] asetuksena
on [S35], [RAW] ja [RAW & XAVC-I] eivät ole
valittavissa.

RAW Output
Format

Saatavilla olevat asetukset
riippuvat [Frequency]-
asetuksista.

Ks. ”[RAW Output Format] -
asetukset” alla.

–

Määrittää RAW-kuvan koon ulkoiseen RAW-
tallentimeen lähettämiseksi.

Huomautus

Kun kohdan [Codec] asetuksena on [RAW &
XAVC-I], [Video Format] -asetus muuttuu
yhdessä [RAW Output Format] -asetuksen
kanssa.

Video
Format

Saatavilla olevat asetukset
riippuvat [Frequency]-, [Imager
Scan Mode]- ja [Codec]-
asetuksista.

Ks. ”[Video Format] -
asetukset” alla.

– Määrittää kuvakoon ja bittinopeuden.

Frequency Imager Scan Mode Codec Asetus

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Oletusarvot näytetään lihavoituna.

5-041-958-73(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Asetus

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Asettaa Log-kuvaustilan asetukset (ks. ”Kuvaustilan määrittäminen” osiossa ”Perustoimintojen määrittäminen”).

Aiheeseen liittyvää

Perustoimintojen määrittäminen
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Asettaa Log-kuvaustilojen ([Flexible ISO], [Cine
EI Quick], [Cine EI]) värialueen.

Embed
LUT File

On / Off On
Kytkee 3D LUT -tiedoston (CUBE-tiedosto)
metadatan tallennuksen päälle / pois päältä.
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Simul Rec

Määrittää 2-paikkaisen samanaikaisen tallennustilan asetukset (ks. ”Muistikorteille A ja B tallentaminen samanaikaisesti
(2 paikan Simul Rec)”).
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off
Kytkee 2 paikan samanaikaisen
tallennustoiminnon tilan
päälle / pois päältä.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:<Slot
A> 2nd Rec Button:<Slot B> / Rec Button:
<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A>
<Slot B> 2nd Rec Button:
<Slot A> <Slot B>

Ohjelmoi kunkin
tallennusvälineen ohjaamiseen
käytettävät tallennuspainikkeet.
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Proxy Rec

Määrittää Välityspalvelimelle tallentaminen -tilan asetukset (ks. ”Välityspalvelimelle tallentaminen”).

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off Kytkee välityspalvelintallennuksen päälle / pois päältä.

Audio Channel CH1/CH2 / CH3/CH4 CH1/CH2 Valitsee välityspalvelintietojen tallentamisen äänikanavan.

316



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Interval Rec

Määrittää intervallikuvaustilan asetukset (ks. ”Videon tallentaminen jaksottaisesti (Interval Rec)”).
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off
Kytkee intervallikuvauksen päälle / pois
päältä. (Kun tämä tila asetetaan tilaan
On, muut erikoistilat siirtyvät tilaan Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hour)

1
Määrittää tallennusten välisen aikavälin
Interval Rec -tallennustilassa (kun
kohdan Interval Rec asetuksena on On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Saatavilla olevat asetukset
riippuvat valitun videomuodon
kuvataajuudesta.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Määrittää tallennettavien kuvien
lukumäärän kuvauskertaa kohti Interval
Rec -tallennustilassa (kun kohdan
Interval Rec asetuksena on On).
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Picture Cache Rec

Määrittää Picture Cache -tallennustilan asetukset (ks. ”Kuvien tallentaminen välimuistiin (Picture Cache Rec)”).

Aiheeseen liittyvää

Kuvien tallentaminen välimuistiin (Picture Cache Rec)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off Kytkee kuvan välimuistitoiminnon päälle / pois päältä.

Cache Size
Short / Medium / Long
/ Max

Max
Määrittää ajan, jolta kuvia kerätään kuvavälimuistiin
(kuvavälimuistin tallennusaika).

Cache Rec
Time

– –
Näyttää ajan, jolta kuvia kerätään kuvavälimuistiin
(kuvavälimuistin tallennusaika).
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SDI/HDMI Rec Control

Määrittää SDI/HDMI-tallennuksen ohjausasetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Määrittää ulkoisella, liitetyllä laitteella tallennuksen
alkamisen/päättymisen ohjauksen SDI/HDMI-lähtösignaalin kautta.
Off: Älä käytä kaukosäädintä.
SDI/HDMI Remote I/F: Ulkoisella liitetyllä laitteella tallennuksen
alkamisen/päättymisen ohjaus, kun laitteeseen ei ole asetettu
tietovälinettä. Kuvien oikea-aikaisuutta ei synkronoitu laitteen
tietovälineen kanssa.
Parallel Rec: Ulkoisella liitetyllä laitteella tallennuksen
alkamisen/päättymisen ohjaus, kun laitteeseen on asetettu
tietoväline. Kuvien oikea-aikaisuus synkronoitu laitteen tietovälineen
kanssa.

Huomautus

Määritä HDMI-lähtösignaalin hallinta kameran valikossa valitsemalla
kohdan [TC/Media] > [HDMI TC Out] > [Setting] asetukseksi [On].
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Assignable Button

Määrittää ohjelmoidut toiminnot ohjelmoitaville painikkeille (<1>–<9>) ja [Focus Hold Button] -painikkeelle.
Ohjelmoitavissa ovat seuraavat toiminnot.
[Off]: Ei ohjelmoitua toimintoa.
[Base ISO/Sensitivity]: Vaihtaa kuvakennon perusherkkyyden.
[AGC]: Kytkee AGC-toiminnon päälle / pois päältä.
[Push AGC]: Mahdollistaa AGC-toiminnon painikkeen painalluksella.
[ND Filter]

Variable-tilassa: Säätää ND-suodattimen lähetystä. Vaihda Clear/Manual/Auto-asetusten välillä pitämällä painettuna.
Preset-tilassa: Vaihda esiasetuksia pitämällä painettuna.

[ND Filter Position]: Vaihtaa ND-suodattimia.
[Auto ND Filter]: Kytkee automaattisen ND-suodatintoiminnon päälle / pois päältä.
[Push Auto ND]: Mahdollistaa automaattisen ND-suodatintoiminnon painikkeen painalluksella.
[Auto Iris]: Kytkee himmennintoiminnon päälle / pois päältä.
[Push Auto Iris]: Mahdollistaa automaattisen himmennintoiminnon painikkeen painalluksella.
[Bokeh Control]: Kytkee boken hallintatilan päälle / pois päältä.
[Auto Shutter]: Kytkee automaattisen suljintoiminnon päälle / pois päältä.
[AE Level/Mode]: Säätää AE-tasoa. Vaihda AE-tilaa pitämällä painettuna.
[Backlight]: Vaihtaa asetusten Backlight ja Standard välillä.
[Spotlight]: Vaihtaa asetusten Spotlight ja Standard välillä.
[Preset White Select]: Vaihtaa valkotasapainon esiasetetun tilan arvon.
[ATW]: Kytkee ATW-toiminnon päälle / pois päältä.
[ATW Hold]: Keskeyttää ATW-toiminnon.
[AF Speed/Sens.]: Vaihtaa automaattitarkennuksen siirtymisnopeuden asetuksen ja automaattitarkennuksen
kohteenvaihtumisherkkyyden asetuksen.
[Focus Setting]: Määrittää tarkennusalueen.
[Face/Eye Detection AF]: Vaihtaa kasvojentunnistuksen automaattitarkennuksen asetukset.
[Push AF Mode]: Vaihtaa Push AF -tilan asetuksen.
[Push AF/MF]: MF-tarkennustilassa aktivoi automaattitarkennuksen painikkeen painalluksella. AF-tarkennustilassa
aktivoi manuaalitarkennuksen painikkeen painalluksella.
[Focus Hold]: AF-tarkennustilassa tarkennus lukittuu painikkeen painalluksella.
[S&Q Motion]: Kytkee hidastus- ja nopeutustilan päälle / pois päältä. Määrittää kuvaamisen kuvataajuuden pitkään
painettaessa.
[LUT On/Off]: Kytkee LUT-toiminnon päälle / pois päältä. Vaihtokohde asetetaan kohdassa [Shooting] > [LUT On/Off] >
[LUT On/Off Button Target].
[SteadyShot]: Vaihtaa asetusten Active, Standard ja Off välillä.
[Crop Select]: Vaihtaa Imager Scan Mode. Vaihtaminen on käytössä alueen sisällä muuttamatta tallennusmuotoa.
[Rec]: Aloittaa/pysäyttää tallentamisen.
[Picture Cache Rec]: Kytkee kuvan välimuistitallennuksen päälle / pois päältä.
[Rec Review]: Kytkee tallennuksen tarkastustoiminnon päälle / pois päältä.
[Clip Flag OK]: Suorittaa Add OK. Suorita Delete Clip Flag painamalla kahdesti.
[Clip Flag NG]: Suorittaa Add NG. Suorita Delete Clip Flag painamalla kahdesti.
[Clip Flag Keep]: Suorittaa Add KEEP. Suorita Delete Clip Flag painamalla kahdesti.
[Slot Select]: Vaihtaa muistipaikkojen (A) ja (B) välillä.
[Color Bars]: Kytkee väripalkit päälle / pois päältä.
[DURATION/TC/U-BIT]: Vaihtaa asetusten Time Code, Users Bit ja Duration välillä.
[Display]: Kytkee näytön ilmaisimet päälle / pois päältä.
[Lens Info]: Vaihtaa terävyysalueen ilmaisinta.
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[Video Signal Monitor]: Vaihtaa videosignaalin näyttöä (kuten aaltomuoto).
[Marker]: Kytkee merkkitoiminnon päälle / pois päältä.
[Thumbnail]: Näyttää pikkukuvanäytön / poistuu pikkukuvanäytöstä.
[Auto Upload (Proxy)]: Kytkee välityspalvelintiedoston automaattisen siirron päälle / pois päältä.
[Direct Menu]: Näyttää suoravalikon / poistuu suoravalikosta.
[User Menu]: Näyttää User-valikon / poistuu valikosta.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Scene File

Määrittää kohtaustiedostoihin liittyvät asetukset (ks. ”Kuvaaminen halutulla ulkoasulla”).
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Recall – –

Lataa sisäiseen muistiin tallennetun
kohtaustiedoston ja ottaa käyttöön
asetukset nykyisinä
kuvanlaatuasetuksina.

Store – –
Tallentaa nykyisen kuvanlaatutilan
kohtaustiedostona sisäiseen muistiin.

Delete – – Poistaa sisäiseen muistiin tallennetun
kohtaustiedoston.

Preset
Recall

Kun kohdan Shooting Mode asetuksena
on Custom ja kohdan Target Display
asetuksena on SDR(BT.709): S-Cinetone /
Standard / Still / ITU709/ 709tone
Kun kohdan Shooting Mode asetuksena
on Custom ja kohdan Target Display
asetuksena on HDR(HLG): HLG Live / HLG
Natural

–

Ottaa käyttöön esiasetetut
kuvanlaatuasetukset (ei
uudelleenkirjoitettavat) nykyisinä
kuvanlaatuasetuksina.
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Base Look

Määrittää perusulkoasuun liittyvät asetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Select

Kun kohdan Shooting Mode
asetuksena on Custom ja kohdan
Target Display asetuksena on
SDR(BT.709): S-Cinetone / Standard /
Still / ITU709 / 709tone / User1–User16
Kun kohdan Shooting Mode
asetuksena on Custom ja kohdan
Target Display asetuksena on
HDR(HLG): HLG Live / HLG Natural /
User1–User16
Kun kohdan Shooting Mode
asetuksena on Log-kuvaustilat: s709 /
709(800) / S-Log3 / User1–User16

Kun kohdan Shooting Mode
asetuksena on Custom ja
kohdan Target Display
asetuksena on SDR(BT.709): S-
Cinetone
Kun kohdan Shooting Mode
asetuksena on Custom ja
kohdan Target Display
asetuksena on HDR(HLG): HLG
Live
Kun kohdan Shooting Mode
asetuksena on Log-kuvaustilat:
s709

Valitsee perusulkoasun.

Delete – –
Poista valitun
perusulkoasun.

Delete
All

– –
Poistaa kaikki
perusulkoasut.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Määrittää tuloalueen
perusulkoasulle, joka on
valittu valinnalla [Select].

Output BT.709 / HLG BT.709
Määrittää lähtövärialueen
perusulkoasulle, joka on
valittu valinnalla [Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Määrittää valotuksen
viitearvon valitulle
perusulkoasulle, joka on
valittu valinnalla [Select].
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Reset Paint Settings

Palauttaa [Paint/Look]-valikkoasetukset, pois lukien perusulkoasu.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Reset without Base
Look

Execute / Cancel –
Palauttaa [Paint/Look]-valikkoasetukset, pois lukien
perusulkoasu.
Execute: Suorita toiminto.
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Black

Määrittää mustan asetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Master Black −99.0–+99.0 ±0.0 Määrittää master-mustan tason.

R Black −99.0–+99.0 ±0.0 Määrittää R-mustan tason.

B Black −99.0–+99.0 ±0.0 Määrittää B-mustan tason.
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Knee

Määrittää ylivalotuksen estoasetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting

Kun kohdan Target
Display asetuksena on
SDR(BT.709): On / Off / ---
Kun kohdan Target
Display asetuksena on
HDR(HLG): On / Off / ---

Kun kohdan Target
Display asetuksena on
SDR(BT.709): Off
Kun kohdan Target
Display asetuksena on
HDR(HLG): Off

Kytkee ylivalotuksen eston korjaustoiminnon
päälle / pois päältä.

Huomautus

Käytössä vain, kun kohdan [Base Look] >
[Select] asetuksena on [Standard], [ITU709],
[709tone], [HLG Live] tai [HLG Natural].

Auto
Knee

Kun kohdan Target
Display asetuksena on
SDR(BT.709): On / Off / ---
Kun kohdan Target
Display asetuksena on
HDR(HLG): On / Off / ---

Kun kohdan Target
Display asetuksena on
SDR(BT.709): On
Kun kohdan Target
Display asetuksena on
HDR(HLG): Off

Kytkee automaattisen
ylivalotuksenestotoiminnon päälle / pois päältä.

Huomautus

Käytössä vain, kun kohdan [Base Look] >
[Select] asetuksena on [Standard], [ITU709] tai
[709tone].

Point 75%–109% 90% Määrittää ylivalotuksen estokohdan.

Slope −99–+99 ±0 Määrittää ylivalotuksen eston kulmakertoimen.
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Detail

Määrittää yksityiskohtien säätöasetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting On / Off On Kytkee yksityiskohtatoiminnon päälle / pois päältä.

Level −7–+7 ±0 Määrittää yksityiskohtatason.

Manual
Setting

On / Off / --- Off
Kytkee yksityiskohtien manuaalisäätötoiminnon päälle / pois
päältä.

H/V Ratio −2–+2 ±0

Määrittää vaakasuuntaisten (H) ja pystysuuntaisten (V)
yksityiskohtien tasapainon yksityiskohtien manuaalisäätöä
varten.

Huomautus

Tämä kohde vaihtelee eri ohjelmistoversioissa *1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3

Määrittää matalan luminanssin alueiden mustien (B)
yksityiskohtien ja korkean luminanssin alueiden valkoisten (W)
yksityiskohtien välisen tasapainon yksityiskohtien
manuaalisäätöä varten.

Limit 0–7 7
Määrittää yksityiskohtien rajatason yksityiskohtien
manuaalisäätöä varten.

Crispening 0–7 0 Määrittää terävöintitason yksityiskohtien manuaalisäätöä varten.

High Light
Detail

0–4 0
Määrittää korkean luminanssin alueiden yksityiskohtatason
yksityiskohtien manuaalisäätöä varten.

Ohjelmistoversiossa 1.00 valikkokohta on [V/H Balance]. Ohjelmistoversiossa 1.10 ja uudemmissa valikkokohta on [H/V Ratio]. Asetusalue on
sama (−2 ... 0 ... +2), mutta vaikutus kuvanlaatuun vaihtelee.
Ohjelmistoversio 1.00: mitä suurempi arvo, sitä enemmän yksityiskohtia vaakasuunnassa (H).
Ohjelmistoversio 1.10 tai uudempi: mitä suurempi arvo, sitä enemmän yksityiskohtia pystysuunnassa (V).
Kun ohjelmistoversio on päivitetty 1.00:sta 1.10:een tai uudempaan, [All File], [Scene File] ja muut asetukset periytyvät, mutta polariteetti on
käänteinen (kuvanlaatu säilyy).
Jos olet rekisteröinyt valikkokohdan [V/H Balance] valikossa [User], se korvataan automaattisesti valikkokohdalla [H/V Ratio] valikossa [User]
ohjelmiston päivittämisen jälkeen.

*1
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Matrix

Määrittää matriisinkorjausasetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

User Matrix On / Off Off
Kytkee käyttäjän matriisinkorjaustoiminnon päälle / pois
päältä.

User Matrix
Level

−99–+99 ±0 Säätää koko kuvan värikylläisyyttä.

User Matrix
Phase

−99–+99 ±0 Säätää koko kuvan värisävyä (-vaihetta).

User Matrix R-G −99–+99 ±0 Määrittää käyttäjän määrittämän R-G-käyttäjämatriisin.

User Matrix R-B −99–+99 ±0 Määrittää käyttäjän määrittämän R-B-käyttäjämatriisin.

User Matrix G-R −99–+99 ±0 Määrittää käyttäjän määrittämän G-R-käyttäjämatriisin.

User Matrix G-B −99–+99 ±0 Määrittää käyttäjän määrittämän G-B-käyttäjämatriisin.

User Matrix B-R −99–+99 ±0 Määrittää käyttäjän määrittämän B-R-käyttäjämatriisin.

User Matrix B-G −99–+99 ±0 Määrittää käyttäjän määrittämän B-G-käyttäjämatriisin.
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Multi Matrix

Määrittää monen matriisin korjausasetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off
Kytkee monen matriisin korjaustoiminnon
päälle / pois päältä.

Reset Execute / Cancel –
Palauttaa kunkin akselin värin sävyn ja
kylläisyyden oletusarvoihin.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− /
YL / YL+ / G− / G / G+ / CY / CY+ / B−

B Valitsee akselin.

Hue −99–+99 ±0 Määrittää monen matriisin korjaukseen
käytettävän värin sävyn.

Saturation −99–+99 ±0
Määrittää monen matriisin korjaukseen
käytettävän värin kylläisyyden.
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P/T Acceleration

Määrittää panorointi-/kallistustoimintojen kiihdytykseen liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Ramp
Curve

1–9 8
Valitsee panorointi-/kallistustoimintojen kiihdytyksen/jarrutuksen. Mitä
suurempi numero, sitä nopeampi kiihdytys.

330



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Timecode

Määrittää aikakoodin asetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Mode Preset / Regen / Clock Preset

Määrittää aikakoodin käyntitilan.
Preset: Käynti alkaa esiasetetusta arvosta.
Regen: Käynti alkaa edellisen leikkeen lopun aikakoodista.
Clock: Käyttää sisäistä kelloa aikakoodina.

Run Rec Run / Free Run Rec Run
Rec Run: Käy vain tallennettaessa.
Free Run: Käy aina tallennustoiminnosta riippumatta.

Setting – – Määrittää aikakoodille mielivaltaisen arvon.
Set: Määritä arvo.

Reset Execute / Cancel –
Palauttaa aikakoodiksi 00:00:00:00.
Execute: Suorita toiminto.

TC Format DF / NDF DF
Määrittää aikakoodin muodon.
DF: Drop Frame -tasaus
NDF: Ei Drop Frame -tasausta
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TC Display

Määrittää aikatietojen näyttöasetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Display Select Timecode / Users Bit / Duration Timecode Vaihtaa aikatietojen näytön.
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Users Bit

Määrittää nimitietoihin liittyvät asetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Mode Fix / Time Fix
Määrittää nimitietotilan.
Fix: Käyttää nimitiedoissa mielivaltaista kiinteää arvoa.
Time: Käyttää nimitiedoissa kuluvaa tuntia, minuuttia ja sekuntia.

Setting – – Määrittää nimitiedoille mielivaltaisen arvon.
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HDMI TC Out

Määrittää aikakoodin lähtöön liittyvät tiedot käytettäessä HDMI-kaapelia.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting On / Off Off
Määrittää, lähetetäänkö aikakoodi laitteille muita tarkoituksia varten
HDMI-kaapelin kautta.
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Clip Name Format

Määrittää leikkeen nimeämiseen ja poistamiseen liittyvät asetukset.
Kun kohdan [Auto Naming] asetuksena on [Cam ID + Reel#], leikkeiden nimien neljä ensimmäistä merkkiä määritetään
kullekin tallennusvälineelle. Kun laitteeseen asetetaan uusi tallennusväline tai kun tallennusvälineen viimeisin leike ei
vastaa [Camera ID]- tai [Reel Number] -asetusta, leikkeen nimi vilkkuu tämän merkiksi.
Kun kohdan [Auto Naming] asetuksena on [Title], voit käyttää leikkeiden nimen ensimmäisessä osassa vapaavalintaista
merkkijonoa.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Auto
Naming

Cam ID + Reel# / Title

Valitsee leikkeen nimen muodon.
Cam ID + Reel#: kameran tunnus + kelanumero + otoksen
numero + pvm + satunnainen merkkijono
Title: Vapaavalintainen merkkijono, joka määräytyy [Title
Prefix] -asetuksen ja leikkeen numeron perusteella

Camera ID A to Z A

Määrittää kameran tunnuksen, jota käytetään leikkeiden
nimien luomisessa.

Huomautus

Määritettävissä vain, kun kohdan [Auto Naming]
asetuksena on [Cam ID + Reel#].

Reel
Number

001–999 001

Määrittää kelanumero-osan, jota käytetään leikkeiden
nimien luomisessa.

Huomautus

Määritettävissä vain, kun kohdan [Auto Naming]
asetuksena on [Cam ID + Reel#].

Camera
Position

C / L / R C

Määrittää otosnumeron ensimmäisen merkin, jota
käytetään leikkeiden nimien luomisessa.

Huomautus

Määritettävissä vain, kun kohdan [Auto Naming]
asetuksena on [Cam ID + Reel#].
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[Title Prefix] -asetuksen määrittäminen

Aiheeseen liittyvää
Merkkijonon syöttäminen
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Title Prefix

nnn_ (nnn on
sarjanumeron 3 viimeistä
numeroa)
(enint. 7 merkin näyttö)

nnn

Määrittää leikkeen nimen otsikko-osan (4–46 merkkiä).
Avaa merkkijonon syöttönäytön.

Lisätietoja otsikon määrittämisestä ja merkkien
syöttönäytöstä on kohdissa ”Otsikon määrittäminen”
alla ja ”Merkkijonon syöttäminen”.

Huomautus

Määritettävissä vain, kun kohdan [Auto Naming]
asetuksena on [Title].

Number
Set

0001–9999 0001

Määrittää 4-numeroisen luvun liitteeksi leikkeen nimeen.

Huomautus

Määritettävissä vain, kun kohdan [Auto Naming]
asetuksena on [Title].

Valitse [Title Prefix] -alueella kohdistimen kohdalle asetettava merkki merkkivalinta-alueelta GUI-
hallintapaneelin nuolipainikkeilla (merkki on korostettu) ja paina GUI-hallintapaneelin [Set]-painiketta.

Valittu merkki asetetaan ja kohdistin siirtyy oikealle.

1

Määritä otsikko toistamalla vaihe 1.

Käytä [BS]-painiketta tarpeen mukaan.

2

Sulje syöttönäyttö otsikon määrittämisen jälkeen valitsemalla [Done].

Lisätietoja merkkien syöttönäytöstä on kohdassa ”Merkkijonon syöttäminen”.

Valittavissa ovat seuraavat merkit.
!#$%()+,-.;=@[ ]^_~ välilyönti
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Päivittää muistikorttien hallintatiedoston (ks. ”Muistikorttien palauttaminen”).

Aiheeseen liittyvää

Muistikorttien palauttaminen
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Media(A) Execute / Cancel –
Päivittää korttipaikassa A olevan muistikortin hallintatiedoston.
Execute:: Suorita toiminto.

Media(B) Execute / Cancel –
Päivittää korttipaikassa B olevan muistikortin hallintatiedoston.
Execute: Suorita toiminto.
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Format Media

Formatoi (alustaa) muistikortit (ks. ”Muistikorttien formatoiminen (alustaminen)”).

Aiheeseen liittyvää
Muistikorttien formatoiminen (alustaminen)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Media(A) Full Format / Quick Format / Cancel – Formatoi korttipaikassa A olevan muistikortin.

Media(B) Full Format / Quick Format / Cancel – Formatoi korttipaikassa B olevan muistikortin.
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Media Life

Näyttää muistikorttien jäljellä olevan käyttöiän.

Huomautus

Edellyttää muistikortteja, jotka tukevat tietovälineen jäljellä olevan käyttöiän näyttämistä.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Media(A) – –
Näyttää korttipaikassa A olevan muistikortin jäljellä olevan
käyttöiän.

Media(B) – –
Näyttää korttipaikassa B olevan muistikortin jäljellä olevan
käyttöiän.
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Output Format

Määrittää lähtömuodon asetukset.

Aiheeseen liittyvää
Lähtömuodot ja rajoitteet
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

SDI Tietoja asetuksista on osiossa ”Lähtömuodot ja
rajoitteet”.

– Määrittää SDI- ja HDMI-lähdön
tarkkuuden.HDMI –
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Display On/Off

Määrittää näyttökohteen asetukset.
Tuo näyttökohde näkyviin valitsemalla On. Piilota näyttökohde valitsemalla Off.

Kohde Alakohteen asetus Tehdasasetus

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Kohde Alakohteen asetus Tehdasasetus

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Määrittää videosignaalin näyttöasetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting Off / Waveform / Vector / Histogram Off Määrittää videosignaalin näyttötyypin.

Level Marker 1 0%–109% 70% Määrittää tasomerkki 1:n kirkkaustason.

Level Marker 2 0%–109% 100% Määrittää tasomerkki 2:n kirkkaustason.
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Marker

Määrittää merkkinäytön asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off On
Kytkee kaikkien merkkien näytön päälle / pois
päältä.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Valitsee merkkisignaalivärin.

Center
Marker

1 / 2 / 3 / 4 / Off Off Valitsee keskimerkin.

Safety Zone On / Off Off Kytkee turva-alueen merkin päälle / pois
päältä.

Safety Area 80% / 90% / 92.5% / 95% 90%
Valitsee turva-alueen merkin koon
(prosenttiosuutena näytön kokonaiskoosta).

Aspect
Marker

Line / Mask / Off Off Valitsee kuvasuhdemerkin tyypin.

Aspect
Mask

0–15 12
Määrittää merkin ulkopuolisen videosignaalin
tason.

Aspect
Safety Zone

On / Off Off Kytkee kuvasuhteen turva-alueen merkin
päälle / pois päältä.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Valitsee kuvasuhteen turva-alueen merkin
koon (prosenttiosuutena näytön
kokonaiskoosta).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 / 2.39:1
/ Custom

2.39:1
Määrittää tilan, kun kuvasuhdemerkki
näytetään.

Custom
Aspect
Ratio

Syötä mielivaltainen arvo. 01.00:01.00

Määrittää kuvasuhteelle mielivaltaisen arvon.

Huomautus

Käytössä, kun kohdan [Aspect Select]
asetuksena on [Custom].

Guide
Frame

On / Off Off
Kytkee ohjauskehyksen näytön päälle / pois
päältä.

100%
Marker

On / Off Off Kytkee 100%-merkin päälle / pois päältä.

User Box On / Off Off
Kytkee käyttäjäruudun merkin päälle / pois
päältä.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

User Box
Width

3–479 240
Määrittää käyttäjäruudun merkin leveyden
(etäisyys keskeltä vasempaan ja oikeaan
reunaan).

User Box
Height

3–269 135
Määrittää käyttäjäruudun merkin korkeuden
(etäisyys keskeltä ylä- ja alareunaan).

User Box H
Position

−476–+476 0
Määrittää käyttäjäruudun merkin keskikohdan
vaaka-asennon.

User Box V
Position

−266–+266 0 Määrittää käyttäjäruudun merkin keskikohdan
pystyasennon.
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Audio Input

Määrittää äänitulon asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

AUDIO IN
Select

MIC / LINE MIC Valitsee AUDIO IN -liittimeen liitetyn laitteen tyypin.

Phantom
Power +48V

On / Off Off Ilmaisee +48 V-phantom-virransyöttölaitteen tilan.

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

Näyttää tallennuksen tulolähteen kanavalla 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Vaihtaa tallennuksen tulolähteen kanavalla 2.

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

Vaihtaa tallennuksen tulolähteen kanavalla 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Vaihtaa tallennuksen tulolähteen kanavalla 4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Määrittää viitetallennustason XLR-mikrofonitulolle tulosta
AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Määrittää viitetallennustason XLR-mikrofonitulolle tulosta
AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Valitsee viitetulotason, kun kohdan [AUDIO IN Select]
asetuksena on LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB Valitsee 1 kHz:n viiteäänisignaalin tallennustason.

CH1 Wind
Filter

On / Off Off
Ottaa käyttöön / poistaa käytöstä tuulimelun
vähennyssuodattimen kanavan 1 tallennuksessa.

CH2 Wind
Filter

On / Off Off
Ottaa käyttöön / poistaa käytöstä tuulimelun
vähennyssuodattimen kanavan 2 tallennuksessa.

CH3 Wind
Filter

On / Off Off
Ottaa käyttöön / poistaa käytöstä tuulimelun
vähennyssuodattimen kanavan 3 tallennuksessa.

CH4 Wind
Filter

On / Off Off
Ottaa käyttöön / poistaa käytöstä tuulimelun
vähennyssuodattimen kanavan 4 tallennuksessa.

CH1 Level
Control

Auto / Manual Auto
Valitsee äänitulon tason automaattisen säädön tai
manuaalisen säädön kanavan 1 tallennukselle.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

CH2 Level
Control

Auto / Manual Auto
Valitsee äänitulon tason automaattisen säädön tai
manuaalisen säädön kanavan 2 tallennukselle.

CH3 Level
Control

Auto / Manual Auto
Valitsee äänitulon tason automaattisen säädön tai
manuaalisen säädön kanavan 3 tallennukselle.

CH4 Level
Control

Auto / Manual Auto
Valitsee äänitulon tason automaattisen säädön tai
manuaalisen säädön kanavan 4 tallennukselle.

CH1 Input
Level

0–99 49 Määrittää tulotason kanavan 1 tallennukselle.

CH2 Input
Level

0–99 49 Määrittää tulotason kanavan 2 tallennukselle.

CH3 Input
Level

0–99 49 Määrittää tulotason kanavan 3 tallennukselle.

CH4 Input
Level

0–99 49 Määrittää tulotason kanavan 4 tallennukselle.

Master Input
Level

0–99 99 Määrittää master-äänen tulotason.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Valitsee rajoittimen ominaisuudet suurille tulosignaaleille,
kun äänen tulotasoa säädetään manuaalisesti.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Määrittää automaattisen tasonsäädön tilan kanavan 1 ja
kanavan 2 tallennukselle. Kun asetuksena on Stereo, AGC
on yhdistetty kanavien välillä.

CH3&4 AGC
Mode Mono / Stereo Stereo

Määrittää automaattisen tasonsäädön tilan kanavan 3 ja
kanavan 4 tallennukselle. Kun asetuksena on Stereo, AGC
on yhdistetty kanavien välillä.

AGC Spec
−6dB / −9dB / −12dB
/ −15dB / −17dB

−6dB Valitsee AGC-ominaisuudet.

1kHz Tone on
Color Bars

On / Off Off

Kytkee 1 kHz:n viiteäänisignaalin päälle / pois päältä, kun
väripalkit ovat näkyvissä.

Huomautus

Kun asetukseksi on määritetty [On], 1 kHz:n viiteäänisignaali
on määritetty kanavan 3 ja kanavan 4 tallentamiseen, vaikka
kohtien [CH3 Input Select] ja [CH4 Input Select] asetuksena
olisi [Off].
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Määrittää äänilähdön asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

HDMI/Stream Output
CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Määrittää äänikanavien yhdistelmän
HDMI-/suoratoistolähtöä varten.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display Clip Properties

Näyttää leikkeen ominaisuusnäytön.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Display Clip Properties – – Näyttää leikkeen ominaisuusnäytön.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Set Clip Flag

Määrittää leikelipun asetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Add OK – – Lisää OK-lipun.

Add NG – – Lisää NG-lipun.

Add KEEP – – Lisää KEEP-lipun.

Delete Clip Flag – – Poistaa leikelipun.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lock/Unlock Clip

Määrittää leikkeen suojausasetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Select Clip – – Valitsee ja lukitsee leikkeen / avaa leikkeen lukituksen.

Lock All Clips – – Lukitsee kaikki leikkeet.

Unlock All Clips – – Avaa kaikkien leikkeiden lukituksen.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Delete Clip

Poistaa leikkeitä.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Select Clip – – Poistaa valitun leikkeen.

All Clips – – Poistaa kaikki leikkeet.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip

Siirtää leikkeitä.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Select Clip – – Siirtää valitut leikkeet.

All Clips – –

Siirtää kaikki leikkeet.

Huomautus

Enintään 200 siirtotyötä voidaan rekisteröidä.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip (Proxy)

Siirtää välityspalvelinleikkeet.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Select Clip – – Siirtää valittuja leikkeitä vastaavat välityspalvelinleikkeet.

All Clips – –

Siirtää kaikkia leikkeitä vastaavat välityspalvelinleikkeet.

Huomautus

Enintään 200 siirtotyötä voidaan rekisteröidä.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Filter Clips

Määrittää näytettävien leikkeiden asetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

OK – – Näyttää vain leikkeet, joilla on OK-lippu.

NG – – Näyttää vain leikkeet, joilla on NG-lippu.

KEEP – – Näyttää vain leikkeet, joilla on KEEP-lippu.

None – – Näyttää vain leikkeet, joilla ei ole lippua.

All – – Näyttää kaikki leikkeet riippumatta siitä, onko niillä lippu vai ei.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Customize View

Vaihtaa pikkukuvanäkymän.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Vaihtaa pikkukuvien alla
näytettävän tiedon.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Color Bars

Määrittää väripalkin asetukset.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off Kytkee väripalkit päälle / pois päältä.

Type ARIB / 100% / 75% / SMPTE ARIB Valitsee väripalkin tyypin.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Genlock

Määrittää tahtilukituksen tilanäkymän (ks. ”Videosignaalin vaiheiden synkronointi (tahtilukitus)”).

Aiheeseen liittyvää
Videosignaalin vaiheiden synkronointi (tahtilukitus)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Reference Internal / External(HD) / External(SD) – Näyttää tahtilukituksen viitesignaalin tyypin.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Määrittää tallennuksen merkkivalon asetukset (ks. ”Tally-merkkivalosignaalin yhdistäminen”).

Aiheeseen liittyvää

Tally-merkkivalosignaalin yhdistäminen
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Tally Lamp
Brightness

High / Low / Off High Määrittää tallennuksen merkkivalon kirkkauden.

G Tally Lamp Enable / Disable Enable Ottaa G tally -merkkivalon käyttöön / pois käytöstä.

Tally Control
External /
Internal

Internal

Valitsee kohteen laitteen tallennuksen merkkivalon
hallintatietojen hyväksymiselle.
External: Tally-merkkivalon hallinta kameran ulkopuolelta.
Internal: Hallinta kameran tallennustoiminnon kautta.

359



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Review

Määrittää tallennuksen tarkastelun asetukset (ks. ”Tallennuksen tarkasteleminen (Rec Review)”).

Aiheeseen liittyvää
Tallennuksen tarkasteleminen (Rec Review)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting 3s / 10s / Clip 3s Määrittää juuri tallennettujen leikkeiden toistoajan tarkastelua varten.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Zoom

Määrittää zoomin asetukset (”Zoomin säätäminen”).
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Määrittää zoomin tyypin.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens

Määrittää objektiiveihin liittyvät asetukset.

Aiheeseen liittyvää

Hengityksen kompensaatio
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Lens Calibration Execute / Cancel –
Suorittaa toiminnon, joka korjaa zoomausasennon
eroja, jotka johtuvat yksittäisten objektiivien eroista, kun
käytetään moottorizoom-objektiivia.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Määrittää zoomausrenkaan suunnan.

Huomautus

Käytössä vain, kun käytetään E-pidikkeellistä
objektiivia, joka tulee zoomausrenkaan
suunnanvaihtoa.

Shading
Compensation

Auto / Off Auto Määrittää automaattisen varjostustoiminnon.

Chroma
Aberration Comp.

Auto / Off Auto
Määrittää automaattisen väripoikkeaman
kompensaation.

Distortion Comp. Auto / Off Auto Määrittää automaattisen vääristymän kompensaation.

Breathing
Compensation

Auto / Off Off
Määrittää objektiivin hengityksen kompensaation.

Ks. ”Hengityksen kompensaatio”.

Distance Display Meter / Feet Meter
Määrittää objektiivin tietojen ja tarkennuskohdan
näyttöyksiköt.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length Määrittää zoomausasennon näyttömuodon.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

APR

Suorittaa APR-toiminnon.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

APR Execute / Cancel –

Suorittaa APR-toiminnon (Automatic Pixel Restoration) kuvakennon
automaattisäätöä varten.
Execute: Suorita toiminto.

Huomautus

Kiinnitä objektiivinsuojus aina ennen APR-toiminnon suorittamista.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Määrittää lankaverkkoyhteyksiin liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

HTTP Port – 80 Näyttää HTTP-käyttöportin.

Detail
Settings

– – Näyttää langallisen LAN-verkkoyhteyden ominaisuudet.

DHCP
On / Off

On Näyttää, onko DHCP käytössä (On) vai ei (Off).

IP Address –
Näyttää laitteen IP-osoitteen, kun kohdan [DHCP] asetuksena on
[Off].

Subnet Mask –
Näyttää laitteen aliverkon peitteen, kun kohdan [DHCP]
asetuksena on [Off].

Gateway –
Näyttää laitteen oletusyhdyskäytävän, kun kohdan [DHCP]
asetuksena on [Off].

DNS Auto
On / Off

On Näyttää automaattisen DNS-saannin asetuksen.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Määrittää tiedostonsiirtoihin liittyvät asetukset (ks. ”Tietoja tiedoston siirrosta”).

Aiheeseen liittyvää

Tietoja tiedoston siirrosta
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Auto Upload
(Proxy)

On / Off Off
Kytkee välityspalvelintiedoston automaattisen latauksen
päälle / pois päältä.

Default
Upload
Server

Server
Settings1–3 >
Display Name

–

Valitsee tiedostojen latauksen kohdepalvelimen. Tässä valitusta
palvelimesta tulee välityspalvelintiedostojen automaattisen
latauksen kohdepalvelin ja pikkukuvanäytöstä ladattavien
tiedostojen kohdepalvelin.
Näyttää [Display Name] -asetukset, jotka on määritetty kohdassa
[Server Settings1 –3].

Clear
Completed
Jobs

Execute / Cancel –
Tyhjentää valmiit siirtotyöt luettelosta.
Execute: Suorita toiminto.

Clear All
Jobs

Execute / Cancel –
Tyhjentää kaikki siirtotyöt luettelosta.
Execute: Suorita toiminto.

View Job List – – Näyttää siirtotyöluettelon.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Language

Määrittää näyttökielen.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Select – –
Määrittää näyttökielen.
Set: Määritä arvo.

366



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Clock Set

Määrittää sisäisen kellon asetukset.

Huomautus

Kun muutat asetusta kameran valikosta, katkaise laitteen virransyöttö ja käynnistä laite uudelleen. Järjestelmä voi toimia
odottamattomalla tavalla, jos se kytketään virran valmiustilaan infrapunakaukosäätimellä tai verkkosovelluksella.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Time Zone UTC – 12:00 – UTC + 14:00 –
Määrittää aikaeron UTC-aikaan 30 minuutin
jaksoissa.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY YYMMDD

Valitsee päivämäärien näyttömuodon.
YYMMDD: vuosi, kuukausi, päivä
MMDDYY: kuukausi, päivä, vuosi
DDMMYY: päivä, kuukausi, vuosi

12H/24H 12H / 24H 24H
Valitsee kellon näyttömuodon.
12H: 12 tunnin tila
24H: 24 tunnin tila

Date – –
Määrittää kuluvan päivän päivämäärän.
Set: Määritä arvo.

Time – –
Määrittää tämänhetkisen kellonajan.
Set: Määritä arvo.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hours Meter

Näyttää kertyneen käyttöajan.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Hours(System) – – Näyttää kertyneet käyttötunnit (ei voida nollata).

Hours(Reset) – – Näyttää kertyneet käyttötunnit (voidaan nollata).

Reset Execute / Cancel –
Palauttaa kertyneen käyttöajan arvoon 0.
Execute: Suorita toiminto.
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Interchangeable Lens Digital Camera
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ISO/Gain -asetukset ja oletusarvot

[ISO/Gain<L>]-asetusalue ja -oletusarvot vaihtelevat riippuen kohtien [Mode], [Base Look] > [Select] ja [Base Sensitivity]
asetuksista.
Taulukoiden oletusarvot näytetään lihavoituna.

Kun kohdan [Mode] asetuksena on [ISO]

Kun kohdan [Base Look] > [Select] asetuksena on [S-Cinetone], [Standard], [ITU709], [709tone] tai
[Still]

Kun kohdan [Base Look] > [Select] asetuksena on [HLG Live] tai [HLG Natural]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [Low]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

369



Kun kohdan [Base Look] > [Select] asetuksena on [User1]–[User16]

Kun kohdan [Mode] asetuksena on [dB]

Arvon voi määrittää 1dB:n välein välillä −3dB–+30dB.
Oletusarvona on 0dB.
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Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [Low]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [Low]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

AGC Limit -asetukset ja oletusarvot

[AGC Limit]-valikon asetusalue ja oletusarvot vaihtelevat riippuen kohtien [Mode], [Base Look] > [Select] ja [Base
Sensitivity] asetuksista.
Taulukoiden oletusarvot näytetään lihavoituna.

Kun kohdan [Mode] asetuksena on [ISO]

Kun kohdan [Base Look] > [Select] asetuksena on [S-Cinetone], [Standard], [ITU709], [709tone] tai
[Still]

Kun kohdan [Base Look] > [Select] asetuksena on [HLG Live] tai [HLG Natural]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [Low]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Kun kohdan [Base Look] > [Select] asetuksena on [User1]–[User16]

Kun kohdan [Mode] asetuksena on [dB]

Valitse arvoista 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Oletusarvona on 15dB.
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Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [Low]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [Low]

Kun kohdan [ISO/Gain/EI] > [Base Sensitivity]
asetuksena on [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Kullekin kuvaustilalle tallennetut kuvanlaatuasetukset

Kuvanlaatuun liittyvien määrityskohteiden nykyinen tila tallennetaan kullekin seuraavista kuvaustiloista. Kun vaihdat
kuvaustilaa, sitä vastaavat kohteen kuvaustilaan tallennetut asetukset otetaan käyttöön.

Custom-tila SDR(BT.709) kohdenäyttö
Custom-tila HDR(HLG) kohdenäyttö
Log-kuvaus (Cine EI, Cine EI Quick, Flexible ISO)

Alla olevissa taulukoissa näkyvät kullekin kuvaustilalle tallennetut kuvanlaatuun liittyvät määrityskohteet.
”Kyllä” ilmaisee tallennetun asetuksen ja ”Ei” ilmaisee tallentamattoman asetuksen. ”Kyllä”, joka kattaa useita sarakkeita,
ilmaisee yleisasetuksia.

Kohde

Kuvaustila

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Shooting-
valikko

ISO/Gain/EI

ISO/Gain Kyllä1) Kyllä Ei

Exposure Index Ei Ei Kyllä Kyllä

Base Sensitivity Kyllä Ei

Base ISO Ei Kyllä4) Ei3) Kyllä4)

White
Preset White Kyllä Kyllä

Muu kuin yllä Kyllä

White Setting Kyllä

Offset White Kyllä Ei

LUT On/Off Ei Kyllä

Noise
Suppression

Setting(Custom) Kyllä Kyllä Ei

Level(Custom) Kyllä Kyllä Ei

Setting (Cine
EI/Flex. ISO)

Ei Kyllä

Level (Cine EI/Flex.
ISO)

Ei Kyllä
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Kohde

Kuvaustila

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look-
valikko

Base Look

Select Kyllä Kyllä Kyllä

Input2) Kyllä

Output2) Kyllä

AE Level Offset2) Kyllä

Black Kyllä Kyllä Ei

Knee
Auto Knee Kyllä Ei Ei

Muu kuin yllä Kyllä Kyllä Ei

Detail Kyllä Kyllä Ei

Matrix Kyllä Kyllä Ei

Multi Matrix Kyllä Kyllä Ei

Erilliset ISO-herkkyyden asetukset tallennetaan molempiin Custom-tiloihin SDR(BT.709) ja HDR(HLG).1)

Asetukset tallennetaan kullekin perusulkoasulle, eivätkä ne riipu kuvaustilasta.2)

ISO-perusherkkyys muuttuu valotusindeksin mukana.3)

Yleinen asetusarvo Flexible ISO- ja Cine EI -kuvaustiloissa.4)
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Verkkovalikon määritykset

Tuo asetusnäyttö näkyviin painamalla [Settings] -toimintanäytön vaihtovälilehteä.
Käytä asetusnäyttöä laitteen eri kohteiden määrittämiseen, mukaan lukien aloitusasetukset, verkkoasetukset ja
kuvaus-/toistoasetukset, verkkovalikon avulla.

Valikko sisältää seuraavat valikot.

Valikon määritykset ja hierarkia

Taso 1 Tason 1 kuvaus Taso 2

Shooting Sisältää kuvaamiseen liittyvät asetukset. Focus
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Taso 1 Tason 1 kuvaus Taso 2

Project Sisältää projektin perusasetukset.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Sisältää kuvanlaatuun liittyvät asetukset. Base Look

Pan-Tilt Sisältää panerointiin/kallistukseen liittyvät asetukset.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Sisältää videolähtöön ja kuvanäyttöön liittyvät asetukset.
Output Format

Output Display

Audio Sisältää ääneen liittyvät asetukset. Audio

Technical Sisältää teknisten kohteiden asetukset.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Sisältää verkkoihin liittyvät asetukset.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack Protection
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Huomautus

[Accessibility] on saatavilla vain Pohjois-Amerikan malleissa.
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Taso 1 Tason 1 kuvaus Taso 2

Stream Sisältää suoratoistoon liittyvät asetukset.

Stream

Video Stream

Audio Stream

Maintenance Sisältää laiteasetukset, kuten kellon ja kielen.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Verkkovalikon toiminnot

Tuo asetusnäyttö näkyviin painamalla [Settings]-toimintanäytön vaihtovälilehteä laitteen eri kohteiden määrittämiseen,
mukaan lukien aloitusasetukset, verkkoasetukset ja kuvaus-/toistoasetukset, verkkovalikon avulla.
Määritä asetukset verkkovalikossa tabletin kosketustoimintojen tai tietokoneen hiiritoimintojen avulla.
Paina valikossa kohteita, jotka haluat määrittää, jotta saat kyseisen valikon määrityskohteet ja asetukset näkyviin.

Määritysmenetelmä

Arvon valitseminen

Paina kohteen valintapainiketta. Valitun kohteen valintapainike näkyy oranssina.

Valikko (taso 1)1.

Valikko (taso 2)2.

Asetukset3.

378



Kohde päälle / pois päältä

Ota kohde käyttöön tai pois käytöstä painamalla kytkintä. Kytkin on oranssi, kun kohde on käytössä, ja valkoinen, kun se
ei ole käytössä.

Arvon valitseminen listalta

Paina pudotusvalikon painiketta ja valitse kohde näkyviin tulevalta listalta.

Numeroarvon valitseminen

Valitse numeroarvo painamalla < tai >. Jos numeroarvo on alleviivattu, voit myös syöttää numeroarvon suoraan.

Merkkien/numeroiden syöttäminen

Määrittäminen eri näytöllä
Suorita määritystoimintoja eri näytöllä painamalla painiketta.

Ohjeviesti

Näkyviin tulee tietoja, jotka auttavat määrittämään joitakin asetuksia, ja viestejä, jotka vaativat käyttäjän huomiota.

Asetuksen tallentaminen

Kun asetuksen määrittäminen on valmis, tallenna asetus painamalla [OK]-painiketta.
Hylkää asetukseen tehdyt muutokset ja palaa edelliseen asetukseen painamalla [Cancel]-painiketta.
Päivitä näytön näkymä painamalla [Reload]-painiketta.

Huomautus

Jos painat [Reload]-painiketta ennen asetuksen tallentamista, asetukseen tehdyt muutokset hylätään.

Jos siirryt toiselle sivulle ennen asetuksen tallentamista, asetukseen tehdyt muutokset hylätään.
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Focus

Määrittää tarkennusasetukset.

Aiheeseen liittyvää

Automaattitarkennuksen kohteen asettaminen käsin (AF Assist) verkkosovelluksen avulla
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Määrittää tilapäisen automaattitarkennuksen tilan.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Määrittää toiminnon, kun kameran kuvanäyttöä kosketaan MF-
tilassa.

AF Assist
Control

On / Off On

Kun asetuksena on [On], voit käyttää verkkosovelluksen
tarkennusliukusäädintä automaattitarkennuksen aikana
tarkennuskohdan säätämiseen.

Lisätietoja on kohdassa ”Automaattitarkennuksen kohteen
asettaminen käsin (AF Assist) verkkosovelluksen avulla”.

Huomautus

Tämä kohde on käytössä vain, kun kameran valikon kohdan [AF
Assist] asetuksena on [On].
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Base Setting

Määrittää perusasetukset.

Aiheeseen liittyvää

Perustoimintojen määrittäminen
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Määrittää kuvaustilan.

Ks. ”Kuvaustila” osiossa ”Perustoimintojen
määrittäminen”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Määrittää tallennuksen/lähdön värialueen
Custom-tilassa.
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Rec Format

Määrittää tallennusmuodon asetukset.

[RAW Output Format] -asetukset

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94

Valitsee järjestelmän taajuuden.

Huomautus

Jos taajuus muuttuu, kamera käynnistyy
uudelleen. Lataa sivu uudelleen
verkkoselaimessa uudelleenkäynnistyksen
jälkeen.

Imager Scan
Mode

FF / S35 FF Valitsee kuvakennon koon.

Codec
RAW / RAW & XAVC-I / XAVC-I
/ XAVC-L

XAVC-I

Määrittää leikkeen tallennus-/toistokoodekin.

Huomautus

Kun kohdan [Imager Scan Mode] asetuksena on
[S35], [RAW] ja [RAW & XAVC-I] eivät ole
valittavissa.

RAW Output
Format

Saatavilla olevat asetukset
riippuvat [Frequency]-
asetuksista.

Ks. ”[RAW Output Format] -
asetukset” alla.

–

Määrittää RAW-kuvan koon ulkoiseen RAW-
tallentimeen lähettämiseksi.

Huomautus

Kun kohdan [Codec] asetuksena on [RAW &
XAVC-I], [Video Format] -asetus muuttuu
yhdessä [RAW Output Format] -asetuksen
kanssa.

Video
Format

Saatavilla olevat asetukset
riippuvat [Frequency]-, [Imager
Scan Mode]- ja [Codec]-
asetuksista.

Ks. ”[Video Format] -
asetukset” alla.

– Määrittää kuvan koon.

Frequency Imager Scan Mode Codec Asetus

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160
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Oletusarvot näytetään lihavoituna.
Ehdot, joissa [RAW Output Format] ei ole määritettävissä, on jätetty pois.

[Video Format] -asetukset

Oletusarvot näytetään lihavoituna.
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Frequency Imager Scan Mode Codec Asetus

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Asetus

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Määrittää 2-paikkaisen samanaikaisen tallennustilan asetukset (ks. ”Muistikorteille A ja B tallentaminen samanaikaisesti
(2 paikan Simul Rec)”).

Aiheeseen liittyvää

Muistikorteille A ja B tallentaminen samanaikaisesti (2 paikan Simul Rec)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off
Kytkee samanaikaisen tallennuksen päälle / pois päältä ja
määrittää tietovälineen, johon tallennetaan.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Näyttää kullekin tallennusvälineelle ohjelmoidun
tallennuspainikkeen.
Aseta kameran valikon kohdassa [Project] > [Simul Rec] > [Rec
Button Set].

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Määrittää Välityspalvelimelle tallentaminen -tilan asetukset (ks. ”Välityspalvelimelle tallentaminen”).
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off Kytkee välityspalvelintallennuksen päälle / pois päältä.
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Interval Rec

Määrittää intervallikuvaustilan asetukset (ks. ”Videon tallentaminen jaksottaisesti (Interval Rec)”).

Aiheeseen liittyvää
Videon tallentaminen jaksottaisesti (Interval Rec)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off
Kytkee intervallikuvauksen päälle / pois
päältä. (Kun tämä tila asetetaan tilaan
On, muut erikoistilat siirtyvät tilaan Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hour)

1
Määrittää tallennusten välisen aikavälin
Interval Rec -tallennustilassa (kun
kohdan Interval Rec asetuksena on On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Saatavilla olevat asetukset
riippuvat valitun videomuodon
kuvataajuudesta.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Määrittää tallennettavien kuvien
lukumäärän kuvauskertaa kohti Interval
Rec -tallennustilassa (kun kohdan
Interval Rec asetuksena on On).
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Picture Cache Rec

Määrittää Picture Cache -tallennustilan asetukset (ks. ”Kuvien tallentaminen välimuistiin (Picture Cache Rec)”).

Aiheeseen liittyvää

Kuvien tallentaminen välimuistiin (Picture Cache Rec)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off Kytkee kuvan välimuistitoiminnon päälle / pois päältä.

Cache Size
Short / Medium / Long
/ Max

Max
Määrittää ajan, jolta kuvia kerätään kuvavälimuistiin
(kuvavälimuistin tallennusaika).

Cache Rec
Time

– –
Näyttää ajan, jolta kuvia kerätään kuvavälimuistiin
(kuvavälimuistin tallennusaika).
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All File

Suorittaa ALL-tiedoston toiminnot (ks. ”Määritystietojen tallentaminen ja lataaminen”).
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Load All
File

– –

Lataa ALL-tiedosto laitteeseen laitteesta, jossa verkkosovellusta
käytetään.

Huomautus

Kun ALL-tiedosto on ladattu laitteeseen, laite käynnistyy uudelleen.
Lataa sivu uudelleen verkkoselaimessa uudelleenkäynnistyksen jälkeen.

Save All
File – –

Tallenna laitteen asetukset ALL-tiedostona laitteelle, jossa
verkkosovellusta käytetään.
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Base Look

Laitteeseen voi ladata perusulkoasun.
Saatavilla olevien perusulkoasujen lista näkyy näytöllä. Tämänhetkinen perusulkoasu osoitetaan ●-merkillä
perusulkoasun numeron vasemmalla puolella.

[No.]: Perusulkoasun numero
[Base Look Name]: Perusulkoasun nimi
[Input]: Perusulkoasun tulosignaali
[Output]: Perusulkoasun lähtösignaali
[AE Level Offset]: Perusulkoasun valotuksen viitteen poikkeama-arvo

Perusulkoasun lisääminen
Tuo uusi perusulkoasu painamalla [Import]-painiketta. Noudata näytöllä näkyviä ohjeita.
Määritä tuonnin jälkeen sopivat arvot kohdille [Input], [Output] ja [AE Level Offset]. Lisätietoja on kohdassa ”Halutun
perusulkoasun tuominen”.

Aiheeseen liittyvää
Halutun perusulkoasun tuominen
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P/T Speed

Määrittää panorointi-/kallistusnopeuteen liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Speed
Step

Normal /
Extended

Extended

Määrittää panoroinnin/kallistuksen ohjauksen nopeusvaiheiden määrän.
Normal: Nopeus voidaan määrittää 24-portaisella asteikolla. Käytä tätä
asetusta olemassa olevien Sony-etäkameroiden yhteensopivuuden
määrittämiseksi.
Extended: Nopeus voidaan määrittää 50-portaisella asteikolla.

Speed
Mode

Normal / Slow Normal

Määrittää panoroinnin/kallistuksen ohjauksen nopeustilan.
Käytössä vain, kun kohdan [Speed Step] asetuksena on [Normal].
Normal: Toimii normaalinopeuden asteikolla (pienimmästä suurimpaan
(60 astetta/sekunti)).
Slow: Toimii alhaisen nopeuden asteikolla (pienimmästä suurimpaan
(40 astetta/sekunti)).
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P/T Acceleration

Määrittää panorointi-/kallistusnopeuteen liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Acceleration 1–9 8
Valitsee panorointi-/kallistustoimintojen kiihdytyksen/jarrutuksen.
Mitä suurempi numero, sitä nopeampi kiihdytys.
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P/T Range Limit

Määrittää panoroinnin/kallistuksen toiminta-alueen rajoittamiseen liittyvät asetukset.
Määritä panoroinnin/kallistuksen toiminta-alueen rajoitukset seuraavalla näytöllä.

Huomautus

Kun laite on päällä tai panorointi/kallistus nollataan, tämä asteikkorajoitusasetus jätetään huomiotta. Tätä toimintoa ei voi käyttää
laitteen lähellä olevien esteiden välttämiseen.

Siirrä [Setting]-kytkin On-asentoon.

Panoroinnin/kallistuksen toiminta-alueen rajoitustoiminto otetaan käyttöön.

1

Tarkista kuva kameran panorointi-/kallistustoimintojen avulla.2

Määritä asennot, joihin toiminta rajoitetaan, painamalla kyseisten kohtien painikkeita [Left], [Right], [Up],
[Down] > [Set Current Value].

[Left]: Kameran vasen puoli
[Right]: Kameran oikea puoli
[Up]: Kameran yläpuoli

3
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Huomautus

Rajoitusasentojen ulkopuolisia kameran asentoja ei voi tallentaa esiasetuksina.

Jos kohdan [Pan-Tilt] > [P/T Direction] > [Ceiling] asetus muuttuu, määritetyt rajoitusasentojen asetukset palautuvat
tehdasasetuksiin.

Asetusta ei voi muuttaa toiston aikana, pikkukuvanäkymässä, panorointi-/kallistusvirheen tapahtuessa, panoroinnin/kallistuksen
ollessa alustamatta ja kun panorointi/kallistus on lukittu.
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[Down]: Kameran alapuoli

Rajoitusasennot määritetään ja näytetään numeroarvoina (kulma).
Peruuta rajoitus painamalla yksittäisten asentojen [Reset]-painiketta.

Paina [OK]-painiketta.

Panorointi-/kallistustoiminto rajataan määritettyjen rajoitusasentojen sisälle.

4
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P/T Direction

Määrittää panorointi-/kallistussuuntaan liittyvät asetukset.

Huomautus

Kun [Ceiling]-asetus otetaan käyttöön, kaikki esiasetusasennot poistetaan, sillä panorointi-/kallistuskoordinaatit muuttuisivat
vastakkaisiksi.

Panorointi-/kallistusohjauksen alue muuttuu seuraavan kaavion mukaisesti [Ceiling]-asetuksesta riippuen.

A: Kun kohdan [Ceiling] asetuksena on [Off]
B: Kun kohdan [Ceiling] asetuksena on [On]
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Ceiling On / Off Off

Kun laite on kiinnitetty työpöydälle, aseta tilaksi [Off]. Kun laite on
kiinnitetty kattoon, aseta tilaksi [On]. Kun kohdan [Ceiling] asetuksena
on [On], kohdan [Pan Direction] asetukseksi tulee automaattisesti
[Opposite].

Pan
Direction

Normal /
Opposite

Normal
Määrittää panorointiohjauksen suunnan. Kun asetusta muutetaan,
kulkusuunta muuttuu.

Tilt
Direction

Normal /
Opposite

Normal
Määrittää kallistuksen ohjauksen suunnan. Kun asetusta muutetaan,
kulkusuunta muuttuu.
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P/T Preset

Määrittää kameran esiasetuksiin liittyvät asetukset.

Pan-Tilt
Määrittää esiasetusten nopeuden.

Default
Määrittää oletusarvot, jotka asetetaan esiasetusvalintaa tallennettaessa.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Määrittää sen, määritetäänkö esiasetusnopeudet erikseen vai
yleisellä asetuksella.

Pan-Tilt Speed
for Common

1–50 50

Määrittää esiasetusten yleisen nopeuden.

Huomautus

Enimmäisnopeutta 24 käytetään, jos arvoksi asetetaan vähintään
25, kun kohdan [Pan-Tilt] > [P/T Speed] > [Speed Step]
asetuksena on [Normal].

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Pan-Tilt Speed
for Separate

1–50 50
Määrittää esiasetusten nopeuden, kun esiasetusten
nopeudenvalintamenetelmäksi on valittu [Separate].

Zoom Sync On / Off On
Määrittää, synkronoidaanko panorointi-/kallistustoiminto ja
zoomaustoiminto, kun esiasetusvalinta palautetaan.

Zoom Speed 0–32767 32767 Määrittää zoomausnopeuden.

Focus Recall On / Off On Määrittää, palautetaanko tarkennusasetukset.

MF Speed 0–32767 32767 Määrittää manuaalisen tarkennuksen tarkennusnopeuden.
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Output Format

Määrittää lähtömuodon asetukset.

Aiheeseen liittyvää
Lähtömuodot ja rajoitteet
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

SDI Tietoja asetuksista on osiossa ”Lähtömuodot ja
rajoitteet”.

– Määrittää SDI- ja HDMI-lähdön
tarkkuuden.HDMI –
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Output Display

Määrittää lähtösignaaleihin liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

SDI On / Off Off Määrittää, upotetaanko valikko ja tila SDI-lähtösignaaliin.

HDMI/Stream On / Off On

Määrittää, upotetaanko valikko ja tila HDMI-lähtösignaaliin.

Huomautus

Tätä asetusta käytetään myös HDMI-lähtösignaalikuvaan,
suoratoistokuvaan ja verkkosovelluksen kameran kuvapaneeliin.
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Audio Input

Määrittää CH1–CH4-äänituloon liittyvät asetukset.

Määrittää master-äänen tulotason. Master-äänen tulotasoa käytetään kaikille kanaville 1–4.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Level
Control

Auto / Manual Auto
Valitsee äänitulon tason automaattisen säädön tai
manuaalisen säädön.

Level 0–99 49 Määrittää tulotason.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 ja CH3: AUDIO
IN CH1
CH2 ja CH4: AUDIO
IN CH2

Määrittää äänen tulolähteen.

Huomautus

Kohdan CH1 asetuksena on [AUDIO IN CH1]
(kiinteä).

Wind
Filter

On / Off Off
Kytkee tuulimelun vähennyssuodattimen
päälle / pois päältä.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Master 0–99 99 Määrittää master-tulotason.
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Audio Output

Määrittää äänen lähtöön liittyvät asetukset.

Huomautus

Tätä asetusta käytetään myös suoratoiston lähtöääneen.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

HDMI/Stream Output
CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Määrittää äänikanavien yhdistelmän
HDMI-/suoratoistolähtöä varten.
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Tracking Data Output

Määrittää seurantatietojen (free-d-protokolla) lähettämiseen liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Transfer Mode
Off / Always / On
Demand

Off Valitsee seurantatietojen lähetystavan.

Camera ID 0–255 255 Asettaa laitteen tunnuksen.

Destination
Address

IPv4-osoite –
Kun kohdan [Transfer Mode] asetuksena on [Always],
määrittää seurantatietojen kohteen IP-osoitteen.

Destination
Port

1024–65534 40000 Kun kohdan [Transfer Mode] asetuksena on [Always],
määrittää seurantatietojen kohteen portin numeron.

Listen Port 1024–65534 40000
Kun kohdan [Transfer Mode] asetuksena on [On Demand],
määrittää asiakkaiden pyyntöjen kuunteluportin numeron
laitteessa.
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Tally

Määrittää tallennuksen merkkivalon asetukset (ks. ”Tally-merkkivalosignaalin yhdistäminen”).

Aiheeseen liittyvää

Tally-merkkivalosignaalin yhdistäminen
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Tally Lamp
Brightness

High / Low / Off High Määrittää tallennuksen merkkivalon kirkkauden.

G Tally Lamp Enable / Disable Enable Ottaa G tally -merkkivalon käyttöön / pois käytöstä.

Tally Control
External /
Internal

Internal
Valitsee kohteen laitteen tallennuksen merkkivalon
hallintatietojen hyväksymiselle.
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IR Remote

Määrittää infrapunakaukosäätimeen liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting On / Off On
Ottaa laitteen käyttämisen infrapunakaukosäätimellä käyttöön / pois
käytöstä.
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RCP/MSU

Määrittää asetuksen, kun RCP/MSU (lisävaruste) on liitetty.
Lisätietoja on kohdassa ”RCP:n/MSU:n (lisävaruste) liittäminen”.

Huomautus

Määritä asetukset RCP:ssä/MSU:ssa tarpeen mukaan.

Monikamerajärjestelmä edellyttää MSU:ta.

Käytettäessä useita MSU-laitteita yksi MSU-laite on määritettävä päälaitteeksi ja kaikki muut asiakkaiksi.
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

CNS Mode
Off / Bridge / MCS /
PC Control

Off Määrittää RCP:n/MSU:n yhteystilan.

Master IP
Address

IPv4-osoite 0.0.0.0
Määrittää päälaitteen IP-osoitteen muodostettaessa LAN-
pohjaista monikamerajärjestelmää.

Camera No. Camera No. (1–96) 1
Määrittää yksilöivän kameranumeron järjestelmässä
muodostettaessa LAN-pohjaista monikamerajärjestelmää.
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Lens Controller

Määrittää liitetyn objektiivin ohjaimen (lisävaruste) asetukset.
Lisätietoja on kohdassa ”Objektiivin ohjaimen liittäminen”.

Huomautus

Kun [Setting] muuttuu, laite käynnistyy uudelleen. Lataa sivu uudelleen verkkoselaimessa.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting On / Off Off Määrittää, käytetäänkö objektiivin ohjainta (lisävaruste).

Mode 0–15 0

Määrittää objektiivin ohjaimen (lisävaruste) toimintatilan.
Mahdollinen arvoalue on 0–15, mutta todelliset valittavissa olevat arvot
vaihtelevat objektiivin ohjaimen (lisävaruste) mukaan. Lisätietoja on
objektiivin ohjaimen käyttöohjeessa.

Reverse On / Off Off Kääntää objektiivin ohjaimen (lisävaruste) kiertosuunnan.

Initialize – – Alustaa objektiivin ohjaimen (lisävaruste).
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Camera Name

Määrittää kameran nimeen liittyvät asetukset (laitteen nimi).

Camera Name voi sisältää enintään kahdeksan (0–8) seuraavista merkeistä.
Kirjaimet ja numerot
Symbolit (välilyönti !#$`*+-./;<=>?@[\]^_`{|})
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Camera Name – FR7 Määrittää kameran nimen.
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User

Määrittää laitteen pääsytietoihin liittyvät asetukset.

Pääkäyttäjiin (Administrator) liittyvät asetukset (pakollinen)

Yleisiin käyttäjiin liittyvät asetukset (User 1 – User 9) (valinnainen)
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

User Name – admin Määrittää käyttäjänimen.

Current Password – – Kun vaihdat salasanaa, syötä nykyinen salasana.

New Password – – Anna uusi salasana.

Re-Type Password – – Vahvista antamalla uusi salasana uudelleen.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

User Name – – Määrittää käyttäjänimen.

Current Password – – Kun vaihdat salasanaa, syötä nykyinen salasana.

New Password – – Anna uusi salasana.

Re-Type Password – – Vahvista antamalla uusi salasana uudelleen.
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Wired LAN

Status
Näyttää verkon tilan.

IPv4
Määrittää IPv4-verkkoon liittyvät asetukset.

IPv6
Määrittää IPv6-verkkoon liittyvät asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Host Name – – Näyttää isäntänimen.

MAC Address – – Näyttää laitteen MAC-osoitteen.

Ethernet Status – – Näyttää nykyisen viestintänopeuden.

IP Address – – Näyttää laitteen IP-osoitteen.

Subnet Mask – – Näyttää laitteen aliverkon peitteen.

Gateway – – Näyttää laitteen IPv4-oletusyhdyskäytävän.

Primary DNS Server – – Näyttää laitteen ensisijaisen DNS-palvelimen.

Secondary DNS Server – – Näyttää laitteen toissijaisen DNS-palvelimen.

IPv6 Address 1 – – Näyttää laitteen IPv6-osoite 1:n.

IPv6 Address 2 – – Näyttää laitteen IPv6-osoite 2:n.

IPv6 Gateway – – Näyttää laitteen IPv6-oletusyhdyskäytävän.

Link-local IPv6 Address – – Näyttää laitteen LinkLocal IPv6 -osoitteen.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

DHCP On / Off On Kytkee [DHCP]-toiminnon päälle / pois päältä.

IP Address – – Määrittää IPv4-osoitteen, kun kohdan [DHCP] asetuksena on Off.

Subnet
Mask

– –
Määrittää aliverkon peitteen, kun kohdan [DHCP] asetuksena on
Off.

Gateway – –
Määrittää IPv4-oletusyhdyskäytävän, kun kohdan [DHCP]
asetuksena on Off.
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Common
Määrittää IPv4/IPv6-verkkojen yhteiset asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Obtain an IP Address
Automatically

On / Off On
Kytkee automaattisen IPv6-osoitteen saannin
päälle / pois päältä.

IP Address – –
Määrittää IPv6-osoitteen, kun kohdan [Obtain an IP
Address Automatically] asetuksena on Off.

Prefix Length – –
Määrittää etuliitteen, kun kohdan [Obtain an IP Address
Automatically] asetuksena on Off.

Gateway – – Määrittää IPv6-oletusyhdyskäytävän, kun kohdan [Obtain
an IP Address Automatically] asetuksena on Off.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

HTTP Port 80, 1024–65534 80 Määrittää HTTP-portin numeron.

DNS Auto On / Off On Määrittää, haetaanko DNS-osoitteet DHCP-palvelimelta.

Primary DNS
Server

IPv4/IPv6-osoite –
Määrittää ensisijaisen DNS-palvelimen, kun kohdan [DNS
Auto] asetuksena on Off.

Secondary DNS
Server

IPv4/IPv6-osoite –
Määrittää toissijaisen DNS-palvelimen, kun kohdan [DNS
Auto] asetuksena on Off.
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File Transfer

Määrittää tiedostonsiirtoihin liittyvät asetukset.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Auto
Upload
(Proxy)

On / Off Off
Kytkee välityspalvelintiedoston automaattisen latauksen
päälle / pois päältä.

Default
Upload
Server

Server
Settings1–3 >
Display Name

Server
Settings1

Valitsee tiedostojen latauksen kohdepalvelimen. Tässä valitusta
palvelimesta tulee välityspalvelintiedostojen automaattisen
latauksen kohdepalvelin ja pikkukuvanäytöstä ladattavien
tiedostojen kohdepalvelin.
Näyttää [Display Name] -asetukset, jotka on määritetty kohdassa
[Server Settings1 –3].
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FTP Server 1–3

Määrittää FTP-tiedostonsiirtoihin liittyvät asetukset.
Asetukset ovat yleisiä palvelimille FTP Server 1–3.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Display Name – –
Määrittää siirtokohteen määritysvalikossa näkyvän
näyttönimen.

Service – – Näyttää palvelimen tyypin.

Host Name – – Määrittää siirtokohteen palvelimen isäntänimen.

Port 21, 990, 1024–
65534

21 Määrittää siirtokohteen palvelimen portin numeron.

User Name – –
Määrittää käyttäjänimen siirtokohteen palvelinyhteyden
todennukseen.

Password – –
Määrittää salasanan siirtokohteen palvelinyhteyden
todennukseen.

Passive Mode On / Off Off Kytkee passiivitilan päälle / pois päältä.

Destination
Directory

– – Määrittää siirtokohteen hakemiston nimen.

Using Secure
Protocol

On / Off Off
Määrittää, käytetäänkö (On) suojattua FTP-siirtoa vai ei
(Off).

Root Certificate – –

Lataa päävarmenteen suojattua FTP-siirtoa varten.
Paina [Load]-painiketta ja valitse päävarmenne näkyviin
tulevalla näytöllä.
Poista ladattu päävarmenne painamalla [Delete]-
painiketta.

Root Certificate
Status

– – Näyttää päävarmenteen latauksen tilan.

Reset – – Palauttaa [Server Settings] -asetukset oletuksiksi.
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SSL

Määrittää SSL:ään liittyvät asetukset.

SSL
Ottaa SSL-toiminnon käyttöön / pois käytöstä.

SSL Server Authentication
Määrittää SSL-palvelimen tunnistamiseen liittyvät asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Function
Disable / Enable / Enable (Allow HTTP connection
for some clients)

Disable
Ottaa SSL-toiminnon käyttöön /
pois käytöstä.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external
certificate

–
Määrittää SSL-palvelinvarmenteen
asennusmenetelmän.

Status – –
Näyttää SSL-palvelinvarmenteen voimassaolon, kun
kohdan [Certificate Options] asetuksena on [Use a
self-signed certificate (For test use)].

Issuer DN – –
Näyttää SSL-palvelinvarmenteen myöntäjän tunnetun
nimen, kun kohdan [Certificate Options] asetuksena
on [Use a self-signed certificate (For test use)].

Subject DN – –

Näyttää SSL-palvelinvarmenteen vastaanottajan
tunnetun nimen, kun kohdan [Certificate Options]
asetuksena on [Use a self-signed certificate (For test
use)].

Available Period – –
Näyttää SSL-palvelinvarmenteen voimassaoloajan,
kun kohdan [Certificate Options] asetuksena on [Use
a self-signed certificate (For test use)].

Extended Key
Usage

– –
Näyttää pidennetyn avaimen käyttömenetelmän, kun
kohdan [Certificate Options] asetuksena on [Use a
self-signed certificate (For test use)].

Delete – –

Painike tulee näkyviin, kun kohdan [Certificate
Options] asetuksena on [Use a self-signed certificate
(For test use)].
Poistaa asennetun SSL-palvelinvarmenteen.

Import – –
Asentaa ulkoisen SSL-palvelinvarmenteen listalta,
kun kohdan [Certificate Options] asetuksena on [Use
an external certificate].
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Kohde Alakohteen asetus Tehdasasetus Kuvaus

Private Key
Password

– –
Määrittää SSL-palvelinvarmenteen yksityisen
avaintiedon salasanan, kun kohdan [Certificate
Options] asetuksena on [Use an external certificate].

Reset – –
Tämä painike tyhjentää yksityisen avaimen
salasananäytön uutta salasanaa varten.

Self-Signed
Certificate
Generation

– –

Luo itse allekirjoitettu varmenne painamalla
[Generate]-painiketta, kun kohdan [Certificate
Options] asetuksena on [Use a self-signed certificate
(For test use)].
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Referer Check

Määrittää Referer Check -tarkistuksiin liittyvät asetukset.

Exception List
Määrittää Referer Check -poikkeusluetteloon liittyvät asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off On Kytkee Referer Check -toiminnon päälle/pois.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

No. 1–10 – Määrittää poikkeuksen numeron listalta.

Host
Name

– – Määrittää poikkeuksen isäntänimen.

Port
Number

– – Määrittää poikkeuksen portin numeron.

Set – – Rekisteröi määritetty poikkeus poikkeusluetteloon painamalla.

Delete – –
Valitse poikkeus, jonka haluat poistaa, ja poista rekisteröity poikkeus
poikkeusluettelosta painamalla painiketta.
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Brute Force Attack Protection

Määrittää väsytyshyökkäyksen torjuntaan liittyvät asetukset.

Kun hyökkääjä havaitaan, hyökkääjäluettelon tiedot näytetään.
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Setting On / Off On
Kytkee [Brute Force Attack Protection]-toiminnon päälle / pois
päältä.

Count 3–100 8
Määrittää, kuinka monta yritystä katsotaan hyökkäykseksi.
Käytössä, kun kohdan [Setting] asetuksena on On.

Release
Mode

Always / Timer Timer

Määrittää vapautusehdon.
Käytössä, kun kohdan [Setting] asetuksena on On.
Always: Älä poista hyökkääjälistalta.
Timer: Poista hyökkääjälistalta, kun kohdassa [Release Time]
määritetty vapautusaika on kulunut.

Release
Time

30–86400 s 60

Määrittää vapautusajan.
Käytössä, kun kohdan [Setting] asetuksena on On.
Kun kohdan Release Mode asetuksena on [Timer], kohteet
poistetaan hyökkääjälistalta, kun vapautusaika on kulunut.
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Stream

Määrittää suoratoistoasetukset (ks. ”Tietoja suoratoistosta”).

Stream Setting
Määrittää suoratoistoprotokollaan liittyvät asetukset.

Huomautus

Jos haluat käyttää RTMP:tä, aseta kohdan [Stream] > [Audio Stream] > [Setting] asetukseksi ennalta [On].

RTSP
Seuraavat kohteet näytetään, kun kohdan [Stream Setting] asetuksena on [RTSP].
Määrittää RTSP-suoratoistoon liittyvät asetukset.

RTMP
Seuraavat kohteet näytetään, kun kohdan [Stream Setting] asetuksena on [RTMP].
Määrittää RTMP-suoratoistoon liittyvät asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX / Off RTSP Valitsee suoratoistoprotokollan.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Port Number
554, 1024–
65534

554 Määrittää RTSP-portin numeron.

Time Out 0–600 60
Määrittää RTSP-suoratoiston Keep Alive -komennon
aikakatkaisun.

Authentication On / Off On Kytkee RTSP-tunnistamistoiminnon päälle / pois päältä.

Video Port
Number 1

1024–65534 51000
Määrittää RTSP-täsmälähetyssuoratoistoon lähetettävän
video 1:n porttinumeron.

Video Port
Number 2

1024–65534 53000
Määrittää RTSP-täsmälähetyssuoratoistoon lähetettävän
video 2:n porttinumeron.

Audio Port
Number

1024–65534 57000
Määrittää RTSP-täsmälähetyssuoratoistoon lähetettävän
äänen porttinumeron.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Server URL – – Määrittää RTMP- tai RTMPS-yhteyden kohde-URL:n.
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SRT
Seuraavat kohteet näytetään, kun kohdan [Stream Setting] asetuksena on [SRT-Caller] tai [SRT-Listener].
Määrittää SRT-suoratoistoon liittyvät asetukset.

NDI|HX
Seuraavat kohteet näytetään, kun kohdan [Stream Setting] asetuksena on [NDI|HX].
Määrittää NDI|HX:ään liittyvät asetukset.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Stream Key – –
Määrittää RTMP-palvelimen puolelta saadun
suoratoistoavaimen.

Root
Certificate

– –

Lataa RTMP-palvelimen yhteyden edellyttämän
juurivarmenteen.
Paina [Load]-painiketta ja valitse päävarmenne näkyviin
tulevalla näytöllä.
Poista ladattu päävarmenne painamalla [Delete]-painiketta.
Tila näkyy kohdassa [Root Certificate Status].

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Destination – –
Määrittää yhteyden kohde-URL:n, kun laite toimii
soittajana.

Port
Number

1024–65534 4201
Määrittää kuuntelun porttinumeron, kun laite toimii
kuuntelijana.

Latency 20–8000 ms 120 Määrittää viiveen.

TTL 1–255 64 Määrittää TTL-arvon.

Encryption Off / AES128 / AES256 Off Ottaa salauksen käyttöön / pois käytöstä ja määrittää
salausmenetelmän.

Passphrase
0 tai 10–79 merkin
merkkijono

0
Määrittää salaukseen käytettävän salasanan.
Tyhjennä syötetty salasana painamalla Reset.

ARC On / Off On
Kytkee Adaptive Rate Control -toiminnon päälle / pois
päältä.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

License – – Näyttää NDI-lisenssiavaimen asennustilan.

Source Name – – Näyttää NDI-lähteen nimen.

Group On / Off Off Kytkee NDI-ryhmittelytoiminnon päälle / pois päältä.

Group Name – –
Näytetään, kun NDI-ryhmittelytoiminnon asetuksena on On.
Määrittää ryhmän nimen.

Discovery Server
1

– – Määrittää NDI-hakupalvelimen 1.
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Aiheeseen liittyvää

Tietoja suoratoistosta
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Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Discovery Server
2

– – Määrittää NDI-hakupalvelimen 2.

Multicast Mode On / Off Off Kytkee monilähetyssuoratoiston päälle / pois päältä.

Multicast Prefix 239.255.0.0 239.255.0.0
Näytetään, kun kohdan [Multicast Mode] asetuksena on
On.
Määrittää monilähetyssuoratoistossa käytettävän etuliitteen.

Multicast
Netmask

255.255.0.0 255.255.0.0

Näytetään, kun kohdan [Multicast Mode] asetuksena on
On.
Määrittää verkkomaskin, joka määrää monilähetyksen
osoitevälin.

Multicast TTL 1–256 3
Näytetään, kun kohdan [Multicast Mode] asetuksena on
On.
Määrittää TTL-arvon monilähetyssuoratoistolle.

Multi-TCP Mode On / Off Off Kytkee Multi-TCP -tilan päälle / pois päältä.

Unicast UDP
Mode

On / Off On Kytkee Unicast UDP -tilan päälle / pois päältä.
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Video Stream

Määrittää suoratoiston videokoodekkiin liittyvät asetukset.

Video Stream 1
Määrittää videokoodekkiin 1 liittyvät asetukset.

Video Stream 2

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Codec 1 H.264 / H.265 H.264 Määrittää kuvan 1 koodekin.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 Määrittää kuvan 1 kuvakoon.

Frame Rate 1

Lisätietoja tuetuista kuvataajuuksista on
kohdassa ”Videokoodekin
määrittäminen suoratoistoa varten”.

– Määrittää kuvan 1 kuvataajuuden.

I-Picture Mode 1 Time / Frame Time
Määrittää kuvan 1 IDR-Frame-
lisäämisintervallin ajaksi tai kuvien
määräksi.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Näytetään, kun kohdan [I-Picture
Mode 1] asetuksena on Time.
Määrittää H.264:n ja H.265:n IDR-
Frame-lisäämisintervallin ajaksi.

I-Picture Ratio 1 15–300 kuvaa 30

Näytetään, kun kohdan [I-Picture
Mode 1] asetuksena on Frame.
Määrittää H.264:n ja H.265:n IDR-
Frame-lisäämisintervallin kuvien
määräksi.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Määrittää profiilin H.264 tai H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Määrittää kuvan 1 bittinopeuden
pakkaamistilan.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 / 24000 /
32000 / 50000 / 64000 / 80000 kbps

16000

Näytetään, kun kohdan [Bit Rate
Compression Mode 1] asetuksena
on On.
Määrittää bittinopeuden
kohdearvon, kun bittinopeuden
pakkaamistilan asetuksena on
CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Määrittää laadun H.264 tai H.265.
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Määrittää videokoodekkiin 2 liittyvät asetukset.

Video Stream 3
Määrittää videokoodekkiin 3 liittyvät asetukset.

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Codec 2 H.264 / H.265 / Off Off Määrittää kuvan 2 koodekin.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 Määrittää kuvan 2 kuvakoon.

Frame Rate 2

Lisätietoja tuetuista kuvataajuuksista
on kohdassa ”Videokoodekin
määrittäminen suoratoistoa varten”.

–
Näytetään, kun kohdan [Codec 2]
asetuksena ei ole Off.
Määrittää kuvan 2 kuvataajuuden.

I-Picture Mode 2 Time / Frame Time

Näytetään, kun kohdan [Codec 2]
asetuksena ei ole Off.
Määrittää kuvan 2 IDR-Frame-
lisäämisintervallin ajaksi tai kuvien
määräksi.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Näytetään, kun kohdan [Codec 2]
asetuksena ei ole Off ja kohdan [I-
Picture Mode 2] asetuksena on [Time].
Määrittää H.264:n ja H.265:n IDR-
Frame-lisäämisintervallin ajaksi.

I-Picture Ratio 2 15–300 kuvaa 30

Näytetään, kun kohdan [Codec 2]
asetuksena ei ole Off ja kohdan [I-
Picture Mode 2] asetuksena on
[Frame].
Määrittää H.264:n ja H.265:n IDR-
Frame-lisäämisintervallin kuvien
määräksi.

Profile 2
H.264: high / main / baseline
H.265: main

– Määrittää profiilin H.264 tai H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Näytetään, kun kohdan [Codec 2]
asetuksena ei ole Off.
Määrittää kuvan 2 bittinopeuden
pakkaamistilan.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

8000

Näytetään, kun kohdan [Codec 2]
asetuksena ei ole Off ja kohdan [Bit
Rate Compression Mode 2]
asetuksena on [On].
Määrittää bittinopeuden kohdearvon,
kun bittinopeuden pakkaamistilan
asetuksena on CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Näytetään, kun kohdan [Codec 2]
asetuksena on H.264 ja kohdan [Bit
Rate Compression Mode 2]
asetuksena on Off.
Määrittää laadun H.264 tai H.265.
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Aiheeseen liittyvää

Videokoodekin määrittäminen suoratoistoa varten

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Codec 3 JPEG JPEG
Määrittää kuvan 3
koodekin.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Määrittää kuvan 3
kuvakoon.

Frame
Rate 3

Lisätietoja tuetuista kuvataajuuksista on kohdassa
”Videokoodekin määrittäminen suoratoistoa varten”. –

Määrittää kuvan 3
kuvataajuuden.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Määrittää laadun.

421



Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Stream

Määrittää suoratoiston äänikoodekkiin liittyvät asetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Setting On / Off Off Asettaa äänen suoratoiston lähdön päälle/pois.

Codec AAC (128 kbps) / AAC (256 kbps) AAC (128 kbps)
Näytetään, kun kohdan [Setting] asetuksena on On.
Määrittää äänikoodekin suoratoistoa varten.
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Language

Määrittää näyttökielen.

Huomautus

Saatavilla olevat kielet voivat vaihdella maasta tai alueesta riippuen.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Language – – Määrittää näyttökielen.
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Accessibility

Määrittää äänilukuun (puhesynteesi) liittyvät asetukset.

Huomautus

Tämä toiminto on saatavilla vain Pohjois-Amerikassa myytävissä malleissa. Näytönlukijatoimintoa voi käyttää vain, kun kieleksi
on asetettu englanti (julkaisuhetkellä).

Ota verkkoselaimen näytönlukijatoiminto käyttöön laitteella, jossa verkkosovellusta käytetään.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Screen
Reader

On / Off Off 
Kytkee näytönlukijatoiminnon verkkosovelluksen
kameran kuvapaneelissa päälle/pois.

Speech
Rate

Slow2 / Slow1 / Normal / Fast1
/ Fast2 / Fast3 / Fast4

Normal
Määrittää näytönlukijatoiminnon nopeuden.
Näytekappale luetaan ääneen määritetyllä
nopeudella.

Speech
Volume

1–15 7

Määrittää verkkosovelluksen näytönlukijatoiminnon
äänenvoimakkuuden.
Näytekappale luetaan ääneen määritetyllä
äänenvoimakkuudella.
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Clock Set

Määrittää sisäisen kellon asetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Current Date
& Time

– – Näyttää laitteeseen määritetyn nykyisen ajan.

PC Clock – –
Näyttää määrittämiseen käytetyn tabletin tai
tietokoneen nykyisen ajan.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd Määrittää päivämäärän ja ajan näyttömuodon.

12 h / 24 h 12 h / 24 h 24 h Määrittää ajan 12/24 tunnin näyttömuotoon.

Time Setting
Keep current setting /
Synchronize with PC / Manual
setting / Synchronize with NTP

–
Määrittää päivämäärän ja kellonajan
määritysmenetelmän.

yy-mm-dd
hh:mm:ss

yy: 19–37
mm: 01–12
dd: 01–31
hh: 00–23
mm: 00–59
ss: 00–59 (sekuntia)

–
Näytetään, kun kohdan [Time Setting] asetuksena
on Manual setting.
Määrittää päivämäärän ja kellonajan käsin.

NTP Auto On / Off Off

Näytetään, kun kohdan [Time Setting] asetuksena
on Synchronize with NTP.
Määrittää, haetaanko NTP-palvelimen IP-osoite
DHCP-palvelimelta.

NTP Server IPv4/IPv6-osoite tai isäntänimi –

Näytetään, kun kohdan [Time Setting] asetuksena
on [Synchronize with NTP] ja kohdan [NTP Auto]
asetuksena on Off.
Määrittää ajan synkronointiin käytettävän NTP-
palvelimen.

Time Zone UTC – 12:00 – UTC + 14:00 – Valitsee aikavyöhykkeen.
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Reset

Alustaa laitteen.

Reboot
Käynnistää laitteen uudelleen.

Reset
Nollaa laitteen asetukset.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Reboot Execute –

Käynnistää laitteen uudelleen.
Execute: Suorita toiminto.

Huomautus

Lataa sivu uudelleen verkkoselaimessa uudelleenkäynnistyksen
jälkeen.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

All Reset (except
for Network
Settings)

Execute –

Nollaa laitteen asetukset (paitsi verkkoasetukset).
Execute: Suorita toiminto.

Huomautus

Tuotuja perusulkoasuja ja LUT-tiedostoja ei poisteta.

Network Reset Execute –

Nollaa laitteen verkkoasetukset.
Execute: Suorita toiminto.

Huomautus

Network Reset-toiminnon suorittamisen jälkeen laite käynnistyy
uudelleen. Lataa sivu uudelleen verkkoselaimessa
uudelleenkäynnistyksen jälkeen.

Factory Default Execute –

Nollaa laitteen asetukset tehdasasetustilaan.
Execute: Suorita toiminto.

Huomautus

Factory Default-toiminnon suorittamisen jälkeen laite
käynnistyy uudelleen. Lataa sivu uudelleen verkkoselaimessa
uudelleenkäynnistyksen jälkeen.
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Information

Näyttää kameran ja objektiivin tiedot. Käytetään myös ohjelmiston päivittämiseen.

Camera
Näyttää kameran tiedot ja päivittää ohjelmiston.

Lens
Näyttää objektiivin tiedot ja päivittää ohjelmiston.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Model
Name

– – Näyttää kameran mallin nimen.

Serial
Number

– – Näyttää kameran sarjanumeron.

Version
Number – – Näyttää kameran ohjelmistoversion.

Version Up – –

Päivitä kameran ohjelmisto painamalla [Choose File] -painiketta ja
noudattamalla näytöllä näkyviä ohjeita.

Huomautus

Laite käynnistyy uudelleen päivittämisen jälkeen. Lataa sivu
uudelleen verkkoselaimessa uudelleenkäynnistyksen jälkeen.

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Model
Name

– – Näyttää objektiivin mallin nimen.

Serial
Number

– – Näyttää objektiivin sarjanumeron.

Version
Number

– – Näyttää objektiivin ohjelmistoversion.
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Aiheeseen liittyvää

E-pidikkeellisen objektiivin ohjelmiston päivittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

Version Up – –

Päivitä objektiivin ohjelmisto painamalla [Choose File] -painiketta ja
noudattamalla näytöllä näkyviä ohjeita.

Lisätietoja on kohdassa ”E-pidikkeellisen objektiivin ohjelmiston
päivittäminen”.

Huomautus

Laite käynnistyy uudelleen objektiivin päivittämisen jälkeen. Lataa sivu
uudelleen verkkoselaimessa uudelleenkäynnistyksen jälkeen.
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System Log

Määrittää järjestelmälokiin liittyvät asetukset.

Haettu loki näytetään alla olevassa muodossa.

Aiheeseen liittyvää

E-pidikkeellisen objektiivin ohjelmiston päivittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Määrittää järjestelmälokiin lisättävien merkintöjen
tason.

Log Size 200–1024 1024
Määrittää järjestelmälokiin tallennettavien
merkintöjen koon.

Download
as File

– –
Tallenna järjestelmäloki tabletille tai tietokoneelle
näkyvissä olevalta näytöltä painamalla [Download]-
painiketta.
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HTTP Access Log

Määrittää HTTP-käyttölokiin liittyvät asetukset.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen asetus Tehdasasetus Kuvaus

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Määrittää HTTP-käyttölokiin lisättävien merkintöjen
tason.

Log Size 200–1024 1024
Määrittää HTTP-käyttölokiin tallennettavien
merkintöjen koon.

Download
as File

– –
Tallenna HTTP-käyttöloki tabletille tai tietokoneelle
näkyvissä olevalta näytöltä painamalla [Download]-
painiketta.
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Service

Hakee yksikön laitetiedot. Käytä ottaessasi yhteyttä Sonyn palveluedustajaan.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kohde Alakohteen
asetus Tehdasasetus Kuvaus

I agree to
download device
information.

– –

Aseta tähän valintamerkki osoittamaan, että hyväksyt
laitetietojen hakemisen, ja paina [OK]-painiketta.
Paina näkyviin tulevaa [Download]-painiketta. Verkkoselain
lataa tiedoston nimeltä deviceinformation.dat.

Huomautus

Laite käynnistyy uudelleen lataamisen jälkeen. Käynnistä laite
uudelleen manuaalisesti, jos se ei käynnisty uudelleen
automaattisesti. Lataa sivu uudelleen verkkoselaimessa
uudelleenkäynnistyksen jälkeen.
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EULA

Näyttää loppukäyttäjän lisenssisopimuksen (EULA).

5-041-958-73(1) Copyright 2022 Sony Corporation
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Software

Näyttää ohjelmistolisenssin.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ulkoisten näyttöjen ja tallennuslaitteiden liittäminen

Jotta voit näyttää tallennettua/toistettavaa kuvaa ulkoisessa näytössä, määritä ulkoisen näytön videolähdön tyyppi ja
käytä sopivaa kaapelia näytön liittämiseen.
Voit liittää myös ulkoisen tallentimen ja tallentaa lähtösignaalia laitteesta.
Voit näyttää ulkoisella näytöllä samat tiedot, joka näkyvät kameran kuvapaneelissa, kuten tilatiedot ja valikot. Määritä
haluttu näytön järjestelmätyyppi tilaan On verkkovalikon kohdassa [Monitoring] > [Output Display].

Huomautus

Jos HDMI-liittimeen on kytkettynä näyttö, joka ei tule verkkovalikon tai kameran valikon [Monitoring]-valikossa määritettyä HDMI-
lähtömuotoa, kameran kuvaa ei lähetetä verkkosovellukseen. Suoratoistovideota ei myöskään voida lähettää.

Molempien kohtien, [Output Display] > [SDI] ja [HDMI/Stream], asetuksena voi olla [Off], mutta tällöin näytöstä riippuvien kameran
valikon ja toimintojen käyttö ei onnistu. Lisäksi laitteen virheviestit rajoittuvat laitteen lamppuihin (palavat tai vilkkuvat) ja
verkkosovelluksen oikeassa yläkulmassa näkyvään ilmoitusmerkkiin. Jotta näet tilan tarkemmin, määritä kohdan [Output Display]
asetukseksi [On].

Vihje

Kohdan [Output Display] > [SDI] tehdasasetuksena on [Off], ja kohdan [HDMI/Stream] tehdasasetuksena on [On]. Jos haluat
käyttää suoratoistoa päävideona, aseta kohdan [SDI] asetukseksi [On] ja kohdan [HDMI/Stream] asetukseksi [Off] ja tarkkaile
kameran tilaa SDI-näytöltä.

SDI OUT -liitin (BNC-tyyppi)

Aseta lähtömuoto verkkovalikon tai kameran valikon kohdassa [Monitoring].
Käytä liitäntään kaupallisesti saatavilla olevaa 75 Ω:n koaksiaalikaapelia.

Huomautus

Tarkista, että laitteen ja ulkoisen laitteen välinen liitäntä on maadoitettu, ennen kuin kytket laitteisiin virran.

On suositeltavaa, että laite ja ulkoinen laite kytketään päälle 75 Ω:n koaksiaalikaapelin liittämisen jälkeen.
Jos ulkoinen laite on liitettävä laitteeseen laitteen ollessa päällä, liitä 75 Ω:n koaksiaalikaapeli ensin ulkoiseen laitteeseen
ja sen jälkeen laitteeseen.

Tallennuksen aloittaminen samanaikaisesti laitteella ja ulkoisella laitteella
Kun SDI-signaalin lähtö on käytössä, määritä kameran valikon kohdan [Project] > [SDI/HDMI Rec Control] > [Setting]
asetukseksi [SDI/HDMI Remote I/F] tai [Parallel Rec], jotta voit ottaa käyttöön REC-liipaisusignaalin lähdön ulkoiseen
laitteeseen, joka on liitetty SDI OUT -liittimeen. Tämä synkronoi tallentamisen ulkoiseen laitteeseen yhdessä laitteen
kanssa.

Huomautus

Jos liitetty ulkoinen laite ei tue REC-liipaisusignaalia, laitetta ei voi käyttää.

Kun kohdan [Project] > [SDI/HDMI Rec Control] > [Setting] asetuksena kameran valikossa on [SDI/HDMI Remote I/F], vain REC-
liipaisusignaali lähetetään silloin, kun tallennuksen tietovälinettä ei ole asetettu paikalleen ja tallennuksen START/STOP-
painiketta käytetään.

HDMI OUT -liitin (Type A -liitin)
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Määritä lähdön On/Off-asetus ja lähtömuoto kameran valikon [Monitoring]-valikossa.

Tallennuksen aloittaminen samanaikaisesti laitteella ja ulkoisella laitteella
Kun HDMI-signaalin lähtö on käytössä, määritä kameran valikon kohdan [TC/Media] > [HDMI TC Out] > [Setting]
asetukseksi [On] ja kohdan [Project] > [SDI/HDMI Rec Control] > [Setting] asetukseksi [SDI/HDMI Remote I/F] tai
[Parallel Rec], jotta voit ottaa käyttöön REC-liipaisusignaalin lähdön ulkoiseen laitteeseen, joka on liitetty HDMI OUT -
liittimeen. Tämä synkronoi tallentamisen ulkoiseen laitteeseen yhdessä laitteen kanssa.

Huomautus

Jos liitetty ulkoinen laite ei tue REC-liipaisusignaalia, laitetta ei voi käyttää.

Kun kohdan [Project] > [SDI/HDMI Rec Control] > [Setting] asetuksena kameran valikossa on [SDI/HDMI Remote I/F], vain REC-
liipaisusignaali lähetetään silloin, kun tallennuksen tietovälinettä ei ole asetettu paikalleen ja tallennuksen START/STOP-
painiketta käytetään.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Yhdistäminen RCP:llä/MSU:lla

Joitakin laitteen toimintoja voidaan etäohjata liittämällä laitteeseen LAN-kaapelilla etäohjauspaneeli (RCP), kuten RCP-
3500/3501, tai päämäärityslaite (MSU), kuten MSU-3500.
Liittämistapa vaihtelee laitteiden ja sovelluksen määritysten mukaan.

Lisätietoa laitteen ja RCP:n kahdenvälisestä yhteydestä on kohdassa ”Laitteen ja RCP:n kahdenvälinen yhteys”.
Lisätietoja useiden kameroiden yhdistämisestä MSU:n tai kameran hallintaohjelmiston avulla on kohdassa ”Laitteen
käyttäminen monikameraympäristössä MSU:lla tai kameran etäohjausohjelmistolla”.

Aiheeseen liittyvää

Laitteen ja RCP:n kahdenvälinen yhteys

Laitteen käyttäminen monikameraympäristössä MSU:lla tai kameran etäohjausohjelmistolla

5-041-958-73(1) Copyright 2022 Sony Corporation
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Laitteen ja RCP:n kahdenvälinen yhteys

Huomautus

Tutustu lukuun ”Tuettujen toimintojen lista” ja määritä laite siten, että se täyttää haluamiesi toimintojen käyttöedellytykset. Ota
sitten yhteys käyttöön RCP:llä noudattamalla seuraavia ohjeita.

Aiheeseen liittyvää
Tuettujen toimintojen lista

5-041-958-73(1) Copyright 2022 Sony Corporation

Kytke kukin laite päälle.1

Aseta kameran verkkovalikon kohdan [Technical] > [RCP/MSU] > [CNS Mode] asetukseksi [Bridge].2

Määritä RCP:ssä seuraavat asetukset.

Tietoja määrittämisestä on RCP:n käyttöohjeissa.

3

Valitse yhteystilaksi Bridge-tila.1.
Rekisteröi kameran IP-osoite.2.
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Laitteen käyttäminen monikameraympäristössä MSU:lla tai kameran
etäohjausohjelmistolla

MSU:n tai kameran etäohjausohjelmiston avulla voidaan yhdistää useita kameroita.

Huomautus

Tutustu lukuun ”Tuettujen toimintojen lista” ja määritä laite siten, että se täyttää haluamiesi toimintojen käyttöedellytykset. Ota
sitten yhteys käyttöön MSU:lla tai kameran etäohjausohjelmistolla noudattamalla seuraavia ohjeita.

Aiheeseen liittyvää
Tuettujen toimintojen lista

5-041-958-73(1) Copyright 2022 Sony Corporation

Kytke kukin laite päälle.1

Määritä järjestelmän verkkoasetukset MSU:lla tai kameran etäohjausohjelmistolla.

Lisätietoja määrittämisestä on MSU:n tai kameran etäohjausohjelmiston käyttöohjeissa.

2

Määritä seuraavat asetukset kameran verkkovalikon kohdassa [Technical] > [RCP/MSU].3

Jos käytät MSU:ta, aseta kohdan [CNS Mode] asetukseksi [MCS]. Jos käytät kameran etäohjausohjelmistoa,
valitse [CNS Mode] -asetukseksi [PC Control].

1.

Määritä pää-MSU:n tai kameran etäohjausohjelmiston IP-osoite kohdassa [Master IP Address].2.
Määritä kameran rekisteröinnissä käytettävä kameranumero kohdassa [Camera No.].3.
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Tuettujen toimintojen lista

Seuraavassa taulukossa luetellaan tuetut toiminnat ja niiden käyttöedellytykset.

Käyttöpaneeli Laitteen toiminnot Käyttöedellytykset

IRIS Himmentimen säätäminen käsin –

AUTO IRIS Auto Iris -toiminnon kytkeminen päälle / pois päältä –

ND
ND-suodattimen esiasetusvalinnan (Clear/Preset1 to
Preset3) vaihtaminen

Tämä toiminto on käytössä, kun kameran
valikon kohdan [Shooting] > [ND Filter] >
[Mode] asetuksena on [Preset].

MASTER GAIN
Herkkyysvahvistuksen säätäminen käsin (3 dB:n
välein)

Käytössä, kun kameran valikossa on valittu
kuvaustilaksi Custom ja kohdan [Shooting] >
[ISO/Gain/EI] > [Mode] asetuksena on [dB].

WHITE (R/B)
Valkotasapainon säätäminen (R Gain/B Gain)
manuaalisesti

Käytössä, kun kohdan [White Mode]
asetuksena on [Memory A(R/B)] tai [Memory
A(T/T)].WHITE (Color

Temp)

Valkotasapainon (värilämpötila/sävy) säätäminen
manuaalisesti

RCP – [Color Temp]: Valkotasapainon
värilämpötila
RCP – [Balance]: Valkotasapainon sävyarvo

ATW
ATW (Auto Tracing White Balance) -toiminnon
kytkeminen päälle / pois päältä

Käytössä, kun kuvaustilaksi on valittu
Custom.

BLACK R/B Mustatasapainon säätäminen
Käytössä, kun kuvaustilaksi on valittu
Custom.
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Huomautus

Määritä laite siten, että se täyttää haluamiesi toimintojen käyttöedellytykset. Ota sitten yhteys käyttöön RCP:llä/MSU:lla. Jos
käyttöedellytyksiä säädetään yhteyden käyttöönoton jälkeen, järjestelmä voi toimia odottamattomalla tavalla.
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Käyttöpaneeli Laitteen toiminnot Käyttöedellytykset

MASTER
BLACK

Master-mustan tason säätäminen

Käytössä, kun kuvaustilaksi on valittu
Custom.
H/V Ratio ja Crispening ovat käytössä,
kun kameran valikon kohdan
[Paint/Look] > [Detail] > [Manual Setting]
asetuksena [On].

DETAIL

Yksityiskohtatoiminnon kytkeminen päälle / pois
päältä
Yksityiskohtatason määrittäminen
Asetus H/V Ratio
Asetus Crispening

User Matrix

Käyttäjän matriisinkorjaustoiminnon kytkeminen
päälle / pois päältä
Matriisin korjausarvojen määrittäminen (R-G/R-
B/G-R/G-B/B-R/B-G)

Multi Matrix

Monen matriisin korjaustoiminnon kytkeminen
päälle / pois päältä
Monen matriisin korjaukseen käytettävän värin
sävyn ja kylläisyyden määrittäminen

Knee

Ylivalotuksen estotoiminnon kytkeminen päälle / pois
päältä
Automaattisen ylivalotuksen estotoiminnon
kytkeminen päälle / pois päältä
Ylivalotuksen estokohdan ja eston kulmakertoimen
määrittäminen

BARS Väripalkkien kytkeminen päälle / pois päältä

SHUTTER

Suljintoiminnon kytkeminen päälle / pois päältä
Suljinajan arvon asettaminen
(Automaattisen suljintoiminnon kytkemistä
päälle / pois päältä, suljinkulman asetusta, hitaan
sulkimen asetusta, ECS:n asetusta ei tueta.)

Huomautus

RCP-suljinasetusten näkyvyys riippuu
määritetystä suljinajan arvosta.

RCP-suljinasetukset eivät ehkä näy oikein, jos
suljinta ei voida ohjata RCP:llä.

Kun automaattinen suljin on käytössä, sen
toiminta jatkuu, vaikka kytket sulkimen
päälle / pois päältä tai muutat suljinajan
arvoa RCP:llä.
Kun sulkimen asetus on [Angle], sulkimen
kytkemistä päälle / pois päältä ja suljinajan
asetuksen muuttamista RCP:llä ei tueta.
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Toimintojen käyttäminen RM-IP500-kaukosäätimen (lisävaruste) avulla

Laitetta voi käyttää Sony RM-IP500 -kaukosäätimellä, kun ohjelmistoversio on 2.2 tai uudempi. Laitteet viestivät VISCA
over IP (LAN) -toiminnon kautta.
Käytettävästä kohteesta riippuen laitteen näytön on ehkä oltava näkyvissä. Valmistele näyttö, jota voidaan käyttää
näkymän näyttämiseen.
Seuraavia toimintoja voidaan käyttää RM-IP500-kaukosäätimellä.

Kohdekameran valitseminen
Rajauksen säätäminen (panorointi, kallistus, zoom)
Tarkennuksen säätäminen (ei kosketustoiminnot)
Esiasetusvalintojen rekisteröinti ja haku
Laitteen valikon käyttäminen (ei verkkovalikko)
Kirkkauden säätäminen
Valkotasapainon säätäminen
Mustatasapainon säätäminen
Äänen tulotason säätäminen
Tallentamisen aloittaminen/lopettaminen
Laitteen ohjelmoitujen painikkeiden toimintojen suorittaminen

Lisätietoja RM-IP500-toiminnoista on RM-IP500:n käyttöohjeessa.

Vihje

Kun käytät RM-IP500:tä, käytä RM-IP500:n mukana toimitettua tämän laitteen paneelisivua.

RM-IP500 (tämän laitteen paneelisivun käyttö)
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RM-IP500-kaukosäätimen liittäminen

Lisätietoja toimintojen ohjelmoimisesta on RM-IP500:n käyttöohjeessa.
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Ota VISCA over IP -viestintä käyttöön kääntämällä laitteen SETUP-kytkin 3 ON-asentoon.

Huomautus

Kytkimen asetukset otetaan käyttöön, kun laite käynnistyy seuraavan kerran.

1

Yhdistä RM-IP500 samaan verkkoon kuin laite.2

Noudata RM-IP500:n käyttöohjeen vaiheita VISCA over IP (LAN) -yhteyden määrittämiseen RM-IP500:ssa.

Ohjelmoi tämä laite kohdassa RM -valikko > AUTO IP SETUP > ASSIGN CAM.

3

Ohjelmoi tämän laitteen toiminnot painikkeisiin ja nuppeihin tarvittaessa seuraavien RM-IP500:n RM-valikon
kohteiden avulla.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Synkronoiminen ulkoisen laitteen kanssa

Kun kuvataan useilla laitteilla, laitteet voidaan synkronoida tiettyyn viitesignaaliin tai aikakoodiin laitteiden GENLOCK-
liittimen avulla.

Lisätietoja tahtilukituksesta on kohdassa ”Videosignaalin vaiheiden synkronointi (tahtilukitus)”.
Lisätietoja aikakoodien synkronoimisesta on kohdassa ”Aikakoodin lukitseminen muihin laitteisiin”.

Aiheeseen liittyvää
Videosignaalin vaiheiden synkronointi (tahtilukitus)

Aikakoodin lukitseminen muihin laitteisiin

5-041-958-73(1) Copyright 2022 Sony Corporation
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Videosignaalin vaiheiden synkronointi (tahtilukitus)

Tahtilukituksen voi ottaa käyttöön toimittamalla viitesignaalin GENLOCK-liittimeen.
Käytettävissä olevat tuloviitesignaalit riippuvat valitun tallennusmuodon järjestelmätaajuudesta.

Voit tarkistaa ulkoisen synkronoinnin tilan kameran valikon kohdassa [Technical] > [Genlock] > [Reference].

Huomautus

Jos viitesignaali on epävakaa, tahtilukitusta ei voida tehdä.

Apukantoaalto ei synkronoidu.
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Tallennusmuodon taajuusasetus Tuetut tulonviitesignaalit

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Aikakoodin lukitseminen muihin laitteisiin

Määritä aikakoodin antava laite tilaan, jossa aikakoodin lähtö pysyy toiminnassa (kuten Free Run tai Clock).

Huomautus

Tarkista, että toimitettu viiteaikakoodi ja viitevideosignaali ovat vaihesuhteessa, joka vastaa SMPTE-aikakoodistandardia.

Kun käytät ulkoista lukitusta, aikakoodi saa heti lukituksen ulkoiseen aikakoodiin ja ulkoisen aikakoodin arvo näkyy aikatietojen
näytön alueella. Älä kuitenkaan aloita tallentamista välittömästi. Odota ennen tallentamista muutama sekunti, että
aikakoodigeneraattori tasaantuu.

Jos viitevideosignaalin taajuus ja laitteen kuvataajuus eivät ole samat, lukitus ei onnistu eikä laite toimi kunnolla. Jos näin käy,
aikakoodin lukitus ulkoiseen aikakoodiin ei onnistu.

Jos yhteys ulkoiseen aikakoodilähteeseen katkeaa, aikakoodi voi muuttua yhden kuvan verran tunnissa viiteaikakoodin suhteen.

Ulkoisen lukituksen vapauttaminen
Muuta kameran valikon asetus [TC/Media] > [Timecode].
Ulkoinen synkronointi vapautuu myös, jos järjestelmän taajuus muuttuu jakun alat tallentaa erikoistallennustilassa
(hidastus ja nopeutus tai Interval Rec).
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Aseta seuraavat kameran valikon kohdassa [TC/Media] > [Timecode].

Määritä kohdan [Mode] asetukseksi [Preset].
Määritä kohdan [Run] asetukseksi [Free Run].

1

Näytä aikakoodi näytöllä painamalla ohjelmoitavaa painiketta, johon [DURATION/TC/U-BIT] -toiminto on
ohjelmoitu.

2

Toimita HD- tai SD-viitevideosignaali GENLOCK-liittimeen ja viiteaikakoodi TC IN -liittimeen.

Laitteen aikakoodigeneraattori lukittuu viiteaikakoodiin, ja näytöllä näkyy ”EXT-LK”.
Kun noin kymmenen sekuntia on kulunut aikakoodi lukituksen jälkeen, ulkoisen lukituksen tila säilyy, vaikka ulkoisen
viiteaikakoodin lähteen yhteys katkeaisi.

3
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Ulkoisen mikrofonin tai ulkoisen äänilaitteen liittäminen

Signaalin tuloon voi käyttää ulkoista mikrofonia tai äänilaitetta ja upottaa äänen laitteen tallentamaan tai lähettämään
videoon.

Liitä ulkoinen mikrofoni tai ulkoinen äänilaite XLR-johdon avulla.

Kun äänen asetukseksi on valittu [LINE] kameran valikon kohdassa [Audio] > [Audio Input] > [AUDIO IN Select],
AUDIO IN -liitin toimii AUDIO IN CH-1- ja AUDIO IN CH-2 -liittimenä.

1

Navan nro Toiminto

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Sammuta laite ja liitä XLR-johto AUDIO IN -liittimeen.2

Määritä SETUP-kytkin 2 käyttämään phantom-virransyöttöä tarpeen mukaan.

Kytke +48V-virta (phantom-virransyöttö) alla kuvatulla tavalla.
Kytkin 2
Määrittää, kytketäänkö +48 V -virtalähde (phantom-virta) päälle / pois päältä, kun äänitulolaite on kytkettynä.

3

Asetus Kuvaus

OFF
(oletus)

Tämä poistaa +48 V -phantom-virransyötön käytöstä ja määrittää LINE- tai MIC-tulon CH-1- ja CH-
2-äänilähteeksi.
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Huomautus

Jos tämä kytkin on ON-asennossa ja liitetty mikrofoni ei ole yhteensopiva +48 V -lähteen kanssa, liitetty laite voi vaurioitua.
Tarkista asetus ennen laitteen liittämistä.

Asetus Kuvaus

ON
Tämä ottaa +48 V -phantom-virransyötön käyttöön ja määrittää phantom-virtaa tukevan mikrofonin
CH-1- ja CH-2-äänilähteeksi.

Käynnistä laite ja aseta liitetyn laitteen tyyppi kameran valikon kohdassa [Audio] > [Audio Input] > [AUDIO
IN Select].

4
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Leikkeiden hallitseminen/muokkaaminen tietokoneella

Leikkeitä voi hallita/muokata tietokoneella.

Leikkeiden tuominen kortinlukijan (lisävaruste) avulla

Liitä CFexpress Type A -kortinlukija tai SD-kortinlukija tietokoneeseen ja tuo leikkeet käyttämällä ohjelmistoa, joka tukee
tämän laitteen tallennusmuotoa, esimerkiksi Catalyst Browse.

Non-lineaarisen editointijärjestelmän käyttäminen

Non-lineaarisessa editointijärjestelmässä tarvitaan editointiohjelmisto (lisävaruste), joka tukee laitteen tallentamia
muotoja.
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Optisen kuitusignaalin lähettäminen

Optiseen muotoon muunnetun SDI-signaalin voi lähettää liittämällä SFP+-moduulin (lisävaruste) laitteen OPTICAL-
liittimeen. Käytä SFP+-moduulia, joka vastaa kunkin muodon signaalikaistaa.
Signaalikaista

4K (59.94p, 50p): 12G
4K (muu kuin 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (muu kuin 59.94p, 50p): 1.5G

Huomautus

Käytä moduulia, joka noudattaa seuraavia standardeja.

SFF-standardit
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI-standardit
ST297/ST292/ST424/ST425/ST2081/ST2082

SDI-lähtöliittimen signaali on sama, joka lähetetään SFP+-moduuliin.

Laite ei tue optisen kuidun signaalituloa.

Käytä SFP+-moduulia optisen kuidun signaalituloon. Lisätietoja vahvistetuista SFP+-moduuleista saat ottamalla yhteyttä
jälleenmyyjään tai Sonyn palveluedustajaan.
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* Tehotaso I (1,0 W)
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Tally-merkkivalosignaalin yhdistäminen

Tässä osiossa käsitellään Tally-merkkivalosignaalin hallintaa.

Tally-merkkivalon sytyttäminen kaukosäätimen signaalin avulla

Tally-merkkivalon voi sytyttää VISCA over IP -komennolla ulkoisesta laitteesta, kuten RM-IP500:sta.
Aseta verkkovalikon tai kameran valikon kohdan [Technical] > [Tally] > [Tally Control] asetukseksi [External].

Tally-merkkivalon sytyttäminen ulkoisen laitteen avulla

Tally-merkkivalon voi sytyttää punaisena tai vihreänä ulkoisesta laitteesta, kuten RM-IP500:sta tai vaihtajasta. Tally-
merkkivaloa voi hallita komennoilla, jotka lähetetään verkon kautta, tai laitteen OPTION-liittimen Tally-signaalitulon avulla.
Aseta verkkovalikon tai kameran valikon kohdan [Technical] > [Tally] > [Tally Control] asetukseksi [External].
Kun Tally-signaali tuodaan OPTION-liittimeen, oikosulje napa 7 GND:hen (joko napa 4 tai 5), niin Tally-merkkivalo syttyy
vihreänä, tai napa 8 GND:hen (joko napa 4 tai 5), niin Tally-merkkivalo syttyy punaisena.

Huomautus

Kun [Tally Control]-asetuksena on [External], laitteen tallentamisen tilaa ei osoiteta Tally-merkkivalolla.

Kun punainen ja vihreä Tally-signaali tuodaan yhtä aikaa, laitteen Tally-merkkivalo syttyy punaisena.

OPTION-liittimen napojen tekniset tiedot

Navan
nro

Signaalin
suunta Signaalimääritykset

1 – RS-232C TX -signaali (objektiivin ohjainta varten)

2 – RS-232C RX -signaali (objektiivin ohjainta varten)

3 OUT

Vihreän Tally-merkkivalon lähtö
Matalan tason lähtö, kun vihreä Tally-merkkivalo palaa.
Hi-Z (Open Drain -lähtö), kun vihreä Tally-merkkivalo ei pala.

4 – GND (maadoitus)

5 – GND (maadoitus)
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Ulkoisen laitteen Tally-merkkivalon sytyttäminen laitteen signaalin avulla

Ulkoisen laitteen Tally-merkkivalon voi sytyttää laitteen signaalin avulla liittämällä OPTION-liittimen navat 3 ja 6 alla
kuvatulla tavalla.
OPTION-liittimen napojen 3 ja 6 liittämisen esimerkki

Huomautus

Älä syötä virtaa napoihin 7 ja 8.

Älä liitä ulkoista laitetta, joka voi syöttää virtaa OPTION-liittimeen.

Jos napoihin 3 tai 6 syötetään luokituksen ylittävä sysäys- tai estojännite, se voi aiheuttaa toimintahäiriön, savua tai tulipalon.

Aseta lähtösignaali verkkovalikon tai kameran valikon kohdassa [Technical] > [Tally] > [Tally Control].
[Internal]: Laitteen tallennustoiminnon tila
[External]: Vihreän/punaisen tally-signaalin TAI-toimitus laitteeseen IN-signaalien tai kaukosäätimien kautta.
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Navan
nro

Signaalin
suunta Signaalimääritykset

6 OUT

Punaisen Tally-merkkivalon lähtö
Matalan tason lähtö, kun punainen Tally-merkkivalo palaa.
Hi-Z (Open Drain -lähtö), kun punainen Tally-merkkivalo ei pala.

7 IN
Vihreän Tally-merkkivalon ulkoisen hallinnan tulo
Oikosulku maahan (napa 4 tai 5) aiheuttaa laitteen Tally-merkkivalon syttymisen
vihreänä.

8 IN
Punaisen Tally-merkkivalon ulkoisen hallinnan tulo
Oikosulku maahan (napa 4 tai 5) aiheuttaa laitteen Tally-merkkivalon syttymisen
punaisena.
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Seurantatietojen lähetys (free-d)

Laite voi lähettää panoroinnin/kallistuksen/zoomauksen, tarkennuksen ja himmentimen seurantatiedot synkronoituina
synkronointisignaaliin.
Lähetetyt tiedot ovat alan standardina käytetyn free-d-protokollan mukaisia. Voit valita lähetystavan: jatkuva lähetys tai
lähetys asiakkaiden pyynnöstä. Valitse lähetysmenetelmä VR-/AR-järjestelmäsi mukaan.

Datan lähetysmuoto

Vihje

Teknisiä tietoja on ”Integration manual for free-d” -oppaassa. Ota yhteyttä Sonyn myyntiedustajaan.

Laitteen lähettämät seurantatiedot käsittävät seuraavat tiedot free-d-protokollan kohdassa Type D0/D1 määritetyn
muodon mukaisesti.
Type D0 – poll/command

Varmista, että laite on käynnissä.1

Aseta seurantatietojen lähetystapa.

Jatkuva lähetys

Lähetys asiakkaiden pyynnöstä

2

Aseta verkkovalikon kohdan [Technical] > [Tracking Data Output] > [Transfer Mode] asetukseksi [Always].1.
Aseta laitteen tunnus kohdassa [Camera ID].2.
Määritä lähetyskohteen IP-osoite kohdassa [Destination Address].3.
Määritä lähetyskohteen portin numero kohdassa [Destination Port].4.
Paina [OK]-painiketta.5.

Aseta verkkovalikon kohdan [Technical] > [Tracking Data Output] > [Transfer Mode] asetukseksi [On Demand].1.
Aseta laitteen tunnus kohdassa [Camera ID].2.
Määritä asiakkaiden pyyntöjen kuunteluportin numero kohdassa [Listen Port].3.
Paina [OK]-painiketta.4.

Symboli Sisältö Kuvaus

<D0> Message type

<CA> Camera ID

<CD> command

Seuraavia komentoja tuetaan:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

Huomautus

Seurantatiedot voivat viivästyä tai niiden arvot eivät ehkä päivity seuraavissa tilanteissa:

Kun lähetetään RAW-videota
Kun S&Q Motion on käytössä
Kun kameran valikko on näkyvissä
Kun pikkukuvanäyttö on näkyvissä
Kun toistetaan tallennettuja leikkeitä
Kun verkkovalikko on näkyvissä
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Symboli Sisältö Kuvaus

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Panorointikulma (−170° – +170°)

<TH><TM><TL> Camera Tilt Angle Kallistuskulma (−30° – +195°)

<RH><RM><TL> Camera Roll Angle Ei tueta (aina 0)

<XH><XM><XL> Camera X-Position Ei tueta (aina 0)

<YH><YM><YL> Camera Y-Position Ei tueta (aina 0)

<HH><HM><HL> Camera Height Ei tueta (aina 0)

<ZH><ZM><ZL> Camera Zoom Polttoväli

<FH><FM><FL> Camera Focus Tarkennusetäisyys

<SH><SL> Spare/User Defined Himmentimen asento

<CK> Checksum
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Objektiivin ohjaimen liittäminen

Manuaalisen zoom-objektiivin zoomia voi ohjata verkkosovelluksella, RM-IP500:lla (lisävaruste) tai
infrapunakaukosäätimellä liittämällä objektiiviin tämän laitteen kanssa yhteensopivan objektiivin ohjaimen (lisävaruste).
Lisätietoja objektiivin ohjaimen liittämisestä on objektiivin ohjaimen käyttöohjeessa.
Lisätietoja on zoomin säätämisestä objektiivin ohjaimella on kohdassa ”Zoomin säätäminen objektiivin ohjaimella”.

Huomautus

Lue objektiivin ohjaimen käyttöohje huolellisesti ennen objektiivin ohjaimen käyttöä ja varmista, että ymmärrät ohjeet. Sony ei
vastaa mistään vaateista, jotka aiheutuvat objektiivin ohjaimen käytöstä.

Clear Image Zoom ei ole käytettävissä, kun käytetään objektiivin ohjainta. On suositeltavaa asettaa Clear Image Zoom -suhteeksi
1.0× tai poistaa Clear Image Zoom käytöstä.

Kun objektiivin ohjain on käytössä, kameran rajaustoimintoja ei voida tallentaa tai toistaa.

Aiheeseen liittyvää
Zoomin säätäminen objektiivin ohjaimella

5-041-958-73(1) Copyright 2022 Sony Corporation
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Zoomin säätäminen objektiivin ohjaimella

Liitä objektiivin ohjain seuraavien ohjeiden mukaisesti ja säädä zoomia.

Objektiivin ohjaimen tilan tarkistaminen
Avaa kameran tilanäyttö painamalla  (Kameran tila) -painiketta verkkosovellusnäytön yleisellä alueella.

Liitä objektiivin ohjain laitteen liitäntälohkon OPTION-liitäntään.

Tietoja liittämisestä on objektiivin ohjaimen käyttöohjeessa.

1

Määritä objektiivin ohjain zoom-objektiivia varten.

Lisätietoja on objektiivin ohjaimen käyttöohjeessa.

2

Lukitse laitteen panorointi/kallistus ja kiinnitä zoom-objektiivi.

Lisätietoja on kohdassa ”Objektiivin kiinnittäminen”.

3

Säädä objektiivin ohjain siten, että se voi ohjata zoom-objektiivia.4

Tasapainota kamerapää etu-/takasuunnassa, jotta liukualusta on vaakatasossa.

Lisätietoja on objektiivin ohjaimen käyttöohjeessa ja kohdassa ”Objektiivin kiinnittäminen”.

5

Aseta verkkovalikon kohdan [Technical] > [Lens Controller] > [Setting] asetukseksi [On] ja paina [OK]-
painiketta.

Laite käynnistyy uudelleen. Odota, kunnes panoroinnin/kallistuksen nollaus on päättynyt.

6

Paina verkkosovelluksen suoran käyttönäkymän  (Alusta objektiivin ohjain) -painiketta 
(Others) -välilehdessä kameran hallintapaneelissa.

Objektiivin ohjain liikkuu zoomausalueen havaitsemiseksi. Lisätietoja on objektiivin ohjaimen käyttöohjeessa.
Kun kameran kuvapaneelin vasemmassa yläkulmassa näkyvä  (Objektiivin ohjaimen virhe) -ilmaisin muuttuu 
(Objektiivin ohjain valmis) -ilmaisimeksi, valmistelu on päättynyt.

Huomautus

Ota huomioon objektiivin toiminta-alue objektiivin ohjainta alustaessasi.

7

Säädä zoomia verkkosovelluksen [Zoom]-liukusäätimellä tai infrapunakaukosäätimen zoomauksen
hallintapainikkeilla.

8
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Näet objektiivin ohjaimen tässä näytössä.

Huomautus

Alusta objektiivin ohjain, kun vaihdat objektiivia.

Clear Image Zoom ei ole käytettävissä, kun käytetään objektiivin ohjainta. On suositeltavaa asettaa Clear Image Zoom -suhteeksi
1.0× tai poistaa Clear Image Zoom käytöstä.

5-041-958-73(1) Copyright 2022 Sony Corporation

Tila Kuvaus

Off Käytä E-pidikkeellisen objektiivin moottorizoomausta.

Communication
Error

Tiedonsiirtovirhe laitteen ja objektiivin ohjaimen välillä.
Tarkasta laitteen ja objektiivin ohjaimen välinen yhteys. Lue sitten objektiivin ohjaimen käyttöohje
ja alusta objektiivin ohjain.

Uninitialized Suorita alustus.

Initializing Odota, kunnes alustus on päättynyt.

Initialization Failed
Tarkasta laitteen ja objektiivin ohjaimen välinen yhteys. Lue sitten objektiivin ohjaimen käyttöohje
ja alusta objektiivin ohjain.

Working Ohjaa zoomia objektiivin ohjaimella.

Rotation Error
Tallennettu zoomauksen liikealue ja objektiivin liikealue eivät ehkä vastaa toisiaan. Alusta
objektiivin ohjain.

System Error Tarkasta laitteen ja objektiivin ohjaimen välinen yhteys. Lue objektiivin ohjaimen käyttöohje ja
alusta objektiivin ohjain tai käynnistä laite ja objektiivin ohjain uudelleen.Unknown Error
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Käyttöä koskevat varoitukset

Muistettavaa kuljetuksessa ja pakkaamisessa
Kun laitetta siirretään tai pakataan, noudata seuraavia ohjeita ja vältä laitteen altistamista voimakkaalle tärinälle tai
iskuille.

Irrota objektiivi ja kiinnitä rungon suojus.
Kun kamerapää (A) on siirretty eteen, lukitse kamerapää kääntämällä kamerapään lukitusvipua (B) nuolen suuntaan.

Suuntaa kamerapää siten, että se osoittaa eteenpäin, ja lukitse se panoroinnin/kallistuksen lukitusvivulla.

Irrota liitäntäjohdot.

Kondensaatio
Jos laite siirretään suoraan kylmästä lämpimään paikkaan tai ympäristön lämpötila nousee yhtäkkiä, laitteen pinnalle
ja/tai sisälle saattaa muodostua kosteutta. Tätä kutsutaan kosteuden kondensoitumiseksi. Jos huomaat
kondensoitumista, katkaise virta laitteesta äläkä käytä sitä, ennen kuin kondenssi on haihtunut. Jos laitetta käytetään,
kun siinä on kondenssia, laite saattaa vahingoittua.

Kameran CMOS-kuvakennon ilmiöt

Huomautus

Seuraavat kuvissa mahdollisesti näkyvät ilmiöt ovat ominaisia kuvakennoille. Ne eivät ole merkkejä toimintahäiriöstä.

Valkoiset täplät
Vaikka kuvakennot edustavat huipputeknologiaa, näytölle voi joissakin harvinaisissa tapauksissa muodostua
hienoisia valkoisia täpliä esimerkiksi kosmisen säteilyn vuoksi.
Se liittyy kuvakennojen toimintaperiaatteeseen eikä kyse ole toimintahäiriöstä. Suorita APR säännöllisesti.
Valkoisia täpliä näkyy tyypillisesti seuraavissa tapauksissa:
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Kun laitetta käytetään ympäristön korkeissa lämpötiloissa
Kun herkkyysvahvistus on suuri

Välkkyminen
Kun kuvataan loisteputkien, natriumlamppujen, elohopealamppujen tai LED-valojen valaisemassa ympäristössä,
näyttö voi välkkyä tai värit voivat vaihdella.

Objektiivin ja panoroinnin/kallistuksen ohjausyksiköt
Jos linssin ja panoroinnin/kallistuksen ohjausmekanismi on pitkän aikaa käyttämättä, sen sisäpuolella olevan rasvan
viskositeetti voi lisääntyä, mikä estää mekanismin liikkumista. Käytä linssin ja panoroinnin/kallistuksen ohjausta
säännöllisesti.

Kulutusosista
Tuuletin ja sisäinen akku ovat kulutusosia, jotka on vaihdettava säännöllisesti.
Huoneenlämpötilassa käytettäessä normaali vaihtoväli on noin 5 vuotta. Tämä vaihtoväli on kuitenkin vain ohjeellinen
eikä takaa näiden osien odotettua käyttöikää.
Sonyn huoltoliike tai jälleenmyyjä antaa lisätietoja osan vaihtamisesta.

Verkkolaitteen ja elektrolyyttikondensaattorin odotettu käyttöikä on noin 5 vuotta normaaleissa käyttölämpötiloissa ja
normaalikäytössä (8 tuntia päivässä ja 25 päivää kuukaudessa). Jos edellä mainittu käyttömäärä ylitetään, odotettu
käyttöikä saattaa lyhentyä vastaavasti.

Määräaikaiset tarkastukset ovat suositeltavia, jotta laite toimii kunnolla ja sen käyttöikä olisi mahdollisimman pitkä.
Lisätietoja tarkastuksista saat ottamalla yhteyttä Sonyn palveluedustajaan.

Tietoa sisäisestä ladattavasta akusta
Laitteessa on sisäinen ladattava akku, jotta päivämäärä, kellonaika ja muita asetuksia pysyy tallessa silloinkin, kun laite
on pois päältä. Sisäinen ladattava akku latautuu täyteen 24 tunnissa, jos laite on liitetty pistorasiaan verkkovirtalaitteella
tai jos se ladataan PoE++:n avulla, riippumatta siitä, onko laite kytketty päälle / pois päältä. Ladattava akku purkautuu
tyhjäksi noin 2 kuukaudessa, jos verkkovirtalaitetta ei liitetä pistorasiaan. Käytä laitetta akun lataamisen jälkeen. Vaikka
ladattavaa akkua ei olisi ladattu, se ei kuitenkaan vaikuta laitteen käyttöön, jos päivämäärää ei tarvitse tallentaa.

Käyttö- ja säilytyspaikat
Säilytä tasaisessa, tuuletetussa paikassa.
Vältä laitteen käyttöä tai säilytystä seuraavissa paikoissa.

Paikoissa, jotka altistuvat sateelle tai vedelle (mukaan lukien räystäiden alla)
Ulkona ja paikoissa, joiden lämpötila ylittää 40 °C
Muista, että kesällä lämpötila voi autossa ikkunat suljettuina helposti ylittää 50 °C.
Paikoissa, joiden lämpötila alittaa 0 °C.
Kosteissa ja pölyisissä paikoissa. Paikoissa, joissa laite voi altistua sateelle
Paikoissa, joihin kohdistuu tärinää tai iskuja
Paikoissa, joissa syntyy säteilyä, röntgensäteitä ja voimakkaita magneettikenttiä.
Lähellä radio- tai televisiolähetintä, joka muodostaa vahvoja sähkömagneettisia kenttiä.
Pitkäaikaisesti suorassa auringonpaisteessa tai lähellä lämmittimiä

Huomautus lasersäteistä
Lasersäteet voivat vaurioittaa CMOS-kuvakennoa. Jos kuvaat lasersäteitä sisältävää kohtausta, ole varovainen äläkä
anna lasersäteen suuntautua kohti kameran CMOS-kuvakennoa. Erityisesti lääketieteellisten laitteiden ja muiden
laitteiden erittäin voimakkaat lasersäteet voivat aiheuttaa vaurioita heijastuvan valon ja hajavalon vuoksi.

Kannettavista viestintälaitteista tulevan sähkömagneettisen häiriön estäminen
Kannettavien puhelinten ja muiden viestintälaitteiden käyttäminen tämän laitteen lähellä voi aiheuttaa toimintahäiriöitä
sekä ääni- ja videosignaalien häiriöitä. On suositeltavaa, että kannettavien laitteiden virta sammutetaan tämän laitteen
lähellä.

Älä sijoita tätä laitetta lähelle lääketieteellisiä laitteita
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Tässä tuotteessa (lisävarusteet mukaan lukien) on magneetteja, jotka voivat häiritä tahdistimia, hydrokefalian hoitoon
tarkoitettuja ohjelmoitavia sunttiventtiileitä tai muita lääketieteellisiä laitteita. Älä sijoita tätä laitetta lähelle henkilöitä, jotka
käyttävät tällaisia lääketieteellisiä laitteita. Neuvottele lääkärin kanssa ennen tämän tuotteen käyttämistä, jos käytät jotain
tällaista lääketieteellistä laitetta.

Turvallisuusvaroitukset
SONY EI VASTAA MINKÄÄNLAISISTA VAHINGOISTA, JOTKA AIHEUTUVAT LÄHETYSLAITTEIDEN
ASIANMUKAISTEN TURVATOIMENPITEIDEN LAIMINLYÖNNISTÄ, LÄHETYSMÄÄRITYSTEN AIHEUTTAMISTA
VÄISTÄMÄTTÖMISTÄ TIETOVUODOISTA TAI MINKÄÄNLAISISTA TURVALLISUUSONGELMISTA.
Käyttöympäristöstä riippuen verkon valtuuttamattomat kolmannet osapuolet saattavat pystyä käyttämään laitetta. Kun
liität laitteen verkkoon, muista varmistaa, että verkon tietoturva on suojattu.
Turvallisuuden takaamiseksi verkkoon yhdistettyä laitetta käytettäessä on ehdottoman suositeltavaa käyttää Control-
ikkunaa verkkoselaimen kautta ja muuttaa tehtaalla määritettyjä käyttörajoitusasetuksia. On myös suositeltavaa
asettaa salasanaksi riittävän pitkä merkkijono, jota muiden on vaikea arvata, ja säilyttää se turvallisessa paikassa.
Yhdistä tuote verkkoon suojaustoiminnolla varustetun järjestelmän, esimerkiksi reitittimen tai palomuurin, kautta.
Yhdistäminen ilman tällaista suojausta voi johtaa tietoturvaongelmiin.

Virtalähde
Laitteessa ei ole virtakytkintä. Sammuta laite tarkistamalla, että kaikki toiminnot ovat päättyneet ja laite on virran
valmiustilassa, ja irrottamalla sitten verkkovirtalaite. Jos virransyöttöön käytetään PoE++:tä, irrota LAN-kaapeli.
Käytä mahdollisuuksien mukaan sellaisessa paikassa olevaa virtalähdettä, jossa pistoke on helppo asettaa ja irrottaa.
Jos käytät pölyisessä paikassa olevaa pistorasiaa, puhdista pistorasian ympäristö säännöllisesti pintavirran
välttämiseksi.
Irrota virransyöttö, kun laitetta ei käytetä.

Muistettavaa liikkuvista osista
Varmista, että liikkuviin osiin ei pääse vieraita aineita.
Älä käytä liikaa voimaa, kun liikutat osia käsin. Se voi aiheuttaa toimintahäiriön.
Älä puutu liikkuvien osien toimintaan niiden liikkuessa. Se voi aiheuttaa loukkaantumisen tai toimintahäiriön.
Liikkuvat osat eivät välttämättä toimi normaalisti, jos laite on käyttämättä pitkiä aikoja. Käytä laitteen
panorointi-/kallistustoimintoa säännöllisesti.

Muistettavaa jatkuvassa käytössä
Laitteen virta voi olla kytkettyn 24 tuntia vuorokaudessa, 365 päivää vuodessa (virran valmiustila).
Suorita aina kuvaustesti ja varmista, että laite toimii normaalisti.

Jatkuvaa kuvausta yli 24 tunnin jaksoissa ei taata.
Jos kuvaat yli 24 tuntia, aseta laite virran valmiustilaan ja käynnistä laite sitten uudelleen.

Huomaa, että Sony ei ole vastuussa minkäänlaisista korvauksista kuvien sisällön osalta, jos kuvaaminen ei ole
mahdollista toimintavirheen takia tätä laitetta käytettäessä.
Varmista aina ennen käyttöä, että laite toimii kunnollisesti. SONY EI OLE MISSÄÄN VASTUUSSA VAHINGOISTA
MUKAAN LUKIEN, MUTTA EI NIIHIN RAJOITTUEN, KORVAUKSET TAI HYVITYKSET TÄMÄN LAITTEEN
TAKUUKAUDEN AIKAISISTA TAI TAKUUAJAN UMPEUDUTTUA TAPAHTUNEISTA TOIMINTAHÄIRIÖISTÄ
AIHEUTUNEIDEN NYKYISTEN TAI TULEVIEN TULOJEN MENETYKSISTÄ.
SONY EI OLE MISSÄÄN VASTUUSSA LAITTEEN KÄYTTÄJIEN TAI KOLMANSIEN OSAPUOLTEN ESITTÄMISTÄ
VAATIMUKSISTA.
SONY EI OLE MISSÄÄN VASTUUSSA TÄHÄN LAITTEESEEN LIITTYVIEN PALVELUIDEN LOPETTAMISESTA TAI
KESKEYTYKSISTÄ, JOTKA VOIVAT JOHTUA MISTÄ TAHANSA SYYSTÄ.

Muistettavaa tallennustoiminnosta
Tee aina koetallennus ja varmista, että tallennus onnistui. SONY EI OLE MISSÄÄN VASTUUSSA VAHINGOISTA
MUKAAN LUKIEN, MUTTA EI NIIHIN RAJOITTUEN, KORVAUKSET TAI HYVITYKSET AIHEUTUEN SIITÄ, ETTÄ
TÄMÄ LAITE TAI SEN TALLENNUSMEDIA TAI MUUT MEDIAT TAI VARASTOJÄRJESTELMÄT EIVÄT TALLENNA
JOTAKIN SISÄLTÖÄ.
Varmista aina ennen käyttöä, että laite toimii kunnollisesti. SONY EI OLE MISSÄÄN VASTUUSSA VAHINGOISTA
MUKAAN LUKIEN, MUTTA EI NIIHIN RAJOITTUEN, KORVAUKSET TAI HYVITYKSET TÄMÄN LAITTEEN
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TAKUUKAUDEN AIKAISISTA TAI TAKUUAJAN UMPEUDUTTUA TAPAHTUNEISTA TOIMINTAHÄIRIÖISTÄ
AIHEUTUNEIDEN NYKYISTEN TAI TULEVIEN TULOJEN MENETYKSISTÄ.
SONY EI OLE MISSÄÄN VASTUUSSA LAITTEEN KÄYTTÄJIEN TAI KOLMANSIEN OSAPUOLTEN ESITTÄMISTÄ
VAATIMUKSISTA.
SONY EI OLE MISSÄÄN VASTUUSSA SISÄISEEN TALLENNUSJÄRJESTELMÄÄN, TALLENNUSVÄLINEILLE TAI
MUIHIN TALLENNUSVÄLINEISIIN TAI -JÄRJESTELMIIN TALLENNETTUJEN TIETOJEN MENETYKSESTÄ,
KORJAUKSESTA TAI KOPIOINNISTA.
SONY EI OLE MISSÄÄN VASTUUSSA TÄHÄN LAITTEESEEN LIITTYVIEN PALVELUIDEN LOPETTAMISESTA TAI
KESKEYTYKSISTÄ, JOTKA VOIVAT JOHTUA MISTÄ TAHANSA SYYSTÄ.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Lähtömuodot ja rajoitteet

Tässä osiossa käsitellään lähtömuotoja ja rajoitteita.

Huomautus

Lähtömuodon tarkkuutta rajoittavat verkkovalikon tai kameran valikon kohtien [Project] > [Rec Format] > [Frequency], [Codec] ja
[Video Format] asetukset.

Lähtömuodon tarkkuutta rajoittaa myös yhdistäminen S&Q-kuvataajuuteen. Alla olevan SDI OUT- / HDMI OUT -liittimen
lähtömuodot -taulukon lisäksi HDMI-lähtömuoto muuttuu Full HD:ksi tai alhaisemmaksi, kun kaikki seuraavista ehdoista täyttyvät.

Kohdan [Shooting] > [S&Q Motion] > [Setting] asetuksena on [On]
[Shooting] > [S&Q Motion] > [Frame Rate] on suurempi kuin 60fps

Kun edellä mainitut ehdot täyttyvät, HDMI-lähdön vaihtoehdot 4096×2160P ja 3840×2160P kohdassa [Monitoring] > [Output
Format] > [SDI/HDMI] näkyvät harmaina eikä niitä voi valita.

Toistettavaa kuvaa ei lähetetä, jos tarkkuus on määritetty toistettavan kuvan tarkkuutta suuremmaksi.

SDI OUT- / HDMI OUT -liittimen lähtömuodot

Kun järjestelmän taajuus on 50/59.94 Hz

Asetus Valittava lähtömuoto

Tallennus-/toistotila RAW-lähdön resoluutio/
sisäisen tallennuksen resoluutio SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (oletus)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (oletus)
1920×1080i
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Kun järjestelmän taajuus on 25/29.97 Hz

Asetus Valittava lähtömuoto

Tallennus-/toistotila RAW-lähdön resoluutio/
sisäisen tallennuksen resoluutio SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (oletus)
1920×1080P (oletus)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (oletus) 1920×1080P (oletus)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A) (oletus)
1920×1080P (oletus)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(lähtö pysäytetty)
720×480P2)

720×576P3)

Näkymä ei salli päällekkäiskuvia.1)

Kun järjestelmän taajuus on 59.942)

Kun järjestelmän taajuus on 503)

Asetus Output Format (lähtöresoluutio)

Tallennus-/toistotila RAW-lähdön resoluutio/
sisäisen tallennuksen resoluutio SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (oletus)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
1920×1080i (oletus)
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Kun järjestelmän taajuus on 23.98 Hz

Kun järjestelmän taajuus on 24 Hz

Asetus Output Format (lähtöresoluutio)

Tallennus-/toistotila RAW-lähdön resoluutio/
sisäisen tallennuksen resoluutio SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (oletus) 1920×1080i (oletus)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (oletus) 1920×1080i (oletus)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Asetus Output Format (lähtöresoluutio)

Tallennus-/toistotila RAW-lähdön resoluutio/
sisäisen tallennuksen resoluutio SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (oletus)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (oletus)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P (oletus) 1920×1080P (oletus)

3840×2160
3840×2160 (2SI)

3840×2160P
1920×1080P

1920×1080P (oletus) 1920×1080P (oletus)

1920×1080 1920×1080P (oletus) 1920×1080P (oletus)
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Asetus Output Format (lähtöresoluutio)

Tallennus-/toistotila RAW-lähdön resoluutio/
sisäisen tallennuksen resoluutio SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (oletus)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P (oletus)

4096×2160P
1920×1080P (oletus)
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Vianetsintä

Virtalähde

Kuvalähtö

Oire Syy Ratkaisu

Laitteen virta
ei kytkeydy.

Verkkolaitetta ei ole kunnolla kiinnitetty DC IN -
liitäntään.

Syötä virtajohto tukevasti niin pitkälle kuin se
menee.

AC-virtajohtoa ei ole kunnolla syötetty
verkkolaitteeseen tai pistorasiaan.

Syötä virtajohto tukevasti niin pitkälle kuin se
menee.

LAN-kaapelia ei ole kunnolla kytketty laitteen ja
PoE++-virransyöttölaitteen välille.

Tarkista, että kaapeli syötetään niin pitkälle,
että se lukittuu.

LAN-kaapeli on kytketty OPTION-liittimeen mutta
ei LAN-liittimeen.

Kytke LAN-kaapeli kunnolla LAN-liittimeen.

Laite on kytketty virransyöttölaitteeseen, joka ei tue
PoE++:aa (IEEE802.3bt, Type 4, Class 8 -
yhteensopiva).

Kytke virransyöttölaitteeseen, joka tukee
PoE++:aa (IEEE802.3bt, Type 4, Class 8 -
yhteensopiva).

Kokonaisvirrankulutus ylittää PoE++-
virransyöttölaitteen enimmäisluokituksen.

Tutustu PoE++-virransyöttölaitteen
käyttöohjeeseen.

Kytkettynä on verkkokaapeli, jonka
kategorialuokitus ei tule PoE++-virransyöttöä.

Käytä vähintään kategorian 5e verkkokaapelia,
joka on kytketty LAN-liittimeen.

Kameraa, PoE++-virrantuottolaitetta ja
oheislaitteita ei ole kytketty maahan.

Kytke kamera, PoE++-virransyöttölaite ja
oheislaitteet maahan.

Oire Syy Ratkaisu

Kuvaa ei lähetetä.

Liitettyjä laitteita ei ole yhdistetty kunnolla. Yhdistä liitetyt laitteet oikein.

Alkuasetuksia ei ole suoritettu.
Suorita alkuasetukset valmiiksi
verkkosovelluksella.

HDMI-liittimestä ei
lähetetä kuvaa.

On määritetty signaali, jota HDMI-lähdön kohdelaite ei
tue.

Muuta HDMI-lähtömuodon
asetuksia tai käytä laitetta, joka
tukee lähtösignaalia.

Käytössä on kaapeli, joka ei tue HDMI-lähtöstandardia.
Käytä kaapelia, joka tukee
käytettävää HDMI-
lähtöstandardia.
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Kaukosäädin

Infrapunakaukosäädin

Oire Syy Ratkaisu

SDI-liittimestä ei
lähetetä kuvaa.

Käytössä on kaapeli, joka ei tue SDI-lähtöstandardia.
Käytä kaapelia, joka tukee
käytettävää SDI-
lähtöstandardia.

SDI-liittimeen kytketty näyttö ei tue lähtösignaalia.
Käytä näyttöä, joka tukee SDI-
lähtöstandardia.

Tallennusmuodoksi on asetettu RAW-lähtö.
Muuta tallennusmuodon
asetukseksi jokin muu kuin
RAW-lähtö.

HDMI-lähtö on asetettu SD-tarkkuudelle.
Aseta HDMI-lähdön
tarkkuudeksi jokin muu kuin SD.

Optisesta kuidusta ei
lähetetä kuvaa tai kuva
on vääristynyt.

Käytettävä moduuli ei noudata SFF- tai SMPTE-
standardeja tai se ei vastaa virtataso I:tä (1,0 W).

Ks. ”Optisen kuitusignaalin
lähettäminen”.

Kuvaa ei lähetetä tai
kuva on vääristynyt
ulkoista synkronointia
käytettäessä.

Määritettyyn videosignaalimuotoon sopivaa ulkoista
synkronointisignaalia ei tule.

Syötä määritettyyn
videosignaalimuotoon sopiva
ulkoinen synkronointisignaali.

Äänessä on kohinaa.

Kameraa, PoE++-virrantuottolaitetta ja oheislaitteita ei
ole kytketty maahan.

Kytke laite, PoE++-
virransyöttölaite ja oheislaitteet
maahan.

Laitetta käytetään ympäristössä, jossa olevat laitteet
synnyttävät voimakkaita sähkö- ja magneettikenttiä
(kuten TV-/radiolähetinantennin,
harrastelijaradiolähettimet, ilmastointilaitteiden moottorit,
virtalähdemuuntajat).

Pidä laite kaukana laitteista,
jotka synnyttävät voimakkaita
sähkö- ja magneettikenttiä.

Objektiivi, objektiivin tuki ja ohjauslaite ovat yhteydessä
laitteeseen tai ympäristön kohteeseen, josta syntyy
epätavallista kohinaa.

Kiinnitä objektiivi kunnolla.

Tarkista kameran ympäristö
esteiden varalta.

Oire Syy Ratkaisu

Infrapunakaukosäädin ei toimi,
kun painikkeita painetaan.

Infrapunakaukosäätimen toiminta on
pois käytöstä.

Aseta verkkovalikon kohdan [Technical] >
[IR Remote] > [Setting] asetukseksi [On].

Paristo on tyhjentynyt tai pariston
napaisuus on väärä.

Käytä infrapunakaukosäädintä lähellä
laitteen IR-anturia. Jos Power LED -valo
vilkkuu, vaihda paristo.

Alkuasetuksia ei ole suoritettu.
Suorita alkuasetukset valmiiksi
verkkosovelluksella.

Panoroinnin/kallistuksen
käyttönopeus on hidas.

Panoroinnin/kallistuksen nopeus
infrapunakaukosäätimestä on asetettu
normaalitilaan.

Käännä laitteen liitäntälohkossa oleva
SETUP-kytkin 4 ON-asentoon.
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RM-IP500

Verkkosovellus

Oire Syy Ratkaisu

Toiminta vaikutti eri kameraan
kuin oli tarkoitettu.

Infrapunasignaalin vastaanotti eri
kamera kuin oli tarkoitettu.

Aseta kohdan [Technical] > [IR Remote] >
[Setting] valinnaksi [Off] sen kameran
verkkovalikossa, jota et halua ohjata.

Oire Syy Ratkaisu

Kameraa ei voi ohjata RM-IP500-
kaukosäätimellä.

Kameran virtalähdettä ei ole
kytketty.

Tarkista, että laitteen POWER-merkkivalo on
vihreä tai oranssi.

Kamera tai kaukosäädin ei
ole yhteydessä verkkoon.

Tarkista laitteen ja kaukosäätimen liitännät.

Kameran alkuasetuksia ei
ole suoritettu.

Suorita alkuasetukset valmiiksi
verkkosovelluksella.

VISCA over IP -viestintä ei
ole käytössä.

Käännä laitteen liitäntäpaneelissa oleva SETUP-
kytkin 3 ON-asentoon laitteen kuvaan ja käynnistä
laite uudelleen.

Kameran IP-osoite on
muuttunut.

Tarkista kameran IP-osoite verkkovalikon tai
kameran valikon kohdassa [Network] > [Wired
LAN].

Kameran IP-osoite on muutettu
AUTO IP SETUP -toiminolla RM-
IP500-kaukosäätimessä.

Kameran käynnistämisestä
on kulunut vähintään
20 minuuttia.

Käynnistä laite uudelleen. IP-osoite voidaan
vaihtaa AUTO IP SETUP -toiminnolla
ensimmäisten 20 minuutin kuluessa laitteen
käynnistämisestä.
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Oire Syy Ratkaisu

Ei voida yhdistää verkkoselaimella.

Vähintään kategorian 5e LAN-
kaapelia ei ole yhdistetty.

Yhdistä vähintään kategorian 5e LAN-
kaapeli.

LAN-liitäntä on virheellinen tai
yhdistetty verkko ei toimi
normaalisti.

Tarkista, että LAN-liittimen Link LED -valo
palaa. Jos Link LED -valo ei pala, ota yhteys
verkonvalvojaan.

Kameran virtalähdettä ei ole
kytketty.

Ks. ”Virtalähde”-osio yllä.

Laitteelle ei ole määritetty
voimassa olevaa IP-osoitetta.

Suorita verkon nollaus.

Määritetty IP-osoite on
käytössä toisella laitteella.

Tarkista, että oheislaitteiden IP-osoitteet ovat
yksilöllisiä.

Määritetty aliverkon peite ei
vastaa käytettyä aliverkon
peitettä.

Suorita verkon nollaus.

Laitetta käytetään samassa
paikallisverkossa
välityspalvelimen kautta.

Muuta määrityksiä niin, että välityspalvelinta
ei käytetä.

Laitteen määritetty
oletusyhdyskäytävä on
virheellinen.

Suorita verkon nollaus.

Syötetty URL on virheellinen. Syötä oikea URL ja yritä uudelleen.

HTTP-portti on virheellinen.

Näytä kameran valikko ulkoisella näytöllä ja
tarkista asetus kohdassa [Network] > [Wired
LAN] > [HTTP Port]. Jos arvoksi on
määritetty jokin muu kuin 80, lisää HTTP-
porttinumero verkkoselaimeen syötettyyn
isäntänimeen tai IP-osoitteeseen.
Esimerkki: jos HTTP-portin asetuksena on
8080, syötä http://<IP-osoite>:8080

Laitteen HTTP-porttinumero
suodatetaan tai estetään.

Vaihda laitteen HTTP-porttinumero porttiin,
jota ei suodateta tai estetä.

Verkkoselaimen vanha
välimuisti haittaa toimintaa.

Tyhjennä verkkoselaimen välimuisti.

Verkkosovellukseen ei voida
yhdistää 2D-koodin (QR-koodin)
avulla.

Käytössä oleva laite ei tule
mDNS:ää.

Käytä laitetta, joka tukee mDNS:ää.
Jos käytössä on laite, joka ei tule mDNS:ää,
syötä IP-osoite suoraan verkkoselaimeen.

Tabletti tai tietokone on liitetty
eri verkkoon kuin kamera.

Yhdistä tabletti tai tietokone samaan
paikallisverkkoon kuin laite.

Verkkosovellukseen ei voida
yhdistää syöttämällä URL käsin.

Käytössä oleva laite ei tule
mDNS:ää.

Käytä laitetta, joka tukee mDNS:ää.

Tabletti tai tietokone on liitetty
eri verkkoon kuin kamera.

Yhdistä tabletti tai tietokone samaan
paikallisverkkoon kuin laite.
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Oire Syy Ratkaisu

Tunnistamisnäyttö on jatkuvasti
näkyvillä.

Oikeaa käyttäjänimeä ja
salasanaa ei ole annettu.

Anna rekisteröity käyttäjänimi ja salasana.
Jos olet unohtanut rekisteröidyt
käyttäjätiedot, ks. ”RESET-kytkin” osiossa
”Liitäntälohko” ja alusta käyttäjätiedot
verkkoyhteyttä varten.

Toisella verkkoselaimella
kirjautunut käyttäjä on voinut
muuttaa käyttäjänimen ja
salasanan.

Tarkista oikea käyttäjänimi ja salasana
laitteen pääkäyttäjältä.

Kameran kuva ei ole näkyvissä
verkkosovelluksessa.

Kameran HDMI-lähdön
asetuksena on 720×480 tai
720×576.

Muuta laitteen HDMI-lähdön tarkkuutta.

Liitettynä on HDMI-näyttö, joka
ei tue kameran HDMI-
lähtösignaalia.

Irrota HDMI-näyttö tai käytä HDMI-näyttöä,
joka tukee HDMI-lähtöasetuksia.

Laite käynnistetiin uudelleen ja
istunto katkaistiin.

Odota noin minuutin ajan ja lataa
verkkoselain uudelleen.

Verkkoselaimen vanha
välimuisti haittaa toimintaa.

Tyhjennä verkkoselaimen välimuisti.

Verkkosovelluksessa näkyvän
kameran kuvan tarkkuus on
alhainen.

Verkkosovelluksen käyttämän
videotoisto 3:n tarkkuus on
säädetty alhaiseksi.

Suurenna arvoa verkkovalikon kohdassa
[Stream] > [Video Stream] > [Size 3].

Kameran valikko ei tule näkyviin
[Menu]-painiketta painettaessa.

Kameran valikko on määritetty
niin, että sitä ei upoteta HDMI-
lähtösignaaliin.

Aseta verkkovalikon kohdan [Monitoring] >
[Output Display] > [HDMI/Stream]
asetukseksi [On].

Asetuksen arvo asetusnäytöllä ei
päivity/näy oikein.

Verkkosovelluksen
asetusnäyttä ei automaattisesti
näytä toisessa
verkkosovelluksessa
muutettuja asetuksia.

Paina [Reload]-painiketta verkkosovelluksen
asetusnäytön alareunassa. Näkyvissä olevan
asetusnäytön asetukset latautuvat uudelleen
ja päivittyvät.

Väliaikaisten internettiedostojen
asetukset vaikuttavat
toimintaan.

Tyhjennä verkkoselaimen välimuisti.

Määritystiedostoa tai -lokia ei voi
ladata.

Verkkoselaimen
tiedostonlataustoiminto on pois
käytöstä.

Ota verkkoselaimen tiedostonlataustoiminto
käyttöön.

Verkkosovelluksen asetusnäyttö on
käytettävissä, mutta suorassa
käyttönäkymässä ja
toistotoimintonäkymässä ei voi
suorittaa toimintoja.

Verkkosovelluksen
toimintanäyttö on lukittu.

Aseta toimintalukon vipu verkkosovelluksen
oikeassa yläkulmassa  (Operation
Unlock) -asentoon.

Verkkosovelluksen näkymä tulee
näkyviin viiveellä.

Usea käyttäjä katsoo laitteen
suoratoistokuvaa
samanaikaisesti.

Vähennä sellaisten käyttäjien määrää, jotka
voivat käyttää verkkosovellusta
samanaikaisesti.
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Kuvaaminen

Kamera

Panorointi/kallistus

Oire Syy Ratkaisu

Kuvassa on häiriöitä tai se nykii.

Videotiedot eivät siirry oikein,
koska viestintäpolulla on
tungosta.

Alenna suoratoiston bittinopeutta tai valitse
kohdassa [Video Stream 3] > [Size] pienin
vaihtoehto tai alenna nopeutta luodaksesi
tilaa viestintäalueelle.

Tabletissa on käynnissä useita
verkkoselaimia, jotka käyttävät
muistia.

Sulje taustalla käynnissä olevat
verkkoselaimet.

Avoinna on liian monta
verkkoselaimen välilehteä,
jotka hidastavat toimintaa.

Sulje välilehdet, joita et käytä.

Verkkoselaimen välimuistin ja
selaushistorian täyttyminen
hidastaa toimintaa.

Tyhjennä verkkoselaimen välimuisti.

Oire Syy Ratkaisu

Kuva näyttää vääristyneeltä
panorointi-/kallistustoiminnon alussa ja
lopussa.

Kuva voi olla vääristynyt, jos
objektiivin kuvanvakautustoiminto on
päällä.

Ota objektiivin
kuvanvakautustoiminto pois
päältä.

Kuvakulma muuttuu ilman käyttäjän
toimintaa.

Tapahtui objektiivin hengitys.
Ks. ”Hengityksen
kompensaatio”.

Tarkennusta, zoomia tai himmennintä ei voi
käyttää.

Objektiivin kytkinasetukset saattavat
olla virheelliset.

Ks. ”Objektiivin kytkinten
tarkistaminen”.

Oire Syy Ratkaisu

Panorointia/kallistusta ei voi
nollata.

Panoroinnin/kallistuksen lukitusvipu
on LOCK-asennossa.

Liu’uta panoroinnin/kallistuksen lukitusvipu
UNLOCK-asentoon.

Kamera ei pysähdy haluttuun
kohtaan.

Kameralohko on epätasapainossa.
Siirrä kameralohkoa eteen/taakse sopivaan
kohtaan osion ”Objektiivin kiinnittäminen”
mukaisesti ja käynnistä laite uudelleen.

Kiinnitettynä on objektiivi, joka ei
tue panorointia/kallistusta.

Tutustu objektiivin yhteensopivuustietoihin
ja kiinnitä objektiivi, joka tukee
panorointia/kallistusta, ja käynnistä laite
uudelleen.

Panoroinnin/kallistuksen
nollaamista ei voi suorittaa.

Nollaa panorointi/kallistus osion
”Panoroinnin/kallistuksen nollaaminen”
mukaisesti.

Kamerapäähän kohdistui
odottamaton voima, joka aiheutti
panoroinnin/kallistuksen
hallintavirheen.
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Oire Syy Ratkaisu

Kamera ei palaudu eteenpäin

(Panoroinnin/kallistuksen
aloitusasento) -painiketta
painettaessa.

Kattokiinnitystila on aktivoitu.

Määritä verkkovalikon kohta [Pan-Tilt] > [P/T
Direction] > [Ceiling] todellisen asennuksen
mukaisesti ja käynnistä laite uudelleen. Kun
kamera on kiinnitetty kattoon, liitäntälohko
on sen etupuolella.

Panorointi-/kallistustoiminto on
rajallinen.

Panorointi-/kallistusalueelle on
määritetty rajat.

Poista panorointi-/kallistusalueelle asetetut
rajat tarpeen mukaan osion ”P/T Range
Limit” mukaisesti.

Kamerapäähän kohdistui
odottamaton voima, joka aiheutti
panorointi-/kallistusvirheen.

Nollaa panorointi/kallistus osion
”Panoroinnin/kallistuksen nollaaminen”
mukaisesti.

Panorointi-/kallistustoiminto
liikkui vastakkaiseen suuntaan.

Kattokiinnityksen asetus on eri kuin
todellinen kiinnitystila.

Määritä verkkovalikon kohta [Pan-Tilt] > [P/T
Direction] > [Ceiling] todellisen asennuksen
mukaisesti.

Panorointi-/kallistussuuntaan
liittyviä asetuksia on muutettu.

Tarkista [Pan-Tilt] > [P/T Direction] -
asetukset verkkovalikossa.

Kuva ei liiku tasaisesti
panorointi-/kallistustoiminnon
alussa ja lopussa.

Panorointi-/kallistustoiminnon
kiihdytys-/jarrutusasetus on liian
suuri.

Pienennä panorointi-/kallistustoiminnon
kiihdytys-/jarrutusasetusta, jotta liike
panorointi-/kallistustoiminnon alussa on
tasaisempi, verkkovalikon tai kameran
valikon kohdassa [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve]. Huomaa, että
tällöin objektiivin enimmäisnopeuden
saavuttaminen kestää kauemmin.

Panorointi-/kallistustoiminto
pysähtyi.

Kameralohko on epätasapainossa.
Siirrä kameralohkoa eteen/taakse sopivaan
kohtaan osion ”Objektiivin kiinnittäminen”
mukaisesti ja käynnistä laite uudelleen.

Tasokäyrän (kiihdytys/jarrutus)
asetus on liian suuri kiinnitetylle
objektiiville.

Jos kiinnitettynä on suuri objektiivi,
pienennä arvoa verkkovalikon tai kameran
valikon kohdassa [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve].

Käytössä on suuri objektiivi. Ota yhteys Sonyn tukiedustajaan.

Laitteen kulku estyy, kun
panorointi-/kallistustoimintoa
käytetään.

Objektiivin tukijalustan
kiinnikeruuvin vipu osuu kameraan.

Käännä objektiivin tukijalustan
kiinnikeruuvin vipu osoittamaan ylöspäin.

Objektiivin tukikiinnikkeen vipu
osuu kameraan.

Käännä objektiivin tukikiinnikkeen vipu
osoittamaan ylöspäin.

Kamerapään lukitusvipu osuu
kameraan.

Varmista, että kamerapään lukitusvipu on
kokonaan LOCK-asennossa.
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Toisto / tallennus

Oire Syy Ratkaisu

Panorointi-/kallistustoiminnon
aikana kuuluu epätavallista
kohinaa.

Kamera on epätasapainossa.
Siirrä kamerapäätä eteen/taakse sopivaan
kohtaan, jotta liukualusta on vaakatasossa.

Tasokäyrän (kiihdytys/jarrutus)
asetus on liian suuri kiinnitetylle
objektiiville.

Jos kiinnitettynä on suuri objektiivi,
pienennä arvoa verkkovalikon tai kameran
valikon kohdassa [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve].

Kamerapää ei ole kiinteästi
paikallaan ja käytettäessä kuuluu
liikkuvaa ääntä.

Aseta kamerapään lukitusvipu LOCK-
asentoon.

Esiasetusvalintaa ei voi tallentaa.
Esiasetusvalintaa ei voi tallentaa,
jos Clear Image Zoom on
toiminnassa.

Aseta Clear Image Zoom -suhteeksi taas
1×. (tila, jossa suhde ei näy 
(Zoomaussuhde) -kohdan oikealla puolella)

Rajaus on siirtynyt toistettaessa
esiasetusvalintaa.

Ympäristön lämpötila on saattanut
muuttua merkittävästi
esiasetusvalinnan tallennushetken
ja toistohetken välillä.

Tallenna esiasetusvalinta uudelleen.

Objektiivia ei ole kalibroitu.
Suorita kalibrointi kameran valikon
kohdassa [Technical] > [Lens] > [Lens
Calibration].

Kiinnitettynä on toinen linssi kuin
se, jota käytettiin esiasetuksen
tallennushetkellä. Manuaalisen
zoomin zoomausasento saattaa
olla muuttunut.

Tallenna esiasetusvalinta uudelleen.

Rajauksen hallintapaneeli
verkkosovelluksessa näkyy
harmaana eikä sitä voi käyttää.

Panorointi-/kallistustoiminto ei ole
käytettävissä pikkukuvanäytön
ollessa näkyvillä ja toiston aikana.

Avaa toiston hallintanäyttö ja poistu
pikkukuvanäytöstä tai lopeta toisto.

Panorointi-/kallistustoiminto ei ole
käytettävissä, kun kameran kuvaa
ei voida näyttää
verkkosovelluksessa.

Ks. ”Verkkosovellus” osiossa ”Vianetsintä”.

Panoroinnin/kallistuksen lukitusvipu
on LOCK-asennossa.

Liu’uta panoroinnin/kallistuksen lukitusvipu
UNLOCK-asentoon.

”Execute Pan-Tilt Reset” näkyy
rajauksen hallintapaneelin alla
verkkosovelluksessa.

Kamerapäähän kohdistui
odottamaton voima, joka aiheutti
panorointi-/kallistusvirheen.

Nollaa panorointi/kallistus osion
”Panoroinnin/kallistuksen nollaaminen”
mukaisesti.
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Tiedoston siirto

IP-suoratoisto

Oire Syy Ratkaisu

Tallentaminen ei ala,
vaikka painat tallennuksen
START/STOP-painiketta.

Muistikortti on täynnä. Vaihda muistikorttiin, jossa on riittävästi tilaa.

Muistikortti on palautettava.
Palauta muistikortti kohdan ”Muistikorttien
palauttaminen” mukaisesti.

Tallennuksen merkkivalo on määritetty
merkkivaloksi, joten tallennuksen tilaa
ei voi määrittää lampun perusteella.

Määritä tallennuksen merkkivalo toimimaan
tallennusvalona osion ”Tally-
merkkivalosignaalin yhdistäminen” mukaisesti.

Äänitys ei ole mahdollista.

Mikrofonia ei ole yhdistetty.
Yhdistä liitäntälohkon AUDIO IN -liitäntään
mikrofoni tai äänilaite.

[Master Input Level] -asetus on
vähimmäisarvossa.

Säädä [Master Input Level].

Äänitetty ääni on
vääristynyt.

Äänen tulotason asetus on liian suuri.

Säädä kohdan [CH1 Input Level] asetukseksi
[CH4 Input Level] ja [Master Input Level].

Kun käytät mikrofonia meluisassa
ympäristössä, esimerkiksi live-konsertissa,
säädä ensin asetukset [AUDIO IN CH1 MIC
Ref.] ja [AUDIO IN CH2 MIC Ref.].

Äänitetyn äänen
kohinataso on liian suuri.

Äänen tulotason asetus on liian pieni.
Säädä asetuksia [Audio Input Level] ja [Audio]
> [Audio] > [Audio Input] > [AUDIO IN CH1 MIC
Ref.] tai [AUDIO IN CH2 MIC Ref.].

Leikkeitä ei voida toistaa.

Leikettä editoidaan.

Leikkeitä ei voida toistaa, jos olet muuttanut
tiedostonimiä tai kansioita, tai jos leike on
käytössä tietokoneella. Tämä ei ole
toimintahäiriö.

Leike tallennettiin muulla kuin tällä
laitteella.

Muulla kuin tällä laitteella tallennettavia leikkeitä
ei voida toistaa tai ne näkyvät väärässä koossa.
Tämä ei ole toimintahäiriö.

Oire Syy Ratkaisu

Tiedoston lataaminen
palvelimelle epäonnistuu.

Palvelimen käyttäjänimi ja
salasana ovat väärin.

Palvelimen käyttäjänimi ja salasana voivat olla
väärin. Syötä oikeat tiedot.
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Oire Syy Ratkaisu

Suoratoisto ei
käytettävissä.

Asiakassovellukseen syötetyt
käyttäjänimi ja salasana suoratoiston
katsomiseksi tästä laitteesta ovat
virheelliset.

Jos laitteen suoratoistomuodon asetuksena on
[RTSP], [SRT-Listener] tai [NDI|HX],
asiakassovellukseen on syötettävä tälle laitteelle
asetetut käyttäjänimi ja salasana. Anna oikea
käyttäjänimi ja salasana.

Suoratoistoprotokollaa ei ole
asetettu.

Valitse kohdeprotokolla verkkovalikon kohdassa
[Stream] > [Stream Setting].

RTSP-istuntoja on asetettu
vähintään kuusi.

Aseta istuntojen määräksi korkeintaan viisi.

UDP-porttinumeroa ei ole asetettu
oikein.

Aseta porttinumero ja muut kohdeprotokollan
asetukset verkkovalikon kohdassa [Stream] >
[Stream] > [Stream Setting].

UDP-viestintä on estetty. Tarkista tietoturvaohjelmiston asetukset.

Ääntä ei
suoratoisteta.

Äänen tulon suoratoiston asetuksena
on [Off].

Aseta verkkovalikon kohdan [Stream] > [Audio
Stream] > [Setting] asetukseksi [On].

Suoratoisto keskeytyi.
Protokolla-asetuksia tai suoratoiston
koodekkiasetuksia muutettiin
suoratoiston aikana.

Määritä protokolla-asetukset ja suoratoiston
koodekkiasetukset ennen suoratoiston aloittamista.

[Video Stream 1] -
kuvakoko ei voi olla
4096×2160 tai
3840×2160.

Kuvakoko on 1920×1080, kun
[Output Format] -asetuksena on
HDMI.

Suoratoiston kuvakoko ei voi olla suurempi kuin
HDMI-kuvakoko. Vaihda HDMI-kuvakokoa
verkkovalikon kohdassa [Monitoring] > [Output
Format].

[Video Stream 1] -
kuvataajuus ei voi olla
60 FPS tai 50 FPS.

Suoratoiston kuvataajuudeksi on
asetettu 29.97 tai vähemmän.

Järjestelmän taajuus rajoittaa suoratoistoon
käytettävää kuvataajuutta. Muuta järjestelmän
taajuutta verkkovalikon kohdassa [Rec Format] >
[Frequency].

[Video Stream 3] -
suoratoisto ei ole
käytettävissä.

[Video Stream 3] ei tue muotoja
RTSP/SRT/NDI.

Käytä [Video Stream 1] tai [Video Stream 2].

RTSP/SRT-näyttö ei
päivity/näy oikein.

RTSP:n tai SRT:n porttinumero
suodatetaan tai estetään.

Vaihda RTSP- tai SRT-porttinumero porttiin, jota
suoratoistoa vastaanottavat laitteet eivät suodata tai
estä. Voit myös muuttaa laitteen RTSP:n tai SRT:n
porttinumeroa.

Kuvassa on häiriöitä
tai se nykii.

Videotiedot eivät siirry oikein, koska
viestintäpolulla on tungosta.

Alenna suoratoiston bittinopeutta tai aseta [Video
Stream 2] -koodekin ([Codec 2]) arvoksi [Off]
luodaksesi tilaa viestintäalueelle.

Videopakettien järjestys on
muuttunut viestintäkanavassa.

Käytä samaa internetpalveluntarjoajaa sekä laitteen
että vastaanottimen puolella.

Ei havaittu NDI-
laitteena.

Suoratoistoprotokollaa ei ole asetettu
arvoon NDI|HX.

Suoratoistoprotokolla on asetettava arvoon NDI|HX,
jotta laite voidaan havaita NDI-laitteena. Aseta
verkkovalikon kohdan [Stream] > [Stream Setting]
asetukseksi [NDI|HX].

Ei voida käyttää NDI-
laitteena.

NDI|HX-lisenssiä ei ole asennettu.
Asenna NDI|HX-lisenssi. Voit tarkistaa, onko käytössä
NDI|HX-lisenssi, verkkovalikon kohdassa [Stream] >
[Stream] > [Stream Setting] > [NDI|HX] > [License].
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Yhteys ulkoisiin laitteisiin

Ulkoinen synkronointi

Tally

Objektiivin ohjain

Oire Syy Ratkaisu

Ulkoiseen lähteeseen
ei voi synkronisoida.

Määritettyyn videosignaalimuotoon
sopivaa ulkoista synkronointisignaalia
ei tule.

Syötä määritettyyn videosignaalimuotoon sopiva
ulkoinen synkronointisignaali.

Laitteessa on kaksi päätevastusta.
Laitteessa on sisäinen 75 Ω päätevastus. Liitä
suoraan signaalilähteeseen (yksi yhteen) tai käytä
jakajaa (haaroitinta).

Oire Syy Ratkaisu

Tally-
merkkivalo ei
syty.

Tally-merkkivalon kirkkauden asetuksena
on Off.

Aseta sopiva kirkkaus verkkovalikon kohdassa
[Technical] > [Tally] > [Tally Lamp Brightness].

Tallennuksen merkkivalo on määritetty
tallennusvaloksi.

Määritä tallennuksen merkkivalo toimimaan tally-
merkkivalona osion ”Tally-merkkivalosignaalin
yhdistäminen” mukaisesti.

RM-IP500 on yhdistetty ja VISCA over IP
on pois käytöstä.

Käännä laitteen liitäntälohkossa oleva SETUP-kytkin 3
ON-asentoon.

OPTION-liittimen liitäntä on virheellinen
tai kohdenastaa ei ole oikosuljettu
GND:hen.

Oikosulje OPTION-liittimen nasta 7 tai nasta 8 GND:hen
osion ”Tally-merkkivalosignaalin yhdistäminen”
mukaisesti.

Oire Syy Ratkaisu

[Communication Error]
näkyy  (Kameran tila) -
kohdassa.

Kamera ei voi viestiä
objektiivin ohjaimen
kanssa.

Tarkasta laitteen ja objektiivin ohjaimen välinen yhteys.
Käynnistä sitten laite ja objektiivin ohjain uudelleen.

[Rotation Error] näkyy 
(Kameran tila) -kohdassa.

Objektiivin ohjaimessa
tapahtui kiertovirhe.

Tallennettu zoomauksen liikealue ja objektiivin liikealue
eivät ehkä vastaa toisiaan. Alusta objektiivin ohjain.
Jos ongelma jatkuu, ota yhteyttä objektiivin ohjaimen
valmistajan edustajaan.

[System Error] näkyy 
(Kameran tila) -kohdassa.

Objektiivin ohjaimessa
tapahtui järjestelmävirhe.

Tarkasta laitteen ja objektiivin ohjaimen välinen yhteys.
Lue objektiivin ohjaimen käyttöohje ja alusta objektiivin
ohjain tai käynnistä laite ja objektiivin ohjain uudelleen.
Jos ongelma jatkuu, ota yhteyttä objektiivin ohjaimen
valmistajan edustajaan.

[Unknown Error] näkyy 
(Kameran tila) -kohdassa.

Objektiivin ohjaimessa
tapahtui tuntematon virhe.

Tarkasta laitteen ja objektiivin ohjaimen välinen yhteys.
Lue objektiivin ohjaimen käyttöohje ja alusta objektiivin
ohjain tai käynnistä laite ja objektiivin ohjain uudelleen.
Jos ongelma jatkuu, ota yhteyttä objektiivin ohjaimen
valmistajan edustajaan.
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Aiheeseen liittyvää
Optisen kuitusignaalin lähettäminen

Liitäntälohko

Hengityksen kompensaatio

Objektiivin kytkinten tarkistaminen

Objektiivin kiinnittäminen

Panoroinnin/kallistuksen nollaaminen

P/T Range Limit

Muistikorttien palauttaminen

Tally-merkkivalosignaalin yhdistäminen

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Virhe-/varoitusviestit

Jos laitteeseen ilmestyy varoitus, huomio tai vahvistusta edellyttävä käyttöehto, kameran kuvapaneelissa näkyy viesti ja
etupaneelin POWER-merkkivalo ja NETWORK-merkkivalo sekä tallennuksen merkkivalo alkavat vilkkua.

Huomautus

Tallennuksen merkkivalon vilkkuminen on käytössä vain silloin, kun kohdan [Technical] > [Tally] > [Tally Control] asetuksena on
[Internal] eikä kohdan [Tally Lamp Brightness] asetuksena ole [Off] verkkovalikossa tai kameran valikossa.

Virheviestit

Jos POWER-merkkivalo ja NETWORK-merkkivalo vilkkuvat alla kuvatulla tavalla, tee seuraavat toimenpiteet.

Laite lakkaa toimimasta, kun seuraava näyttö tulee näkyviin.

Varoitusviestit

Jos jokin seuraavista näytöistä tulee näkyviin, noudata annettuja ohjeita.

POWER-
merkkivalo

NETWORK-
merkkivalo Syy ja ratkaisu

Vilkkuu hitaasti
oranssina

Vilkkuu hitaasti
vihreänä

Laite ei voi toimia normaalisti. Lisätietoja on verkkovalikon kohdassa
[Maintenance] > [System Log]. Jos ongelma jatkuu myös sen jälkeen, kun laite on
asetettu valmiustilaan tai virta on katkaistu ja laitettu uudelleen päälle, ota yhteys
Sonyn palveluedustajaan.

Vilkkuu
nopeasti
oranssina

Vilkkuu
nopeasti
vihreänä

Laitteessa tapahtui virhe. Ota yhteyttä Sonyn palveluedustajaan.

Viestinäkymä Tallennuksen
merkkivalo Syy ja ratkaisu

E + virhekoodi
Nopeasti
vilkkuva

Merkitsee poikkeavuutta laitteessa. Tallennus keskeytyy, vaikka kameran
kuvapaneelissa näkyy ●REC.
Sammuta laite ja tarkista, onko liitetyissä laitteissa, kaapeleissa tai tietovälineissä
ongelmia. Jos virhe ei poistu, kun laite kytketään päälle uudelleen, ota yhteyttä
Sonyn palveluedustajaan. Laitteen tilasta riippuen virhenäyttöä tai varoitusääntä
ei välttämättä ilmesty.

Viestinäkymä Tallennuksen
merkkivalo Syy ja ratkaisu

Temperature High Vilkkuu
Sisäinen lämpötila on korkea.
Sammuta videokamera ja anna sen jäähtyä ennen kuin käytät sitä
uudelleen.
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Huomio- ja toimintaviestit

Seuraavat huomio- ja toimintaviestit voivat ilmestyä näkyviin näytön keskelle. Ratkaise ongelma noudattamalla annettuja
ohjeita.

Viestinäkymä Tallennuksen
merkkivalo Syy ja ratkaisu

Media Temperature
High

Vilkkuu
CFexpress-muistikortin lämpötila on korkea.
Vaihda kortti tai anna sen jäähtyä ennen kuin käytät sitä uudelleen.

Voltage Low Vilkkuu DC IN -jännite on alhainen (taso 1). Tarkista virtalähde.

Insufficient Voltage Nopeasti vilkkuva
DC IN -jännite on liian alhainen (taso 2). Tallennus ei ole käytössä.
Liitä jokin muu virtalähde.

Media Near Full Vilkkuu
Muistikortin jäljellä oleva kapasiteetti on vähissä.
Vaihda mahdollisimman pian.

Media Full Nopeasti vilkkuva
Leikkeitä ei voitu tallentaa tai kopioida, koska muistikortilla ei ole enää
tilaa.
Vaihda heti.

Clips Near Full Vilkkuu
Muistikortille tallennettavissa olevien lisäleikkeiden lukumäärä on
vähissä.
Vaihda mahdollisimman pian.

Clips Full Nopeasti vilkkuva
Muistikortille tallennettavissa olevien leikkeiden enimmäismäärä on
saavutettu.
Leikkeitä ei voida tallentaa tai kopioida enempää. Vaihda heti.

Last Clip Recording Vilkkuu
Tällä hetkellä tallennettava leike on viimeinen, joka voidaan tallentaa,
sillä leikkeiden enimmäismäärä on saavutettu.
Valmistele uusi muistikortti.

Media(A) Life Near
End1) Vilkkuu Muistikortti lähestyy käyttöikänsä päätä. Vaihda mahdollisimman pian.

Media(A) Life End1) Nopeasti vilkkuva Muistikortti on saavuttanut käyttöikänsä pään. Vaihda heti.

Media(A) Near Full1) Vilkkuu Kun käytetään Simul Rec -toimintoa

Media(A) Full1) Nopeasti vilkkuva Kun käytetään Simul Rec -toimintoa

Media(A) Clips Near
Full1) Vilkkuu Kun käytetään Simul Rec -toimintoa

Media(A) Clips Full1) Nopeasti vilkkuva Kun käytetään Simul Rec -toimintoa

Media(A) Last Clip
Rec1) Vilkkuu Kun käytetään Simul Rec -toimintoa

(Ei näyttöä) Vilkkuu
Objektiivin ohjaimessa tapahtui tuntematon virhe.
Tarkista kameran tila verkkosovelluksessa.
Lisätietoja on verkkosovelluksen järjestelmälokissa.

Näkyvissä on ”(B)”, kun kyse on korttipaikan B kortista.1)
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RTMP-suoratoistovirheen tiedot

Näyttöviesti Syy ja ratkaisu

Backup Battery End
Please Change

Vara-akussa jäljellä oleva kapasiteetti ei riitä.
Liitä laite virransyöttöön vähintään 24 tunniksi vara-akun lataamiseksi.

Unknown Media(A)1)

Please Change

Laitteeseen asetettu muistikortti on osioitu tai se sisältää enemmän
leikkeitä kuin laite pystyy käsittelemään.
Korttia ei voida käyttää laitteessa ja se on vaihdettava.

Cannot Use Media(A)1)

Unsupported File System

Videokameraan asetettu kortti käyttää eri tiedostojärjestelmää tai sitä ei
ole formatoitu.
Korttia ei voida käyttää laitteessa ja se on vaihdettava tai alustettava
laitteen avulla.

Media Error
Media(A) Needs to be Restored1)

Muistikortissa ilmeni virhe ja kortti on palautettava.
Palauta muistikortti.

Media Error
Cannot Record to Media(A)1)

Muistikortti voi olla vaurioitunut eikä sitä voida käyttää enää
tallentamiseen.
Toistaminen on mahdollista, joten on suositeltavaa kopioida muistikortti
ja vaihtaa se uuteen.

Media Error
Cannot Use Media(A)1)

Muistikortti voi olla vaurioitunut eikä sitä voida käyttää enää
tallentamisen tai toistamiseen.
Korttia ei voida käyttää laitteessa ja se on vaihdettava.

Media(A) Error1)

Recording Halted
Playback Halted

Tallentaminen ja toistaminen keskeytettiin, koska muistikorttia
käytettäessä ilmeni virhe.
Jos ongelma ei poistu, vaihda muistikortti.

Media Reached Rewriting Limit
Change Media(A)1)

Muistikortti on saavuttanut käyttöikänsä pään.
Tee varmuuskopio ja vaihda kortti välittömästi. Jos jatkat kortin
käyttämistä, kortti ei välttämättä pysty tallentamaan tai toistamaan.
Tietoja saat muistikortin käyttöohjeesta.

The specified address is invalid.
Määritetty osoite on virheellinen.
Tarkista, että asetus on oikein.

Cannot Use Specified Port Number
Määritetty porttinumero on virheellinen.
Tarkista, että asetus on oikein.

Lens I/F Error(xx:xx)

Objektiivivirhe havaittiin objektiivin I/F-tiedonsiirrossa, kun E-
pidikkeellinen objektiivi kiinnitettiin.
Tarkista liitännän tila E-pidikkeellisen objektiivin kanssa.
Jos ongelma jatkuu, ota yhteyttä Sonyn palveluedustajaan ja anna
vikakoodi (viisi merkkiä sulkeissa).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Siirtotöiden enimmäismäärä on saavutettu.
Tyhjennä kaikki tarpeettomat työt. Välityspalvelintiedostojen
automaattisen lataamisen kohdeasetus voi myös olla virheellinen.
Tarkista, että asetus on oikein.

Fan Stopped

Tuuletin on pysähtynyt.
Tarkista, että siinä ei ole pölyä tai roskia.
Jos virhe ei poistu, kun pöly ja roskat on poistettu, ota yhteyttä Sonyn
palveluedustajaan.

Näkyvissä on ”(B)”, kun kyse on korttipaikan B kortista.1)
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Laitteessa saattaa näkyä seuraavia virhetietoja. Tee seuraavat toimet tarpeen mukaan.

SRT-suoratoistovirheen tiedot

Laitteessa saattaa näkyä seuraavia virhetietoja. Tee seuraavat toimet tarpeen mukaan.

5-041-958-73(1) Copyright 2022 Sony Corporation

Virhekoodi
Kuvaus Ratkaisu

RTMP RTMPS

1002
1004

2002
2004

Yhteyttä RTMP-palvelimeen ei voida
muodostaa.

Tarkista, että palvelimen URL-asetus on oikein.
Tarkista verkkoyhteys.

1003 2003 Toimialueen nimeä ei voida ratkaista.
Tarkista, että palvelimen URL-asetus on oikein.
Tarkista DNS-palvelinyhteys.

–
2005
2008

CRL-virhe
Tarkista, että palvelimen URL-asetus on oikein.
Tarkista, että yhteyden kohde on luotettu sivusto.

2006 CA-varmennevirhe
Tarkista, että kellon asetus on oikein.
Tarkista, että CA-varmenne on oikea.

– 2007
CA-varmennetta ei ole asennettu.
Palvelimen varmenteen
todennusvirhe.

Asenna CA-varmenne.
Tarkista, että yhteyden kohde on luotettu sivusto.

4002 RTMP-istunto katkaistiin.

Laitteen yhteys saatettiin katkaista RTMP-palvelimen
puolelta.
Tarkista, että asetukset vastaavat palvelun
koodekkiparametrisuosituksia.

4003 Verkkoyhteys on heikkolaatuinen. Tarkista verkkoyhteys.

Muu Muut virheet.

Virhekoodi
Kuvaus Ratkaisu

SRT-Caller

1001 Odottamaton virhe Laite ei ehkä toimi oikein. Käynnistä laite uudelleen.

1002 Viestintä katkaistu asetusten muutoksen vuoksi
Viestintä katkaistiin, koska asetuksia muutettiin.
Muodosta yhteys uudelleen.

5001 Odottamaton virhe Laite ei ehkä toimi oikein. Käynnistä laite uudelleen.

5005 Yhteysvirhe Tarkista, että yhteyskohteen asetus on oikein.

5006 Salausvirhe Tarkista, että salausasetus on oikein.

5007 Odottamaton virhe
Laite ei ehkä toimi oikein. Käynnistä laite uudelleen.

5008 Odottamaton virhe

5009 Lähetysvirhe
Laitteen yhteys katkaistiin viestinnän aikana.
Tarkista verkkoyhteys.
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Valikkokohteiden luettelo

Seuraavissa taulukoissa luetellaan laitteen valikkokohteet.

Symbolit
”Kameran valikko” ja ”verkkovalikko”
●: Käytettävissä
▲: Joitakin kohteita käytettävissä
–: Ei käytettävissä

”All File” ja ”Scene File”
Kyllä: ALL-tiedostoon tai kohtaustiedostoon tallennettu kohde
Ei: Kohdetta ei tallennettu

”All Reset (except for Network Settings)”
Kun verkkovalikon kohta [Reset] > [Reset] > [All Reset (except for Network Settings)] suoritetaan:
Kyllä: Alustettu kohde (ei sisällä verkkoasetuksia)
Ei: Ei sovellettavissa

”Network Reset”
Kun verkkovalikon kohta [Reset] > [Reset] > [Network Reset] suoritetaan:
Kyllä: Alustettu kohde (verkkoasetus)
Ei: Ei sovellettavissa

”Factory Default”
Kyllä: Kohde palautettu tehdasoletuksiin
Ei: Ei sovellettavissa

Shooting

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Kyllä Kyllä Kyllä Kyllä Kyllä

ND Filter ● – Kyllä Kyllä*1 Kyllä Ei Kyllä

Shutter ● – Kyllä Kyllä Kyllä Ei Kyllä

Iris ● – Kyllä Kyllä Kyllä Ei Kyllä

Auto Exposure ● – Kyllä Kyllä*2 Kyllä Ei Kyllä

White ● – Kyllä Kyllä*3 Kyllä Ei Kyllä

White Setting ● – Kyllä Ei Kyllä Ei Kyllä

Offset White ● – Kyllä Ei Kyllä Ei Kyllä

Focus ● ▲ Kyllä Ei Kyllä Ei Kyllä
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Project

Paint/Look

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

S&Q Motion ● – Kyllä Ei Kyllä Ei Kyllä

LUT On/Off ● – Kyllä Ei Kyllä Ei Kyllä

Noise
Suppression

● – Kyllä Kyllä Kyllä Ei Kyllä

Flicker
Reduce

● – Kyllä Ei Kyllä Ei Kyllä

SteadyShot ● – Kyllä Ei Kyllä Ei Kyllä

[Mode] ei sovellettavissa*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] ei sovellu*2

[Preset White] sovellettavissa*3

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Base Setting ● ● Kyllä Ei Kyllä Ei Kyllä

Rec Format ● ● Kyllä Ei Kyllä*1 Ei Kyllä

Cine
EI/Flex.ISO
Set

● – Kyllä Ei Kyllä Ei Kyllä

Simul Rec ● ● Kyllä Ei Kyllä Ei Kyllä

Proxy Rec ● ▲ Kyllä Ei Kyllä Ei Kyllä

Interval Rec ● ● Kyllä*2 Ei Kyllä Ei Kyllä

Picture Cache
Rec

● ● Kyllä*2 Ei Kyllä Ei Kyllä

SDI/HDMI Rec
Control

● – Kyllä Ei Kyllä Ei Kyllä

Assignable
Button

● – Kyllä Ei Kyllä Ei Kyllä

All File – ● Ei Ei Ei Ei Ei

[Frequency] ei sovellettavissa*1

[Setting] ei sovellettavissa*2

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Scene File ● – Ei Ei Ei Ei Ei
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Pan-Tilt

TC/Media

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Base Look ● ▲ Kyllä*1 Ei Kyllä*1 Ei Kyllä*1

Reset Paint
Settings

● – Ei Ei Ei Ei Ei

Black ● – Kyllä Kyllä Kyllä Ei Kyllä

Knee ● – Kyllä Kyllä Kyllä Ei Kyllä

Detail ● – Kyllä Ei Kyllä Ei Kyllä

Matrix ● – Kyllä Kyllä Kyllä Ei Kyllä

Multi Matrix ● – Kyllä*2 Kyllä*2 Kyllä Ei Kyllä

perusulkoasuna tuotu LUT-tiedosto ei sovellu*1

[Axis] ei sovellu*2

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

P/T Speed – ● Ei Ei Kyllä Ei Ei

P/T
Acceleration

● ● Ei Ei Kyllä Ei Ei

P/T Range
Limit

– ● Ei Ei Kyllä Ei Ei

P/T Direction – ● Ei Ei Kyllä Ei Ei

P/T Preset – ● Ei Ei Kyllä Ei Ei

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Timecode ● – Kyllä*1 Ei Kyllä Ei Kyllä

TC Display ● – Kyllä Ei Kyllä Ei Kyllä

Users Bit ● – Kyllä*1 Ei Kyllä Ei Kyllä

HDMI TC
Out

● – Kyllä Ei Kyllä Ei Kyllä

Clip Name
Format

● – *2 Ei Kyllä Ei Kyllä

Update
Media

● – Ei Ei Ei Ei Ei
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Monitoring

Audio

Thumbnail

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Format
Media

● – Ei Ei Ei Ei Ei

Media Life ● – Ei Ei Ei Ei Ei

[Setting] ei sovellu*1

[Auto Naming] soveltuu, [Camera ID] ei sovellu*2

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Output
Format

● ● Kyllä Ei Kyllä Ei Kyllä

Output
Display – ● Kyllä Ei Kyllä Ei Kyllä

Display
On/Off

● – Kyllä Ei Kyllä Ei Kyllä

Video Signal
Monitor

● – Kyllä Ei Kyllä Ei Kyllä

Marker ● – Kyllä Ei Kyllä Ei Kyllä

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Audio
Input

● ▲ Kyllä Ei Kyllä Ei Kyllä

Audio
Output

● ▲ Kyllä Ei Kyllä Ei Kyllä

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Ei Ei Ei Ei Ei

Set Clip Flag ● – Ei Ei Ei Ei Ei

Lock/Unlock
Clip ● – Ei Ei Ei Ei Ei

Delete Clip ● – Ei Ei Ei Ei Ei

Transfer Clip ● – Ei Ei Ei Ei Ei
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Technical

Network

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Transfer Clip
(Proxy)

● – Ei Ei Ei Ei Ei

Filter Clips ● – Ei Ei Ei Ei Ei

Customize
View

● – Kyllä Ei Kyllä Ei Kyllä

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Color
Bars

● – *1 Ei *1 Ei Kyllä

Genlock ● – Ei Ei Ei Ei Ei

Tally ● ● Kyllä Ei Kyllä Ei Kyllä

Rec
Review ● – Kyllä Ei Kyllä Ei Kyllä

Zoom ● – Kyllä Ei Kyllä Ei Kyllä

IR
Remote

– ● Ei Ei Kyllä Ei Kyllä

Lens ● – Kyllä Ei Kyllä Ei Kyllä

APR ● – Ei Ei Ei Ei Ei

[Type] soveltuu, [Setting] ei sovellu*1

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Camera Name – ● Ei Ei Ei Ei Kyllä

User – ● Ei Ei Ei Kyllä Kyllä

Wired LAN*1 ▲ ● Ei Ei Ei Kyllä Ei

File Transfer ● ▲ Kyllä Ei Kyllä Kyllä Kyllä

FTP Server 1 – ● Ei Ei Kyllä Ei Kyllä

FTP Server 2 – ● Ei Ei Kyllä Ei Kyllä

FTP Server 3 – ● Ei Ei Kyllä Ei Kyllä

SSL – ● Ei Ei Ei Kyllä Kyllä
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Stream

Maintenance

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Referer Check – ● Ei Ei Ei Kyllä Kyllä

Brute Force
Attack
Protection

– ● Ei Ei Ei Kyllä Kyllä

Ei määritettävissä kameran valikossa (vain näyttö)*1

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Stream
Setting

– ● Ei Ei Kyllä*1 Ei Kyllä*1

Video
Stream

– ● Kyllä Ei Kyllä Ei Kyllä

Audio
Stream – ● Kyllä Ei Kyllä Ei Kyllä

[NDI|HX] > [License] ei sovellettavissa*1

Kohde
(taso 2)

Kameran
valikko Verkkovalikko All

File
Scene

File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Language ● ● Kyllä Ei Kyllä Ei Kyllä

Accessibility – ● Kyllä Ei Ei Ei Kyllä

Clock Set ● ● Kyllä*1 Ei Kyllä*2 Ei Kyllä

Reset – ● Ei Ei Ei Ei Ei

Hours Meter ● – Ei Ei Ei Ei Ei

Information – ● Ei Ei Ei Ei Ei

System Log – ● Ei Ei Ei Ei Kyllä

HTTP Access
Log

– ● Ei Ei Ei Ei Kyllä

Service – ● Ei Ei Ei Ei Ei

EULA – ● Ei Ei Ei Ei Ei

Software – ● Ei Ei Ei Ei Ei

Päivä- ja aikatiedot eivät ole sovellettavissa*1

[Time Zone]-, päivä- ja aikatiedot eivät ole sovellettavissa*2
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Esiasetusvalintojen tallennetut kohteet

”Kyllä” ilmaisee esiasetusvalinnan tallennetun asetuksen ja ”Ei” ilmaisee tallentamattoman asetuksen.

Panorointi-/kallistuskohteet

Zoomauskohteet

Tarkennuskohteet

Näyttösijainti Kohde Tallennuskohde

Rajauksen hallintapaneeli suorassa käyttönäkymässä
Panorointi-/kallistusasento Kyllä

[Pan-Tilt Speed] Ei

[Pan-Tilt] verkkovalikossa

[P/T Speed] Ei

[P/T Acceleration] Ei

[P/T Range Limit] Ei

[P/T Direction] Ei

[P/T Preset] > [Pan-Tilt] Ei

[P/T Preset] > [Default] > [Pan-Tilt Speed] Kyllä1)

Asetusten arvot esiasetusvalintaa tallennettaessa tallennetaan kyseisen esiasetusvalinnan arvoina. Kun arvot on tallennettu, kunkin
esiasetusvalinnan arvoja voidaan muuttaa. Lisätietoja on kohdassa ”Esiasetusvalintojen siirtymisnopeuden (panorointi-
kallistus/zoomaus/tarkennus) muuttaminen verkkosovelluksella”.

1)

Näyttösijainti Kohde Tallennuskohde

Rajauksen hallintapaneeli suorassa käyttönäkymässä
Zoomausasento (tarkennusetäisyys) Kyllä

[Zoom Speed] Ei

[Pan-Tilt] > [P/T Preset] > [Default] verkkovalikossa
[Zoom Sync] Kyllä1)

[Zoom Speed] Kyllä1)

[Technical] > [Zoom] kameran valikossa [Zoom Type] Ei

Asetusten arvot esiasetusvalintaa tallennettaessa tallennetaan kyseisen esiasetusvalinnan arvoina. Kun arvot on tallennettu, kunkin
esiasetusvalinnan arvoja voidaan muuttaa. Lisätietoja on kohdassa ”Esiasetusvalintojen siirtymisnopeuden (panorointi-
kallistus/zoomaus/tarkennus) muuttaminen verkkosovelluksella”.

1)
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Aiheeseen liittyvää
Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen esiasetusvalintaa palautettaessa

5-041-958-73(1) Copyright 2022 Sony Corporation

Näyttösijainti Kohde Tallennuskohde

Kameran kuvapaneeli suorassa
käyttönäkymässä

Reaaliaikaisen seurannan AF:lle määritetty
seurantakohde

Ei

Pistetarkennukselle määritetyt koordinaatit Ei

 (Focus) -välilehti suorassa
käyttönäkymässä

[Touch Focus]-kytkin Ei

[Auto Focus]-kytkin Kyllä

[Focus Hold] -painikkeen tila Ei

[Push AF/MF] -painikkeen tila Ei

[Face/Eye Detection AF] Kyllä

[AF Subj. Shift Sens.] Kyllä

[AF Transition Speed] Kyllä

Tarkennusasento Kyllä1)

[Shooting] > [Focus] verkkovalikossa

[Push AF Mode] (mukaan lukien asetukset
ohjelmoitavilla painikkeilla)

Ei

[Touch Function in MF] Ei

[AF Assist Control] Ei

[Pan-Tilt] > [P/T Preset] > [Default]
verkkovalikossa

[Focus Recall] Kyllä2)

[MF Speed] Kyllä2)

[Shooting] > [Focus] kameran valikossa

Tarkennusalueen koko ja sijainti määritetty kohdassa
[Focus Area]

Kyllä

Tarkennusalueen sijainti määritetty kohdassa [Focus
Area (AF-S)]

Kyllä

Ei palauteta, kun [Auto Focus] -kytkin on On-asennossa. Palautetaan, kun asento on Off.1)

Asetusten arvot esiasetusvalintaa tallennettaessa tallennetaan kyseisen esiasetusvalinnan arvoina. Kun arvot on tallennettu, kunkin
esiasetusvalinnan arvoja voidaan muuttaa. Lisätietoja on kohdassa ”Siirtymisnopeuden (panorointi-kallistus/zoomaus/tarkennus) muuttaminen
esiasetusvalintaa palautettaessa”.

2)
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lohkokaaviot

Audio Input

Audio Output

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

E-pidikkeellisen objektiivin ohjelmiston päivittäminen

Voit päivittää E-pidikkeellisen objektiivin ohjelmiston laitteen avulla.
Katso verkkosivustolta tiedot objektiiveista, joita ei voi päivittää, ja vastaavat ohjelmistot.
Ohjelmisto päivitetään verkkovalikon avulla.

Huomautus

Älä tee seuraavia toimenpiteitä ennen kuin päivitys on valmis.

Verkkoyhteyden katkaiseminen
Objektiivin irrottaminen
Virran sammuttaminen

Jos näkyviin tulee viesti, joka ilmoittaa, että päivitys epäonnistui, tarkista näytetty kuvaus ja yritä päivittää uudelleen.

5-041-958-73(1) Copyright 2022 Sony Corporation

Kiinnitä E-pidikkeellinen objektiivi laitteeseen.1

Tarkista verkkovalikossa [Maintenance] > [Information] > [Lens] > [Model Name] ja [Version Number].

E-pidikkeellisen objektiivin ohjelmistoversion numero näkyy reunassa.
Tarkista ohjelmistoversion numero ja päivitä ohjelmisto tarvittaessa.

2

Lataa objektiivin ohjelmistopäivitystiedosto Windowsille (.exe-tiedostopääte) laitteeseen, jossa
verkkosovellus on käytössä.

3

Kohdassa [Maintenance] > [Information] > [Lens] > [Version Up] paina [Choose File] -painiketta ja valitse
ladattu päivitystiedosto.

4

Noudata näytöllä näkyviä ohjeita.5
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektiivin vapautuspainikkeen kannen kiinnittäminen

Objektiivin tahatonta irtoamista voi ehkäistä kiinnittämällä CIB-PCM1-kattotelineen (lisävaruste) mukana toimitetun
objektiivin vapautuspainikkeen kannen objektiivin vapautuspainikkeeseen.

Huomautus

Tämä ei kokonaan estä objektiivin irrottamista.

Aiheeseen liittyvää

Objektiivin kiinnittäminen

5-041-958-73(1) Copyright 2022 Sony Corporation

Kiinnitä objektiivi.

Lisätietoja objektiivin kiinnittämisestä saat kohdasta ”Objektiivin kiinnittäminen”.

1

Liu’uta panoroinnin/kallistuksen lukitusvipu LOCK-asentoon lukitaksesi kamerapään
panoroinnin/kallistuksen.

2

Siirrä kameralohko asentoon, jossa objektiivin poistokansi voidaan kiinnittää.3

Kiinnitä objektiivin poistokansi siten, että se peittää objektiivin vapautuspainikkeen.4

Vakauta objektiivin poistokansi käyttämällä objektiivin poistokannen pidikeruuvia.5
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lisenssit

MPEG-4 AVC Patent Portfolio -lisenssi

TÄMÄ TUOTE ON LISENSOITU AVC PATENT PORTFOLIO -LISENSSIN ALAISENA KULUTTAJAN
HENKILÖKOHTAISEEN KÄYTTÖÖN JA MUUHUN KÄYTTÖÖN, JOSTA EI MAKSETA KORVAUKSIA,
(i) VIDEON KOODAAMISEEN AVC-STANDARDIN MUKAISESTI (”AVC-VIDEO”) JA/TAI
(ii) AVC-VIDEON DEKOODAUKSEEN, JOS VIDEON ON KOODANNUT KULUTTAJA HENKILÖKOHTAISEEN
KÄYTTÖÖN JA/TAI SE ON HANKITTU VIDEOIDEN TOIMITTAJALTA, JOLLA ON LISENSSI AVC-VIDEOIDEN
LEVITTÄMISEEN.
MUITA KÄYTTÖTARKOITUKSIA VARTEN EI MYÖNNETÄ SUORAA TAI EPÄSUORAA LUPAA. LISÄTIETOJA ANTAA
MPEG LA, L.L.C. KS. HTTP://WWW.MPEGLA.COM

GPL/LGPL-lisenssin alaisen ohjelmiston hankkiminen

Tämä tuote käyttää ohjelmistoa, johon sovelletaan GPL-/LGPL-lisenssiä. Tämä on tiedote siitä, että sinulla on oikeus
tarkastella, muokata ja jakaa eteenpäin näiden ohjelmistojen lähdekoodia GPL-/LGPL-lisenssin ehtojen mukaisesti.
Lähdekoodi on saatavilla internetissä. Käytä seuraavaa URL-osoitetta ja noudata latausohjeita.
https://oss.sony.net/Products/Linux/
Toivomme, että et ota meihin yhteyttä lähdekoodin sisällön osalta.

μT-Kernel-lähdekoodi

Tässä tuotteessa käytetään μT-Kernel-lähdekoodia T-lisenssillä 2.1, jonka on myöntänyt TRON Forum (www.tron.org).

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tekniset tiedot

Yleiset

Paino
N. 4,6 kg (pelkkä runko)
N. 6,0 kg (sis. SELP28135G-objektiivin)

Mitat
Ks. ”Ulkomitat”.

Tehontarve
19,5 V DC
PoE++ (IEEE802.3bt, Type 4, Class 8 -yhteensopiva)

Virrankulutus
19,5 V DC: 80,0 W (enint.)
PoE++: 71,3 W (enint.)　

Käyttölämpötila
0 °C–40 °C

Varastointilämpötila
−20 °C–+60 °C

Tallennusmuoto (video)
XAVC Intra
XAVC-I 4K/QFHD -tila: VBR, bittinopeus 600 Mbps (enint.), MPEG-4 AVC/H.264
XAVC-I HD -tila: CBG, 223 Mbps (enint.), MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD -tila: VBR, bittinopeus 150 Mbps (enint.), MPEG-4 H.264/AVC
XAVC-L HD 50 -tila: VBR, 50 Mbps (enint.), MPEG-4 H.264/AVC
XAVC-L HD 35 -tila: VBR, 35 Mbps (enint.), MPEG-4 H.264/AVC

Tallennusmuoto (ääni)
LPCM 24-bittinen, 48 kHz, 4-kanavainen

Tallennuksen kuvataajuus

XAVC Intra
XAVC-I 4K -tila: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD -tila: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD -tila: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD -tila: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50 -tila: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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XAVC-L HD 35 -tila: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Tallennus-/toistoaika
XAVC Intra
XAVC-I QFHD -tila: 59.94P, noin 30 minuuttia (käytössä CEA-G160T)
XAVC-I HD -tila: 59.94P, noin 78 minuuttia (käytössä CEA-G160T)

XAVC Long
XAVC-I QFHD -tila: 59.94P, noin 115 minuuttia (käytössä CEA-G160T)
XAVC-I HD 50 -tila: 59.94P, noin 155 minuuttia (käytössä CEA-G80T)
XAVC-I HD 35 -tila: 59.94P, noin 210 minuuttia (käytössä CEA-G80T)

Huomautus

Tallennus-/toistoaika voi vaihdella käyttöolosuhteista ja muistin ominaisuuksista riippuen. Tallennus- ja toistoajat käsittävät
yhtäjaksoisen tallentamisen yhtenä leikkeenä. Todelliset ajat voivat olla lyhyempiä riippuen tallennettujen leikkeiden
lukumäärästä.

Panoroinnin/kallistuksen ohjaus

Panoroinnin vähimmäisnopeus: 0,02 astetta/s
Kallistuksen vähimmäisnopeus: 0,02 astetta/s
Panoroinnin enimmäisnopeus: 60 astetta/s
Kallistuksen enimmäisnopeus: 60 astetta/s
Panorointialue: −170 astetta – +170 astetta
Kallistusalue: −30 astetta – +195 astetta
Kohinakriteeriluokka: NC35 tai alempi
Esiasetusvalinnat: 100

Kameraosio

Kuvanmuodostuslaite
35 mm koko kehys (35,6 × 23,8 mm), Exmor R CMOS -anturi

Pikselien lukumäärä
Noin 12,9 megapikseliä (kokonaispikselimäärä)
Noin 10,3 megapikseliä (käyttöpikselimäärä)

Automaattitarkennus
Tunnistusmenetelmä: vaiheentunnistus/kontrastintunnistus

Sisäiset ND-suodattimet
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Lineaarisesti muuttuva ND: 1/4ND–1/128ND

ISO-herkkyys
ISO 800/12800 (Cine EI -tila, D55-valonlähde)

Objektiivinpidike
E-pidike

Valotusvara
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15+ aukkoa

Suljinaika
64F–1/8000 s (23.98P)

Suljinkulma
5,6°–360°, 2–64 kuvaa

Hidastus ja nopeutus
XAVC QFHD: 1 fps–120 fps
XAVC HD: 1 fps–240 fps
XAVC 4K: 1 fps–60 fps
XAVC HD (S35): 1 fps–120 fps

Valkotasapaino
2000 K–15000 K

Herkkyysvahvistus
−3 dB–+30 dB (1 dB:n välein)

Perusulkoasu
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Ääniosio

Näytetaajuus
48 kHz

Kvantisointi
24 bittiä

Taajuusvaste
XLR-tulo MIC-tila: 20 Hz–20 kHz (enintään ±3 dB)
XLR-tulo LINE-tila: 20 Hz–20 kHz (enintään ±3 dB)

Dynaaminen alue
XLR-tulo MIC -tila: 80 dB (tyypillinen)
XLR-tulo LINE -tila: 90 dB (tyypillinen)

Vääristymä
XLR-tulo MIC-tila: enintään 0,08% (−40 dBu tulotaso)
XLR-tulo LINE-tila: enintään 0,08% (+14 dBu tulotaso)

Tulo/lähtö

Tulot
DC IN

EIAJ-yhteensopiva, 19,5V DC

AUDIO IN

XLR-tyyppi, 5-nastainen, naaras
LINE / MIC / MIC+48V vaihdettava
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MIC: Reference −30 dBu – −80 dBu

GENLOCK IN

BNC-liitin, 1,0 Vp-p, 75 Ω

TC IN

BNC-liitin

Lähdöt
SDI OUT

BNC-liitin, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Tyypin A liitin

OPTICAL-lähtöliitin

SFP+-yhteensopiva
* Laite ei tue optista signaalituloa.

Tulo/lähtö
LAN-liitin

RJ-45, 1000BASE-T

OPTION-liitin

RJ-45 tally-merkkivalon tulo-/lähtöliitin

Korttipaikat

CFexpress Type A / SD -korttipaikka (2)

Mukana toimitettavat lisävarusteet

Muuntaja (1)
Virtajohto (1)
Infrapunakaukosäädin (1)
Rungon suojus (1) (kiinnitetty yksikköön)
HDMI-kaapelin pidikelevy (1)
Ennen laitteen käyttöä (1)
Takuuvihko (1)

Ulkomitat

Mitat ovat likiarvoja.
Yksikkö: mm

Kameran runko
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Kattoteline
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Rakennetta ja teknisiä tietoja voidaan muuttaa ilman ennakkoilmoitusta.

5-041-958-73(1) Copyright 2022 Sony Corporation
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Ohjekirja

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tavaramerkit

 on Sony Group Corporation -yhtiön tavaramerkki.
XAVC ja  ovat Sony Group Corporation -yhtiön rekisteröityjä tavaramerkkejä.
Termit HDMI ja HDMI High-Definition Multimedia Interface ja HDMI-logo ovat HDMI Licensing Administrator, Inc.:n
tavaramerkkejä tai rekisteröityjä tavaramerkkejä Yhdysvalloissa ja muissa maissa.
Microsoft ja Windows ovat Microsoft Corporationin tavaramerkkejä tai rekisteröityjä tavaramerkkejä Yhdysvalloissa
ja/tai muissa maissa.
Mac ja macOS ovat Apple Inc.:n rekisteröityjä tavaramerkkejä Yhdysvalloissa ja muissa maissa.
”Catalyst Browse” -logo on Sony Group Corporation -yhtiön rekisteröity tavaramerkki.
IOS on Ciscon Yhdysvalloissa ja muissa maissa rekisteröity tavaramerkki ja sitä käytetään lisenssillä.
iPadOS, Safari ja iPad Apple Inc:n rekisteröityjä tavaramerkkejä Yhdysvalloissa ja muissa maissa.
Android ja Google Chrome ovat Google LLC:n rekisteröityjä tavaramerkkejä.
Wi-Fi on Wi-Fi Alliancen rekisteröity tavaramerkki.
SDXC-logo on SD-3C, LLC -yhtiön tavaramerkki.
CFexpress ja CFexpress Type A -logo ovat CompactFlash Associationin tavaramerkkejä.
NewTek™ ja NDI® ovat NewTek, Inc. -yhtiön tavaramerkkejä tai rekisteröityjä tavaramerkkejä.
JavaScript on Oracle-yhtiön ja/tai sen tytäryhtiöiden rekisteröity tavaramerkki.
Intel, Intel-logo ja Intel Core ovat Intel Corporation -yhtiön tai sen tytäryhtiöiden tavaramerkkejä.
QR Code on Denso Wave Inc. -yhtiön tavaramerkki.
Kaikki muut yritysnimet ja tuotenimet ovat omistajiensa rekisteröityjä tavaramerkkejä tai tavaramerkkejä.
Tavaramerkin alaisia tuotteita ei ole tässä asiakirjassa merkitty symboleilla ™ tai ®.

5-041-958-73(1) Copyright 2022 Sony Corporation
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